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Welcome to ER/Studio Business Architect 
ER/Studio Business Architect (previously known as EA/Studio) applies two different types of 
modeling: Business Process Modeling Notation (BPMN), and Conceptual Modeling. These 
modeling processes allow you to integrate roles from various constituencies to collaborate, 
agree, create, and enable executable processes. 

The Business Process Modeling portion of ER/Studio Business Architect (ER/Studio BA) is a 
visual modeling application that focuses on business process modeling and its relationship to 
related enterprise and data artifacts. Business processes do not exist in a vacuum within the 
organization, so ER/Studio BA allows you to link key business process information to data, 
organization, rules, etc. to get a broad view of the organization and show how processes and 
data impact one another. 

The Conceptual Modeling portion allows Data Modelers to create high-level designs of core 
business concepts to gain acceptance and requirements from the business. These high-level 
Conceptual models can be forward engineered to create detailed Logical Data Models in ER/ 
Studio. You can relate data objects to business process information and create Usage (CRUD) 
and Impact Analysis reports. In addition to process-specific information, related business 
information can also be linked to data objects such as business rules, business elements, 
business units, and stewards. 

Through robust reporting, modeling, and graphical impact analysis, users are able to provide 
relevant information to various stakeholders within the organization in a format that makes 
sense to them. For example, a data analyst may wish to see a Usage (CRUD) report showing 
what data is used by a given process for compliance. A business user may want to see a list of 
relevant business rules in a spreadsheet. A process modeler needs to see a semantically-rich 
process model. ER/Studio BA allows each stakeholder to see a different “slice” of 
information—all from the same data source and metadata model. 
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About ER/Studio Business Architect 
ER/Studio BA is used for creating graphical representations of your business from the core 
concepts that describe the business, to the processes detailing how your business operates. You 
can model business processes and how those processes use data. The Business Process Modeling 
is based on the BPMN standard. 

The Conceptual Modeling provides intuitive ways to outline subject areas and concepts that can 
then drive the creation of detailed data models. The Conceptual Modeling uses high-level 
representations allowing for top-down database design. 

Functionality Description 

Conceptual Modeling 

Conceptual Model Creation Support for high-level conceptual modeling using elements such as subject areas, 
business entities, interactions, and relationships. 

Relationship Traceability Model links between any conceptual or process modeling elements allowing you to 
trace relationships between models. 

Conceptual Model Export Conceptual models can be exported to ER/Studio to become the foundation for 
creating ER/Studio logical data models. The export uses pre-defined mapping. 

Business Process Modeling 

Process Model Creation Support for straightforward process modeling that uses standard elements such as 
sequences, tasks, swimlanes, start events, and gateways. 

BPMN Compliance Optional automatic validation of process diagrams to ensure compliance with the 
BPMN specification and prevent the addition of non-compliant modeling elements. 

Embedded sub-process 
support for functional 
decomposition 

Independent sub-processes and embedded collapsible sub-processes can be 
included within a business process to allow for maximum flexibility in diagramming, 
while still ensuring a workable visual diagram. 

Impact Analysis Reporting 

Multi-object, Multi-level 
Reporting 

Impact analysis reports can be generated to show interrelationships between 
process, data, stewardship, business rules, diagram usage, heritage, connecting 
objects etc. 

Report Filtering Impact analysis reports can filter based on type of relationship, object type, or text 
strings including wildcard matching. 

Usage (CRUD) Reporting 

Link Process with Data The relationships between business processes and data objects can be modeled to 
identify what processes create, read, update, or delete data objects. 

CRUD Reporting CRUD reports identify which processes affect which data, and what affects they 
have. Reports are available in a straightforward spreadsheet view. 

Report Filtering Reports can be shown across object types, or can be filtered based on individual 
object types such as tasks or business processes, allowing users to drill down based 
on specific requirements. 

Business Artifact  Modeling 

External Data Objects Support for data objects which are general data storage constructs that can 
represent databases, file systems, or other data storage mechanisms. 
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Functionality Description 

Business Elements Captures business terms that can later be used to enforce naming standards or as 
the foundation of logical data models. 

Business Rules Incorporate policies, practices, or formulas related to business processes as part of 
the process model elements and metadata processes, allowing users to drill down 
based on specific requirements. 

Business Units Create and incorporate business units into process models such as sales, human 
resources, or accounting. 

Stewardship Support for inclusion of organizational roles such as ‘DBA’ or ‘Sales Manager’ to 
incorporate ownership for specific processes or tasks. 

Links Create generic associations between objects for impact analysis and CRUD 
reporting. 

User Interface 

Organizational Hierarchies ER/Studio BA allows you to organize your information to align with your business 
strategy, allowing for a Project-based tree hierarchy which can group multiple 
model types and diagrams into intuitive projects to allow for alignment with 
business initiatives or organizations. 

Flexible Interface Full support for multiple property editors, tab-based navigation, undo/redo, 
collapsible nested tree views, zoom-based navigation, and keyboard shortcuts. 

Flexible object formatting and 
display options 

Ability to customize a wide variety diagram options including line width, color and 
fill options, font displays, line connector points, line bend formats, etc. 

Grid Editing A table-based alternative to the hierarchical tree view, allowing the display of large 
numbers of objects or business rules in an easy to read format. 

Publish Model to Web Automatically generate HTML views of your models to share with other people in 
your organization. 

Import / Export 

Share Information Across 
Multiple Roles and Formats 

Can share process models among a broad range of user groups by exporting them 
into a wide variety of supported formats including xml, csv, html, pdf, rtf, and jpeg. 

ER/Studio Import/Export Import and export ER/Studio Business Architect models for use as data assets or 
Conceptual diagrams. 

Visio Import Configurable import capabilities let you import diagrams from Microsoft® Visio®. 

Collaboration  and Reporting Connect to ER/Studio Repository to share workspaces, diagrams, and models. 
Connect to ER/Studio Portal to explore and report on ER/Studio BA objects in ER/ 
Studio Repository. For more information, see Working with ER/Studio Repository. 

Architecture 

Separation of Data and 
Display 

ER/Studio BA is based on a metadata foundation that allows core data to be 
manipulated and displayed in a variety of formats, without requiring a “picture” or 
diagram, speeding performance and increasing knowledge transfer across multiple 
constituencies. 

Object Reuse Core processes and enterprise objects can be reused across multiple diagrams, 
allowing for a “single version of the truth” across the organization. 

Standards-Based ER/Studio BA is based on industry standards: Eclipse-based, XML file formats with 
published Schema, and BPMN modeling notations. 
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About the User Guide 
The User Guide focuses on the key features and capabilities of the application. The table below 
describes the sections of the online Help: 

Section Description 

Application Basics Explains the application design, navigation tools, and important 
concepts, as well as how to configure the application. 

Using ER/Studio  
Business Architect 

Explains how to use workspaces, projects, models, diagrams, and 
diagram elements as part of the modeling process. 

Working with ER/Studio  
Repository 

Explains how to configure and connect to the repository to get, 
check in, and check out workspaces, diagrams, and models. 

Using Business Process  
Modeling Notations 

Explains how to work with the Business Process Modeling 
Notation. 

Using Conceptual  
Modeling Notations 

Explains how to work with the Conceptual Modeling Notation. 

ER/Studio Business  
Architect Tools 

This chapter covers the main tools used in ER/Studio BA: Create 
Diagrams from Selected Elements, Find, Search, Links, Usages, 
Grid Editor, Reports, and Views. 

ER/Studio Business  
Architect Tools -  
Importing and Exporting 

This chapter covers Conceptual Models Import and Export to ER/ 
Studio, External Data Objects Import and Export to ER/Studio, 
and Visio Import. 

Property Views Explains the fields in the Property View. 

Glossary Defines words used in ER/Studio BA and this documentation. 

For more information, see 

• Technical requirements 

• Product resources 

• Licensing ER/Studio Business Architect 

• Uninstalling ER/Studio Business Architect 

• Additional product resources 

• IDERA Technical Support 

Technical requirements 
Before using ER/Studio BA, verify that your environment meets the application hardware and 
operating system requirements. 
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Hardware requirements 
ER/Studio BA hardware requirements vary. The table below outlines the minimum 
recommended requirements for ER/Studio BA: 

Hardware Minimum Requirement 

CPU 1.2 Ghz 

RAM 1 GB MB of RAM 

Disk Space Hard Drive Install 250 MB 

Storage - Sufficient space for workspaces, which will vary according to 
complexity. 

Video SVGA 

High resolution monitor (1024 x 768 or higher) with high color (16-bit) 

Media CD-ROM or the Internet (www.idera.com). 

Operating system requirements 
ER/Studio BA supports the following operating systems: 

• Microsoft Windows® XP SP2 

• Microsoft® Vista ® 2007 

• Microsoft Windows® 7, 8.1, and 10 

NOTE:  ER/Studio BA is supported on Windows Vista when using the Windows Vista Basic 
experience. The premium experience, Windows Aero®, is not supported for use with 
ER/Studio BA. 

Product resources 
The section gives you additional resources that are available to help you use ER/Studio BA. The 
Object Management Group/Business Process Management Initiative is responsible for 
generating a standard Business Process Modeling Notation (BPMN) providing business with 
standard graphical notations for internal business procedures. For more information, see 
http://www.bpmn.org 

The Business Process Modeling Notation (BPMN) specification provides standardized graphical 
notations for expressing business processes in a Business Process Diagram (BPD). 

For more information, see http://www.omg.org/spec/ 

http://www.bpmn.org/
http://www.omg.org/spec/
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Licensing ER/Studio Business Architect 
For information on licensing ER/Studio BA, go to the ER/Studio Enterprise Team Edition Quick 
Start Guide at www.idera.com/support/productdocuments 

Uninstalling ER/Studio Business Architect 
To uninstall ER/Studio BA so you can install a later version, do the following: 

1. Click Start > Programs > IDERA ER/Studio Business Architect X.X, and then Uninstall 
ER/Studio Business Architect. ER/Studio BA opens the Uninstall Wizard. 

2. You can select to uninstall all or part of the products. The separate components are: 
Program Files, Help Documents, and Common Components. 

3. Complete the wizard panels, and then click Finish. ER/Studio BA and all its components are 
uninstalled. 

NOTE:  During uninstallation, you have the option to remove all preference settings. If the 
settings are removed at this time, all the preferences you have set are lost for 
future installs. 

NOTE:  The workspaces and their related projects, models and diagrams are 
stored in a different directory and are not uninstalled. 

Additional product resources 
The IDERA Web site is an excellent source for additional product information, including white 
papers, articles, FAQs, discussion groups, and the Knowledge Base. 

Go to ER/Studio Support, or click any of the links below, to find: 

• Documentation 

• Online Demos 

• Technical Papers 

• Discussion Forums 

• Knowledge Base 

https://www.idera.com/support/productdocuments
https://www.embarcadero.com/support
https://www.idera.com/support/productdocuments
https://www.idera.com/er-studio-enterprise-data-modeling-and-architecture-tools/resources
https://www.idera.com/er-studio-enterprise-data-modeling-and-architecture-tools/resources
https://forums.embarcadero.com/index.jspa
http://www.embarcadero.com/jive/index.jspa
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IDERA technical support 
If you have a valid maintenance contract with IDERA, the Technical Support team is available to 
assist you with any problems you have with our applications. Our maintenance contract also 
entitles registered users of IDERA products to download free software upgrades during the active 
contract period. 

To save you time, IDERA maintains a Knowledge Base of commonly- encountered issues and 
hosts Discussion Forums that allow users to discuss their experiences using our products and any 
quirks they may have discovered. 

To speak directly with IDERA Technical Support, see Contacting IDERA Technical Support 
below. 

NOTE:  Evaluators receive free technical support for the term of their evaluation (14 days). 

Contacting IDERA Technical Support 
When contacting IDERA Technical Support please provide the following to ensure swift and 
accurate service: 

Personal information 

• Name 

• Company name and address 

• Telephone number 

• Fax number 

• Email address 

Product and System Information 

• IDERA product name and version number. This information is found under Help, About. 

• Your client operation system and version number. 

• Your database and version number. 

Problem description 

A succinct but complete description of the problem is required. If you are contacting us by 
telephone, please have the above information, including any error messages, available so that an 
IDERA Technical Support Engineer can reproduce the error and clearly understand the problem. 

 

https://forums.embarcadero.com/index.jspa
https://forums.embarcadero.com/index.jspa
https://www.embarcadero.com/support
https://www.embarcadero.com/support
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Via the Web 

IDERA Technical Support provides an online form that lets you open a Support case via the 
Web. To access this form, go to ER/Studio support case 

We normally acknowledge the receipt of every case on the same day, depending on the time of 
submission. 

Via p hone 

North America and Latin America 

ER/Studio Technical Support phone number is (800) 523-7070. The hours are Monday through 
Friday, 7:00 A.M. to 5:00 P.M. Pacific time. 

EMEA 

ER/Studio Technical Support phone number is +44 (0)1628 684 499. The hours are Monday to 
Friday, 9 A.M. to 5:30 P.M. U.K. time. 

Via Email 

United States 

Depending on your needs, send your email to one of the following: 

• support@embarcadero.com - Get technical support for users and evaluators 

• upgrade@embarcadero.com - Request upgrade information 

• key@embarcadero.com - Request a product key 

• wish@embarcadero.com - Make a suggestion about one of our products 

EMEA 

Depending on your needs, send your email to one of the following: 

• uk.support@embarcadero.com- Get technical support for users and evaluators 

• uk.upgrade@embarcadero.com - Request upgrade information 

• uk.key@embarcadero.com - Request a product key 

• uk.wish@embarcadero.com - Make a suggestion about one of our products 

 

http://www.embarcadero.com/support/open_case.jsp
mailto:support@embarcadero.com
mailto:upgrade@embarcadero.com
mailto:key@embarcadero.com
mailto:wish@embarcadero.com
mailto:uk.support@embarcadero.com
mailto:uk.upgrade@embarcadero.com
mailto:uk.key@embarcadero.com
mailto:uk.wish@embarcadero.com
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Application basics 
Application Basics acquaints you with the application and provides information about what ER/ 
Studio BA offers in the way of design, navigation, and general application features. The 
information presented here is high-level and conceptual. For information on how to use the ER/ 
Studio BA feature set, see Using ER/Studio Business Architect. 

ER/Studio BA uses workspaces and projects to organize business process and conceptual 
modeling. You can use diagrams to create a visual model of both business process and 
conceptual modeling systems. You can navigate ER/Studio BA by using the application toolbars, 
menus, shortcut menus, and the keyboard commands. 

Application Basics includes three sections: 

Topic Description 

Product Design Explains the views and windows that make up ER/Studio BA. 

Navigation Explains the ER/Studio BA Model View, toolbars, menus, 
palettes, and keyboard commands used to navigate the 
application. 

Preferences Explains the different ways you can configure default application 
settings using Preferences. 

Product design 
ER/Studio BA consists of views and windows used to edit, navigate, and display information 
about each workspace and its corresponding diagrams. The application is broken down into five 
main categories: Workspaces, Projects, Models, Diagrams, and the Grid Editor. 

Workspaces 

A workspace is a unit of storage used for any collection of data modeling projects in ER/Studio 
BA. You can only open and work with one workspace at a time, but you can add any number of 
projects and models in a single workspace. 

For more information, see Using Workspaces. 

Projects 

A project is a unit of storage used for any collection of models and their associated elements in 
ER/Studio BA. You can have multiple Projects open simultaneously so you can easily switch back 
and forth between Projects. 

For more information, see Using Projects. 
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Models 

You can create Business Process and Conceptual models. A model is a specific collection of 
elements/objects related to a specific modeling type, for example the Business Process 
Modeling Notation (BPMN). A BPMN model would contain those objects associated with a 
specific business processes: tasks, swim lanes, gateways, etc. Objects within a model are 
displayed in the Model View tree by type (for example, a grouping node contains all of the tasks 
within the project). 

NOTE:  If you are modeling with the Business Process Modeling Notation, you can create a 
model in ‘Validation” mode, which enforces the rules of the Business Process 
Modeling Notation. With Validation set to Off you can use the visual drawing objects 
without being constrained by the rules of the notation. 

For more information, see Working with Models. 

Diagrams 

You can create two different types of diagrams: 

• Business Process Diagram (BPD): This type of diagram uses a flowcharting technique which is 
tailored for creating graphical models of business process operations. A Business Process 
Model is a network of graphical objects, which track the flow of activities and their order of 
execution. 

• Conceptual Diagrams: This is a high level diagram used to explain entities related to the 
business/organization. 

For more information, see Using Diagrams. 

Grid Editor 

The Grid Editor enables you to view the objects in the Model View tree in a spread-sheet format. 
It can be launched from most nodes in the Model View tree. When launched, the Grid Editor 
appears in the diagram area. If a diagram is already open, it appears as an additional tab. 

NOTE:  If a filter has been set in the tree, this filter carries over to the Grid Editor. 

For more information, see Grid Editor. 
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Navigation 
ER/Studio BA provides tools for navigating the product functionality, and for navigating within 
and between projects and diagrams. The main navigational areas are: 

• Model View 

• Palettes 

• Toolbars 

• Menus 

• Shortcut Menus 

• Keyboard Commands 

Model view 
The Model View appears in the upper left portion of the ER/Studio BA application by default. It 
contains the Model View tree displaying the hierarchy of workspaces, projects, models, diagrams, 
and elements. It also displays the hierarchy of reference elements. Workspaces, projects, models, 
diagrams, and elements can be created, organized, and viewed. 

For more information, see The Model View. 

Palettes 
The Palette contains the palettes used to create modeling diagrams in the Diagram View. You 
can change the display settings of this palette. 

There are seven main palettes: Business Process Objects, Conceptual Objects, Reference 
Objects, External Data Objects, and Drawing Shapes. 

The Modeling palette that is available in the palette depends on what model type you are 
working with. For example, if you are working in a Business Process Model diagram, the 
associated palette appears. If you are working with a Conceptual Model diagram, the Business 
Process Model palette is replaced by the Conceptual Model palette. 

For more information, see Using the Palette. 

Palette icons 

The table below describes the main elements on the Palette: 

Element Palette Icon Description 

Select 
 

 
The select cursor allows you to click on elements and select commands. 

Marquee 
 

 
Click this cursor to select multiple items by enclosing them in a frame. 
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Element Palette Icon Description 

Business  
Process  
Objects 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There are six main groups of notation elements: 

Events: There are three types of events: Start, Intermediate, and End. 
 
Activities: Activities available are: Tasks, Embedded Sub-processes, and 
Independent Sub-processes. 

 
Gateways: Gateways control sequence flows. There are five different gateway 
control types which indicate the flow control behavior. 

 
Connection Elements: There are three different elements used to connect 
elements: Sequence Flow, Message Flow, and Association. 

 
Swimlanes: There are two elements (pools and lanes) that are used to help 
partition and organize activities. 

 
Artifacts: There are four different artifacts that allow you to show additional 
information: Data Objects, Groups, Annotations, and Off-Page Connectors. 

Conceptual  
Objects  

 
 

This palette contains the five objects used in Conceptual Modeling 

Reference  
Objects  

 
 

This palette displays the four available reference objects and the link. 

External Data  
Objects  

 
 

The External Data Objects palette displays the seven different data objects 
available. 

Drawing  
Shapes  

 

The drawing shapes node contains nine basic shapes you can use to create 
diagrams. This palette also includes a text label, line, and annotation. 

Palette Settings d ialog 

The Palette Settings dialog box is where you specify display options for the palette. To open this 
dialog, right click on any object on the Palette and click Settings. The table below describes the 
display options: 

Option Description 

Layout Columns: Icons in the palette are displayed in columns. 

List: Icons in the palette are listed below each main heading. 

List: Displays both the icon and its descriptive text. 

Icons Only: Only the icons in the palette are displayed. No labels are 
shown. 

Details: Icons in the palette are displayed with labels and descriptions. 

Layout Options The layout option displayed depends on which Layout type you select. 

Drawer Options The contents in the palette are organized using drawers, which open and close. 
Each group element contains specific Palette Entries. An Entry defines a tool or 
template for the User. Select one of the options listed below to determine the 
drawer’s behavior. 

• Always close when opening another drawer. 

• Close automatically when there is not enough room. 

• Never close. 
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Business Process Objects palette 

This palette appears in the Diagram Area when you open or create a Business Process diagram. It 
is not available if a Conceptual Model is open. If a element has additional options available, a 
drop-down menu appears to the right of the icon and element name in the palette. For example, 
if you click the End Event element, six additional end event types are available. 

Element Palette Icon Description 

Start Events 

Start Event 
 

 
 

Initiates the start of a Process. 

Link 
 

 

A mechanism for connecting the end of one Process to the start (or 
trigger) of another. 

Message  
 

A message arrives from a participant and triggers the start of the 
Process. 

Rule 
 

 

This type of event is triggered when the conditions for a rule become 
true. 

Timer 
 

 

A specific time-date or a specific cycle (e.g., every Friday at 10:00 
a.m.) is set that triggers the start of the Process. 

Intermediate Events 

Intermediate Event 
 

 

Happens during the course of a process event. 

Cancel 
 

 
This trigger is used within a Transaction Sub-process. This type of 
event must be attached to the boundary of a Sub- process. 

Compensation 
 

 

Compensation is when activities are invoked that undo an 
undesirable outcome. 

Error 
 

 
 

The trigger sets or catches errors. It sets an error if the Event is part of 
a Normal Flow. It reacts to a named error when attached to the 
boundary of an activity. 

Link 
 

 

Connects an End Event of one Process to an Intermediate Event in 
another Process. 

Message 
 

 

 

A message arrives from a participant and triggers an Event. The 
Process then continues if it is waiting for a message, or changes the 
flow for exception handling. 

Rule 
 

 
 

This trigger is only used for exception handling. This event is 
triggered when a Rule becomes True. A Rule is an expression that 
evaluates some Process data. 

Timer 
 

 
 

A specific time-date or cycle is set that triggers an Event. It can act as 
a delay mechanism if used within the main flow. If used for exception 
handling, it changes the Normal Flow into an Exception Flow. 

End Events 

End Event 
 

 

Ends a process flow. 

Cancel 
 

 
 
 
 
 

The type of End is used within a Transaction Sub-process. It 
indicates that the Transaction should be cancelled and triggers a 
Cancel Intermediate Event attached to the Sub-process boundary. It 
also indicates that a Transaction Protocol Cancel message should be 
sent to any Entities involved in the Transaction. 



24  ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

Application basics > Navigation 
 

 

 

 
Element Palette Icon Description 

Compensation 
 

 
 

This End indicates that a Compensation is necessary. The 
Compensation identifier triggers an intermediate Event when the 
Process is rolling back. 

Error 
 

 

A named Error should be generated. This Error is caught by an 
Intermediate Event within the Event Context. 

Link 
 

 

A Link is a mechanism for connecting the end of one process to the 
start of another. 

Message 
 

 
A message is sent to a participant at the conclusion of the process. 

Terminate 
 

 

All activities in the Process should be ended immediately. The Process 
is ended without compensation or event handling. 

Tasks 

Task 
 

 
This is an activity that is performed within a business process. 

Loop Task 
 

 
 
 

The attributes of Tasks and Sub- processes determine if they are 
repeated or performed once. There are two types of loops: Standard 
and Multi-Instance. The looping indicator is displayed at the bottom-
center of the activity. 

Parallel Multiple 
Instance Loop Task  

 
 

This refers to parallel multiple instances of the activities. Activities 
that are Parallel Multi-Instance have a parallel marker placed in the 
bottom center of the activity. 

Sequential Multiple 
Instance Loop Task  

 
 

This refers to sequential multiple instances of the activities. Activities 
that are sequential multi-Instance have a parallel marker placed in the 
bottom center of the activity. 

Embedded Sub-Process 

Embedded Sub- 
Process  

 

 
 
 

An Embedded (or nested) Sub-process is an activity that contains 
other activities (a Process). The Process within the Process is 
dependent on the parent Process for instigation and has visibility to 
the parent’s global data. No mapping of data is required. 

Embedded Sub- 
Process (Collapsed)  

 
Select this icon to place a collapsed embedded sub-process in the 
Diagram View 

Ad Hoc Embedded 
Sub-process  

 
 
 
 
 
 

An Ad Hoc Process is a group of activities that have no pre-
definable sequence relationships. 

Activities within the Process are disconnected from each other. 
During execution of the Process, any one or more of the activities 
may be active and they can be performed in almost any order or 
frequency. 

Loop Embedded 
Sub-process  

 
 

The attributes of Tasks and Sub- processes will determine if they are 
repeated or performed once. There are two types of loops: Standard 
and Multi- Instance. A small looping indicator is displayed at the 
bottom- center of the activity. 

Parallel Multiple 
Instance Embedded 
Sub-process 

 
 
 

The attributes of Tasks and Sub- processes determine if they are 
repeated or performed once. A small parallel indicator is displayed 
at the bottom-center of the activity. 
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Element Palette Icon Description 

Serial Multiple 
Instance Embedded 
Sub-process 

 
 
 

The attributes of Tasks and Sub- processes determine if they are 
repeated or performed once. A small parallel indicator is displayed 
at the bottom-center of the activity. 

Transaction 
Embedded Sub- 
process 

 
 
 
 
 

A Sub-process, either collapsed or expanded, can be set as being a 
Transaction, which has a special behavior that is controlled through a 
transaction protocol (such as BTP or WS-Transaction). The boundary 
of the activity is double-lined to indicate that it is a Transaction. 

Independent Sub-Process 

Independent Sub- 
Process  

 
 

An independent Sub-process element is an activity within a Process 
that calls to another process that exists within a business process 
definition diagram. 

Loop Independent 
Sub-process  

 
 
 

The attributes of Tasks and Sub- processes will determine if they are 
repeated or performed once. There are two types of loops: Standard 
and Multi- Instance. A small looping indicator is displayed at the 
bottom- center of the activity. 

Parallel Multiple 
Instance 
Independent Sub- 
process 

 
 
 

The attributes of Tasks and Sub- processes determine if they are 
repeated or performed once. A small parallel indicator is displayed 
at the bottom-center of the activity. 

Serial Multiple 
Instance 
Independent Sub- 
process 

 
 
 

The attributes of Tasks and Sub- processes determine if they are 
repeated or performed once. A small parallel indicator is displayed 
at the bottom-center of the activity. 

Transaction 
Independent Sub- 
process 

 
 
 
 
 

A sub-process, either collapsed or expanded, can be set as being a 
Transaction, which has a special behavior that is controlled through 
a transaction protocol (such as BTP or WS-Transaction). The activity 
has a double border to indicate that it is a Transaction. 

Gateways 

Gateway 
 

 
 
 

This symbol displays decisions, merges, forks, and joins in the process 
flow. They control how Sequence Flows interact as they converge and 
diverge within a process. You can set the Gateway Control Types of a 
gateway and change the logic specified by it. 

Complex 
 

 
 
 
 
 

Decision: This expression determines which output flow is taken from 
multiple Sequence Flow names. 

Merge: You specify a complex flow condition referencing incoming 
Sequence Flow names or process data coming into a gateway. This 
expression determines when the task starts. 

Data-Based  
 

 
 
 

These are the most common gateways used. A data token traverses 
the Process Flow arriving at the gateway. It can only go out on one 
flow. This control type is represented by either a diamond with an “x” 
in the middle or blank diamond shape. 

Event-Based 
 

 
 
 

Decision: This represents a branching point where the alternatives are 
based on an event occurring at that point. 

Merge: The exclusive merge models data-based or event-based 
merges. Only one of the many inputs is chosen as the output. 
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Element Palette Icon Description 

Inclusive  
 

 
 
 
 
 

Decision: One or more of the outgoing Sequence Flows may be taken. 
A default flow must be specified at this point, there cannot be zero 
output flows. 

Merge: A process flow continues when it receives the first input signal 
from the input Sequence Flow. If other signals arrive after that, they 
are not used. 

Parallel 
 

 
 
 

Fork: All Sequence Flows out of this gateway are taken. 

Join: This gate must receive input signals from all input Sequence 
Flows. The process flow does not continue until it receives all signals. 

Sequence Flows 

Sequence Flow  
 
 
 
 

A sequence flow shows the sequence of processes in an organization. 
You can use the sequence flow lines to connect events, activities, and 
gateways in pools or lanes. The Sequence Flow has five different 
designations that can be set using the Sequence Flow Property View. 
Double-click the Sequence Flow to open the Sequence Flow 
Properties dialog. 

Conditional Flow  
 
 
 
 
 

A conditional flow is evaluated at runtime to determine whether or 
not the flow is used. If the conditional flow is outgoing from an 
activity, then the Sequence Flow has a mini-diamond at the beginning 
of the line. If the conditional flow is outgoing from a Gateway, then 
the line does not have the diamond. 

Default Flow  
 
 
 
 
 
 
 
 

For Data-Based Exclusive Decisions or Inclusive Decisions, one type of 
flow is the Default Condition flow. This flow is used only if all other 
outgoing conditional flows are not true at runtime. These Sequence 
Flows have a diagonal slash added to the beginning of the line. 
You would add a Default Conditional Flow marker to a Sequence Flow 
for two types of decision: Data-based Exclusive and Inclusive 
Decisions. This flow is used only if all the other outgoing conditional 
flows are not true at runtime. 

Exception Flow  
 
 

Exception Flows occur outside the normal flow of the Process and it is 
based upon an Intermediate Event that occurs during the performance 
of the Process. 

Message Flows 

Message Flow  
 

Shows the model order of processes between organizations (i.e. 
between pools). 

Association 

Association 
 

 
An Association is used to associate information and artifacts with 
events and activities 

Association to Target  
 

The Association connection flows from the source to the target. 

Association from 
Target 

 
 

The Association connection flows from the target to the source. 

Association to/from 
Target  

 
The Association connection indicates a flow in both directions. 
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Element Palette Icon Description 

Pools 

Pool (Horizontal) 
 

 
 
 
 

This pool is drawn as a rectangular region placed horizontally. A lane 
is a subpartition within a pool and extends the entire length of the 
pool. A pool represents an organization, function, application, class, 
or an entity. 

Pool (Vertical) 
 

 
 

This pool is drawn as a rectangular region placed vertically. It has the 
same characteristics as the horizontal pool. 

Lanes 

Lanes  
 
 
 
 

Lanes organize and categorize activities. When you place a process in 
a pool or lane you specify who is doing what. If you place an event in a 
lane you specify where that event occurs. When you place a gateway 
in a lane you specify where a decision is made or who makes it. 

Nested Lane  
 

You can place lanes within existing lanes with this object. 

Artifacts 

Data Object 
 

 
 
 

Data objects provide information about how documents, data, and 
other objects are used and updated in a Process. They represent data 
so are defined by a combination of entities or classes. 

Group 
 

 
 

Use the Group symbol to visually organize activities. 

Annotation  
 
 

Textual annotation allows you to provide additional facts and 
details about an element. 

Off-Page Connector 
 

 
 

If a process model extends beyond the length of one printed page 
you can use an Off-Page Connector to show how Sequence Flow 
connections extend across the page breaks. 
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Conceptual Objects palette 

This palette appears in the Diagram Area when you open or create a Conceptual Model 
diagram. It is not available if a Business Process Model is open. If an element has additional 
options available, a drop-down menu appears to the right of the icon and element name in the 
palette. For example, if you click the Relationship element, additional relationship types are 
available. 

Artifact Palette Icon Description 

Subject Area 
 

 
 

Describes the broad term of the business. It can be used by itself as a 
model object and/or as a grouping mechanism containing business 
entities. 

Business Entities 
 

 

“Thing” of the business/organization containing other business 
entities or elements, for example, inventory. 

Business  
Attributes  

 
 

A property of a business entity, for example, an employee 
identification number. You can copy and paste an attribute from one 
Business Entity to another within the same workspace. 

Interaction  
 

 
 

Relationship between two elements representing an action or 
process or transaction. Interactions can be created between different 
types. 

Group 
 

 

A graphical object to visually show that items are grouped together. 

Relationship 

Relationship  
 

 
 
 

Relationship between two elements representing a loose couple. 
Relationships can only be created between conceptual modeling 
elements of the same type. A warning dialog opens if you try to create 
a relationship between different types. 

Many-to-Many 
 

 

Denotes that many components are related to many components. 

Many-to-One  
 

Denotes that many components are related to one component. 

One-to-Many  
 

Denotes that one component is related to many components. 

Group 

Group 
 

 
 

A graphical object to visually show that items are grouped together. 
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References Objects palette 

The Reference Object Palette displays the four main reference objects as well as the Link and 
Usage connectors. Domains are not visualized on diagrams so the Domain element icon is not 
available on the Reference Object’s palette. 

Reference Object Palette Icon Definition 

Business Element 
 

 
 

A singular element of the business that can be bound to different 
business attributes across conceptual models. A Business Element 
can be used to seed business attributes in a business entity. 

Business Rule 
 

 

A business rule is a policy, practice, or formula related to the 
operation and enforcement of business practices. 

Business Unit 
 

 

A business unit is an organizational area within or external to an 
enterprise. 

Stewards 
 

 

A steward is a person or organization responsible to, or associated 
with a model element. 

Links 

Link 
 

 
 

This link displays high-level views of information requirements. This 
type is used to simply relate objects together. The link you create is 
labeled “conceptual”. 

Usage 
 

 
 

When you select this option you create a link that enables you to 
designate a usage type: create, read, update, or delete database 
records. The connection you create is labeled “usage” 

External Data Objects palette 

You can use an External Data Object (EDO) in a diagram for reference or for data flow 
diagramming. You can then link to External Data Objects with a specific business process or 
task. 

There are two different types of EDOs: Logical and Physical. The Logical types are entities and 
attributes. The Physical types are tables and views. 

Type Palette Icon Description 

Entity 
 

 
A set of distinguishable objects that can be represented in a 
database. 

Table 
 

 
A set of data in a database. 

View 
 

 

A view of the data, usually consists of a subset of the tables in the 
database. 

Data Store 
 

 

A repository for data. 

Data Feed 
 

 

A shell for data containment. 

Report 
 

 

A text file 

Flat File 
 

 
A file containing records, one record per line. Fields may have a fixed 
width with padding, or delimited by white space, tabs, commas (CSV), 
or other characters. There are no structural relationships. 
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Drawing Shapes palette 

All drawing shapes can be resized, formatted, and labeled. You can also format the shapes to be 
either shadowed or transparent. 

Type Palette Icon Description 

Rectangle  
 

Rectangle is drawn as a box with 90 degree angles. 

Rounded 
Rectangle 

 
 

Rectangle drawn with rounded corners. 

Circle  
 

Drawn as 360 degree circle. Can be resized to an oval. 

Triangle 
 

 
Drawn as a standard isosceles triangle. 

Diamond 
 

 
Standard diamond shape. 

Pentagon 
 

 

Standard five-sided pentagon. 

Hexagon 
 

 

Standard six-sided hexagon. 

Octagon 
 

 
Standard eight-sided octagon. 

Cylinder 
 

 

Standard cylinder shape. 

Text Label 
 

 

A text label is a non-BPMN object that is pure text, without a tail or 
bracket. You can add borders to the label, and change the color and 
width of those borders. 

Line 
 

 

A line can be used between two drawing shape objects. 

Annotation  
 

A textual annotation allows you to provide additional facts and 
details about a shape. 

Using the palette 

You use the Palette to place objects in the Diagram View. You have the option of expanding or 
minimizing the palette view. 

Expanding the Palette View 

You can expand or collapse this view. If you want to expand it, click the arrow indicator located at 
the top of the palette. Also, if you place the cursor anywhere over the palette when it is 
minimized, it automatically expands. 
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Placing elements in a diagram 

When you place an element from the Palette in the Diagram View a new element is created in 
the diagram and in the Model View tree. 

NOTE:  If you create an element from the Model View tree, a graphical representation of that 
element is not created on a diagram until a diagram is created and you drag the 
element from the tree to the diagram. 

1. Select the element you want to use from the palettes. 

NOTE:  Some items on the palette have a drop-down indicator. Click this to gain access 
to additional selections that are related to the selected element. 

 
2. Click anywhere in the Diagram View. 

Each time you click in the Diagram View, an element is placed on the diagram. Notice that 
the cursor is in multi-drop mode . 

3. Press ESC to disable the multi-drop mode. The cursor returns to its normal mode ( ). 

NOTE:  You can also disable the multi-drop mode by right-clicking in the element. The 
shortcut menu opens and once you close this menu you are no longer in multi-
drop mode.
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Toolbars 
By using the application toolbars you can navigate the most commonly used functionality in ER/ 
Studio BA. You can also move and dock toolbars to further optimize your workspace. ER/Studio 
BA has the following toolbars: 

Toolbar Description 

Business Process Objects 
Toolbar 

Contains the notation elements used when creating business process models. 

Conceptual Objects Toolbar Contains the five notation elements used when creating conceptual models. 

Reference Objects Toolbar Contains the icons representing the four reference objects used in ER/ 
Studio BA. 

External Data Objects  
Toolbar 

Contains the available data object icons that represent different types of data. 

Drawing Shapes Toolbar Contains drawing shapes, text labels, lines and annotation elements. 

Repository Toolbar Commands used to interface with the ER/Studio Repository, such as logging in 
and logging out of the Repository, and checking in and checking out 
workspaces and objects. 

Formatting Toolbars Commands used to format elements in the Diagram View. 

Layout and Alignment  
Toolbar 

Commands used to align and layout elements in the Diagram View. 

Standard Toolbar Contains the standard application tools such as saving, printing, and undo-
redo. 

Business Process Objects toolbar 

You can use the commands on this toolbar for placing business process elements in a diagram. 
These commands are also available on the Palette which is available when you create a new 
diagram or open an existing diagram. 
You have the ability to show and hide this toolbar using the View main menu. By default, the 
Business Process Toolbar appears in the application once you have created a diagram. Do the 
following to hide this toolbar: 

NOTE:  Not all objects appear on the toolbar. A drop-down arrow appears to the right of 
the element icon, indicating that additional selections are available. 

1. On the main menu, click View > Toolbars. 

2. From the pull-right menu, select Business Process Objects. The toolbar is now hidden. 
The table below lists each command, its representative icon, and a brief description of 
each command. 
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Command Icon Description 

Start Event 
 

 
Starts a process flow. In terms of Sequence Flow, the Start Event starts the flow 
of the Process, so it won’t have any incoming Sequence Flows. Click the drop- 
down arrow to gain access to the Start Event trigger that indicates how the 
Process starts: Message, Timer, Rule, Link, or Multiple. 

Intermediate 
Event  

 

This event happens during the course of a process event. Click the drop-down 
arrow to gain access to the Intermediate Event trigger that indicates how the 
Process proceeds: Cancel, Compensation, Error, Link, Message, Rule, or Timer. 

End Event 
 

 

This event ends a process flow. Click the drop-down arrow to gain access to the 
End Event trigger that indicates how the Process ends: Cancel, Compensation, 
Error, Link, Message, or Terminate. 

Task 
 

 
This is an activity that is performed within a business process. Click the drop-
down arrow to gain access to additional tasks: Loop Task, Parallel Multiple 
Instance Loop Task, and Sequential Multiple Instance Loop Task. 

Embedded 
Sub-process  

 
An Embedded (or nested) Sub-process is an activity that contains other 
activities (a Process). The Process within the Process depends on the parent 
Process for instigation and has visibility to the parent’s global data. No mapping 
of data is required. Click the drop-down arrow to gain access to additional 
Embedded Sub-processes: Embedded Sub-Process (Collapsed), Ad hoc, Loop, 
Parallel Multiple Instance Loop, Sequential Multiple Instance, and Transaction. 

Independent 
Sub-process  

 

An independent Sub-process is an activity within a Process that calls to another 
Process that exists within a business process definition diagram. Click the drop-
down arrow to gain access to additional Independent Sub-processes: Loop, 
Parallel Multiple Instance Loop, Sequential Multiple Instance, and Transaction. 

Gateway 
 

 
This symbol displays decisions, merges, forks and joins in the process flow. 
They control how Sequence Flows interact as they converge and diverge 
within a process. You can set the Gateway Control Types of a gateway and 
change the logic specified by it. Click the drop-down arrow to gain access to 
additional gateways: Complex, Data- Based, Event-Based, Inclusive, and 
Parallel. 

Sequence 
Flow 

 
 

A Sequence Flow shows the sequence of processes in an organization. You can 
use the sequence flow lines to connect events, tasks, activities, and gateways 
in pools or lanes. Click the drop-down arrow to gain access to additional 
Sequence Flows: Conditional, Default, and Exception. 

Message 
Flow  

 
Shows the order of processes between organizations (i.e. between 
pools). 

Association 
 

 
An Association is used to associate information and artifacts with events and 
activities. Click the drop- down to gain access to additional Associations: 
Association from Target, Association to Target, and Association to/from Target. 

Pool 
(Horizontal)  

 
This pool is drawn as a rectangular region placed horizontally and a lane is a 
subpartition within a pool and extends the entire length of the pool. A pool 
represents an organization, function, application, class, or an entity. 
When you place a process in a pool or lane you specify who is doing what. If 
you place an event in a pool or lane you specify where that event occurs. When 
you place a gateway in a pool or lane you specify where a decision is made or 
who makes it. 
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Command Icon Description 

Pool (Vertical) 
 

 

This pool is drawn as a rectangular region placed vertically and a lane is a 
subpartition within a pool and extends the entire length of the pool. A pool 
represents an organization, function, application, class, or an entity. 
When you place a process in a pool or lane you specify who is doing what. If 
you place an event in a pool or lane you specify where that event occurs. When 
you place a gateway in a pool or lane, you specify where a decision is made or 
who makes it. 

Lane  
 

A lane is a subpartition within a Pool and extends the entire length of the 
pool, either vertically or horizontally. Lanes are used to organize and 
categorize activities. 

Nested Lane  
 

Lanes can be nested within lanes. 

Data Object 
 

 

Data objects provide information about how documents, data, and other 
objects are used and updated in a Process. They represent data so are 
defined by a combination of entities or classes. 

Group 
 

 

Use the Group symbol to visually organize activities. 

Annotation 
 

 
Textual annotation allows you to provide additional facts and details about an 
element. 

Off-Page 
Connector  

 

This is a graphical object that you can use to indicate to the reader of the 
diagram to move to the next page. 

Conceptual Objects toolbar 

The table below describes the available shapes. Not all objects appear on the toolbar. A drop- 
down arrow appears to the right of the element icon, indicating that additional selections are 
available. 

 

Element Toolbar Icon Description 

Subject Area 
 

 
A subject area can be a model object or a grouping mechanism 
containing business entities. Examples of a subject area are a Customer 
Relationship Management system, or a Point of Sale system. 

Business 
Entity  

 

Elements of a business or organization containing other business entities 
or elements. Examples of an entity would a customer or a product. 

Business 
Attribute  

 
A business attribute is the property of a business entity. Examples of 
attributes would be a customer address or an employee identification 
number. 

Interaction  
 

 

This is the relationship between two elements representing an action, 
process, or transaction. 

Relationship  
 

Displays relationships between two objects representing a loose coupling. 
The relationships are between two like object types. Click the drop-down 
arrow to gain access to additional relationships types: many-to-many, 
many-to-one, and one-to-many. 

Group 
 

 

Use the Group symbol to visually organize activities. 
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External Data Objects toolbar 

The table below describes the objects available on this toolbar. 

 

Element Toolbar Icon Description 

Entity 
 

 
Distinguishable objects that can be represented in a database 

Table 
 

 
A set of data in a database. 

Data Store 
 

 

A data store is a repository for data. 

Data Feed 
 

 

A shell for data containment. 

Report 
 

 

This is a text file. 

Flat File 
 

 
A flat file is a file containing records, one record per line. Fields may have a 
fixed width with padding, or delimited by white space or tabs or commas (CSV) 
or other characters. There are no structural relationships. 

Drawing Shapes toolbar 

Drawing Shapes are used to provide additional information about the Process. There are nine 
drawing shapes, a text label, a line, and an annotation. The table below displays the available 
shapes. 

 

Element Toolbar Icon Description 

Rectangle  
 

Rectangle is drawn as a box with 90 degree angles. Can be resized. 

Rounded 
Rectangle 

 
 

Rectangle drawn with rounded corners. 

Circle 
 

 
Drawn as 360 degree circle. Can be resized to an oval. 

Triangle 
 

 
Drawn as a standard isosceles triangle. 

Diamond  
 

Standard diamond shape. 

Pentagon 
 

 

Standard five-sided pentagon. 

Hexagon 
 

 

Standard six-sided hexagon. 

Octagon 
 

Standard eight-sided octagon. 

Cylinder 
 

 

Standard cylinder. 

Text Label 
 

 

A text label is a non-BPMN object that is pure text, without a tail or bracket. 
You can add borders to the label, and change the color and width of those 
borders. 

Line 
 

 

A line can be used between two drawing shape objects. The line is 
automatically elbowed. 

Annotation  
 

Textual annotation allows you to provide additional facts and details about 
a shape. 
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Repository toolbar 

You can use the commands on the Repository toolbar to log in and out of the Repository, and 
check in and out workspaces, diagrams, and objects. The table below lists each command and its 
representative icon, and provides a brief description of each command. 

 
NOTE:  The commands on the Repository toolbar will be unavailable until you log in to the 

Repository. For information on specifying the Repository details, see. For information 
on logging in to the Repository, see Logging In and Out of the Repository. 

Element Toolbar Icon Description 

Log In 
 

 
 

Logs you into the Repository specified in Window > Preferences > Repository. 
Users must be defined in the Repository. For information on creating users, see 
the “Administrator’s Reference Guide” in the ER/Studio User Guide. 

Log Out 
 

 

Logs you out of the Repository. When you are not using Repository commands 
you should log out. 

Add 
Workspace 

 
 

Copies the local open workspace to the Repository and changes the 
permissions of the open workspace to read-only. 

Get 
Workspace 

 

 
 

Copies the latest version of a workspace in the Repository to local storage. 
Opens a dialog where you can browse through the Repository for the desired 
workspace. 

Get Latest 
Version 

 

 
 

Updates the local copy of the workspace with the copy that is in the 
Repository. 

Check Out 
Workspace 

 

 
 

Changes the permissions of the workspace to read-write and records in the 
Repository that this workspace has been exclusively checked out. Other users 
cannot check out the same workspace simultaneously. 

Undo Check 
Out 
Workspace 

 
 

Makes the workspace available for other users to check out. Permissions of the 
local copy are changed to read- only. 

Check In 
Workspace  

 

Updates the Repository version of the open Workspace and changes the 
permissions of the local copy to read- only. 

Delete 
Workspace 

 

 
 

Deletes the open workspace from the Repository. The local copy of the 
workspace is not deleted. 

Check Out 
Object(s)  

 

Changes the permissions of the local copy of the selected object(s) to read- 
write and marks the Repository copy as exclusively checked out. Other users 
cannot check out the same object(s) simultaneously. 

Check In 
Object(s)  

 

Updates the Repository copy of the selected object with the local object 
content. You can check in Diagrams and Models using this command. 

Change 
Password 

 

 
 

Allows the logged in user to change their Repository account password. 
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Formatting toolbars 

You can use the commands on the formatting toolbar to format the elements in the Diagram 
View. You can use this toolbar to format the fonts, as well as the line and background color of any 
element in the Diagram View. Also, you can hide or show this toolbar in the application. 

To format an element: 

1. Select an element you want to change, for example a Task. 

2. If you want to change this task’s background color click the drop-down arrow next to 

the Change Fill icon ( ) on the Formatting Toolbar. A list of all available colors 
opens. 

3. Select the color you want to use. The task’s background color changes and the color list 
closes. 

To Hide or Show the Formatting toolbar: 

You have the ability to show and hide this toolbar using the View main menu. By default, the 
Formatting Toolbar automatically appears in the application. Do the following to hide this 
toolbar: 

1. On the main menu, click View > Toolbars. 

2. From the pull-right menu, select Formatting.  The toolbar is now hidden. 

The table below lists each command, its representative icon, and a brief description of each 
command. 

 

Command Toolbar Icon Description 

Font 
Selection 

 Select a new font from the drop-down list box. 

Font Size 
Selection  

 

Select a new font size from the drop- down list box. 

Bold 
 

 

Applies bold formatting to the selected text. 

Italics 
 

 

Italicizes the selected text. 

Strikeout 
 

 

A line is drawn through the selected text. 

Underline 
 

 

Underlines the selected text. 

Change Font 
Color  

 
A drop-down menu opens a color palette. When you select a color from the 
palette, the selected text is now displayed in the selected color. 
This list includes the color labeled “default blue” which is the default color 
used as the fill color for all Business Process Modeling Notation objects. 

Change Line 
Color  

 

A drop-down menu opens a color palette. When you select a color from the 
palette, the border of the selected object is now displayed in the selected 
color. 

Change Fill 
Color  

 

A drop-down menu opens a color palette. When you select a color from that 
palette, the background of the selected object now displays the selected 
color. 

Left Justify 
Text  

 

Justifies the text on the left side of the element. 

Center Text 
 

Centers the text in the element. 
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Command Toolbar Icon Description 

Right Justify 
Text  

 
Justifies the text on the right side of the element. 

Align Text - 
Top  

 

Aligns the text to the top of an element. 

Align Text - 
Center  

 

Vertically centers the text in an element. 

Align Text - 
Bottom  

 

Aligns the text to the bottom of an element. 

Increase Font 
Size  

 
Each time you click this icon, the font size of the selected object’s label is 
increased by one point size. 

Decrease 
Font Size  

 

Each time you click this icon, the font size of the selected object’s label is 
decreased by one point size. 

Layout and Alignment toolbar 

The table below lists each command, its representative icon, and a brief description of each 
command. 

 

Command Toolbar Icon Description 

Align Left 
 

 

Left aligns all selected elements with the selected element. 

Align Right 
 

 

Right aligns all selected elements with the selected element. 

Align Top 
 

 

Aligns all selected elements with the top of the selected element. 

Align Bottom 
 

 

Aligns all selected elements with the bottom of the selected element. 

Center 
Vertically  

 

Centers vertically the selected elements with the center of the selected 
element. 

Center 
Horizontally  

 

Centers horizontally the selected elements with the center of the selected 
element. 

Distributing  
Horizontally  

 
Evenly distributes three or more nodes horizontally. 

Distributing  
Vertically  

 

Evenly distributes three or more nodes vertically. 

Match Width 
 

 

All selected elements are resized to match the width of the widest selected 
element. The selected element has black handles. 

Match Height 
 

 

All selected elements are resized to match the height of the longest 
selected element. The selected element has black handles 

Bring to Front 
 

 
If multiple elements are stacked, click this icon to bring the selected element to 
the top or front of the stack. 
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Command Toolbar Icon Description 

Send to Back 
 

 
 

If multiple elements are stacked, click this icon to drop the selected element to 
the back of the stack. An outline of the moved element appears in the stack 
showing the location of the moved element. 
 
 
 
 
 
 
 
 

Group 
 

 
 

Groups two or more selected elements into a single entity that can be moved 
around a diagram. 

Ungroup 
 

 
 

Removes the selected grouping. This command is available only if the 
element selected is in a group. 

Aligning elements in the Diagram view 

Take the following steps to align elements within the Diagram View: 

1. Select the elements you want to align by holding down the mouse button and drawing a box 
around the items you want included. All items within the selection box are now marked. 

2. Shift+click the element you want to align all other elements with. That element is now 
highlighted with black boxes instead of hollow boxes. 

 
3. Click the alignment command and all elements are aligned with the selected element. In the 

example below all elements are centered vertically   with the start event. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By default, the Layout and Alignment Toolbar automatically appears in the application. Do the 
following to hide this toolbar: 

1. On the main menu, click View > Toolbars. 

2. From the pull-right menu, select Layout and Alignment and the toolbar is now hidden. 
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Distributing horizontally 

Once you place elements in the Diagram View you can evenly distribute those elements 
horizontally. 

1. Select three or more elements in the Diagram View. 

NOTE:  Elements don’t have to all be the same (i.e., all tasks or all reference objects). 

2. Click  and the selected elements are spaced equidistantly from each other on a 
horizontal plane. 

NOTE:  Only the spacing between the elements is changed, not the vertical placement of 
the elements in the diagram. 

 

Distributing vertically 

Once you place elements in the Diagram View you can evenly distribute those elements vertically. 

1. Select three or more elements in the Diagram View. 

NOTE:  Elements don’t have to all be the same (i.e., all tasks or all reference objects). 

2. Click  and the selected elements are spaced equidistantly from each other on a vertical 
plane. 

NOTE:  Only the spacing between the elements is changed, not the horizontal placement 
of the elements in the diagram. 
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Reference Objects toolbar 

You can create a link between elements and add a reference object to the Diagram View from 
the Reference Objects palette. The table below lists each object, its representative icon, and a 
brief description of each object. 

 

Command Toolbar Icon Description 

Business 
Element  

 
A singular element of the business that can be bound to different business 
attributes across conceptual models. Can be used to seed business attributes 
in a business entity. 

Business Rule 
 

 

A business rule is a policy, practice, or formula related to the operation and 
enforcement of business practices. 

Business Unit 
 

 

A business unit is an organizational area within or external to an enterprise. 

Steward 
 

A steward is a person or organization responsible or associated with a model 
element. 

Link 
 

 
Display high-level views of information requirements. This type is used to 
simply relate objects together. 

Usage 
 

 
You can label the function of the connection as create, read, update, or delete 
database records. All created connections are labeled “usage”. 

Standard t oolbar 

The Standard Toolbar contains the basic tools used in the application. The table below lists the 
commands, the corresponding icons, and a brief description for each. 

 

Command Toolbar_Icon Description 

Save 
 

 

Saves the workspace, project, model, and/or diagram. 

Print 
 

 

Opens the Print dialog box, where you can print the open diagram in the active 
Diagram View. 

Export 
 

 

You can export the Grid Editor and save in the following formats: csv, html, pdf, 
and rtf. 

Cut 
 

 

When you cut an element, the application removes it from the diagram and 
places it on a clipboard. You can then paste the cut element in the same 
Diagram window, a different Diagram window in the same workspace. The cut 
item remains on the clipboard until you cut or copy another selection. 

Copy 
 

 

When you copy an element, the application leaves it on the diagram and 
places it on a clipboard. You can then paste the copied element in the same 
Diagram window, a different Diagram window in the same workspace. The 
copied item remains on the clipboard until you cut or copy another selection. 

Paste 
 

 

You can paste any cut or copied object into a Diagram window. 
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Command Toolbar_Icon Description 

Delete  
 

When you want to delete an object from the Model View tree, the Delete 
Elements dialog opens. Click Yes to permanently remove the object from the 
model and the diagram. 

When you want to delete an object from the Diagram View, the Delete 
Elements dialog opens. Click Delete to permanently remove the selected 
object from the diagram 

Undo 
 

Standard Undo functionality. 

Redo 
 

Restores the undo command. 

Custom Zoom 
 

 

Enter a specific percent value for zooming. You can also pick from several 
default zoom percentage values ranging from 25 percent to 400 percent. You 
can also select Fit to Page which fits the entire diagram on one page. 

Zoom In 
 

 

Enlarges the active diagram by a preset increment each time you select this 
option. 

Zoom Out 
 

 

Reduces the active diagram by a preset increment each time you select this 
option. 

Menus 
You can use the ER/Studio BA menus to gain access its features. The menus are: File, Edit, View, 
Repository, Diagram, Format, Tools, Window, and Help. 

Menus provide access to many of ER/Studio BA functions. Click any item on the menu bar to 
access its submenu items. The table below describes the functions available under the relevant 
menu bar items: 

Menu Function 

File Create, open, save, and close the current workspace, its models, projects, and diagrams. You 
can also export/import from this menu. 

Edit You can access functionality for undo, redo, cutting, copying, pasting, deleting, and 
selecting all. You can also access the Find and Search functionality. 

View Gives you access to the toolbars, and zoom levels in a view. 

Repository Gives you access to Repository operations such as log in and out, and check in and out 
workspaces and objects. 

Diagram When a diagram is open, the following commands are available: Case Shift, Layout, and Grid. 
The Show All Links and Update Impact Analysis commands are also available when applicable. 

Format You can use these commands in a diagram to group objects, align objects, or reorder the 
layers of objects. 

Tools Gives you access to the following commands: Create Diagram from Selected Objects, 
Create Link, Create Usage, Generate Impact Analysis Diagram, Show Diagrams, Grid Editor, 
and Reports. 

Window Reset perspectives, Show Views, or Preferences. 

Help You can open ER/Studio BA online documentation, view the licensing information, open the 
Evaluation Guide, contact support, and open the About dialog. 
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File 

The table below describes the functions available when you click the File command: 

Menu Item Icon Description 

New - Workspace 
 

 

Opens the New Workspace dialog where you can create a new 
workspace, new project, new model, and new diagram. 

New - Project 
 

 

Opens the New Project diagram. You can enter a description of the new 
project and select where to create the project. 

New - Model 
 

 

Opens the New Model dialog. You can enter a description of the new 
model and select where to create the model. 

New - Diagram  The pull-right menu gives you two options: Business Process or 
Conceptual. This menu displays the type of diagram to be created. For 
example if you are creating a new diagram in a Conceptual Model, only 
Conceptual is available from the pull-right menu.You can enter a 
description of the new diagram and select where to create the diagram. 
You can also rename the pool and lane in the New Diagram dialog for a 
Business Process diagram. 

Open Workspace... 
 

 

Opens the standard windows dialog listing existing workspaces from 
the file system where you can select one to open. You can also press 
Ctrl+O. 

Close - Workspace  Closes the currently opened workspace. 

Close - Diagram  Closes the active diagram only. 

Close - All Diagrams  Closes all the opened diagrams. You are prompted to save the 
diagrams before they are closed. 

Close - All Property 
Views 

 Closes all the opened Property Views. 

Save 
 

 

This saves everything in the Workspace. You can also press Ctrl+S. 

Import - Comma  
Separated Values (CSV) 

 You can import large amounts of Reference Objects data in the 
Comma Separated Value file format into ER/Studio BA. 

Import - From ER/ 
Studio Data Architect 

 Conceptual Objects 

Create New: Select this command to open a wizard where you can select 
data files to import from ER/Studio Data Architect. 
Update Existing: You can use this option to update an existing data 
source. All existing objects that match an object you have selected will be 
updated. 
 
External  Data Objects 

Create New: Select this command to open a wizard where you can select 
data files to import from ER/Studio Data Architect. 
Update Existing: You can use this option to update an existing data 
source. All existing objects that match an object you have selected will be 
updated. 

Import - Microsoft Visio 
Modell  

 

Diagrams created in Microsoft Visio can be imported. 



Application basics > Navigation 
 

52  ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

 

 

 
Menu Item Icon Description 

Import - Workspace 
 

 

You can import a compressed workspace. 

Export - Workspace 
 

 

You can export a workspace and store it as a compressed file. 

Export - Diagrams 
 

 

You can export diagrams and save them in the following file 
formats: jpg, rtf, and pdf. 

Export - Grid Editor... 
 

 

You can export the Grid Editor in the four formats: csv, html, pdf, and 
rtf 

Export 
 

 

You can export Conceptual Models and diagrams to ER/Studio. 

If you right-click on a Conceptual Model node ( ), the command is 
Export>Model to ERStudio Data Architect.... All elements are included in 
the export dialog. 
If you right-click on a Conceptual Model diagram node ( ), the 
command is Export Diagram to ER/Studio Data Architect... Only the 
elements on the selected diagram are available for export. 

Print... 
 

 

Opens the Print dialog. You can also press Ctrl+P. 

History  A list of the most recently opened workspaces is displayed. You can set a 
preference that determines the number of entries that appear in this list. 

Exit  Exits the application. A Save Workspace dialog opens asking if you want 
to save the current workspace. 

Edit 

The table below describes the functions available when you click the Edit command: 

Menu Item Icon Description 

Undo 
 

 

Standard undo functionality. 

Redo 
 

 

Standard redo functionality. 

Cut 
 

 

Moves a selected object to the clipboard and removes it from the 
diagram display. 

Copy 
 

 

Copies selected items to the clipboard. 

Paste 
 

 

Pastes the data from the clipboard into a diagram. 

Delete  
 

Deletes an object from the Diagram View. The deleted object is not placed 
on the clipboard. 

Select All  Selects all objects in the Diagram View. 

Select All of 
Selected Type 

 All related types on a Diagram View are selected. For example, if you select 
a start event and your diagram contains start, intermediate and end events, 
all events are selected. 

Finding in  
Diagram  

 
Opens a dialog where you can search for items by Name and Object Type in 
the opened diagram. The searched-for item is highlighted in the diagram. 

Search... 
 

 
Opens a dialog for an advanced search of the metamodel. The results of the 
search appear in a separate Search Results View dialog. 

Properties 
 

 

Opens the Property View dialog for the selected object. 
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View 

The table below describes the functions available when you click the View command: 

Menu Item Description 

Toolbars Allows you to hide or view the following: 

• Business Process Objects Toolbar 

• Conceptual Objects Toolbar 

• Reference Objects Toolbar 

• External Data Objects Toolbar 

• Drawing Shapes Toolbar 

• Formatting Toolbars 

• Layout and Alignment Toolbar 

Zoom Level Enlarges the active diagram by a preset increment each time you select this option. You can 
also use the Fit to Page or Custom command. 

Repository 

The table below describes the functions available when you click the Repository command: 

Menu Item Description 

Log In Logs you into the Repository specified in Window > Preferences > Repository. Users must be 
defined in the Repository. For information on creating users, see the “Administrator’s 
Reference Guide” in the ER/Studio User Guide. 

Log Out Logs you out of the Repository. When you are not using Repository commands you should log 
out. 

Workspace Add Workspace: Copies the local open workspace to the Repository and changes the 
permissions of the open workspace to read-only. 

Get Workspace: Copies the latest version of a workspace in the Repository to local storage. 
Opens a dialog where you can browse through the Repository for the desired workspace. 

Get Latest Version: Updates the local copy of the workspace with the copy that is in the 
Repository. 

Check Out Workspace: Changes the permissions of the workspace to read-write and records in 
the Repository that this workspace has been exclusively checked out. Other users cannot check 
out the same workspace simultaneously. 

Undo Check Out Workspace: Makes the workspace available for other users to check out. 
Permissions of the local copy are changed to read-only. 

Check In Workspace: Updates the Repository version of the open Workspace and changes the 
permissions of the local copy to read- only. 

Delete Workspace: Deletes the open workspace from the Repository. The local copy of the 
workspace is not deleted. 

Check Out Object(s): Changes the permissions of the local copy of the selected object(s) to 
read-write and marks the Repository copy as exclusively checked out. Other users cannot check 
out the same object(s) simultaneously. 

Check In Object(s): Updates the Repository copy of the selected object with the local object 
content. You can check in Diagrams and Models using this command. 

Security Change Password: Allows the logged in user to change their Repository account password. 
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Diagram 

The table below describes the functions available when you click the Diagram command: 

Menu Item Description 

Case Shift You can set the case format for all element labels. When you make a selection, all labels in the 
diagram conform to the new selection. You have three options: 

Lower: All text appears in lower case lettering, including the initial letter of each word on the 
label. 

Preserve:  All text appears as it was entered in the label. 

Upper: All text appears in upper case lettering. 

Grid This pull-right menu contains three additional commands: 

Show Grid Lines: The grid lines appear in the Diagram View. 

Show Parent Objects as Transparent:  When a parent object such as a pool or lane is placed on 
a diagram, the grid lines appear in the object, i.e. the object is transparent. 

Snap Objects to Grid: When an element is placed in the Diagram View, it automatically snaps 
to the nearest grid. When an element is moved, it also snaps to the nearest grid line. 

Layout Select Curved, Elbowed, or Straight for all connections. The default selection is curved. 

Connections Select this command to display or hide the connections for all or individual objects in the 
diagram. The connections available on the pull-right menu depends on the type of diagram 
(either Business Process or Conceptual). 

Update Impact 
Analysis 

Instead of generating a new Impact Analysis diagram each time you add links or usages, you can 
refresh or update your existing diagram to show new connections. 

For more information, see Edit Diagrams. 

Format 

The table below describes the functions available when you click the Format command. 

Menu Item Description 

Align Objects Gives you access to all of the align and size commands. These commands are also 
available on the Align Toolbar. 

Grouping Group: Groups two or more selected elements into a single entity that can be moved around 
a diagram in a block. The Group command is available if two or more elements are selected. 
Once the items are grouped a bounding box appears around the grouped items. 

Ungroup: Removes the selected grouping. This command is available only if the element 
selected is in a group. 

Order This command gives your access to two functions: Bring to Front and Send to Back. 
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Tools 

The table below describes the functions available when you click the Tools command. 

Menu Item Icon Description 

Create Diagram 
from Selected 
Elements... 

 You can create new diagrams from existing model objects. 

Create Link...  
 

Opens the Create Link wizard. 

Create Usage... 
 

 

Opens the Create Usage wizard. 

 Impact Analysis 
Diagram  

 

Generate New Diagram: Creates a diagram that shows a graphical 
representation of created links or usages. 
You can also update this diagram. 

Show Diagram  When a diagram is closed (i.e., not displayed in the Diagram View), you can 
select the Show Diagram in model view command to open the highlighted 
diagram. 

Grid Editor... 
 

 

The Grid Editor is an spreadsheet-like display format that is an alternative to 
the Model View tree view. This is valuable for large objects or business-related 
objects, such as business rules. The Grid Editor can be printed or exported as a 
report. 

Reports 
 

 

Impact Analysis: Opens an impact analysis property view of the selected 
object. 
Web Report: You can generate an HTML report on all diagrams in the opened 
workspace. 

Window 

The table below describes the functions available when you click the Window command: 

Menu Item Description 

Reset Perspective Reset the current perspective to the default settings. 

Show View The commands available are: 

Error Logging: Opens the Error Logging View. 

Help: Opens online help. Model: Opens the  Model View 

Overview:  Opens the Overview Window. 

Palette: Opens the Palette view in the Diagram View. 

Search Results: Opens the Search Results view to the right of the 
Diagram View area. 

Preferences... Opens the Preferences Editor dialog where you can change default settings. 
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Help 

The table below describes the functions available when you click the Help command: 

Menu Item Icon Description 

Help Contents 
 

 

Displays the main online help file. 

Evaluation Guide  Opens a tutorial which guides you through the initial creation of business 
process and conceptual models. 

Check for Updates  Opens the ER/Studio BA web site where you can download application 
updates. 

Buy Now  Opens the IDERA Product web site where you can purchase IDERA software. 

Contact Support 
 

 

Opens the IDERA Contact Support web site. 

Discussion Forums 
 

 

Opens the IDERA Discussion Forums web site where you can log on and 
participate in forums with other users. 

License  Manager 
 

 

Opens the License Manager dialog. 

About ER/Studio BA  Opens the About ER/Studio BA dialog displaying the version and build 
identification for the current install. 

About ER/Studio BA 

The About dialog displays the version number, build identification number for your application, 
as well as a list of third-party software used in the product. Through this About dialog, you also 
have access to Feature Details, Plug-in Details, and Configuration Details. 

Click Feature Details and a dialog opens displaying how ER/Studio BA is built internally. This is 
for informational purposes only. Click Plug-in Details and a dialog opens displaying the following 
information on all the plug-ins in use: 

• Provider 

• Plug-in Name 

• Version 

• Plug-in ID 

When you click Configuration Details a dialog opens displaying the following information: 

• Platform Details 

• System Properties 

• Features 

• Plug-in Registry 

• User Preferences 

• Current Install Configuration 

• Configured Sites 

• Configured Features 

• Configured Plug-ins 

You can copy and save this configuration information to a clipboard. Also, you can view the 
Eclipse error log in a separate window. 
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Shortcut menus 
Many of ER/Studio BA windows incorporate shortcut menus to give you another method for 
quickly accessing application functions. The contents of these menus mirror the application's 
menu bar functions. To execute shortcut menu options from any selected window, view, dialog, or 
element do the following: 

1. Right-click the selected object to open the applicable shortcut menu. 

2. On the shortcut menu, click the menu item. 

There are two main areas where shortcut menus are available:  Model View Tree Nodes, and 
Diagram View. 

Model view tree nodes 

The following shortcut menus are available: 

• Workspace Node 

• Project Node 

• Model Node - Business Process Modeling 

• Model Node - Conceptual Modeling 

• Diagram Node - Business Process Modeling 

• Diagram Node - Conceptual Modeling 

• Lane Elements on the Model View Tree 

• Elements on the Model View Tree 

• Search Results View 

• Grid Editor 

• Error Logging View 

• Reference Objects 

• Reference Object Elements 

• External Data Objects 

• Palette 



Application basics > Navigation 
 

60  ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

 

 

Workspace node 

The table below describes the functions available when you right-click the Workspace Node in 
the Model View tree: 

Shortcut Menu Item Icon Description 

New  You can create a new workspace, project, or model from this pull- right menu. 

Open Workspace... 
 

 

Select an existing workspace to open. 
Note: You can only have one workspace open at a time. 

Close  Closes the current workspace. A Save Resource dialog opens asking if you want 
to save the changes. 

Save Workspace  Saves the current workspace. Note that an asterisk appears on the Model View 
tab each time you make any changes to the workspace and/or its associated 
projects, models, and diagrams. Once you save the workspace the asterisk is 
removed. 

Rename  Opens the Rename Workspace dialog where you can enter a new name for 
the selected workspace. You can also press F2. 

Delete  
 

Select Delete and the Confirm Workspace Delete dialog opens asking you 
to confirm your decision. 

Import - From ER/ 
Studio Data Architect  

 
 
 
 
 

Create New Conceptual Objects: Select this command to open a wizard 
where you can select data files to import from ER/Studio Data Architect. 

Update Existing Conceptual Objects: You can use this option to update an 
existing data source. All existing objects that match an object you have 
selected will be updated. 

Import - Microsoft Visio 
Model  

 

Opens a wizard that walks you through the importing of a Microsoft 
Visio model into ER/Studio BA. 

Export... 
 

 

You can export your workspaces in a compressed format which can then be 
imported into another ER/Studio BA application on another computer. 

Repository  When logged in to ER/Studio Repository, you can check in and check out 
Repository workspaces. 

Insert Project/Model  If you have deleted a project or model but did not delete the associated 
files, you can select this command to “restore” the deleted project or 
model. 

Refresh 
 

 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected workspace. 
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Project node 

The table below describes the functions available when you right-click the Project Node in the 
Model View tree: 

Shortcut Menu Item Icon Description 

New  You can create a new project or new model from this pull-right menu. 

Close  Closes the open project. 

Save Project  Saves the current project. 

Rename  Opens the Rename Project dialog where you can rename the project and 
its owning folder. 

Delete  
 
 
 
 
 
 

Select Delete and the Confirm Project Delete dialog opens asking you to 
confirm your decision. You have three options in this dialog: 

• No, I do not want to delete the project. 

• Yes, and also delete the associated files. 

• Yes, but do not delete the associated files. 

Links 
 

 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links > Edit. If there are multiple 
links, the pull-right menu displays a list of the existing links. Click the name on 
the pull-right and the Edit Link wizard opens. If there is only one link the 
command is Links > Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage > New and the Usages wizard 
opens. If you want to edit or view an existing usage, click Usage (CRUD)>Edit 
or View. The Usage (CRUD) tab opens in the Property View for the selected 
element. 

Impact Analysis  You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Import - From ER/ 
Studio Data Architect  

 
 
 

Create New Conceptual Objects: Select this command to open a wizard 
where you can select data files to import from ER/Studio Data Architect. 
Update Existing Conceptual Objects: You can use this option to update an 
existing data source. All existing objects that match an object you have 
selected will be updated. 

Import - Microsoft Visio 
Model  

 

Opens a wizard that walks you through the importing of a Microsoft Visio model 
into ER/Studio BA. 

Repository  When logged in to ER/Studio Repository, you can check in and check out 
Repository objects. 

Insert Project/Model  If you have deleted a project or model but did not delete the associated 
files, you can select this command to “restore” the deleted project or 
model. 

Refresh 
 

 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected project. 
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Model n ode - Business Process Modeling 

The table below describes the functions available when you right-click the Model Node in the 
Model View tree: 

Shortcut Menu Item Icon Description 

New  You can create a new diagram, new model, or new pool from this 
pull-right menu. 

Open/Close  This is a toggle command that closes an open model and vice versa. 

Save Model  Saves the open model. 

Rename  Opens the Rename Model dialog where you can rename both the 
model and its folder. 

Delete  
 
 
 
 
 
 

Select Delete and the Confirm Model Delete dialog opens asking 
you to confirm your decision. You have three options in this dialog: 

• No, I do not want to delete the model. 

• Yes, and also delete the associated files. 

• Yes, but do not delete the associated files. 

Links 
 

 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Link>Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage>New and the Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. Grid 
Editors can be printed or exported as a report. 

Impact Analysis  You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Import - Comma  
Separated Values (CSV)  

 

You can import large amounts of Reference Objects data in the 
Comma Separated Value file format into ER/Studio BA. 

Import - Microsoft Visio 
Model  

 

Opens a wizard that walks you through the importing of a Microsoft 
Visio model into ER/Studio BA. 

Export  Allows you to export a model to ER/Studio Data Architect. 

Repository  When logged in to ER/Studio Repository, you can check in and 
check out Repository objects. 

Insert Model...  If you have deleted a model but did not delete the associated files, 
you can select this command to “restore” the deleted model. 

Refresh 
 

 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

 

Opens the Property View dialog for the selected model. 
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Model node - Conceptual Modeling 

The table below describes the functions available when you right-click the Model Node in the 
Model View tree: 

Shortcut Menu Item Icon Description 

New  You can create a new diagram, model, Business Entity or Subject Area from this 
pull-right menu. 

Open/Close  This is a toggle command that closes an open model and vice versa. 

Save Model  Saves the open model. 

Rename  Opens the Rename Model dialog where you can rename both the model and 
its folder. 

Delete  
 
 
 
 
 
 

Select Delete and the Confirm Model Delete dialog opens asking you to 
confirm your decision. You have three options in this dialog: 

- No, I do not want to delete the model. 

- Yes, and also delete the associated files. 

- Yes, but do not delete the associated files. 

Links  
 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are multiple 
links, the pull-right menu displays a list of the existing links. Click the name on 
the pull-right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage>New and the Usages wizard 
opens. If you want to edit or view an existing usage, click Usage (CRUD)>Edit 
or View. The Usage (CRUD) tab opens in the Property View for the selected 
element. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an alternative to 
the Model View tree view. This is valuable for large objects or business-
related objects, such as business rules. Grid Editors can be printed or 
exported as a report. 

Impact Analysis  You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Import - Comma  
Separated Values (CSV)  

 
 

You can import large amounts of Reference Objects data in the 
Comma Separated Value file format into ER/Studio BA. 

Import - From ER/ 
Studio Data Architect  

 
 
 

Create New Conceptual Objects: Select this command to open a wizard 
where you can select data files to import from ER/Studio Data Architect. 
Update Existing Conceptual Objects: You can use this option to update an 
existing data source. All existing objects that match an object you have 
selected will be updated. 

Export Model to ER/ 
Studio Data Architect  

 
 

You can export objects on a Model to ER/Studio Data Architect where the 
elements in the conceptual diagram map to the logical diagram in ER/Studio 
Data Architect. 

Repository  When logged in to ER/Studio Repository, you can check in and check out 
Repository objects. 

Insert Model  If you have deleted a model but did not delete the associated files, you can 
select this command to “restore” the deleted project or model. 

Refresh 
 

 
 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected model. 
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Diagram n ode - Business Process Modeling 

The table below describes the functions available when you right-click a Business Process 
Modeling Diagram Node in the Model View tree: 

Shortcut Menu Item Icon Description 

Open/Close  If the diagram is closed, click this command to open the diagram in the 
Diagram View. 

Save Diagram  This command is available if any changes have been made to the open 
diagram. 

Rename  Opens the Rename Diagram dialog. 

Delete  
 

Delete the diagram from the Model View tree. A Delete Element dialog 
opens asking you to confirm the delete action. 

Grid Editor... 
 

 
 
 
 

The Grid Editor is a spreadsheet-like display format that is an alternative to the 
Model View tree view. This view displays the properties of the selected node. 
For example the Grid Editor for a lane would displays all the elements in the 
lane, the element’s names, and their descriptions. This is valuable for large 
objects or business-related objects, such as business rules. Grid Editors can be 
printed or exported as a report. 

Export 
 

 
 

You can export the opened diagram and save it in the following formats: 
csv, html, pdf, and rtf. 
Note: This command is available only if the diagram is opened in the 
Diagram View area. 

Import Comma  
Separated Values 
(CSV)... 

 
 
 

You can import large amounts of Reference Objects data in the 
Comma Separated Value file format into ER/Studio BA. 

Export Diagram to ER/ 
Studio Data Architect  

 
 

You can export objects on a Model to ER/Studio Data Architect where the 
elements in the business process diagram map to the logical diagram in 
ER/Studio Data Architect. 

Repository  When logged in to ER/Studio Repository, you can check in and check out 
Repository objects. 

Refresh 
 

 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected diagram. 

Diagram node - Conceptual Modeling 

The table below describes the functions available when you right-click a Conceptual Model 
Diagram Node in the Model View tree: 

Shortcut Menu Item Icon Description 

Open/Close  If the diagram is closed, click this command to open the diagram in the 
Diagram View. 

Rename  Opens the Rename Diagram dialog. 

Delete  
 

Delete the diagram from the Model View tree. A Delete Element dialog 
opens asking you to confirm the delete action. 

Grid Editor... 
 

 
 

The Grid Editor is a spreadsheet-like display format that is an alternative to the 
Model View tree view. This view displays the properties of the selected node. 
This is valuable for large objects or business-related objects, such as business 
rules. Grid Editors can be printed or exported as a report. 
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Shortcut Menu Item Icon Description 

Import Comma  
Separated Values (CSV)  

 

You can import large amounts of Reference Objects data in the Comma 
Separated Value file format into ER/Studio BA. 

Export Diagram to ER/ 
Studio Data Architect  

 

You can export elements on a Conceptual Model diagrams to ER/Studio Data 
Architect application. 

Repository  When logged in to ER/Studio Repository, you can check in and check out 
Repository objects. 

Refresh 
 

 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected diagram. 

Lane elements on the Model view tree 

The table below describes the functions available when you right-click a lane on the Model View 
tree: 

Shortcut Menu Item Icon Description 

New  This command is available only for pools and lanes in the Model View tree. 
When you select this command a pull-right is available to create a new lane. 

Move Lane...  Opens a Move Lane dialog where you can move lanes up or down in the 
Model View tree. 

Rename  Makes the node name editable. If the diagram is open, it also renames the 
element in the Diagram View. You can also click F2. 

Delete  
 

 
 
 
 

This command opens the Delete Elements dialog asking if you are sure you 
want to delete the selected elements. Clicking Yes removes the elements 
from the project and any diagrams (both in the Model View tree and in the 
Diagram View) on which the elements appear. 

Links 
 

 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are 
multiple links, the pull-right menu displays a list of the existing links. Click 
the name on the pull-right and the Edit Link wizard opens. If there is only 
one link the command is Links>Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage>New and the Usages wizard 
opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property View for 
the selected element. 

Diagram Usage  A pull-right menu lists the diagram(s) the select element appears in. This 
allows you to quickly locate and open the diagram where the element 
appears. If the element appears on more than ten diagrams the More... 
option appears opening a dialog listing all diagrams. 

Impact Analysis  You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays 
all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Refresh 
 

 

Updates the currently displayed information with new data or changes. 

Properties 
 

 

Opens the Property View dialog for the selected element. 
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Elements on the Model view tree 

The table below describes the functions available when you right-click an element on the 
Model View tree: 

Shortcut Menu Item Icon Description 

New  Creates a new element which is placed in the Model View tree. The list of 
elements available on the pull-right menu depends on the element you right-
click on. This command is not available for all elements. 

Create Diagram from  
Selected Elements... 

 You can create new diagrams from existing model objects. 

Rename  Makes the node name editable. If the diagram is open, it also renames the 
element in the Diagram View. You can also click F2. 

Delete  
 
 
 
 
 

This command opens the Delete Elements dialog asking if you are sure you 
want to delete the selected elements. Clicking Yes removes the elements from 
the project and any diagrams (both in the Model View tree and in the Diagram 
View) on which the elements appear. 

Create Mapping/Edit  
Mapping 

 If you right-click on a Subject Area you can map to one or more Conceptual 
Model diagrams or Business Entities. 

Diagram Mappings  This command is available once you have mapped a diagram to a Subject 
Area. When it is selected a pull-right menu opens displaying the mapped 
diagram(s). 

Diagram Usage  A pull-right menu lists the diagram(s) the select element appears in. This allows 
you to quickly locate and open the diagram where the element appears. If the 
element appears on more than ten diagrams the More... option appears 
opening a dialog listing all diagrams. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an alternative 
to the Model View tree view. This is valuable for business-related objects, 
such as business rules. Grid Editors can be printed or exported as a 
report. 

Links 
 

 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are multiple 
links, the pull-right menu displays a list of the existing links. Click the name on 
the pull-right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage>New and the  Usages wizard 
opens. If you want to edit or view an existing usage, click Usage (CRUD)>Edit 
or View. The Usage (CRUD) tab opens in the Property View for the selected 
element. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Refresh 
 

 
 

Updates the currently displayed information with new data or changes. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 
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Search Results v iew 

The table below describe the functions available when you right-click a row or cell in the Search 
Results view. 

Shortcut Menu Item Description 

Name, Type, Description, Notes By default, all columns are displayed. These are toggle settings, so you can 
select or deselect which columns you want displayed. 

Open Search Dialog Opens the Search dialog so you can specify a new search or modify your 
existing search. 

Find In Opens a pull-right menu with the following commands: 

Active Diagram: This command finds and highlights the selected search item 
in the active diagram. 

All Diagrams: This command searches for the selected search item on all 
diagrams in the model. The Diagram Usage dialog opens displaying all the 
diagrams where the element appears. 

Model View: Finds the selected search item in the Model View tree. 

Run Previous Search The pull-right menu displays the previous searches. Up to ten searches are 
listed. You can also select the Clear History option. 

Filter Results Opens the Search Results Filter dialog. Use this to refine the search. You can 
select which types of objects you don’t want to see in the Results view. You can 
expand or collapse the tree. You can also select or deselect all the tree node 
items. 

Customize Columns Opens the Customize Columns dialog where you select the columns you want 
displayed in the Search Results view. 

Properties Opens the Property View for the selected search item. 

Grid editor 

The table below describes the functions available when you right-click a row or cell in the Grid 
Editor: 

Shortcut Menu Item Icon Description 

Name  Select this command to display the Name column in the Grid Editor. 

Data Type  Select this command to display the Data Type column in the Grid Editor. 

Type  Select this command to display the Type column in the Grid Editor. 

E-Mail Address  Select this command to display the E-Mail Address column in the Grid 
Editor. 

Responsibility  Select this command to display the Responsibility column in the Grid 
Editor. 

Description  Select this command to display the Description column in the Grid 
Editor. 

Notes  Select this command to display the Notes column in the Grid Editor. 

Sort Ascending by 
Name  

 
 

Reorders the selected column by sorting from A to Z. 

Sort Descending by 
Name  

 
 

Reorders the selected column by sorting from Z to A. 
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Shortcut Menu Item Icon Description 

Customize Columns 
 

 
 
 
 

Opens the Customize Columns dialog where you can customize the Grid 
Editor to display only selected columns. Deselect the columns you want 
to hide in the view and click OK. The selected columns no longer 
appear and the tab displays the notation that you have customized this 
Grid Editor. 

Delete  
 
 
 

Deletes a selected item. A warning dialog opens asking if you are sure 
you want to delete the selected item. If you select Yes, the item is 
removed not only from the Grid Editor, but also from the workspace. 

Refresh 
 

 
 

Updates the currently displayed information with new data or 
changes. You can also press F5. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

Error Logging v iew 

You can open the Error View by clicking Window > Show View > Error Logging on the main 
menu. The table below describes the functions available when you right-click the Error View: 

Shortcut Menu Item Icon Description 

Copy 
 

 
 

Copies the event details to the clipboard where you can save or 
print it. 

Clear Log Viewer 
 

 
 

Clears all error details from the Log Viewer. 

Delete Log  
 
 

The action permanently deletes all log events. When you select this 
action a warning dialog opens asking you to confirm the delete action. 

Open Log 
 

 
 

Opens the current log file in Notepad. 

Restore Log 
 

 
 

Restores all the error details that were cleared using the Clear Log 
Viewer command. 

Export Log 
 

 
 

You can export the current log to another file location and save it as a 
.log file. 

Import Log 
 

 
 

All existing files with the .log extension are listed. The selected 
imported log file opens the Error View. 

Event Details 
 

 
 

Opens the Event Details dialog displaying the date, severity level, error 
message, the exception stack trace, and session data. You can copy the 

event details to the clip board by clicking . 
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Reference Objects 

The table below describes the functions available when you right-click the top level Reference 
Objects node in the Model View tree: 

 
Shortcut Menu Item Icon Description 

New  Create a new Business Element, Business Rule, Business Unit, 
Domain, or Steward. The available command depends on which 
node you select. For example if you right-click Business Rules, the 
command is New Business Rule. 

Save Project  Saves the current project. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. Grid 
Editors can be printed or exported as a report. 

Refresh 
 

 
 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

 
 

Opens the Property View dialog for the selected reference object. 

Reference Object nodes 

The table below describes the functions available when you right-click a Reference Objects 
Node (for example Business Units) in the Model View tree: 
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Shortcut Menu Item Icon Description 

New  Create a new Business Element, Business Rule, Business Unit, Domain, 
or Steward. The available command depends on which node you 
select. For example if you right-click Business Rules, the command is 
New Business Rule. 

Create Diagram from  
Selected Elements... 

 You can create new diagrams from existing model objects. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. Grid 
Editors can be printed or exported as a report. 

Import Comma  
Separated Values (CSV)  

 
 

You can import large amounts of Reference Objects data in the Comma 
Separated Value file format into ER/Studio BA. 

Refresh 
 

 
 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

Opens the Property View dialog for the selected reference object. 

Reference Object e lements 

Once you have created a Reference Object element, a shortcut menu for the newly-created 
Reference Object is available: 

Shortcut Menu Item Icon Description 

Create Diagram from  
Selected Elements 

 You can create new diagrams from existing model objects. 

Rename  Makes the node name editable. If the diagram is open, it also renames 
the element in the Diagram View. You can also click F2. 

Delete  
 

 
 
 

This command opens the Delete Elements dialog asking if you are sure 
you want to delete the selected elements. Clicking Yes removes the 
elements from the project and any diagrams (both in the Model View 
tree and in the Diagram View) on which the elements appear. 

Links  
 
 
 
 

If you are creating a new link, click Links > New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are 
multiple links, the pull-right menu displays a list of the existing links. Click 
the name on the pull-right and the Edit Link wizard opens. If there is only 
one link the command is Links > Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage>New and the Usages wizard 
opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property View 
for the selected element. 

Diagram Usage  A pull-right menu lists the diagram(s) the select element appears in. This 
allows you to quickly locate and open the diagram where the element 
appears. If the element appears on more then ten diagrams the More... 
option appears opening a dialog listing all diagrams. 

Bindings...  This command is available when you right-click on a Business Element 
or Domain. It opens the property editor for the selected element where 
you can create or edit bindings. 

Impact Analysis  You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 
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Shortcut Menu Item Icon Description 

Create as Pool  This command is available only for the Business Unit and Stewards. 

Refresh 
 

 
 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

External Data Objects 

The table below describes the functions available when you right-click the top-level External 
Data Objects Node in the Model View tree: 

Shortcut Menu Item Icon Description 

New  Create a new external data source: data source, entity, table, view, data 
store, data feed, report, or flat file. 

Close  Collapses or expands the list of External Data Objects. 

Save Model  Saves any changes made. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. Grid Editors 
can be printed or exported as a report. 

Import - From ER/ 
Studio Data Architect  

 
 
 

Create New External Data Objects: Select this command to open a wizard 
where you can select data files to import from ER/Studio Data Architect. 
Update Existing External Data Objects: You can use this option to 
update an existing data source. All existing objects that match an object 
you have selected will be updated. 

Export to ER/Studio  
Data Architect...  

 
 

You can export objects to ER/Studio Data Architect where the elements 
in the conceptual diagram map to the logical diagram in ER/Studio Data 
Architect. 

Insert Data Source...  If you have deleted a data source file but did not delete the associated 
files, you can select this command to “restore” the deleted data source 
file. 

Refresh 
 

 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

 

Opens the Property View dialog for the selected external data 
object. 
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External Data Object e lements 

Once you have created an External Data Object element, a different shortcut menu is available: 

Shortcut Menu Item Icon Description 

New  Create a new external data source: data source, entity, table, view, data 
store, data feed, report, or flat file. 

Create Diagram from  
Selected Elements... 

 You can create new diagrams from existing model objects. 

Rename  Makes the node name editable. If the diagram is open, it also renames 
the element in the Diagram View. You can also click F2. 

Delete  
 

 
 
 

This command opens the Delete Elements dialog asking if you are sure 
you want to delete the selected elements. Clicking Yes removes the 
elements from the project and any diagrams (both in the Model View 
tree and in the Diagram View) on which the elements appear. 

Diagram Usage  A pull-right menu lists the diagram(s) the select element appears in. This 
allows you to quickly locate and open the diagram where the element 
appears. If the element appears on more than ten diagrams the More... 
option appears opening a dialog listing all diagrams. 

Links  
 
 
 
 

If you are creating a new link, click Links > New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are 
multiple links, the pull-right menu displays a list of the existing links. Click 
the name on the pull-right and the Edit Link wizard opens. If there is only 
one link the command is Links > Edit. 

Usage (CRUD) 
 

 
 
 

If you are creating a new usage, click Usage > New and the Usages wizard 
opens. If you want to edit or view an existing usage, click Usage (CRUD) > 
Edit or View. The Usage (CRUD) tab opens in the Property View for the 
selected element. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Refresh 
 

 

Updates the currently displayed information with new data or 
changes. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Palette view 

The table below describes the functions available when you right-click the Palette View: 

Shortcut Menu Item Description 

Layout Columns: Displays the icons and object labels in two columns within the palette. 

List: Displays both the icon and the object label for each object in the palette. 

Icons Only: Displays the icons without identifying labels. 

Details: Displays each icon with a brief description of the action taken when you 
select the object. 

Settings Opens the Using the Palette dialog where you can change the display characteristics of 
the palette. 
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Diagram view 

The table below describes the functions available when you right-click in the Diagram View: 
 

Shortcut Menu Item Icon Description 

Case Shift  You can set the default case shift for all element labels. You have 
three options: 

Lower: All text appears in lower case lettering, including the initial 
letter of the label. 

Preserve:  Text appears as entered. 

Upper: All text appears in upper case lettering. 

Grid  This pull-right menu contains three additional commands: 

Show Grid Lines: The grid lines appear on the diagram. 

Show Parent Objects as Transparent:  When a parent object such 
as a pool or lane is placed on a diagram, the grid lines appear in the 
object, i.e. the object is transparent. 

Snap Objects to Grid: When an element is placed in the Diagram 
View, it automatically snaps to the nearest grid. When an element is 
moved, it also snaps to the nearest grid line. 

Connections  If it is a Business Process diagram, this command shows or hides: 
All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows, or Usages. 

 
 
If it is a Conceptual Model diagram, this command shows or hides: 
All, Interactions, Line Shapes, Links, Relationships, or Usages. 

 
 
If it is a Impact Analysis diagram, this command shows or hides 
Links and Usages. 

Edit  This opens a pull-right menu allowing you to select all elements in 
the diagram. 

Layout  You have three choices: curved, elbowed, or straight. The default 
setting for connections is curved. If you change this setting to 
“straight” you get a Change Diagram Layout dialog, warning you 
that this selection overrides any changes you have made to 
individual relationships. 

Connection Labels  The default setting is to show connection labels when drawn. You 
can select to hide or show all connection labels in the diagram. 

Grid Editor... 
 

 
 
 

The Grid Editor is an spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. The Grid 
Editor can be printed or exported as a report. 

Zoom In 
 

 
 

Select this command to increase the size of the diagram in the view. 

Zoom Out 
 

 
 

Select this command to decrease the size of the diagram in the 
view. 
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Elements 

Shortcut menus are available for all the elements used in ER/Studio BA. All commands and a 
description of each are listed for each element. There are five different element sets: 

• Business Process Modeling Objects 

• Conceptual Objects 

• Reference Objects 

• External Data Objects 

• Drawing Shapes 

Business Process Modeling Objects 

The commands on the shortcut menus for the Business Process Modeling Objects are very similar. 
However additional commands appear on each of the objects. Shortcut menus are available for 
the following objects: 

• Start and Intermediate Events 

• End Events 

• Tasks 

• Embedded Sub-processes 

• Independent Sub-processes 

• Gateways 

• Pools 

• Lanes 

• Sequence Flows 

• Message Flows 

• Associations 

• Data Objects, Groups, Annotations, and Off-Page Connectors 

Start and Intermediate Events 

A Start Event indicates where a particular process starts. A trigger for a Start Event is designed to 
show the general mechanism that instantiates that particular process. An Intermediate Event 
occurs between a Start Event and an End Event. It is an event that occurs after a Process has been 
started. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Trigger Type  You can change the trigger on an event from the shortcut menu. When you 
select Trigger Type, a pull-right menu displays all the applicable triggers for 
the event, including the setting of “None”. 

Appearance...  Opens the Appearance tab in the Property View where you can edit the font 
and color options, horizontal alignments, and Diagram display options of the 
object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or Usages. 
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Shortcut Menu Item Icon Description 

Grouping  Group: Groups two or more selected elements into a single entity that 
can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment commands are 
available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control stacking 
of elements in the Diagram View: Bring to Front and Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link wizard 
opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property 
View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model View 
tree. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

End Events 

The End Event indicates where a process ends. You can define the consequences or results of 
reaching an End Event. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Result Type  You can change the result type on an event from the shortcut menu. 
When you select Trigger Type, a pull-right menu displays the following 
results for the event: None, Cancel, Compensation, Error, Link, 
Message, and Terminate. 

Appearance...  Opens the Appearance tab in the Property View where you can edit the 
font and color options, horizontal alignments, and Diagram display 
options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or 
Usages. 
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Shortcut Menu Item Icon Description 

Grouping  Group: Groups two or more selected elements into a single entity that 
can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment commands are 
available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control stacking 
of elements in the Diagram View: Bring to Front and Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link wizard 
opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property 
View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model View 
tree. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

Tasks 

A task is an activity that is included within a Process. You use a Task when the work in the Process 
is not broken down to a finer level of Process Model detail. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Appearance...  Opens the Appearance tab in the Property View where you can edit 
the font and color options, horizontal and vertical alignments, 
Diagram display options, and Line display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or 
Usages. 

Grouping  Group: Groups two or more selected elements into a single entity 
that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment commands 
are available on a pull-right menu. 
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Shortcut Menu Item Icon Description 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and Send to 
Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Convert To  You can convert a task to either an Embedded Sub-process or an 
Independent Sub-process 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model View 
tree. 

Properties 
 

 
 
 
 
 
 
 

Opens the Property View dialog for the selected element. When 
you right-click on a task and select Properties, three additional 
commands are available on the pull-right menu: 

Loop Type: Lists all available loop types in the pull-right menu. 
Select a type from the list to change it. 

Task Type: Lists all available task types in the pull-right menu. 
Select a type from the list to change it. 

Embedded Sub-processes 

An Embedded (or nested) Sub-process element is an activity containing other activities (a 
Process). The Process within the Process depends on the parent Process for instigation and has 
visibility to the parent’s global data. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Show As Expanded  When you place an embedded sub-process in the Diagram 
View, the default setting displays it as an expanded sub-process. 
Select this toggle command to expand or contract the sub- 
process. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal and vertical 
alignments, Diagram display options, and Line display options 
of the object. 

Connections  This command shows or hides the following connection objects: 
All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows, or Usages. 
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Shortcut Menu Item Icon Description 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Grid Editor... 
 

 
 
 

The Grid Editor is an spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. The 
Grid Editor can be printed or exported as a report. 

Links  
 

 
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the  Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 

Loop Type  Lists all available loop types in the pull-right menu. Select a type 
from the list to change it. 

Ad hoc 
 

 
 
 
 
 
 

Ad hoc is a boolean attribute, which has a default of False. This 
specifies whether the Process is Ad Hoc or not. The activities 
within an Ad Hoc Process are not controlled or sequenced in a 
particular order. Their performance is determined by the 
performers of the activities. If set to True, then the Ad Hoc 
marker is placed at the bottom center of the Process or the Sub- 
Process shape for Ad Hoc Processes. 

Transaction  
 
 

This option determines whether or not the behavior of the Sub- 
Process will follow the behavior of a Transaction. 

Display Properties 
 

 
 

Opens the Properties dialog for the selected element. 
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Independent Sub-processes 

An Independent Sub-process element is an activity within a Process that “calls” to another Process 
that exists within a separate diagram. The Process that is called is not dependent on the 
Independent Sub-process’ parent Process for instantiation or global data. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Show As Expanded  When you place an independent sub-process in the Diagram View, 
the default setting is that it is displayed as a contracted sub- process. 
Select this toggle command to open a diagram. 

Appearance...  Opens the Appearance tab in the Property View where you can edit 
the font and color options, horizontal and vertical alignments, 
Diagram display options, and Line display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows or Usages. 

Grouping  Group: Groups two or more selected elements into a single entity 
that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment commands 
are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 
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Shortcut Menu Item Icon Description 

Properties 

Loop Type  Lists all available loop types in the pull-right menu. Select a type 
from the list to change it. 

Transaction  
 
 

This option determines whether or not the behavior of the Sub- 
Process follows the behavior of a Transaction. 

Display Properties 
 

 
 

Opens the Properties dialog for the selected element. 

Gateways 

A Gateway controls the divergence and convergence of the Sequence Flow. It determines 
branching, forking, merging, and joining of paths. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Gateway Type  Lists all available gateway types in the pull-right menu. Select a type from the 
list to change it. 

Appearance  Opens the Appearance tab in the Property View where you can edit the font 
and color options, horizontal alignments, Diagram display options, and Line 
display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or Usages. 

Grouping  Group: Groups two or more selected elements into a single entity that can be 
moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is available 
only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment commands are 
available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control stacking of 
elements in the Diagram View: Bring to Front and Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, delete, or 
select all elements in the diagram. 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are multiple 
links, the pull-right menu displays a list of the existing links. Click the name on 
the pull-right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages wizard 
opens. If you want to edit or view an existing usage, click Usage (CRUD)>Edit 
or View. The Usage (CRUD) tab opens in the Property View for the selected 
element. 
You can also select to show or hide the Usage in the Diagram View. 
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Shortcut Menu Item Icon Description 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays 
all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

Pools 

A Pool represents a participant in a  Process. It is also called a “swimlane” and is a graphical 
container for partitioning a set of activities from other pools. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Appearance...  Opens the Appearance tab in the Property View where you can edit the 
font and color options, horizontal alignments, Diagram display options, 
and Line display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or 
Usages. 

Grouping  Group: Groups two or more selected elements into a single entity that 
can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment commands are 
available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control stacking 
of elements in the Diagram View: Bring to Front and Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Insert Lane  Inserts a lane in the pool. You can select where you want the lane 
placed in the pool from the pull-right menu. 

Remove All Lanes 
(Black Box) 

 When all lanes are removed from a pool it becomes a black box pool. 
The pool header label remains, but the lane area is blank. 

Show All Lanes  This is a toggle of the Remove All Lanes command. All hidden lanes in the 
pool are shown. 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are 
multiple links, the pull-right menu displays a list of the existing links. 
Click the name on the pull-right and the Edit Link wizard opens. If there 
is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 
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Shortcut Menu Item Icon Description 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages wizard 
opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property View 
for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the Pool that 
exists on the diagram. 

Grid Editor... 
 

 
 
 

The Grid Editor is an spreadsheet-like display format that is an alternative 
to the Model View tree view. This is valuable for large objects or business-
related objects, such as business rules. The Grid Editor can be printed or 
exported as a report. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

Lanes 

A Lane is a subpartition within a pool. Lanes organize and categorize activities. Lanes are often 
used to separate the activities associated with a specific company function or role. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 

Appearance...  Opens the Appearance tab in the Property View where you can edit the font 
and color options, horizontal alignments, and Diagram display options of the 
object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or Usages. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, delete, or 
select all elements in the diagram. 

Insert Lane  Inserts a lane in the pool. 

Move Lane  Opens the Move Lane dialog where you can reorder the lanes. 

Remove All Lanes 
(Black Box) 

 When all lanes are removed from a pool it becomes a black box pool. The 
pool header label remains, but the lane area is blank. 

Show All Lanes  This is a toggle of the Remove All Lanes command. All hidden lanes in the 
pool are shown. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an alternative to 
the Model View tree view. This is valuable for large objects or business-
related objects, such as business rules. The Grid Editor can be printed or 
exported as a report. 
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Shortcut Menu Item Icon Description 

Links  
 
 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link wizard 
opens. If you are editing an existing link, click Links>Edit. If there are 
multiple links, the pull-right menu displays a list of the existing links. Click 
the name on the pull-right and the Edit Link wizard opens. If there is only 
one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages wizard 
opens. If you want to edit or view an existing usage, click Usage 
(CRUD)>Edit or View. The Usage (CRUD) tab opens in the Property View for 
the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays 
all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 
 

Opens the Property View dialog for the selected element. 

Sequence Flows 

A Sequence Flow shows the sequence of processes in an organization or department. When you 
use pools or lanes in your diagram, you use Sequence Flow lines to connect events, activities, 
and gateways within the pools or lanes. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label is 
shown. 

Condition Type  None 

Conditional 

Default 

Appearance...  Opens the Appearance tab in the Property View where you can edit the 
font and color options, Diagram display options, and LIne display options 
of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, or 
Usages. 

Edit  This opens a pull-right menu allowing you to delete, or select all 
elements in the diagram. 
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Shortcut Menu Item Icon Description 

Layout  You can change the layout on individual connections. The 
commands e available on the pull-right menu are: 

Curved: orthogonal bend points with “curved” corners are placed 
on the line. 

Elbowed: orthogonal bend points are placed on the line. 

Straight: the line is always straight. However there can be bend 
points on the connection. 

Remove Bend Points: Removes all bends so the line traverses the 
shortest distance between two elements. 

Reset to Default Docking Position: The docking position of the 
line/element intersection is reset to its default setting. 

Links 
 

 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 
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Message Flows 

Message Flows are used to show the flow of messages between two participants that are 
prepared to send and receive them. A Message Flow can connect directly to the boundary of a 
pool or it can cross the boundary of a pool and connect to an object within that pool. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label is 
shown. 

Appearance...  Opens the Appearance tab in the Property View where you can edit 
the font and color options, Diagram display options, and Line 
display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows 
or Usages. 

Edit  This opens a pull-right menu allowing you to delete, or select all 
elements in the diagram. 

Layout  You can change the layout on individual connections. The 
commands e available on the pull-right menu are: 

Curved: orthogonal bend points with “curved” corners are placed 
on the line. 

Elbowed: orthogonal bend points are placed on the line. 

Straight: the line is always straight. However there can be bend 
points on the connection. 

Remove Bend Points: Removes all bends so the line traverses the 
shortest distance between two elements. 

Reset to Default Docking Position: The docking position of the 
line/element intersection is reset to its default setting. 

Links 
 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 
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Associations 

An Association is used to associate information with events and activities. It can be used to 
associate reference objects, external data objects, shapes, and activities with textual 
information. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label is 
shown. 

Directional Arrow  You can change the direction on an Association connecting object 
from the shortcut menu. When you select Direction Arrow, a pull- 
right menu displays the following options: 

None: ( ) No directional arrows are shown. 
 
To: ( ) Displays the arrow at the target element. 

 
From: ( ) Displays the arrow at the source element. 

 
Both: ( ) Directional arrows are shown at both ends of the 
connecting object. 

Appearance...  Opens the Appearance tab in the Property View where you can edit 
the font and color options, Diagram display options, and Line 
display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, 
or Usages. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Layout  You can change the layout on individual connections. The 
commands e available on the pull-right menu are: 

Curved: orthogonal bend points with “curved” corners are placed 
on the line. 

Elbowed: orthogonal bend points are placed on the line. 

Straight: the line is always straight. However there can be bend 
points on the connection. 

Remove Bend Points: Removes all bends so the line traverses the 
shortest distance between two elements. 

Reset to Default Docking Position: The docking position of the 
line/element intersection is reset to its default setting. 

Links 
 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 
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Shortcut Menu Item Icon Description 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

Opens the Property View dialog for the selected element. 

Data Objects, Groups, Annotations, and Off-Page Connectors 

Artifacts provide additional information about the business process. Using artifacts allows you to 
add non-standard elements to satisfy a specific need. Since you do not want to alter the basic 
look-and-feel of a diagram, you can use artifacts to link to the existing events and activities 
through Associations. Artifacts do not affect the basic Sequence Flow or Message Flow, nor do 
they affect mapping to execution languages. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label shows. 
This command does not apply to the Annotation object. 

Show State  This command applies to the Data Object element only. 

Appearance...  Opens the Appearance tab in the Property View where you can edit 
the font and color options, horizontal alignment, and Diagram 
display options of the object. 

Connections  This command shows or hides the following connection objects: All, 
Associations, Line Shapes, Links, Message Flows, Sequence Flows, 
or Usages. 

Grouping  Group: Groups two or more selected elements into a single entity 
that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment commands 
are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and Send 
to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 
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Shortcut Menu Item Icon Description 

Links  
 
 
 
 
 

If you are creating a new link, click Links>New and the Create Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull-right and the Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the  Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Conceptual objects 

The commands on the shortcut menus for the Conceptual Modeling Objects are very similar. 
However additional commands appear on each of the objects. Shortcut menus are available for 
the following objects: 

• Subject Area 

• Business Entity 

• Business Attribute 

• Interaction 

• Relationship 

Subject Area 

Conceptual Modeling allows Business Users to create high-level designs of the core “concepts” 
and subject areas that drive the business, which can be passed onto data and process modelers 
to drive more detailed logical and physical design. A Subject Area can reference a collection of 
entities. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Show As Expanded  Shows or hides the expand/contract control that appears in the 
right-hand corner of the object. 

Show Expansion Control  You can hide or show the expander indicator located in the 
lower right-hand corner of the object. The expander is shown as 
the default setting. 
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Shortcut Menu Item Icon Description 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal and vertical 
alignment, Diagram display options, Line display options, and 
shape options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Relationships, Interactions, Line Shapes, Links, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Create Mapping/Edit  
Mapping 

 You can map a Subject Area to one or more Conceptual Model 
diagrams or Business Entities. 

Diagram Mapping  This command is available once you have mapped a diagram to 
a Subject Area. When it is selected a pull-right menu opens 
displaying the mapped diagram(s). 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the 
Subject Area element that exists on the diagram. 

Grid Editor... 
 

 
 
 

The Grid Editor is an spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. The 
Grid Editor can be printed or exported as a report. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

Opens the Property View dialog for the selected element. 
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Business Entity 

A Business Entity is a high-level “container” for businesses/organizations. They can stand alone 
or can be containers for other Business Entities or Business Attributes. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Show As Expanded  Shows or hides the expand/contract control that appears in the 
right-hand corner of the object. 

Show Expansion Control  You can hide or show the expander indicator located in the 
lower right-hand corner of the object. The expander is shown as 
the default setting. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal and vertical 
alignment, Diagram display options, Line display options, and 
Business Attribute display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Relationships, Interactions, Line Shapes, Links, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Insert Attribute  Inserts a Business Attribute in the Business Entity. 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the 
Business Entity element that exists on the diagram. 

Grid Editor... 
 

 
 
 

The Grid Editor is a spreadsheet-like display format that is an 
alternative to the Model View tree view. This is valuable for large 
objects or business-related objects, such as business rules. The 
Grid Editor can be printed or exported as a report. 
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Shortcut Menu Item Icon Description 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Business Attribute 

Business Attributes are the low-level details (i.e., properties), of a Business Entity. You can 
reorder the Business Attributes within a Business Entity. 

Shortcut Menu Item Icon Description 

Unique Identifier  This is a toggle that turns the Unique Identifier setting (#) on or 
off for the selected attribute. 

Data Type  The Data Types available are high level: binary, BLOB/Image, 
boolean, char, CLOB/Large Text, Decimal, Date, Integer, Time 
Stamp, Varchar, and XML. The data type selected appears in the 
Property View for the selected attribute. 

Optionality  You can set the Optionality for an attribute. If you select 
Mandatory it becomes a “required” property and a plus sign (+) 
appears to the left of the attribute. If it is optional, a minus sign 
(-) appears to the left of the attribute. You can set a preference 
under the Display Options for Business Entities to always show 
the optionality indicator for Business Attributes. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options and horizontal alignment of the 
object. 

Connections  This command shows or hides the following connection objects: 
All, Relationships, Interactions, Line Shapes, Links, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the  Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 
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Shortcut Menu Item Icon Description 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

Opens the Property View dialog for the selected element. 

Interaction 

An interaction represents an action, process, or transaction between two objects. These 
interactions are often expressed as action verb phrases. 

Shortcut Menu Item Icon Description 

Show  You can show the name, verb phrase and inverse verb phrase for 
the Interaction. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, Diagram display options, and 
Line display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Relationships, Interactions, Line Shapes, Links, or Usages. 

Edit  This opens a pull-right menu allowing you to delete, or select all 
elements in the diagram. 

Layout  You can change the layout on individual connections. The 
commands e available on the pull-right menu are: 

Curved: Orthogonal bend points with “curved” corners are 
placed on the line. 

Elbowed: Orthogonal bend points are placed on the line. 

Straight: The line is always straight. However there can be bend 
points on the connection. 

Remove Bend Points: Removes all bends so the line traverses 
the shortest distance between two elements. 

Reset to Default Docking Position: The docking position of 
the line/element intersection is reset to its default setting. 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 
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Shortcut Menu Item Icon Description 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Relationship 

Relationships can only be defined between common object types. For example two business 
entities can have a relationship, but a business entity and a subject area cannot. 

Shortcut Menu Item Icon Description 

Show  You can show the name, verb phrase inverse verb phrase, and 
unique identifier for the Relationship. 

Relationship Type  Sets the Relationship type. You can view and/or change this 
setting in the Property View. Your choices are: 

• Generic 

• Many-to-Many 

• Many to One 

• One to Many 

Optionality  Sets the Source to Target Optionality. You can view and/or 
change this setting in the Property View. You choices are: 

• Optional to Optional 

• Optionality to Mandatory 

• None 

• Mandatory to Optional 

• Mandatory to Mandatory 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, Diagram display options, and 
Line display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Relationships, Interactions, Line Shapes, Links or Usage. 

Edit  This opens a pull-right menu allowing you to delete, or select all 
elements in the diagram. 
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Shortcut Menu Item Icon Description 

Layout  You can change the layout on individual connections. The 
commands e available on the pull-right menu are: 

Curved: orthogonal bend points with “curved” corners are 
placed on the line. 

Elbowed: orthogonal bend points are placed on the line. 

Straight: the line is always straight. However there can be bend 
points on the connection. 

Remove Bend Points: Removes all bends so the line traverses 
the shortest distance between two elements. 

Reset to Default Docking Position: The docking position of 
the line/element intersection is reset to its default setting. 

Links 
 

 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Impact Analysis Report...  An Impact Analysis Report can be generated for any node on 
the Model View tree. It shows the interrelationships between 
objects. Impact Analysis reports can be printed or exported. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Reference Objects 

The commands on the shortcut menus for the Reference Objects in a diagram are very similar. 
However additional commands appear on each of the objects. Since Domains are not visible in a 
diagram, no shortcut menu is available here. 

Shortcut menus are available for the following objects: 

• Business Element 

• Business Rule 

• Business Unit 

• Steward 

• Links 

• Usage 
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Business Element 

Business Elements are often used by business users to document their list of “terms and/or 
definitions”. While from a business user’s point-of-view, this may be no more than a list of terms, 
they can be used by a modeler to seed attributes of semantically-rich models. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal alignment, and 
Diagram display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Binding Business Attributes  
to Business Elements... 

 Opens the Bindings tab for the selected Business Element. You 
can add, edit or delete bindings. 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the  Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the 
Business Element that exists on the diagram. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 



Application basics > Navigation 

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 101   

 

 

 
Shortcut Menu Item Icon Description 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Business Rule 

A business rule is a policy, practice, or formula related to the operation and enforcement of 
business practices. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal alignment, and 
Diagram display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the 
Business Rule element that exists on the diagram. 
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Shortcut Menu Item Icon Description 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

Opens the Property View dialog for the selected element. 

Business Unit 

A business unit is an organizational area within or external to an enterprise, for example, Human 
Resources, Sales, Accounting, etc. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal alignment, and 
Diagram display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Line Shapes, Links or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Creating as Pool  This creates a pool and lane with the same name as the Business 
Unit. The Business Unit is automatically associated with the Pool 
as a participant. A conceptual link from the Pool to the Business 
Unit is also created. The name of the link is the name of the 
Business Unit. This command is enabled only when Business 
Process diagrams are open. 

Detaching from Pool  Once you have created a Business Unit or Steward as a pool you 
can eliminate the relationship between the reference object and 
the pool. This command is enabled only when Business Process 
diagrams are open. 

Links 
 

 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 
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Shortcut Menu Item Icon Description 

Usage (CRUD) 
 

 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Create Diagram from  
Selected Elements... 

 This function gives you the ability to create a diagram from the 
Business Unit element that exists on the diagram. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Steward 

A steward is a person or organization responsible for or associated with a model element, for 
example: DBA, Auditor, Jeffrey Smith, etc. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal alignment, and 
Diagram display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Creating as Pool  This creates a pool and lane with the same name as the Steward. 
The Steward is automatically associated with the Pool as a 
participant. A conceptual link from the Pool to the Steward is 
also created. The name of the link is the name of the Steward. 
This command is enabled only when Business Process diagrams 
are open. 
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Shortcut Menu Item Icon Description 

Detaching from Pool  Once you have created a Business Unit or Steward as a pool you 
can eliminate the relationship between the reference object and 
the pool. This command is enabled only when Business Process 
diagrams are open. 

Links  
 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the  Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 

Links 

With a link you create a representation of a relationship between elements. These elements can 
consist of reference objects, data objects, and elements within a diagram. 

Shortcut Menu Item Description 

Show Name (Type) Verb Phrase 

Inverse Verb Phrase 

Appearance... Opens the Appearance tab in the Property View where you can edit the font and 
color options, Diagram display options, and Line display options of the object. 

Connections If you right-click on a connection (for example a Sequence Flow) you get the 
following commands: 

Hide Selected: The selected connection no longer appears in the diagram. 
Show Attached/Hide Attached: 

• If it is a Business Process diagram, the command shows or hides the 
following: All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows, or Usages. 

• If it is a Conceptual Model diagram, the command shows or hides the 
following: All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Edit This opens a pull-right menu allowing you to cut, copy, paste, delete, or select all 
elements in the diagram. 



Application basics > Navigation 

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 105   

 

 

 
Shortcut Menu Item Description 

Layout You can change the layout on individual connections. The commands 
available on the pull-right menu are: 

Curved: Orthogonal bend points with “curved” corners are placed on the line. 

Elbowed: Orthogonal bend points are placed on the line. 

Straight: The line is always straight. However there can be bend points on the 
connection. 

Remove Bend Points: Removes all bends so the line traverses the shortest 
distance between two elements. 

Reset to Default Docking Position: The docking position of the line/element 
intersection is reset to its default setting. 

Find in Model View Select this command to locate the selected element in the Model View tree. 

Properties Opens the Property View dialog for the selected element. 

Usage 

You can show the create, read, update, or delete database attributes on a connection. When this 
connection is created they are labeled with the attributes you selected at the time of creation. 
These elements can consist of reference objects, data objects, and elements within a diagram. 

Shortcut Menu Item Description 

Show Name (Type) Usage 

Appearance... Opens the Appearance tab in the Property View where you can edit the font and 
color options, Diagram display options, and Line display options of the object. 

Connections If you right-click on a connection (for example a Sequence Flow) you get the 
following commands: 

Hide Selected: The selected connection no longer appears in the diagram. 
Show Attached/Hide Attached: 

• If it is a Business Process diagram, the command shows or hides the 
following: All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows, or Usages. 

• If it is a Conceptual Model diagram, the command shows or hides the 
following: All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Edit This opens a pull-right menu allowing you to delete, or select all elements in the 
diagram. 

Layout You can change the layout on individual connections. The commands e 
available on the pull-right menu are: 

Curved: Orthogonal bend points with “curved” corners are placed on the line. 

Elbowed: Orthogonal bend points are placed on the line. 

Straight: The line is always straight. However there can be bend points on the 
connection. 

Remove Bend Points: Removes all bends so the line traverses the shortest 
distance between two elements. 

Reset to Default Docking Position: The docking position of the line/element 
intersection is reset to its default setting. 
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Shortcut Menu Item Description 

Find in Model View Select this command to locate the selected element in the Model View tree. 

Properties Opens the Property View dialog for the selected element. 

External Data Objects 

The shortcut menu for all of the External Data Objects contains the same commands. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal alignment, and 
Diagram display options of the object. 

Connections  This command shows or hides the following connection objects: 
All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the  alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 

 
 
 
 
 

If you are creating a new link, click Links>New and the Create  Link 
wizard opens. If you are editing an existing link, click Links>Edit. If 
there are multiple links, the pull-right menu displays a list of the 
existing links. Click the name on the pull- right and the  Edit Link 
wizard opens. If there is only one link the command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the Usages 
wizard opens. If you want to edit or view an existing usage, click 
Usage (CRUD)>Edit or View. The Usage (CRUD) tab opens in the 
Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the Model 
View tree. 

Properties 
 

 

Opens the Property View dialog for the selected element. 
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Drawing Shapes 

The shortcut menu for all the Drawing Shapes contains the same commands with the exception 
of the Line. 

Shortcut Menu Item Icon Description 

Show Name  This is a toggle command. If it is selected the element label 
shows. 

Appearance...  Opens the Appearance tab in the Property View where you can 
edit the font and color options, horizontal and vertical 
alignment, Diagram display options, and Line display options of 
the object. 

Connections  This command shows or hides connection objects. For 
conceptual diagrams the following connections are listed: All, 
Line Shapes, Links, or Usages. For business process diagrams 
the following connections are listed: All, Associations, Line 
Shapes, Links, Message Flows, Sequence Flows, and Usages. 

Grouping  Group: Groups two or more selected elements into a single 
entity that can be moved around a diagram in a block. 

Ungroup: Removes the selected grouping. This command is 
available only if the element selected is in a group. 

Align Objects  When two or more objects are selected, the alignment 
commands are available on a pull-right menu. 

Order  This is a pull-right menu displaying two commands that control 
stacking of elements in the Diagram View: Bring to Front and 
Send to Back. 

Edit  This opens a pull-right menu allowing you to cut, copy, paste, 
delete, or select all elements in the diagram. 

Links  
 

 
 
 
 
 
 

If you are creating a new link, click Links>New and the Create  
Link wizard opens. If you are editing an existing link, click 
Links>Edit. If there are multiple links, the pull-right menu 
displays a list of the existing links. Click the name on the pull- 
right and the Edit Link wizard opens. If there is only one link the 
command is Links>Edit. 
You can also select to show or hide the link in the Diagram View. 

Usage (CRUD) 
 

 
 
 
 
 

If you are creating a new usage, click Usage>New and the 
Usages wizard opens. If you want to edit or view an existing 
usage, click Usage (CRUD)>Edit or View. The Usage (CRUD) tab 
opens in the Property View for the selected element. 
You can also select to show or hide the Usage in the Diagram 
View. 

Impact Analysis 
 

 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically 
displays all the associated relationships and elements. 

You can also show the  Impact Analysis Report. 

Find in Model View  Select this command to locate the selected element in the 
Model View tree. 

Properties 
 

Opens the Property View dialog for the selected element. 
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Line 

The Line has a different set of commands available because of its different characteristics. 

Shortcut Menu Item Description 

Show Name This is a toggle command. If it is selected the element label shows. 

Appearance... Opens the Appearance tab in the Property View where you can edit the font and 
color options, Diagram display options, and Line display options of the object. 

Connections If you right-click on a connection (for example a Sequence Flow) 
you get the following commands: 

Hide Selected: The selected connection no longer appears in the diagram. 
Show Attached/Hide Attached: 

• If it is a Business Process diagram, the command shows or hides the 
following: All, Associations, Line Shapes, Links, Message Flows, Sequence 
Flows, or Usages. 

• If it is a Conceptual Model diagram, the command shows or hides the 
following: All, Interactions, Line Shapes, Links, Relationships, or Usages. 

Edit This opens a pull-right menu allowing you to cut, copy, paste, delete, or select all 
elements in the diagram. 

Layout You can change the layout on individual connections. The commands e 
available on the pull-right menu are: 

Curved: Orthogonal bend points with “curved” corners are placed on the line. 

Elbowed: Orthogonal bend points are placed on the line. 

Straight: The line is always straight. However there can be bend points on the 
connection. 

Remove Bend Points: Removes all bends so the line traverses the shortest 
distance between two elements. 

Reset to Default Docking Position: The docking position of the line/element 
intersection is reset to its default setting. 

Find in Model View Select this command to locate the selected element in the Model View tree. 

Properties Opens the Property View dialog for the selected element. 

Keyboard commands 
The application keyboard commands help you expedite your tasks by minimizing mouse clicks. 

Command Description 

Hot-Key Object Movement You can move objects by pre-set increments using the specified hot 
keys. 

Eclipse Hot-Key Object Movement You can use the hot-keys to move the elements or connections, but the 
key combination is different 

Selecting Objects in Container  
Elements 

You can select objects in a container element such as a Subject Area 
by using the Alt key. 

Key Assist Commands This is a list of “hot” keys or shortcuts used by ER/Studio BA. 
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Hot-Key Object Movement 

This allows you to move elements and connectors in the Diagram View using specified hot keys. 
You can change the default setting for the hot-key object movement in the Preferences Editor. 

1. From the main menu choose Windows > Preferences. 

2. Select Diagrams. The default setting for “Override Eclipse hot-key object movement” is 
enabled. 

When the hot-key movement is overridden you can move elements and connections in the 
Diagram View using the arrow keys. 

Action Key Combination 

Directional arrow key only Each time you click a directional arrow, the element or connection is 
moved one pixel in the direction of the arrow. 

Shift + directional arrow While holding down the Shift key, each time you click a directional 
arrow, the element or connection is moved ten pixels in the direction of 
the arrow. 

Ctrl + directional arrow While holding down the Ctrl key, each time you click a directional arrow, 
the element or connection is moved 20 pixels in the direction of the 
arrow. 

NOTE:  If this preference is not enabled, the directional arrow keys are used to move between 
elements on the diagram. 

Eclipse Hot-Key Object Movement 

When the override preference is not selected, you can still use the hot-keys to move the elements 
or connections, but the key combination is different. 

1. Select the element that you want to move. 

2. Press the period key and a directional arrow. 

NOTE:  Notice that the element changes color when it is in the move mode. 

 
3. Each time you click a directional arrow, the element is moved one pixel in the direction of 

the arrow. 

4. When you press the period key again, you are taken out of the move function to the resize 
function. 

5. Each time you press the period key, the resize cursor moves to a difference resize point on 
the element. 
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Selecting Objects in Container Elements 

You can select multiple elements that have been placed in container elements. 

1. To invoke the marquee cursor, hold down the ALT key while dragging the mouse around the 
items you want selected with the container. 

 
2. Release both the ALT key and the mouse button and the items within the frame are 

selected. 

NOTE:  The container elements used in ER/Studio BA consist of: Subject Area, Business 
Entity, Pool/Lane, and Embedded Subprocess. 

Key Assist Commands 

ER/Studio BA offers the following general shortcuts/accelerators for the application. Select Ctrl + 
Shift + L to open the list of Key Assist Commands in the application. The table below describes 
the keyboard commands: 

Result Keyboard  Command 

Activate Editor F12 

Backward History Alt+Left 

Bold Ctrl+B 

Close Ctrl+W 

Close All Ctrl+Shift+F4 

Content Assist Ctrl+Space 

Context Information Ctrl+Shift+Space 

Console Alt+Shift+Q, C 

Copy Ctrl+C 

Cut Shift+X 

Group Ctrl+Shift+G 

Italics Ctrl+I 

Last Edit Location Ctrl+Q 
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Result Keyboard  Command 

Maximize Active View or Editor Ctrl+M 

New Workspace Ctrl+N 

New Menu Alt+Shift+N 

Next Ctrl+. 

Next Editor Ctrl+F6 

New Perspective Ctrl+F8 

Next View Ctrl+F7 

Open Editor Drop Down Ctrl+E 

Open Property View from Grid Editor Alt+Enter 

Open Resource Ctrl+Shift+R 

Open Workspace Ctrl+0 

Paste Shift+V 

Previous Ctrl+, 

Previous Editor Ctrl+Shift+F6 

Previous Perspective Ctrl+Shift+F8 

Previous View Ctrl+Shift+F7 

Print Ctrl+P 

Properties Alt+Enter 

Quick Fix Ctrl+1 

Redo Ctrl+Y 

Refresh F5 

Rename F2 

Save Ctrl+S 

Save All Ctrl+Shift+S 

Select All Ctrl+A 

Select All text in Notes and Description Fields Ctrl+A 

Select Element Shift+Click 

Show In Menu Alt+Shift+W 

Show Key Assist Ctrl+Shift+L 

Show System Menu Alt+- 

Show View (View: Outline) Alt+Shift+Q, O 

Show View (View: Problems) Alt+Shift+Q, X 

Show View Menu Ctrl+F10 

Switch to Editor Ctrl+Shift+E 

Underline Ctrl+U 

Undo Ctrl+Z 

Ungroup Ctrl+Shift+U 

Zoom In Ctrl+= 

Zoom Out Ctrl+- 
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Preferences 
You can configure many of ER/Studio BA’s properties to better suit your workflow and your work 
goals. The application offers a number of configuration options from different locations. 

You can customize the application configuration to meet your specific needs. You do this using 
the Preferences Editor, where you set your preferences for the application’s global defaults. You 
can also use this dialog to add, edit, and delete selected default values. 

Preferences Editor 
You can use the Preferences Editor to make changes to defaults used application-wide. You can 
also edit default values. 
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The table below describes the components in the Preferences Editor: 

Component Description 

type filter text This is a search text box which enables you to quickly locate the 
preference you want to change. The item you are searching for appears in 
the Categories tree. 

Categories tree Displays in tree form all preferences available for editing, adding, or 
deleting. Expand the nodes of this tree to display each node’s defaults in 
the Details grid. 

Details pane Lists all options and their default values for any node selected in the 
Categories tree. 

Apply to 
Diagram 

This button is available on applicable preferences (for example 
Formatting). It applies the changes immediately to the open diagram. 
Note: The Apply to Diagram function does not apply to the Display 
Options command for existing elements in a diagram. 

Restore Defaults Restores the default values for all preferences on the opened preference 
page, and displays a warning message explaining the repercussions of the 
restoration. 

Apply Click Apply to institute the changes you made in the Preferences dialog. 

OK Accepts all the changes made and closes the dialog. 

Cancel Cancels all changes made and closes the dialog. 

Opening the Preferences Editor 

1. On the main menu, click Window > Preferences.... 

2. To locate the preference you want to change, you can type the preference name in the Type 
Filter Text box and press Enter. The preference appears in the Categories tree.  
OR 
Expand the nodes in the Categories tree and select the preference you want to edit. 

3. In the Details pane, edit the settings you want to change. 

NOTE:  When working Formatting Preferences, if you are changing preferences in 
multiple panes, you must click Apply before going to the next pane or all 
formatting changes to the object is lost. 

4. Click OK and ER/Studio BA saves your changes and the Preferences dialog closes. You can 
set preferences for behavior and appearance in the ER/Studio BA application.  

The nodes available are: 

• Business Process Modeling 

• Conceptual Modeling 

• Default Values 

• Diagrams 

• Find/Search 

• Formatting 

• Import/Export 

• License Manager 

• Messages 
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• Model View 

• Naming 

• Property Views 

• Reporting 

• Repository Options 

• Workspaces/Models 

Business process modeling 
In this node you can set preferences that directly affect the Business Process Modeling Notation 
elements. The table below describes the details available for the Business Process Modeling 
node. 

Detail Description 

Display Diagram Usage 
When Deleting Elements 

If you select this preference, the Delete dialog displays the following option: “Click 
here to see the diagrams on which the elements appear.” When you click , a box 
opens showing a list of the other diagrams that are using this object. 

Automatically Delete Event 
Triggers and Results 

You have two options when deleting a trigger/result from an event: 

Prompt: A Delete dialog will always open warning you that all event triggers/results 
along with their associated information will be deleted. When you select OK, the 
trigger/result(s) are removed from the event. 

Always: The trigger/result(s) are deleted without a warning dialog. 

The default setting is Prompt. 

Validating Against BPMN  
Specification 

When you create a new project, this validation preference sets the default value (on or 
off) in the New Project Wizard dialog. 

There are two subnodes listed in the Business Processing Modeling node:  Pools and Processes. 

Pools 

The Pools preference has one setting: 

Detail Description 

Adjust pool size when 
resizing lanes 

When this option is selected (default setting) if you increase the size of a lane, the pool 
increases in size as well. If you deselect this preference, you won’t see the pool grow in 
size and the lane above or below it will shrink. 

Processes 

The Processes preference has one setting: 

Detail Description 

Show Processes in 
Application 

Select this option to display elements in a diagram or pool under the Process node 

( ) in the Model View. 
If this option is not selected, all elements are displayed under the Pool node. 



ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 117   

Application basics > Preferences  

 

Conceptual modeling 
Expand the Conceptual Model node to gain access to the subnode Bindings. The table below 
describes the preferences available for bindings. 

Detail Description 

Duplicate attribute warning options 

Automatically create business 
attributes from business elements 

You have two settings on how you want to handle the binding of 
business elements to business attributes: 

Prompt: A Binding Creation Warning dialog will always open prompting 
you for a decision on how to handle business attributes that already 
exist with the same name. 

Always: If a bound business attribute with the same already exists in the 
business entity, a new bound business attribute will always be created with 
a unique name. When this option is selected, the second preference is 
made available. 

The default setting is Prompt. 

Create the new attribute with a 
unique name and bind it to the 
business element 

This option is enabled if the “Always” preference is selected. Select it if 
you want all newly created attributes to have unique names and 
automatically bound to the business element. 

Create the new attribute with a 
unique name but do not bind it to 
the business element 

This option is enabled if the first preference is selected. Select it if you 
want all newly created attributes to have unique names, but do not want it 
automatically bound to the business element. 

Display warning when attempting 
to bind a business element and 
domain to an attribute 

You cannot bind both a Business Element and a Domain to an attribute. A 
warning dialog opens giving you an opportunity to resolve the conflict. 
You can deselect this option to hide this warning. 

Default values 
The preferences in this section set default values for metadata objects. You can set these values 
for Attributes, Business Attributes, Business Elements, Columns, and Domains. 

Attributes 

The table below describes the preference available for the Attributes node: 

Detail Description 

Data Type Select the default value you want to always appear for Attributes. You can select: 
None, Binary, Boolean, Char, Date, Decimal, Float, Integer, Long Binary, Money, 
Timestamp, Varchar, and XML. 

Width Set the default length of the attribute/domain datatype. 

Scale Set the default number of digits after a decimal (for those data types that imply a 
decimal. 
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Business a ttributes 

The table below describes the preference available for the Business Attributes node: 

Detail Description 

Data Type Select the default value you want to always appear for Business Attributes. You can 
select: None, Binary, Boolean, Char, Date, Decimal, Float, Integer, Long Binary, 
Money, Timestamp, Varchar, and XML. 

Width Set the default length of the attribute/domain datatype. 

Scale Set the default number of digits after a decimal (for those data types that imply a 
decimal. 

Business e lements 

The table below describes the preference available for the Business Elements node: 

Detail Description 

Data Type Select the default value you want to always appear for Business Elements. You can 
select: None, Binary, BLOB/Image, Boolean, Char, CLOB/Large Text, Date, 
Decimal, Integer, Timestamp, Varchar, and XML. 

Columns 

The table below describes the preference available for the Columns node: 

Detail Description 

Data Type Select the default value you want to always appear for Columns You can select: 
None, Binary, Boolean, Char, Date, Decimal, Float, Integer, Long Binary, Money, 
Timestamp, Varchar, and XML. 

Width Set the default length of the attribute/domain datatype. 

Scale Set the default number of digits after a decimal (for those data types that imply a 
decimal. 

Domains 

The table below describes the preferences available for the Domains node: 

Detail Description 

Data Type Select the default value you want to always appear for Domains. You can select: 
None, Binary, BLOB/Image, Boolean, Char, CLOB/Large Text, Date, Decimal, 
Integer, Timestamp, Varchar, and XML. 

Width Set the default length of the attribute/domain datatype. 

Scale Set the default number of digits after a decimal (for those data types that imply a 
decimal. 

Optionality Select the optionality you want to always appear for Domains. Your choices are: 
None, Mandatory, or Optional. 
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Diagrams 
You can set global preferences for three main diagram preferences. You can also set a preference 
for the generation of Impact Analysis Diagrams. The table below describes the preferences 
available for the Diagrams node: 

Detail Description 

Options for All Diagrams 

Automatically perform 
diagram layout 

You have two options for the type of notification you get when right-clicking in 
a diagram and selecting one of the Layout options: prompt, and always. The 
default setting is Prompt. 

Enable multi-drop on object 
creation 

Select this preference to enable the multi-drop mode. When you select an 

element from the Palette view, the cursor is in the multi-drop mode    . 
So, you can place as many elements as you need. This preference is 
selected as the default setting. 

Override Eclipse hot-key 
object movement 

Select this option to override the Eclipse  Hot-Key Object  Movement. This 
allows you to use the directional keys to move elements in the Diagram View. 

Options for New Diagrams 

Default Line Layout When creating a new diagram, you can set the default line style used when you 
create a connecting object between two objects. Your three options are 
curved, elbowed, or straight. The default setting is curved. 

Default Case Shift When creating a new diagram, you can set the default case shift for all 
element labels. You have three options: 

Lower: All text appears in lower case lettering, including the initial letter of 
the label. 

Preserve:  Text is preserved as it was entered. Upper: All text 

appears in upper case lettering. The default setting is 

“Preserve.” 

Show Grid Lines Changes the default setting so that each time a diagram is opened or a 
new diagram is created, the grid lines automatically appear. 

Show parent objects as 
transparent when grid lines 
are displayed 

When a parent object such as a pool or lane is placed on a diagram, the grid 
lines appear in the object, i.e. the object is transparent. 

Snap Objects to Grid Changes the default setting so that when an element is placed in the Diagram 
View, it automatically snaps to the nearest grid. When an element is moved, it 
also snaps to the nearest grid line. 

General Preferences 

Open last used diagram 
when starting application 

The last used diagram opens when the workspace is opened. This option is 
selected by default. 
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Impact Analysis d iagrams 

The table below describes the preference available for Impact Analysis diagrams: 

Detail Description 

Automatically generate 
large Impact Analysis 
Diagrams 

Select this option if you always want Impact Analysis Diagrams of any size 
automatically generated. If this option is not selected you are given the option 
whether to generate a large diagram or not. 

Find/Search 
There are two sets of preferences you can set: Search Dialog and Search Results. 

Search d ialog 

The one preference for the Search Dialog lets you set the number of entries you want to appear in 
the search history list. 

Search r esults 

There are two preferences you can set for the Search Results view: 

Preference Description 

Maximum number of elements to 
return 

Enter the maximum number of returns to show for a search. The 
preference would be helpful if you are search large models with 
many elements. 

Display Options You can select which columns you want to appear in the Search 
Results view. Your options are: Name, Type, Description, Notes, 
Parent, and Project Hierarchy. 

Formatting 
You can set global preferences for the following element types: 

• Business Process Modeling Formatting 

• Conceptual Modeling Formatting 

• External Data Objects Formatting 

• Reference Objects Formatting 

• Shapes Formatting 

The changes you make in these preference dialogs are then applied to all future elements you 
place in the Diagram View. For example, if you change the fill color of a gateway to red. Now all 
gateways you place in the diagram View will be red. The preferences you can set are fonts and 
colors, text justification, rendering, display option settings, and line display options. 

To open the Formatting Preferences dialog, do the following: 

1. From the main menu select Windows > Preferences. 

2. Expand the Formatting node and select element types you want to format (i.e., Business 
Process Modeling, Conceptual Modeling, External Data Objects, etc.). 
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Once you select the type of elements you want to format, additional information appears where 
you can specify display format defaults for a selected element. The formatting options are 
explained below: 

Detail Description 

Tree The Tree contains the set of business processing modeling elements which have visual 
formatting preferences set. This is anything which can be viewed in a diagram and 
printed. When you open the Formatting Preferences, all available elements are listed. 

Font and Color  
Options 

Once you select an object in the List Pane, you can change the following settings: font 
type, font size, font style, and font color. You can also change an element’s fill color and 
line color. 

Horizontal Alignment You can set the justification style for text in a selected element. 

Vertical Alignment You can set the top to bottom alignment of text in a selected element. 

Rendering You can set the appearance of a selected element using the shadowed and gradient 
settings. 

Display Options The Show Name on Creation option displays an element’s name when that element is 
placed on a diagram. 

Note: This only applies to newly created elements on a diagram. Existing elements are 
not updated when you click the Apply to Diagram button. 

Line Display Options Depending on the element you are formatting, you can change the following: line 
width, source decorator, source decorator size, line style, target decorator, and target 
decorator size. 

Each dialog offers action buttons. The table below describes each button: 

Button Description 

Apply to Diagram Applies the changes immediately to elements in an open diagram. 

Note: The Apply to Diagram function does not apply to the Display Options command for 
existing elements in a diagram. 

Restore Defaults Restores formatting of the element to the application defaults. 

Apply Applies your specifications without closing the dialog box. 

OK Applies your specifications, and then closes the dialog box. 

Cancel Closes the Preferences dialog and cancels all changes made in the Formatting dialog, 
unless something has been applied earlier. 

Business Process Modeling formatting 

This is where you can set global preferences for Business Process Modeling Notation (BPMN) 
elements. You can set  Font and Color Options, Horizontal Alignment, Vertical Alignment, 
Rendering,  Display Options, and  Line Display Options. The availability of the formatting elements 
depends on the element you select. 
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Font and color options 

You can change the font style, font size, and font colors. You can also change the fill and line 
colors of a selected element in the Font and Color portion of the Formatting dialog. 

Command Icon Description 

Front Style  Select a new font style from the drop- down list. 

Front Size  Select a new font size from the drop- down list. 

Bold 

 
 
 

Applies bold formatting to the label text. 

Italics 

 
 
 

Italicizes the label text. 

Underline 

 
 
 

Underlines the label text. 

Strikeout 

 
 
 

A line is drawn through the label text. 

You can also change the font color, element outline color, and element fill color. 

Command Icon Description 

Change Font 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the background of the element. 

Horizontal alignment 

You can change the justification setting for the text label in an element. 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 

 
 
 

Centers the text within the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 
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Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 

 
Command Icon Description 

Top 

 
 
 

Places the text in the top portion of the element. 

Center 

 
 
 

Centers the text within the element. 

Bottom 

 
 
 

Places the text in the bottom portion of the element. 

Rendering 

There are two commands available that affect the appearance of elements in the Diagram View: 

Command Description 

Shadowed When this option is selected the element has a slight shadowed background. The 
Shadowed option is the default setting. 

Gradient When this option is selected the element has gradient shading. If it is not selected 
the element is a solid color. The Gradient option is the default setting. 

Display o ptions 

The Show Name on Creation option displays an element’s name when that element is placed on a 
diagram. 

NOTE:  This only applies to newly created elements on a diagram. Existing elements are not 
updated when you click the Apply to Diagram button. 

Line display o ptions 

You can set the line display preferences for the Sequence Flow, Message Flow, and Association 
objects. Not all preferences are available for all objects. 

Command Description 

Line Width This preference sets the width of an interaction or relationship in a diagram. Select 
1 through 5 pixels from the drop-down list box. This preference is available for the 
Sequence Flow, Message Flow, and Association. 

Line Style Choose a line style from the drop-down list. You can select from one of five 
different styles from the drop down list. The list includes solid, dash, dot, dash-dot, 
and dash-dot-dot. 

Source Decorator Size You can set the size of the target decorator. This option is available for the 
Message Flow element. 

Target Decorator Size You can set the size of the target decorator. This option is available for the 
Sequence Flow, and Message Flow elements. 
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Conceptual Modeling formatting 

This is where you can set global preferences for conceptual Data Modeling elements. The 
following preferences can be set: Font and Color Options, Horizontal Alignment, Vertical 
Alignment, Rendering, Diagram Display Options, Shape, and Line Display Options. The availability 
of the formatting elements depends on the element you select. 

Font and color options 

You can change the font style, font size, and font colors. You can also change the fill and line 
colors of a selected element in the Fonts and Colors portion of the Formatting dialog. 

Command Icon Description 

Front Style  Select a new font style from the drop- down list. 

Front Size  Select a new font size from the drop- down list. 

Bold 

 
 
 

Applies bold formatting to the label text. 

Italics 

 
 
 

Italicizes the label text. 

Underline 

 
 
 

Underlines the label text. 

Strikeout 

 
 
 

A line is drawn through the label text. 

You can also change the font color, element outline color, and element fill color. 

Command Icon Description 

Change Font 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the background of the element. 

Horizontal alignment 

You can change the justification setting for the text label in an element. 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 

 
 
 

Centers the text in the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 
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Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 

Command Icon Description 

Top 

 
 
 

Places the text in the top portion of the element. 

Center 

 
 
 

Centers the text within the element. 

Bottom 

 
 
 

Places the text in the bottom portion of the element. 

Rendering 

There are two commands available that affect the appearance of elements in the Diagram View: 

Command Description 

Shadowed When this option is selected the element has a slight shadowed background. 
The Shadowed option is the default setting. 

Gradient When this option is selected the element has gradient shading. If it is not 
selected the element is a solid color. The Gradient option is the default setting. 

Diagram d isplay o ptions 

You can set the global preferences for the objects. Not all options are available for all objects. 

Command Description 

Show Name on Creation The Show Name on Creation option displays an element’s name when that 
element is placed on a diagram. Applies to all Conceptual Modeling 
elements. 

Show Unique Identifier You can show or hide the Unique Identifier indicator (#) on Business Attributes. 
For a Relationship, you can control whether or not to display the unique 
identifier source decorator by default. 

Show Expansion Control This preference can be set for the Business Entity and Subject Area only. Select 
this option to display the “+” or “-” indicator in the element. This option is not 
selected by default. 

Show Business Attributes Displays the Business Attributes in a Business Entity element. This preference 
applies only to the Business Entity element. 

Align Attributes to Top As you add attributes they are stacked at the top of the Business Entity. If this 
preference is not selected, attributes are added from the bottom up. This 
preference applies only to the Business Entity element 

Show Optionality If an Optionality type is set for a Business Attribute, you can set the 
preference to always show the indicator This preference applies only to the 
Business Entity element. 

NOTE:  This only applies to newly created elements on a diagram. Existing elements are not 
updated when you click the Apply to Diagram button.
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Shape 

You can change the shape for a Subject Area element. 

Command Description 

Oval Element appears as an elongated circle in the Diagram View. 

Rectangle Element appears as a rectangle in the Diagram View. 

Line display o ptions 

You can set the line display preferences for the Business Entity, Subject Area, Interaction and 
Relationship objects. 

Command Description 

Line Width This preference sets the width of a border on an element, or an interaction or 
relationship in a diagram. Select 1 through 5 pixels from the drop- down list 
box. 

Line Style This preference sets the line style of an interaction or relationship in a diagram. 
You can select from one of five different styles from the drop down list. The list 
includes solid, dash, dot, dash-dot, and dash-dot-dot. 

Source Decorator Set the preference for the beginning or source of an interaction or relationship 
connection in a diagram. Your five options are None, Arrow, Diamond, Crows 
Feet, Triangle, or Hollow Circle. 

Target decorator Set the preference for the end or target of an interaction connection in a 
diagram. Your five options are None, Arrow, Diamond, Crows Feet, Triangle, 
or Hollow circle. 

Target Decorator Size You can set the size of the target decorator for the Interaction element. 

External Data Objects formatting 

This is where you can set global preferences for External Data Object elements. For all External 
Data Objects you can set  Font and Color Options, Horizontal Alignment,  Vertical Alignment, 
and Display Options. The availability of the formatting elements depends on the element you 
select. 

Font and color options 

You can change the font style, font size, and font colors. You can also change the fill and line 
colors of a selected element in the Fonts and Colors portion of the Formatting dialog. 

Command Icon Description 

Front Style  Select a new font style from the drop- down list. 

Front Size  Select a new font size from the drop- down list. 

Bold 

 
 
 

Applies bold formatting to the label text. 
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Command Icon Description 

Italics 

 
 
 

Italicizes the label text. 

Underline 

 
 
 

Underlines the label text. 

Strikeout 

 
 
 

A line is drawn through the label text. 

You can also change the font color, element outline color, and element fill color. 

Command Icon Description 

Change Font 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the background of the element. 

Horizontal alignment 

You can change the justification setting for the text label in an element. 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 

 
 
 

Centers the text in the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 

Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 

Command Icon Description 

Top 

 
 
 

Places the text in the top portion of the element. 

Center 

 
 
 

Centers the text within the element. 

Bottom 

 
 
 

Places the text in the bottom portion of the element. 
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Display o ptions 

The Show Name on Creation option displays an element’s name when that element is placed on a 
diagram. 

NOTE:  This only applies to newly created elements on a diagram. Existing elements are not 
updated when you click the Apply to Diagram button. 

Reference Objects formatting 

This is where you can set global preferences for Reference Object elements. For all Reference 
Objects you can set Font and Color Options, Horizontal Alignment, Vertical Alignment, and 
Diagram Display Options. You can also set Line Display Options for the Link and Usage Reference 
Objects. The availability of the formatting elements depends on the element you select. 

NOTE:  Since Domains are not visualized on a diagram, you cannot set formatting preferences 
for them. 

Font and color options 

You can change the font style, font size, and font colors. You can also change the fill and line 
colors of a selected element in the Fonts and Colors portion of the Formatting dialog. 

Command Icon Description 

Front Style  Select a new font style from the drop- down list. 

Front Size  Select a new font size from the drop- down list. 

Bold 

 
 
 

Applies bold formatting to the label text. 

Italics 

 
 
 

Italicizes the label text. 

Underline 

 
 
 

Underlines the label text. 

Strikeout 

 
 
 

A line is drawn through the label text. 

You can also change the font color, element outline color, and element fill color. 

Command Icon Description 

Change Font 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the background of the element. 
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Horizontal alignment 

You can change the justification setting for the text label in an element. 
 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 

 
 
 

Centers the text in the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 

Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 

Command Icon Description 

Top 

 
 
 

Places the text in the top portion of the element. 

Center 

 
 
 

Centers the text within the element. 

Bottom 

 
 
 

Places the text in the bottom portion of the element. 

Diagram d isplay o ptions 

You can set preferences for what you want displayed on creation of a reference object. 

Command Description 

Show Name on 
Creation 

Displays an element’s name when that element is placed on a diagram. This 
preference is available for all reference objects. 

Show Usage on 
Creation 

Displays the Usage settings when a usage is created on the diagram (C=Create, 
R=Read, U=Update, and D=Delete). This preference is available only for the Usage 
reference object. 

NOTE:  These only apply to newly created elements on a diagram. Existing elements are 
not updated when you click the Apply to Diagram button. 

Line display o ptions 

You can set preferences for the Link and Usage Reference objects. 

Command Description 

Line Width This preference sets the width of an interaction or relationship in a diagram. 
Select 1 through 5 pixels from the drop-down list box. This is the only line 
display option you can set for a Link. 

Line Style This preference sets the line style of an interaction or relationship in a diagram. 
You can select from one of five different styles from the drop down list. The list 
includes solid, dash, dot, dash-dot, and dash-dot-dot. This applies only to a 
Usage. 
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Command Description 

Source Decorator Set the preference for the beginning or source of an interaction or relationship 
connection in a diagram. Your five options are None, Arrow, Diamond, Crows 
Feet, Triangle, or Hollow Circle. This applies only to a Usage. 

Target decorator Set the preference for the end or target of an interaction connection in a 
diagram. Your five options are None, Arrow, Diamond, Crows Feet, Triangle, 
or Hollow circle. This applies only to a Usage. 

Shapes formatting 

This is where you can set global preferences for drawing shapes. For all Shapes you can set Font 
and Color Options, Horizontal Alignment, Vertical Alignment, Rendering, Display Options and 
Line Display Options. The availability of the formatting elements depends on the element you 
select. 

Font and color options 

You can change the fonts, font size, font colors, and the fill and line colors of a selected element 
in the Colors and Fonts portion of the Formatting dialog. 

To change the font, select a font from the drop-down menu in the Font text box. You can also 
change the font size by selecting a size from the drop-down menu in the size text box. You can 
edit the font settings of all element labels. The following commands are available: 

Command Icon Description 

Front Style  Select a new font style from the drop- down list. 

Front Size  Select a new font size from the drop- down list. 

Bold 

 
 
 

Applies bold formatting to the label text. 

Italics 

 
 
 

Italicizes the label text. 

Underline 

 
 
 

Underlines the label text. 

Strikeout 

 
 
 

A line is drawn through the label text. 

You can also change the font color, element outline color, and element fill color with the 
following. 

Command Icon Description 

Change Font 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select an existing color or create a custom 
color for the background of the element. 
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Horizontal alignment 

You can change the justification settings for the text label in an element. 

NOTE:  These commands do not justify the text labels on elements that use text boxes outside 
the element. 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 

 
 
 

Centers the text in the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 

Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 

Command Icon Description 

Top 

 
 
 

Places the text in the top portion of the element. 

Center 

 
 
 

Centers the text within the element. 

Bottom 

 
 
 

Places the text in the bottom portion of the element. 

Rendering 

There are two commands available that affect the appearance of elements in the Diagram View: 

Command Description 

Shadowed When this option is selected the element has a slight shadowed background. The 
Shadowed option is the default setting. 

Gradient When this option is selected the element has gradient shading. If it is not selected 
the element is a solid color. The Gradient option is the default setting. 

Transparent The shapes have a transparent background when this preference is selected. 

Transparent Line This preference refers to the border of the text box. When placed in a pool, you 
can set the preference so the border does not show. 
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Display o ptions 

The Show Name on Creation option displays an element’s name when that element is placed on a 
diagram. 

NOTE:  This only applies to newly created elements on a diagram. Existing elements are not 
updated when you click the Apply to Diagram button. 

Line display o ptions 

You can set the line display preferences for the Line object. 

Command Description 

Line Width This preference sets the width of an interaction or relationship in a diagram. Select 
1 through 5 pixels from the drop-down list box. 

Line Style This preference sets the line style of an interaction or relationship in a diagram. You 
can select from one of five different styles from the drop down list. The list includes 
solid, dash, dot, dash-dot, and dash-dot-dot. 

Source Decorator Set the preference for the beginning or source of an interaction or relationship 
connection in a diagram. Your five options are None, Arrow, Diamond, Crows 
Feet, or Triangle. 

Target decorator Set the preference for the end or target of an interaction or relationship 
connection in a diagram. Your five options are None, Arrow, Diamond, Crows 
Feet, or Triangle. 

Import/Export 
You can set the default locations for importing workspaces and exporting workspaces, diagrams, 
and grid editors. Click Browse to open the Browse for Folder dialog. 

Preference Description 

Default Export Location Select the location where you want the exported files placed. The default location 
that appears in the Browse for Folder dialog is the My Documents folder. 

Default Import Location Select the location where the imported files reside. The default location that appears 
in the Browse for Folder dialog is the My Documents folder. 

You can also set the following preferences: 

• Comma Separated Values Preferences 

• ER/Studio Data Architect Preferences 

• Impact Analysis Preferences 

• Usage(CRUD) Preferences 

• Visio Preferences 
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Comma Separated Values p references 

You can set import options when you are importing comma Separated Value files. 

Preference Description 

Default Import Location Select the location where the imported files reside. The default location that 
appears in the Browse for Folder dialog is the My Documents folder. 

ER/Studio Data Architect preferences 

You can set export options when you are importing from and exporting to ER/Studio: 

Preference Description 

Export Options 

Default export location Select the location where you want the exported model placed. The default 
location that appears in the Browse for Folder dialog is the My Documents 
folder. 

Installed version of ER/ 
Studio Data Architect 

You have three options: None, 7.0, and 7.1, 7.5. Choose 7.5 for versions 7.5 and 
later ER/Studio 7.0 does not support an XML data type. If this option is 
selected and the exported file contains a business attribute with an XML data 
type, it will be exported as VARCHAR. 
ER/Studio 7.1 supports XML data type and will be exported intact. 

Automatically Open 
Generated Models in ER/ 
Studio Data Architect 

Select this option if you want ER/Studio Data Architect to open automatically 
after the export of a Conceptual Model. When this option is selected, the 
option in the Export to ER/Studio Data Architect dialog is also selected. 

Import Options 

Default Import Location Select the location where the ER/Studio Data Architect models reside. The 
default location that appears in the Browse for Folder dialog is the My 
Documents folder. 

Import Domains as Select the type of element you want domains imported as. Your choices are: 
Business Elements, Domains, and Business Elements Referencing Domains. 

Impact Analysis p references 

You can set import options when you are importing Impact Analysis report files. 

Preference Description 

Default Import Location Select the location where the imported files reside. The default location that 
appears in the Browse for Folder dialog is the My Documents folder. 

Usage (CRUD) preferences 

You can set import options when you are importing Usage (CRUD) report files. 

Preference Description 

Default Import Location Select the location where the imported files reside. The default location that 
appears in the Browse for Folder dialog is the My Documents folder. 
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Visio p references 

You can set import options when you are importing from Microsoft Office Visio®. 

Preference Description 

Automatically Save Main 
Object Type Mapping 

The Instance-level mappings are not saved as part of the custom mapping 
file. You have two options: 

Prompt: The “Unable to Save Instance-Level Mappings” dialog always appears 
when you click Save, giving you the option to save or reject the current object type 
mappings. 

Always: The current object type mappings are automatically saved without any 
warning. 

Default Import Location Select the location where the imported Visio files reside. The default location that 
appears in the Browse for Folder dialog is the My Documents folder. 

Default Custom Mapping 
File Location 

Select the location where you want to save your custom mapping settings 
when importing Visio models. 

Retain Visio object sizes 
when creating 
presentation elements 

Select this option to ensure that if a presentation element is resized in Visio, that 
resizing is carried over to ER/Studio BA. 

License Manager 
You can set preferences for what licensing information you want logged. 

Preference Description 

File Location Set the file location of the License Manager log. You can change the location 
by clicking Browse to go to the Open dialog. 

Mag Log Size (bytes) The default log size is 1048576. 

Log Options You can select to display the following message types: Error, Information, and 
Debug. The options you select determine what messages appear in the Error 
Logging View. 

Messages 
The Messages Preference settings display the default location of the application log file and what 
type of error logging messages are displayed. 

Preference Description 

Log File Location Displays the location of the log file. This location cannot be edited. 

Error Logging Options You can select to display the following message types: Debug, Error, Fatal, 
Information, Trace, and Warning. The options you select determine what 
messages appear in the Error Logging View. 
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Model view 
There are two different preferences you can set for the Model View: 

Preference Description 

Automatically Expand 
when Clicking Expand All 
Button 

If you have large models and click the Expand All icon in the Model View, you will 
get a dialog warning you that this action may take an extended length of time. 

Prompt: The warning dialog will always appear. 

Always: The Expand All action happens without the warning dialog. 

Display Tooltips When “On” is selected, a descriptive text box appears when the cursor is placed 
on an icon or node in the Model View tree. 

Group Objects by Type Objects within a model are displayed in the tree grouped by type (for example, a 
Task node will contain all of the tasks within the model). 

Select presentation nodes 
when using the Find In 
Model View Feature 

If this preference is set, both the presentation element node (designated by a 

small arrow placed on the element ) as well as the element node are 
highlighted in the Model View tree. 

Naming 
Select this option if you want to include the source and target in the relationship names. 

If you select this option the relationship names are displayed as follows in the Model View tree 
and diagram: 

 
If this option is not selected, the target/source relationship names are displayed as follows in the 
Model View tree and diagram: 
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Property views 
You can set a preference for opening Property Views for each created object. When this 
preference is selected, each time you create an object, either in the Model View or from the 
palette, the associated Property View is opened as well. 

NOTE:  You can close all Property Views by selecting File > Close > All Property Views from 
the main menu or the Close All menu on the Property View toolbar. 

Preference Description 

Open Property View 
on object creation 

If you select this option, whenever you place a new object on the diagram window the 
property view pane displays so you can enter property values for the new object. 

Reporting 
You have two options for the Web Report: 

Preference Description 

Launch report upon 
completion 

If you select this option, once you select the command to generate reports on all diagrams 
in an opened workspace, a web browser is launched showing the report. 

Default report 
location 

Click Browse to select the folder where you want your Web Reports stored. You can also 
create a new folder in the Browse For Folder dialog. 

Repository options 
You have three options for the Repository: 

Preferences Description 

Server Machine Specify the URL or hostname of ER/Studio Repository. 

Server Port Specify the port ER/Studio BA uses to communicate with the repository server. The 
default is 54333. 

Check out model 
when checking out 
diagram 

Choose what action, if any, you want the system to perform with respect to the models in a 
diagram, when a diagram is checked out; always check out the models, never check out 
the models, or prompt the user to decide what to do each time a diagram is checked out. 

Workspaces/Models 
The table below describes the preferences available for the Workspaces/Models node: 

Detail Description 

Workspace Options 

Default workspace directory Click the browse button to open the Browse For Folder dialog. You can change the 
existing default directory or create a new folder to be the default directory. 

Entries in recently used 
workspace list 

Set the number of previous workspaces you want to appear in the File > History 
menu. The default setting is 4. 

Prompt for workspace when 
starting application 

If this option is selected, the Welcome dialog opens when you first start the 
application. It allows you to create a new workspace, open the last used 
workspace, import a compressed-format workspace, or open an existing workspace. 
If it is not selected, ER/Studio BA opens to the last used workspace. 

Model Options 

Default Model Type When you create a model, the default model type can be set so the preferred 
type always appears in the Model Type list box. 
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Using ER/Studio Business Architect 
The ER/Studio BA workflow enforces a hierarchical approach to help you manage large design 
projects. To use the application effectively, it is important that you understand the product’s 
scope and the relationship between Workspaces, Projects, Models, Diagrams, and Diagram 
Elements (objects) before using the product. This section of Help gives you information on how 
to use the ER/Studio BA features listed below: 

• Workspaces and Projects 

• Using Models 

• Processes - Business Process Modeling 

• Diagrams and Elements 

• Reference Objects 

• External Data Objects 

• Drawing Shapes 

Workspaces and projects 
A workspace is a unit of storage used for any collection of data modeling projects, reference 
objects, and data source projects. In ER/Studio BA you can only open and work with one 
workspace at a time, but you can collect any number of projects in a single workspace. 

A project is used to create a collection of user-created data models or subprojects. Data sources 
and reference objects also exist as their own projects within the workspace. A Project is a 
collection of items including models, diagrams, model elements, documents, business rules, etc. 
For example, a “Human Resources” project might contain a business process model describing 
the main functions of the Human Resources department, and a data model describing the data 
structures used by these processes, and business rules describing prescribed behavior of the 
organization. You can also create nested projects where a project is a parent of another project. 
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The graphic below shows both a Business Process Modeling workspace and project in the Model 
View tree. 

 

Using workspaces 
In the Model View tree, your workspace occupies the root node under which all projects and their 
associated elements appear in a hierarchical format. On creation, you can specify the name and 
location of your workspace and save it as an *.exw file. 

It is easy to create a workspace from the Welcome page that opens when you first start the 
application. Once you create a workspace you can insert a  project or a  model. You can then save, 
open, close, rename, and delete it. You can also open a workspace in read-only mode. You can 
open the Property View for the workspace. 

Using the Workspace d ialog 

When you first start ER/Studio BA the splash screen opens followed by the Welcome to ER/ 
Studio Business Architect dialog. You have four options available: 

Option Description 

Create a new workspace (with optional 
project, model, and diagram) 

Opens the New Workspace dialog where you create a new 
workspace, project, model, and diagram. For more information, see 
Creating a New Workspace. 

Express create You can quickly create a workspace, project, model, and diagram. 
Select the type of model and enter a name, which is used for the 
workspace, project, model and diagram that are created. For more 
information, see  Using Express Create. 
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Option Description 

Import a compressed workspace You can import and open an existing workspace that you have 
exported and stored as a compressed file. For more information, see 
Importing a Compressed Workspace. 

Open My Last Used Workspace Opens the last workspace you worked on. This is the default setting if 
a previous workspace exists. 

Open an Existing Workspace Click Browse to open the Browse for a workspace file dialog. The 
default path is x:/My Documents/ EStudioBusinessArchitect/ 

Get a workspace from the Repository When selected and OK has been clicked, the ER/ Studio Repository 
log in dialog appears where you can log in and then copy a 
workspace from the ER/ Studio Repository to your local desktop. 

Always use last workspace on startup If you select this option, each time you open ER/ Studio BA, the 
last workspace you worked on automatically opens. 
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Creating a new workspace 

You can create a Workspace, and if desired, a Project, a Model, and a Diagram as well using the 
Create a New Workspace dialog. The file extension of a workspace is .exw. 

1. On the File menu, select New > Workspace. The New Workspace dialog opens. 

NOTE: When creating a new workspace, if an existing workspace is open, you get a Save 
Workspace dialog asking if you want to save the current workspace. Click Yes 
and it is closed. When the previous workspace is closed, all projects, models, and 
diagrams associated with the workspace are also saved and closed. 

2. Enter the workspace name in the first text box. 

The default path for workspaces is ...\My Documents\IDERA\ERStudioDataArchitect. 
You can click the drop-down arrow in this text box to display a list of last used locations. 

3. If you want to change the path, click Browse to open the Browse For Folder dialog and 
select another folder. 

NOTE:  You can also create a new folder by clicking Make New Folder. 

4. If you want to create an associated project at this time, click Create a project within this 
workspace.  You can now enter the name of that project in the Project Name text box. 

Next, you can create a model and associate it with either the project or the workspace. A 
model is a specific collection of elements related to a modeling notation such as Business 
Process Modeling Notation or Conceptual Modeling. 

5. Click Create a model within this... and then select either Project or Workspace from the 
drop-down list. 

6. Enter the name of your model in the Model Name text box. 

7. Select either Business Process or Conceptual from the Model type drop-down list. 

8. If you are creating a Business Process model, you can select On in the Validate against 
BPMN specification box, to enable the validation option. 

The validation checks compliance to the Business Process Modeling Notation 
specifications. For example, if validation is enabled and you draw a message flow from a 
start event to a task, you get a dialog stating that this is an invalid relationship. If validation 
is set to Off, it is drawn without notification. 

NOTE:  When you select On the following icon is displayed  next to the model node 
in the tree. If you select Off, a different icon       is displayed. 

9. To create a diagram associated with the model click Create a diagram within this model 
and enter the name of your diagram in the Diagram Name text box. 

NOTE:  If you are creating a Business Process model, notice that the diagram name, the 
Name of pool with invisible boundary and First lane name text boxes are 
populated with the same name as the Model name. You can then rename the 
diagram, the pool, and the lane if desired. If you are creating a Conceptual 
model, these fields are not available. 

In the Business Process Modeling Notation Specification, all business process diagrams 
must contain at least one pool and each pool is a container for one process. In ER/Studio 
BA, when you create a diagram, a pool and lane with an invisible boundary are 
automatically created. 

10. Click OK. ER/Studio BA creates the workspace (with the file extension of .exw), project, 
model, and diagram and adds them to the Model View tree. 
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Related Topics: 

• Creating a Project 

• Upgrading Workspaces 

Upgrading w orkspaces 

If you have upgraded ER/Studio BA to a newer version your workspace must be upgraded before 
it can be used. The first time you open an existing workspace, or if you are importing a 
compressed workspace, the Workspace Upgrade dialog opens. This process updates the version 
number in the workspace, project(s), model(s), and data source files. It also updates business 
attribute optionality and connection label justification. 

CAUTION: When upgrading workspaces that have elements created by importing an ER/ 
Studio model, if the ER/Studio model is imported again in version 1.6, new 
elements are added instead of updating the existing ones. 

1. Click Details to view a list of what the upgrade process includes. The upgrades include the 
following: 

o Business Process Modeling process information 

o Shape transparency 

o Mandatory Property of conceptual modeling relationships 

o Unique identifier options for conceptual model business attributes 

o Bound element properties for conceptual model business attributes 

o Enforcement options for business elements. 

2. The hierarchy that appears in the list box includes the workspace and all projects and 
models. It also includes any reference and external data objects. Clear the check box of any 
items you want excluded from the upgrade. 

NOTE:  Excluded items are removed from the workspace and are automatically 
upgraded if they are inserted back into the workspace. 

3. You have the option to back up your workspace before performing the upgrade. Browse to 
the location where you want to store your backup. The workspace name is appended with 
“backup” and has a file extension of .exz. 

NOTE:  If the upgrade fails you can import the backup file. 

4. Click OK and a progress dialog opens telling you the workspace is being upgraded. A 
dialog opens telling you that the upgrade was successful. 

5. Click Details and a list of all upgraded files open. You can print or save these details. 

6. Click OK to close this dialog and the upgraded workspace opens in ER/Studio BA. 

CAUTION:  Workspaces created in ER/Studio BA’s beta versions are not upgraded. 

Updating b usiness e lements and business a ttributes 

The upgrade processes business attributes first and then business elements, based on rules 
below. 

• For business elements, if the enforce/propagate properties are cleared in the 1.0/1.1 
version, the enforcement options should be cleared after upgrade. If the enforce/propagate 
properties are selected in the 1.0/1.1 version, the enforcement options should be selected 
after upgrade. 
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• For business attributes: 

o If the “enforce name” property is selected on the original business element, a 
comparison will be done on each business attribute bound to the business element. If 
the attribute name matches the business element name, the override property is not 
set. If the names don’t match, the override property is set. 

o If the “propagate data type” property is selected on the original business element, a 
comparison will be done on each business attribute bound to the business element. If 
the data type matches the business element data type, the override property is not 
set. If the data types don’t match, the override property is set. 

o If the “propagate description” property is selected on the original business element, 
a comparison will be done on each business attribute bound to the business element. 
If the attribute description matches the business element description, the override 
property is not set. If the descriptions don’t match, the override property is set. 

o If the “propagate notes” property is selected on the original business element, a 
comparison will be done on each business attribute bound to the business element. If 
the attribute’s notes match the business element’s notes, the override property is not 
set. If the notes don’t match, the override property is set. 

Exporting a workspace 

You can export your workspaces in a compressed format. You can then import that compressed 
workspace into another ER/Studio BA application on another computer. The file extension for 
this compressed file is .exz. 

1. Open the workspace you want to export in the Model View tree. 

2. Select File > Export > Workspace from the main menu and the Export dialog opens. 
OR 
Right-click the workspace node in the Model View tree and select  Export.... 

NOTE:  If your workspace has been modified and has not been saved, you will get a 
warning dialog asking you to save it. 

3. Select the location where you want to save the compressed file and enter a new file name if 
desired. 

NOTE:  You will get a warning if the compressed files already exist in that location. 

4. Click Save and the file is saved to your chosen location. The workspace name is appended 
with “_backup” and has a file extension of .exz. 

Importing a compressed w orkspace 

You can import and open a compressed workspace in ER/Studio BA. 

1. In the Welcome to ER/Studio BA dialog (which is available when you first start the 
application), select Import a Compressed Workspace. 
OR 
From the main menu select File > Import > Workspace....  The Import a Compressed 
Workspace dialog opens. 

2. Enter or browse to the location where you stored your compressed workspace. 

NOTE:  The file extension for the compressed workspace is .exz.
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3. Enter or browse to the location where you want to extract the selected workspace. 

CAUTION: You will get a warning in the dialog if you attempt to extract a compressed 
workspace file to a folder that already contains one or more files included in the compressed 
file. 

4. Click OK and compressed workspace is opened in the Model View tree. 

NOTE:  If you are importing a workspace into a newer version of ER/Studio BA, a 
Workspace Upgrade dialog opens. 

Using Express Create 

When you first open ER/Studio BA a Welcome to ER/Studio Business Architect dialog opens. 
Instead of using the Create a New Workspace option, you can use the Express Create which 
streamlines the creation process by creating a workspace, project, model, and diagram all named 
the same. 

NOTE:  The Express Create option is only available in the Welcome to ER/Studio Business 
Architect dialog. 

1. Select the Express Create option in the Welcome dialog. 

2. Select the Type from the drop-down list box. Your choices are Business Process and 
Conceptual. 

3. Enter the name you want to use for your new workspace, project, model, and diagram. 

4. When you click OK the created workspace, project, model and diagram appear in the Model 
View tree. The diagram is also opened in the Diagram View as a tabbed view. The palette 
associated with the model (i.e., either Business Process or Conceptual) is available in the 
Palette view. 

Saving a workspace 

A workspace is saved under the following conditions: 

• When a workspace is created, it is automatically saved. 

• When you close a workspace or exit the application, you are prompted to save your current 
workspace. 

• When you open an existing workspace or create a new workspace, if another workspace is 
open, you are prompted to save that workspace. 

When you make additions or changes in a workspace, you can save your workspace by: Clicking 

Save ( ) on the main toolbar. 

OR 

Right-clicking the workspace name in the Model View tree and selecting Save Workspace.  

OR 

From the main menu, select File > Save. 
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Opening a workspace 

Only one workspace can be opened at a time in the Model View tree. 

1. Choose File > Open Workspace.  

2. Press Ctrl +O. 

3. Right-click in the Model View and select Open Workspace. The Open dialog appears 
listing all available workspaces in the default location. 

4. Expand the Workspace folder you want to open and double-click the file with the extension 
.exw. This is the file extension for all workspaces. 

NOTE:  If you have another workspace open, you are prompted to save the current 
workspace. 

When you click Yes, that workspace is saved and the newly selected workspace is opened in the 
Model View tree. 

Closing a workspace 

1. Choose File > Close>Workspace. 

2. Right-click the workspace node in the Model View and select Close. 

NOTE:  If you have made additions or changes to your workspace you are prompted to 
save your current workspace. Click Yes and the workspace and all the project, 
model, and diagram data is saved and closed. 

Renaming a workspace 

1. Right-click the workspace node in the Model View tree and select Rename Workspace. 

NOTE:  If your workspace is unsaved a Save Workspace dialog opens telling you that you 
must save your workspace before it can be renamed. 

2. In the Rename Workspace dialog, enter the new name in the text box and click OK. 

Deleting a workspace 

When you create a new workspace, a folder with the workspace name is created in your default 
location, for example ...My Documents\ERStudioBusinessArchitect\workspace name. 

To delete a workspace: 

1. Right-click the Workspace name in the Model View tree and select Delete. 

2. In the Confirm Workspace Delete dialog you have three choices. 

No, I do not want to delete the 
workspace. 

The delete action is canceled and no action is taken. 

Yes, and also delete the 
associated files under 
x:\.Documents and Settings\.... 

This option lists the entire path where the workspace files are 
stored. When you choose this option, the workspace is deleted 
from the Model View tree and the folder containing the 
workspace information is also deleted. 

Yes, but do not delete the associated 
files. 

The reference to the workspace in the Model View tree is 
removed but the workspace folder still remains in the directory. 

3. Select the option you want and click OK. 

NOTE:  If you select the third option, reopen the workspace by going to the location 
where the workspace is stored, for example ...My Documents\ 
ERStudioBusinessArchitect\workspace name, and double-click the name.
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Using read-only w orkspaces 

A workspace will be opened as read-only under the following conditions 

• Open the same workspace on the same computer 

• Open the same workspace on a network 

When you open a workspace that is already open, you will be informed that the workspace is in 
use but that it can be opened as read-only. You can then choose to open the workspace as read 
only or cancel the operation.. 

When you open workspace as read-only, the workspace name is shown in the title bar with a read-
only indicatory. You can view the models in the workspace, generate reports, but can’t make any 
changes to the workspace data or diagrams. All import mechanisms are also disabled. 

NOTE:  A temporary marker file is used to track the open status of a workspace 
(~MyWorkspace.etwtemp), created in the workspace’s folder on the file system. 

The following actions are NOT allowed in a read-only workspace: 

• Import of Visio, CSV, or ER/Studio 

• Deleting from menus, diagrams, model views, or property views 

• Create actions from menus, diagrams, model view, property views 

• Cut/copy and paste 

• Accessing Property Views 

• Diagram creation 

• Editing a Diagram (moves, deletes, editing, show/hide) 

• Dropping elements from toolbars or palettes 

• Drag/drop in model view within metadata or diagram nodes 

• No drag/drop from model view to diagram 

• Any save actions 

• Setting of properties from right-click menus 

The following actions are allowed in a read-only workspace: 

• Export 

• Generation of a new web report 

• Rename - Project, Model, Diagram, Independent Sub-process, Invisible Pool. 

• Insert Project/Model, Insert Model. 

• Creating Impact Analysis Diagram.
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Using projects 
A Project is a collection of items including models, documents, business rules, etc. For example, a 
“Human Resources” project might contain a business process model describing the main 
functions of the Human Resources department, and a data model describing the data structures 
used by these processes, and business rules describing prescribed behavior of the organization. 
The file extension of a project is .exp. You can: 

• Creating a Project 

• Inserting a Project 

• Reparenting a Project 

• Renaming a Project 

• Closing a Project 

• Saving a Project 

• Deleting a Project 

NOTE:  You can have multiple Projects open simultaneously. You can then easily switch back 
and forth between them. 

Right-click a Project in the Model View tree to gain access to additional functions: 

Command Icons Description 

Links 
 

 
 

This command opens the Create Link wizard which allows you to create links 
between elements. 

Usages 
 

 
 

This command opens the Create Usage wizard which allows you to create 
usage connections between elements. 

Impact Analysis 
 

 
 
 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the Impact Analysis Report. 

Refresh 
 

 
 

Updates the currently displayed information in the 
Model View with new data or changes. 

Properties 
 

 
 

Opens the Property View for the selected element. 

Creating a project 

When you create a workspace, you can create a new project at that time in the New Workspace 
dialog. But you can also create other new projects in that workspace to store your models and 
diagrams using the New Project dialog. 

1. On the File menu, select New > Project. 
OR 
In the Model View tree right-click the workspace and select New > Project. The New 
Project dialog opens. 

2. In the Project name box, type the name of the new project. 

3. You can enter a description of the new project in the Description text box. Press Enter to 
add a CRLF in the text box. 

NOTE:  If you press Ctrl+Enter the New Project dialog closes and the new project name 
appears in the Model View tree.
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4. You can then select where to create the project: in the existing workspace or nested in the 
existing project. 

5. Click OK. The project is created and the dialog box closes. 

NOTE:  The default storage directory for the new project is set when you create the 
workspace. 

Inserting a project 

If you have deleted a project or model but did not delete the associated files you can select this 
command to “restore” the deleted project or model. You can: 

• insert a model in a model 

• insert a model in a project 

• insert a project in a workspace 

• insert a data source project under External Data Objects node. 

The following actions are NOT allowed when inserting projects and models: 

• insert a project from another workspace 

• insert a project under a model 

• insert a reference object project under a workspace, project, or model 

• insert a data source project under a workspace, project, or model 

• insert a project or model under the External Data Objects node 

• insert a reference project under the External Data Objects node 

CAUTION: The undo/redo function is not available for the insert project command. 

To insert a project: 

1. Right-click the Workspace node in the Model View tree and select Insert Project/Model. 

2. In the Insert Project or Model dialog open the folder that is labeled with the project’s name 
that you want to restore. 

CAUTION: If you attempt to insert a project into another workspace you will get a 
warning dialog. A project can only be inserted into the workspace it was 
created in. 

3. Select the file labeled meta-model.exp, click Open and the selected project is placed in the 
Model View tree. 

Reparenting a project 

You can reparent a project within a workspace by dragging and dropping the project from one 
location to another. Basically you will be removing the project from the current workspace 
location and immediately reinserting the project into the workspace at another location. When 
you reparent the project, all associated files including models, diagrams, and elements are also 
reparented. 

CAUTION: It is recommended you  back up your workspace before doing a reparenting 
action. 
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The following rules apply to the reparenting action. If any of the error conditions listed below 
occurs, you will get a dialog warning you that the reparenting is not valid and will not be allowed. 

• Projects can be reparented to workspace. 

• A project will be allowed to be reparented to another project, but not to one of its own child 
projects. 

• A project will not be allowed to be reparented to the following: (1) Reference Object project; 
(2) External Data Object project; (3) a data source; or (4) a model. 

• A model will be allowed to be reparented to a project. 

• A model will be allowed to be reparented to a model of its same nature (i.e., Conceptual or 
Business Process) as long as it isn’t one of its own child models. 

• Models can be reparented to workspace. 

• You cannot reparent a Reference Object project or an External Data Object project. 

• A data source: 

o will be allowed to be reparented to another data source as long as it isn’t one of its 
own children. 

o will be allowed to be reparented to the External Data Objects project. 

o will not be allowed to be reparented to the Reference Object project. 

o will not be allowed to be reparented to a project or model. 

To Reparent a Project: 

1. In the Model View, select the project you want to reparent and drag it to its new location. 

NOTE:  When dragging the node, the destination node must be highlighted as illustrated 
in the following screen shot. 

 
NOTE:  If you have not saved your workspace you will get a warning dialog telling you that 

you must save the workspace and all associated diagrams must be closed. If you 
click Yes the workspace is saved, all associated diagrams are closed, and the 
project is reparented.
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2. Release the node and the project and all associated files are reparented to its new 
location. 

Renaming a project 

You can rename a project by using the Rename Project command. When you rename a project 
you are changing the name of the project and the associated project’s folder on the file system. 

In the Model View tree, select the project node you want to rename. 

1. Right-click the node and select Rename Project. 

2. Enter the new name in the text box and press Enter. The project’s name changes. 

Closing a project 

1. Right-click the project node in the Model View and select Close. 

NOTE:  If you have made additions or changes to your project you are prompted to 
save it. Click Yes and the project, model, and diagram data are saved and 
closed. 

Saving a project 

A project is saved under the following conditions: 

• When a project is created, it is automatically saved. 

• When you close a project, you are prompted to save it. 

When you make additions or changes to a model or diagram in a project, you can save your 
project by: 

1. Clicking Save ( ) on the main toolbar. 

2. Right-clicking the project name in the Model View tree and selecting Save Project.  

3. On the main menu, choose File > Save. 

Deleting a project 

1. Right-click the Project name in the Model View tree and select Delete. 

2. In the Confirm Project Delete dialog you have three choices: 

No, I do not want to delete the project. The delete action is canceled and no action is taken. 

Yes, and also delete the associated 
files under x:\.Documents and 
Settings\.... 

This option lists the entire path where the Project files are 
stored. When you choose this option, the project is deleted from 
the Model View tree and the folder containing the project 
information is also deleted. 

Yes, but do not delete the associated 
files. 

The reference to the project in the Model View tree is 
removed but the project folder still remains in the directory. 

3. Select the option you want and click OK. 

CAUTION: The undo/redo function is not available for the remove command, which 
is the third option in the Confirm Project Delete dialog. 
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Using models 
A model is a specific collection of elements/objects related to a modeling notation (BPMN, 
Conceptual, etc.). For example, the Human Resources BPMN model would contain those objects 
associated with the business processes of HR: tasks, swimlanes, gateways, etc. A model is where 
the object “lives”. i.e., objects are stored within a model, but can be visualized in other formats 
such as a visual diagram, grid editor, etc. In Business Process Modeling you can choose whether 
to create a model in “Validation” mode, which enforces the rules of the specified notation, or with 
validation off, which allows you to use the visual objects without being constrained by the rules of 
the notation. Nested models are allowed. The file extension of a model is .exm. 

When you create a workspace or project in ER/Studio BA you are given the opportunity to create a 
new model. You can have “nested” models with a model. These nested models can also contain 
diagrams as shown in the following graphic. 

 
Elements within a model can be displayed two different ways in the Model View tree: 

Command Description Example 

Grouping by Object  
Type 

When you click the Group by Object 
type icon ( ), elements are 
sorted by type, for example, a Task 
node contains all of the tasks within 
the model. Under each node the 
items are sorted alphabetically, 
unless there is a sequence 
associated with an object (lanes, for 
example).  
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Command Description Example 

Model View Hierarchy This is a hierarchal representation of all 
elements in a model, in a diagram 
node, and in the model node. 

 
 
 

Working with models 
You can create a new Model at the time you create a workspace or by using the menu command. 
Once you create it, you can do the following to a model: 

• Open/close 

• Save 

• Rename 

• Reparent 

• Insert 

• Delete 

Right-click a model node in the Model View tree to gain access to the following additional 
functions: 

Command Icon Description 

Links  
 
 

This command opens the Create Link wizard which allows you to create links 
between elements. 

Usages 
 

 
 
 

This command opens the Create Usage wizard which allows you to create 
usage connections between elements. 

Grid Editor 
 

 
 
 

This is a table-like editor which is an alternative to the Model View. Content in 
the Grid Editor can be printed or exported as a report. 

Impact Analysis 
 

 
 
 
 
 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically displays all the 
associated relationships and elements. 

You can also show the Impact Analysis Report. 
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Command Icon Description 

Refresh 
 

 
 

Updates the currently displayed information with new data or changes. 

Properties 
 

 
 

Opens the  Property View for the selected model. 

Creating a model using the Menu command 

1. On the File menu, select New > Model. 
OR 
In the Model View tree, right-click the workspace and select New > Model to open the 
New Model dialog. 

NOTE:  You can also create a new model by right-clicking the project node or the model 
node in the Model View tree. 

2. Enter the model name in the Model Name text box. 

3. In the Model Type drop-down list, select the type of model you want to create. You have the 
following options: 

Model Icon Model Type Description 

 
 
 
 
 
 

Conceptual Modeling Conceptual modeling is used by enterprise architects, 
business users, and data architects to model information 
about the business as it relates to data, data flow, process, or 
information assets. 

 
 
 
 

Business Process Modeling Uses the Business Process Modeling Notation (BPMN) 
specification to graphically express business processes. 

4. If you are creating a Business Process model, select On in the Validate against BPMN 
specification box to enable the validation option. If you are creating a Conceptual Model, 
this option is unavailable. 

The validation checks compliance to the Business Process Modeling Notation 
specifications. For example, if validation is enabled and you draw a message flow from a 
start event to a task, you get a dialog stating that this is an invalid relationship. If validation 
is off, it is drawn without notification. When you select On, the following icon is displayed 

  next to the model node in the tree. If you select Off, a different icon  is displayed. 

NOTE:  The default preference for validation can be set. When creating a new model, the 
New Model Wizard displays the preference set, which you can change. 

5. You can enter a description of the new model in the Description text box. Press Enter to add 
a CRLF in the text box. 

NOTE:  If you press Ctrl+Enter the New Model dialog closes and the new model name 
appears in the Model View tree. 

6. Select where to create the model: either in the workspace, or in a project. You can also nest 
a model within a model. 

NOTE:  The default storage directory for the new model is set when you create the 
workspace.
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7. To create a diagram associated with the model click Create a diagram within this model 
and enter the name of your diagram in the Diagram Name text box. 

NOTE:  If you are creating a Business Process model, notice that as you enter the diagram 
name, the Name of pool with invisible boundary and First lane name text boxes are 
populated with the same name. You can then rename both the pool and the lane 
if desired. If you are creating a Conceptual model, these fields are not available. 

In the Business Process Modeling Notation Specification, all business process diagrams 
must contain at least one pool and each pool is a container for one process. In ER/Studio 
BA, when you create a diagram, a pool and lane with an invisible boundary are automatically 
created. 

8. Click OK. The new model is created and placed in the location you selected. 

Saving a model 

A model is saved under the following conditions: 

• When a model is created, it is automatically saved. 

When you make additions or changes in a model, you can save your model by:  

• Clicking Save ( ) on the main toolbar. 

OR 

• Right-clicking the model name in the Model View tree and selecting Save Model. 

Renaming a model 

You can rename a model in the Model View tree. 

1. In the Model View tree, right-click the model node you want to rename and select Rename 
Model. 

2. In the Rename Model dialog enter the new name in the text box and click OK. The model is 
renamed in the Model View tree and in the file folder. 

Reparenting a model 

You can reparent a model within a workspace by dragging and dropping the model from one 
location to another. Basically you will be removing the model from the current workspace location 
and immediately reinserting the model into the workspace at another location. When you 
reparent the model, all associated files including diagrams and elements are also reparented. 

CAUTION: It is recommended you  back up your workspace before doing a reparenting 
action. 

The following rules apply to the reparenting action. If any of the error conditions listed below 
occurs, you will get a dialog warning you that the reparenting is not valid and will not be allowed. 
Note that these rules apply to both projects and models. 

• Projects can be reparented to workspace. 

• A project will be allowed to be reparented to another project, but not to one of its own child 
projects. 

• A project will not be allowed to be reparented to the following: (1) Reference Object project; 
(2) External Data Object project; (3) a data source; or (4) a model.
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• A model will be allowed to be reparented to a project. 

• A model will be allowed to be reparented to a model of its same nature (i.e., Conceptual or 
Business Process) as long as it isn’t one of its own child models. 

• Models can be reparented to workspace. 

• You cannot reparent a Reference Object project or an External Data Object project. 

• A data source: 

o will be allowed to be reparented to another data source as long as it isn’t one of its 
own children. 

o will be allowed to be reparented to the External Data Objects project. 

o will not be allowed to be reparented to the Reference Object project. 

o will not be allowed to be reparented to a project or model. 

To Reparent a Model: 

1. In the Model View, select the model you want to reparent and drag it to its new location. 

NOTE:  When dragging the node, the destination node must be highlighted as 
illustrated in the following screen shot. 

 
NOTE:  If you have not saved your workspace you will get a warning dialog telling you 

that you must save the workspace and all associated diagrams must be closed. If 
you click Yes the workspace is saved, all associated diagrams are closed, and 
the model is reparented. 

2. Release the node and the model and all associated files are reparented to its new location. 

Deleting a model 

When you delete a model, you are presented with three different options in the Confirm Model 
Delete dialog. 

1. In the Model View tree, right-click the model node you want to delete and select Delete. 

2. In the Confirm Model Delete dialog you have three choices: 
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No, I do not want to delete the model. The delete action is canceled and no action is taken. 

Yes, and also delete the associated files under 
x:\.Documents and Settings\.... 

This option lists the entire path where the model files are stored. 
When you choose this option, the model is deleted from the Model 
View tree and the folder containing the model information is also 
deleted. 

Yes, but do not delete the associated files. The reference to the model in the Model View tree is removed but the 
model folder still remains in the directory. 

3. Select the option you want and click OK. 

Opening and closing a model 

When you first open a workspace the model is closed. You can open the model and all 
associated diagrams and elements: 

1. Right-click the model in the Model View tree. 

2. Click Open. The Model View tree expands displaying all associated diagrams and diagram 
elements. 

NOTE:  You can also open the model by clicking the plus icon ( ) next to the model 
node. 

You can close the model as well. This action collapses the model node in the Model View 
tree. 

3. Right-click the model in the Model View tree. 

4. Click Close. The Model node of the Model View tree collapses hiding all associated 
diagrams and diagram elements. 

Inserting a model 

If you have deleted a model but did not delete the associated files, you can select this command 
to “restore” the deleted model. 

1. Right-click the Model node in the Model View tree and select Insert Project/Model. 

2. In the Insert Model dialog open the folder that is labeled with the model’s name that you 
want to restore. 

3. Select the file labeled meta-model.edsp, click Open and the selected model is placed in 
the Model View tree. 

Processes – Business Process modeling 
When working in ER/Studio BA, you have two different types of models, Conceptual and Business 
Process. When working with Business Process models, you work with Processes. This section 
discusses how processes are used when working with Business Process models. 

A Process is a collection of flow objects connected by flows that is executed in a sequence 
(usually depicted on a diagram). In ER/Studio BA, all processes are contained by a pool. A pool 
contains only one process, but you can have multiple pools in a diagram which can then 
collaborate via messages. 

You can set a preference to display elements in a diagram or pool under the Process node ( ) 
in the Model View. If this option is not selected, all elements are displayed under the Pool node.
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In the Business Process Modeling Notation Specification, all Business Process Diagrams must 
contain at least one pool. In ER/Studio BA, when you  Diagram, a pool and lane with an invisible 
boundary are created as well. In ER/Studio BA, when you place an object in the diagram, that 
object is automatically placed in the pool. 

Initially when you create the diagram, the pool and lane are given a default name. You can 
rename both the created pool and its associated lane. 

In the following example, the diagram contains a pool with an invisible boundary (named Order 
Picking Pool) and is indicated by the  icon in the Model View tree. The lane, named Order 
Picking Lane, is “owned” by the pool. The event is owned by the process, but since the process is 
hidden, it appears under the pool. 

 

• When you place an element, for example a Start Event, that start event is shown as a 
presentation element under the Diagram node (this is indicated by an arrow symbol placed 
on the icon     ). 

 

In the following example, the model contains one visible pool/lane and one invisible pool/lane. 
The Model View tree displays the elements under the pool. However, in the diagram node, the 
presentation elements are displayed under the lane node to show their location within the lanes 
depicted on the diagram. 
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• If you select the preference to show process in the application the elements in a pool are 
displayed under the Process node. 



Using ER/Studio Business Architect > Processes – Business process modeling 

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 171   

 

 

 

Diagrams and elements 
This section outlines how to work with diagrams and diagram elements and covers the following 
topics: 

• Using diagrams 

• Using diagram elements 

Using diagrams 
In ER/Studio BA, you can model two different types of diagrams: Business Process and 
Conceptual. 

Business Process d iagrams 

A Business Process Diagram (BPD) uses a flowcharting technique which is tailored for creating 
graphical models of business process operations. A Business Process Model is a network of 
graphical elements, which track the flow of activities and their order of performance. 

A BPD is made up of a set of graphical elements that enable the easy development of simple 
diagrams. The elements utilize shapes that are familiar to most modelers. For example, activities 
are rectangles and decisions are diamonds. The end result is a mechanism used for creating 
business process models which are able to handle complex business processes. 

The graphical aspects of the notation are separated into specific categories. This provides a small 
set of notation categories so that the reader of a BPD can easily recognize the basic types of 
elements and understand the diagram. Within the basic categories of elements, additional 
variation and information can be added to support the requirements for complexity without 
dramatically changing the basic look-and-feel of the diagram. 

Conceptual d iagrams 

Conceptual modeling is used by enterprise architects, business users, and data architects to 
model information about the business as it relates to mostly to data. However it could include 
other things like data flow, process, or information assets. The conceptual model is used to drill 
down into more detail which would be Process models and Logical/Physical data models. It 
simplifies the organization of hundreds if not thousands of physical objects. It is powerful enough 
to link to further technical (or physical) detail, but simple enough to communicate to non-
technical users. 

Diagram Basics 

• The Diagram View contains visual displays of elements. 

• The Model View tree contains element nodes which are separate definitional metadata for 
those elements. Therefore, you can create an element without needing a graphical 
representation of it on the diagram. 

• Elements can be reused or referenced in multiple models, regardless of model type, i.e. a 
database element from a data model can be reused/referenced in a business process model. 

• The file extension of a diagram .exd. 

The following sections discuss creating and working with diagrams, editing diagrams, and using 
the zoom features. Related Topics: 

• Using Diagram Elements.
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Working with diagrams 

You can create two different types of diagrams: Business Process Diagrams and Conceptual 
Diagrams. In the Business Process Diagram, you can create graphic business process models 
based on the Business Process Modeling Notation. When you create a business process diagram, 
a pool and a lane with an invisible boundary are automatically created. In the Business Process 
Modeling Notation Specification, all business process diagrams must contain at least one pool 
and each pool is a container for one process. 

In the Conceptual Diagram, you model information about a business as it relates to data, data 
flow, process, or information assets. 

When you create a diagram, the application opens a new diagram view, which you can use to 
arrange the elements and links of your diagram. 

You have the following actions available with diagrams:  create, open and close, export,  delete 
Business Process diagrams, delete Conceptual Model diagrams, rename, and print. You can also 
have a Diagram Usage dialog that helps you locate an element on multiple diagrams. 

Right-click the newly created diagram to gain access to additional functions: 

Command Description 

Grid Editorr This is a table-like editor which is an alternative to the Model View. Content in the Grid 
Editor can be printed or exported as a report. 

Refresh Updates the currently displayed information with new data or changes. 

Properties Opens the Property View for the selected element. 

Creating a diagram 

You can create a new diagram at the time you create a workspace or by using the menu 
command. 

1. On the File menu, select New > Diagram. The pull-right menu displays the type of diagram 
to be created. For example if you are creating a new diagram in a Conceptual Model, only 
Conceptual is available from the pull-right menu. 
OR 
Right-click the model name in the Model View tree and select New > Diagram. 

2. In the New Diagram dialog, enter the diagram name in the Diagram name text box. 

3. You can enter a description of the new diagram in the Description text box. Press Enter to 
add a CRLF in the text box. 

NOTE:  If you press Ctrl+Enter the New Diagram dialog closes and the new diagram 
name appears in the Model View tree. 

4. You can then select which model to place the diagram in from the models appearing in the 
list box. 

NOTE:  If you are creating a Business Process diagram, when you entered the diagram 
name in the Diagram Name text box, the Pool Name and Lane Name text boxes 
were populated with the same name. You can rename both the pool and the 
lane. 

If you are creating a Conceptual model, this option is not available. 

5. Press OK to close the dialog. The new diagram appears in the Model View tree and a 
tabbed view opens in the Diagram View.
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Opening and closing diagrams 

You can open and close diagrams to better manage system resources. When you open a project, 
all its diagrams remain closed. You can only work with a diagram and its elements when it is 
open. 

Opening diagrams 

Do one of the following options to open a diagram: 

• In the Model View tree, right-click the diagram node and click Open.  

OR 

• In the Model View tree, double-click the diagram. 

OR 

• In the Model View tree, select the diagram you want to open and press Enter. 

Closing diagrams 

The following describe the various ways used to close diagrams. 

• Closing a Single Diagram 

• Closing Other Diagrams 

• Closing All Diagrams 

Closing a single d iagram 

To close any single diagram, do one of the following: 

• In the Model View tree, right-click the diagram node, and then click Close. The diagram is 
closed and automatically saved. 

OR 

• On the Diagram window, right-click the Diagram View tab, and then click Close. A Save 
Resources dialog opens asking you if you want to save the changes. Click Yes and the 
diagram closes. 

OR 

• Click the  in the Diagram View tab for the opened diagram. A Save Resources dialog 
opens asking you if you want to save the changes. Click Yes and the diagram closes. 

Closing other d iagrams 

You can close all the opened diagrams except the active one. 

1. Right-click the Diagram View tab of the active diagram. 

2. Click Close Others from the menu. If the other diagrams you are closing have been 
modified a Save Resources dialog opens asking you if you want to save the changes. Click 
Yes and all the ‘diagrams close with the modifications saved. 

Closing a ll d iagrams 

1. To close all open diagrams, right-click any Diagram View tab, and then click Close All. 

2. If any of the diagrams you are closing have been modified a Save Resources dialog opens 
asking you if you want to save the changes. Click Yes and all the other diagrams close with 
the modifications saved.
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Exporting diagrams 

You can export both Business Process and Conceptual diagrams in three different formats: rtf, 
pdf, and jpg. You can also export a Conceptual diagram to ER/Studio. Take the following steps to 
export a diagram: 

1. Open the diagram you want to export in the Model View tree. 

2. Once the diagram is opened, right-click the diagram node in the Model View tree and select 
Export.... 

OR 

From the main menu, select File > Export > Diagram.... 

3. In the Export dialog, select the directory where you want to save the exported diagram, 
enter the file name, and select the type of file (jpg, rtf, or pdf). 

4. Click Save and the exported file is saved in the selected file format. You can then open the 
exported file it in the appropriate application. 

Deleting Business Process Diagrams 

You can permanently delete any Business Process diagram listed in the Model View tree. To 
delete a diagram, do the following: 

In the Model View tree, right-click the diagram, and then click Delete. If it is a Business Process 
diagram, it is associated with a pool having an invisible boundary which can also be deleted. So, 
in the Delete Diagram with Associated Pool dialog you are given two options. 

Do you want to delete the associated pool, along with 
the elements it contains? 

Click Yes the diagram, and all associated pools 
and lanes are deleted. 

Do you want to delete only the diagram? Click No. When this option is selected the invisible pool, 
its associated lane, and all elements in the lane are still in 
the Model View tree. 

NOTE:  You can undo the deletion by clicking Undo Delete Elements from the Edit menu. 
The diagram and all associated elements are restored in the Model View tree. 

Deleting Conceptual Model Diagrams 

You can permanently delete any Conceptual Model diagram listed in the Model View tree. To 
delete a diagram, do the following: 

1. Right-click the diagram node in the Model View tree and select Delete. 

OR 

Select the diagram node you want to delete in the Model View tree and click  on the 
toolbar. 

OR 

Select the diagram node you want to delete in the Model View tree and click the Delete 
key. 

2. The Delete Items dialog box opens. Clicking Yes completely removes the selected diagram 
from the workspace. 

NOTE:  You can undo the deletion by clicking Undo Delete Elements from the Edit menu. 
The diagram and all associated elements are restored in the Model View tree. 
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Renaming d iagrams 

You can rename a diagram in the Model View tree. 

1. In the Model View tree, right-click the diagram node you want to rename and select Rename 
Diagram. If your diagram is unsaved, a warning dialog opens asking if you want to continue 
with the renaming process. 

2. Click Yes and the Rename Diagram dialog opens. 

3. Enter the new name in the text box and click OK. The diagram is renamed in the Model View 
tree. 

Printing d iagrams 

You can print the diagram you have created using ER/Studio BA. You can also save the print 
settings for the opened diagram. To open the Print dialog: 

1. Open the diagram you want to print in the Diagram View. 

Click  on the main menu.  

OR 

On the main menu, click File > Print. 

OR 

Press Ctrl+P. The Print dialog opens. The following settings are available: 

Setting Description 

Printer... When you click the Printer button the Print dialog opens where you can select the Printer 
you want to use. 

Preferences In this dialog, you can select the printer, set a page range, and set the number of 
copies you want to print. 
Note: Once you set your print options in this dialog, click Print to close this dialog. 
However, the diagram does not print until you click the OK button in the first Print 
dialog. 

Scale 

Actual Size The page is printed as is with no zoom. 

Fit Page All elements in the diagram are reduced to fit on one page. 

Custom You can set the percentage of the page you want printed. As you change the 
percentage in the combo box, notice that the information in the preview pane changes. 
As you increase the percentage a grid appears in the preview pane indicating where the 
page divisions appear. 
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Setting Description 

Margins 

Inches Sets the margins for the page. As you increase the size of the margin, notice that the 
preview pane shows where the page divisions appear based on the margin size. 

Note: The value you enter for the margin must contain the decimal separator. For 
example if you want one inch margins, you must enter 1.0, not 1. 

Copies 

Number of 
Copies 

Select the number of copies you want printed of the selected diagram. 

Collate Multiple copies are printed in order. 

Options 

Center to Page Centers the diagram in the center of the printed page. 

Print Page 
Numbers 

A page number is placed on each page as it is printed. 

Print Border When you select this option a border is placed around the printed diagram. You can 
set the width of this border. 

Width When you select the Print Border option, you can then set the width of the border. 

2. After you make any changes to the print options, click OK. The diagram is printed and any 
changes you made to the print options are saved with the diagram. 

NOTE:  Click Save Settings if you make print option changes and want to save these 
options without printing the diagram. 

Using the Diagram Usage dialog 

The Diagram Usage dialog helps you quickly locate elements on one or more diagrams. There are 
two different ways of using this dialog: 

• When you right-click on an element in the Model View, a pull-right menu lists the diagram(s). 
This allows you to quickly locate and open the diagram where the element appears. If the 
element appears on more than ten diagrams the More... option appears, opening a dialog 
listing all the diagrams. 

• Right-click on an element in the Search Results View and select Find In > All Diagrams. The 
Diagram Usage dialog opens where you can select and open a diagram from those listed. You 

can also click  on the Search Results toolbar.
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Edit diagrams 

When you select Diagram on the main menu, you gain access to four commands that help you 
edit diagrams: 

• Case Shift 

• Grid 

• Layout 

• Connections 

Case shift 

You can set the case format for all element labels. When you make a selection, all labels in the 
diagram conform to the new selection. You have three options: 

Command Description 

Lower Case All text appears in lower case lettering, including the initial letter of the label. 

Preserve Case All text appears as it was entered for the label. 

Upper Case All text appears in upper case lettering. 

Grid 

Rather than guessing at the alignment of your elements, you can use the lines of the grid as a 
guide. The grid, which you can turn on or off, is a network of lines that covers your diagram. The 
Snap Objects to Grid command is a toggle command that you can turn on or off as well. 

Command Description 

Show Grid Lines Select this command and grid lines appear in the diagram. You can change the 
preferences so that the appearance of grid lines is the default setting for the 
application. 
The grid also displays in a pool, sub-process, or subject area. You can change the  
preferences for this so the grid lines don’t display. 

Show Parent Objects as 
Transparent 

When a parent object such as a pool, lane, or subject area is placed on a diagram, 
the grid lines appear in the object. You can change the preferences to make it the 
default setting. 

Snap Objects to Grid Changes the default setting so that when an element is moved, it snaps to the 
nearest grid. This feature is active whether the grid lines are showing or not. 
You can change the preferences so that the snap to grid action is the default 
setting for the application. 
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Layout 

When you change this setting you get a Change Diagram Layout dialog warning you that this 
selection overrides any changes you have made to individual relationships. For example, if the 
setting was elbowed when you created your diagram and you then change to straight, all 
connections are changed to the selected layout style. 

Command Description 

Elbowed All connections are drawn with ninety degree bends in the line. This is the 
default setting. 

Straight All connections are drawn as the shortest distance between the two 
elements you are connecting. 

Connections 

Once you have created a link in the Diagram View, select this command to show or hide the links 
for the entire object in the diagram. 

Using Zoom In diagrams 

You can change the scale of any diagram displayed in a Diagram View. The application offers 
several zooming features which are described in the following table: 

Feature Description 

Preset Percentages You can enlarge or reduce a diagram using a present percentage. 

Note: You also have the option of setting a Custom on the Standard 
Toolbar. 

Custom Zooming Custom zoom into and out of any Diagram window by specifying a zoom 
percentage on the Formatting toolbar. When you use the custom zoom feature, 
you type a specific zoom percentage, or select a preset percentage from the 
custom zoom drop-down list. The higher the specified percentage value, the 
closer the zoom. 

Zooming In and Out Incrementally zoom into and out of any Diagram window, enlarging or reducing the 
size of your diagram gradually with the click of a button. 

Fit to Page Reduces the size of all elements in the Diagram View so that the entire 
diagram fits on one page. 

TIP:  ER/Studio BA also offers an  Overview Window, where you can zoom into and out of 
specific parts of any Diagram window from a single, unscalable window. 

Preset p ercentages 

To enlarge or reduce a diagram using a preset percentage, do the following: 
 

1 On the View menu, click Zoom Level. 
 

2 From the pull-right menu, select the percentage amount that you want to enlarge or reduce 
your diagram. The available percentages are: 25, 50, 75, 100, 200, and 400.
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Custom zooming 

You can gain access to the Custom Zoom feature three different ways: 

• On the View menu, click Zoom Level > Custom to open the Zoom Level dialog.  

OR 

• On the Standard toolbar, click the Custom Zoom box ( ). In the Custom Zoom box, 
do one of the following: 

o Type a zoom percentage value. 

OR 

o Select a preset zoom value from the list to display the diagram at the specified zoom 
percentage. 

TIP:  The custom zoom drop-down list also offers the option to Fit to Page. 

Zooming i n and out 

To zoom in (enlarge the diagram), do one of the following:  

• On the Standard toolbar, click . 

OR 

• In the Diagram View, right-click, and then click Zoom In. 

To zoom out (reduce the diagram), do one of the following: 

• On the Standard toolbar, click .  

OR 

• In the Diagram View window, right-click, and then click Zoom Out to redraw the diagram 
according to the zoom size specified. 

Fit to page 

Fit to Page reduces or enlarges the diagram so all elements appear in the visible view area of the 
diagram. 

• On the View menu, click Zoom Level > Fit to Page.  

OR 

• On the Standard toolbar, click the drop-down arrow in the Custom Zoom box  
and click Fit to Page. 

All elements in the Diagram View are reduced or enlarged so the entire diagram now fits on one 
page.
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Using diagram elements 
The table below describes the different functions available when working with the diagram 
elements in ER/Studio BA. 

Diagram Element Function Description 

Create New Elements Explains how to create and place elements in the diagram from both the Model 
View and the palette. 

Label Diagram Elements Explains how to label elements placed in a diagram. You can also edit those labels. 

Edit Diagram Elements Explains how to cut, copy, paste, select all diagram elements, select all similar 
diagram elements, delete elements, and change the diagram element size. 

Format Diagram Elements You can format an individual element or a group of elements using the Formatting 
toolbar. 

Right-click an element in the Model View tree to gain access to the following functions: 

Command Icon Description 

New  You can create new elements from a lane node in a Business Process diagram, and 
from a Subject Area or Business Entity in a Conceptual Model diagram. 

Rename  You can rename elements two different ways. 

Delete  
 
 

There are several different ways to delete elements. 

Create Mapping  This command is only available for a Subject Area element in a Conceptual Model. 
You can map a Subject Area to one or more Conceptual Model diagrams. 

Diagram Mapping  This command is available if you have mapped a Subject Area to a Conceptual 
Model. Click this command and a pull-right displays the name of the diagram the 
Subject Area is mapped to. 

Grid Editor 
 

 
 
 

This is a table-like editor which is an alternative to the Model View. Content in the 
Grid Editor can be printed or exported as a report. 

Links  
 
 

This command opens the Create Link wizard which allows you to create links 
between elements. 

Usages 
 

 
 
 

This command opens the Create Usage wizard which allows you to create 
usage connections between elements. 

Impact Analysis 
 

 
 
 
 
 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an Impact Analysis Diagram which graphically displays all the 
associated relationships and elements. 

You can also show the Impact Analysis Report. 

Refresh 
 

 
 

Updates the currently displayed information with new data or changes. 

Properties 
 

 
 

Opens the Property View for the selected element. 
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Create new elements 

ER/Studio BA offers two methods for creating new elements in the Diagram View: from the 
palette, and from the Model View tree. How you create elements in the Model View tree depend 
on whether you are working the Business Process Models or Conceptual Models. You can also 
create multiple existing elements from the Model View. 

Creating n ew e lements from the palette 

To create any type of element in the Diagram View, do the following: 
 

1 On the Palette, click the element icon you want to use. 
 

2 In the Diagram View, click a location in the view to place the element. 
 

NOTE:  The cursor is in the multi-drop mode    so you can place as many elements as you 

need. Press ESC to exit the multi-drop mode. The cursor changes from   to . You 
can also set a  preferences to disable the multi-drop mode globally. 

 

Creating n ew e lements in the Model v iew for a Business Process m odel 

You can create a new element in the Model View tree from the lane node. Once you have created 
the element, you can drag the element onto an open diagram in the Diagram View. 

To create any type of element in the Diagram drawing area, do the following: 
 

1 In the Model View tree, right-click the lane node where you want to place the new element. 
 

NOTE:  You can also create a new lane from the Pool node. 
 

 
2 Select New and click the element you want created from the pull-right menu. The selected 

element is placed in the lane node. 
 

You can then drag the elements that are not nested onto an open diagram. 

Creating n ew e lements in the Model v iew for a Conceptual m odel 

You can create a new element in the Model View tree from several different nodes. Once you 
have created the element, you can drag the element onto an open diagram in the Diagram View. 

To create any type of element in the Diagram drawing area, do the following: 
 

1 To create a specific element: 
 

o For a Business Entity or Subject Area element for a model, right-click the model node 
where you want to place the new element. 

o For a new Subject Area to be nested in an existing Subject Area, right-click the 
Subject Area node where you want to nest the new element. 

o For a Business Attribute, right-click the Business Entity where you want the new 
attribute to reside. 

o For a new Business Entity to be nested in an existing Business Entity, right-click the 
Business Entity node where you want to nest the new element.
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2 Select New and click the element you want created from the pull-right menu. The selected 
element is placed in the lane node. 

 
3 You can then drag the elements that are not nested onto an open diagram. 

Creating m ultiple e xisting e lements from the Model v iew 

To place multiple diagram elements listed in the Model View tree on the Diagram View, do the 
following: 

 
1 On the Model View, click the first element. 

 
2 Press CTRL and click all remaining elements. 

 
3 Drag the elements on the Diagram View and the elements are placed in the Diagram 

window. The application displays any links shared between elements. 

Label diagram elements 

When you label the elements in a diagram you can use autotype feature for quick and easy 
labeling. You can also  edit existing labels. 

Using the Autotype feature 

Once you have placed an element on a diagram you can use the autotype feature to label it. This 
feature enables you to start typing immediately in a text box that opens automatically. 

The autotype feature has the following functions: 

• As you enter text, it autowraps in the text box. 

• You can use returns in the text box by pressing Ctrl+Enter. As you enter text, the text box 
continues to expand downward. 

• The autotype text box is closed by clicking the mouse button in the diagram or by pressing 
Enter. 

Editing e xisting labels 

You can edit existing labels for elements three ways: 

• If it is a label outside the element, for example a start event, select the element you want to 
edit in the Diagram View and then click the label. An editable text box opens allowing you to 
change or replace the existing label. 

• If the element itself is labeled, for example a task, select the element and just start entering 
text. It automatically goes into the autotype mode. 

• Double-click the element and the Property View opens. You can change the label in the 
Name text box. 

• Right-click an element in the Model View tree and select Rename from the context menu. 
The new label appears on the selected element and in the Model View tree.
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Edit diagram elements 

Once you place a diagram element, you edit them in the following ways: 

• Renaming elements 

• Deleting elements 

• Cutting elements 

• Copying elements 

• Pasting elements 

• Selecting all elements 

• Selecting all similar elements 

• Grouping elements 

• Changing diagram element size 

Renaming elements 

You have two different ways of renaming an element in the Model View tree:  

• Right-click the element node and select Rename. 

OR 

• Select the element and press F2. The element node name becomes editable. 

Deleting elements 

You can delete elements from the Model View tree and the Diagram View area. When you delete 
elements you have different options presented to you in the Delete Element dialog depending 
on whether you are deleting the element from the Model View tree or from the Diagram View. 
The table lists the options available: 

Location Description 

Remove This command is available when you delete the element from the diagram only. The 
element and its associated metadata remain in the project to be used by this or other 
diagrams (the remove command affects the display only). 

Delete This action permanently removes the element from the project, including the visual 
display on the diagram, the element itself, and its associated metadata. 
Note: Because this delete action may include other diagrams sharing this element, 
click  in the Delete Items dialog to list all the diagrams that are affected by this 
deletion. You can set a preference to turn this listing option off. 

View diagrams on which 
the elements appear. 

When you click  in the Delete Element dialog, a window opens displaying the 
diagram where the element resides as well as its connecting elements. 

Cancel No action is taken and the element remains in the project and on the diagram. The 
Delete Element dialog is closed. 

NOTE:  ER/Studio BA does not place deleted elements on the clipboard for future pasting. 
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Deleting e lements from the Model v iew t ree 

Do one of the following options to delete elements: 

1 In the Model View tree, select the diagram element. 

o From the main menu, select Edit and then click Delete.  

OR 

o Right-click the element and click Delete. The Delete Elements dialog opens. 

 
2 Click  to view all the diagrams on which the element(s) appear. 

 
3 Click Yes to delete the selected element from the Model View tree. 

NOTE:  If you delete an element that resides on both the Model View tree and the 
diagram, and the diagram isn’t open, when you open the diagram the deleted 
element no longer appears in the diagram. 
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Deleting e lements from the Diagram v iew 

Do one of the following options to delete elements: 

1 In the Diagram View, select the diagram element. 

o On the Standard toolbar click .  

OR 

o Right-click the element, and, under Edit, click Delete. 

The Delete Elements dialog opens. 

 
NOTE:  The default preference setting is to display a list of the other diagrams that are 

using this element in the Delete Element dialog. When you click in the Delete 
Element dialog a window opens displaying the diagram where the element resides 
as well as its connecting elements. You can change this preference so this list no 
longer appears in the Delete Elements dialog. 

2 Click  to view all the diagrams on which the element(s) appear. 
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3 Click one of three choices: 

o Remove: Disassociates the element from the Diagram View. 

o Delete: Completely removes the element from the workspace. 

o Cancel: Cancels the actions and the element is not deleted. 

Cutting e lements 

You can cut most elements displayed in the Diagram View. When you cut an element, the 
application removes it from the window and places it on a clipboard. You can then paste the cut 
element in the same Diagram window, or in a different Diagram window in the same workspace, 
or in selected third-party applications like Microsoft Word©. The cut item remains on the 
clipboard until you cut or copy another selection. 

NOTE:  You cannot cut a lane within a pool. 

To cut a selected element 

• Right-click the element and select Edit > Cut.  

OR 

• Select the element and select Edit > Cut from the main menu.  

OR 

• Select the element and press Ctrl+X.  

OR 

• Select the element and click  on the Standard toolbar. 

ER/Studio BA removes the element from the Diagram window, placing it on a clipboard for 
pasting. 

Copying e lements 

You can copy most elements displayed in a Diagram View. When you copy an element, the 
application leaves the original on the diagram and places a copy of it on a clipboard. 

NOTE:  You cannot copy a lane within a pool. 

You can then paste the copied element in the same Diagram window, or in a different Diagram 
window in the same workspace, or in selected third-party applications like Microsoft Word® or 
Microsoft Visio®. The copied item remains on the clipboard until you cut or copy another 
selection. 

NOTE:  ER/Studio BA fully utilizes Window's copy buffer, letting you copy elements from any 
model for placement in Microsoft applications. Because the application 
automatically pastes copied graphics into third-party applications, you do not need to 
export images from ER/Studio BA for import into these applications. 
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To copy an element 

• Right-click the element and select Edit > Copy.  

OR 

• Select the element and select Edit > Copy from the main menu.  

OR 

• Select the element and press CTRL+C.  

OR 

• Select the element and click  on the Standard toolbar. 

ER/Studio BA copies the element, placing the duplicate on a clipboard for pasting. 

Pasting e lements 

You can paste any cut or copied element into the following: 

• same diagram 

• different diagram in the same workspace 

• different diagram in a different workspace 

• external document such as Microsoft® Word. 

NOTE:  Pasting to an external application is done using the .jpg format so the image only 
appears in applications that supports the .jpg format. 

When you cut or copy an element, the application places it on a clipboard for you to paste. The 
copied item remains on the clipboard until you cut or copy another selection. You can paste a 
symbol from the clipboard as many times as you want. 

TIP:  Cut or copied elements cannot be pasted into different model types. For example if 
you copied a Start Event from a Business Process model diagram, you cannot paste 
that event onto a Conceptual Model diagram. 

NOTE:  When you cut or copy an element in a diagram, when it is pasted to an external 
application, it is done using the .jpg format. Therefor the image will only appear in 
applications that can handle the jpg format. 

To paste an element 

• Right-click the background of the destination window, and then select Edit > Paste.  

OR 

• On the Standard toolbar, click .  

OR 

• From the main menu, select Edit > Paste. 

OR 

• Press CTR+V.
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Selecting all elements 

You can select all elements in a Diagram View. When you select a single element (by clicking the 
element), ER/Studio BA displays handles around the selected graphic. Likewise, when you select 
all elements, the application displays handles around every element in the window, letting you 
cut, copy, delete, or otherwise work with all elements at once. 

To select all elements in a Diagram View  

• On main menu select Edit > Select All.  

OR 

• Press CTRL+A. 

OR 

• Right-click an element in the diagram and select Edit > Select All. 

Selecting all similar e lements 

You can select all elements or links of a given type in the Diagram View. When you select a single 
element or link (by clicking it), ER/Studio BA displays handles around the selected graphic. 
Likewise, when you select all similar elements or links, the application displays handles around 
every element or link of the same type in the window, letting you cut, copy, delete, or otherwise 
work with them all at once. For example, when you click a task in a diagram, and then click Select 
All Similar Elements, ER/Studio BA selects all other tasks in the Diagram View. 

To select all similar elements in a Diagram window 

• Select the element, and on the main menu select Edit > Select All Similar Elements.  

OR 

• Select the element and press Ctrl+Shift+A. 

Grouping e lements 

This feature provides the ability to group elements together into a single entity that can be 
moved around a diagram in the Diagram View. Once items are grouped, a bounding box 
appears around the group items. They move together in a block and are essentially “locked” 
together, movement-wise. The Ungroup feature removes the grouping and allows the elements 
to be moved separately again. 

The Group/Ungroup command is available on the Format main menu, the Alignment and Layout 
Toolbar, and on the shortcut menus of all elements (except the connecting elements). You can 
also use Ctrl+Shift+G to group and Ctrl+Shift+U to ungroup. 

The following rules and constraints apply to the Grouping functionality: 

• The Group command is only available if more than one item selected. 

• The Ungroup command is only available if the item selected is in a group. 

• If you select both the source and target elements, the connecting flow is also selected. If you 
select just one of the ends, the flow is not selected. However, when you move the grouped 
elements, the connecting flow remains connected to both the source and target and adjusts 
to the move accordingly. 

• When doing a Copy and Paste, all grouped objects are copied and they are grouped 
together upon paste. 

• The grouping is removed if only one presentation element remains in a group. 
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To group e lements: 

1 Select the elements you want to group by clicking and dragging a box around the select 
items. You can also select each item by holding down the left mouse button and clicking on 
each element in the diagram. 

2 Right-click in any of the selected elements and click Grouping>Group. A bounding box 
appears around the selected elements. 

3 Place the cursor on the bounding box and the cursor changes to the move cursor ( ). 
4 Hold down the left mouse button and move the grouped items in the diagram. 

NOTE:  You can move elements within the group box. Click on the element you want to 
move and handles appear around the element. You can then move the selected 
element within the box. Note that the box stays in the same location. 

Changing d iagram e lement s ize 

You can change the size of any element in a Diagram window. 

1 To change the size of an element, in the element’s Diagram view, click the element. 
 

2 Drag the element handles to change its size. 

Format diagram elements 

You can format an individual element or a group of elements using the Formatting toolbar. 

 
NOTE:  You can also set global formatting preferences for both the Business Process 

Modeling and Conceptual elements by selecting Windows > Preferences. For more 
information, see  Formatting. 

Font and color options 

You can change the font style, font size, font colors, and the fill and line colors of a selected 
element in the Colors and Fonts portion of the Formatting dialog. 

To change a selected font, select a font from the drop-down menu in the Font text box. You can 
also change the font size by selecting a size from the drop-down menu in the size text box. You 
can edit the font settings of all element labels. The following toolbar commands are available: 

Command Icon Description 

Bold  
 
 

Applies bold formatting to the label text. 

Italics  
 
 

Italicizes the label text. 

Strikeout  
 
 

A line is drawn through the label text. 

Underline 
 

 
 

Underlines the label text. 
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You can also change the font color, element outline color, and element fill color with the following 
commands. 

Command Icon Description 

Change Font 
Color  

 
 
 
 

Click the drop-down arrow to select an existing color or click “Other” to open the 
Color dialog where you can create a custom color for the color of the label font. 

Change Line 
Color  

 
 
 
 

Click the drop-down arrow to select an existing color or click “Other” to open the 
Color dialog where you can create a custom color for the border of the element. 

Change Fill 
Color  

 
 
 
 

Click the drop-down arrow to select an existing color or click “Other” to open the 
Color dialog where you can create a custom color for the background of the 
element. 

Justification 

You can change the justification settings for the text label in an element. 

NOTE:  These commands do not justify the text labels on elements that use text boxes outside 
the element. 

Command Icon Description 

Left Justify 
Text  

 
 

Justifies the text on the left side of the text box. 

Center Text 
 

 
 

Centers the text in the text box. 

Right Justify 
Text  

 
 

Justifies the text on the right side of the text box. 

Font s ize 

You can incrementally increase or decrease the text size of a selected element in the diagram. 

Command Icon Description 

Increase Font 
Size  

 
 

Each time you click this icon, the font of the selected label increases by one point size. 

Decrease Font 
Size  

 
 

Each time you click this icon, the font of the selected label decreases by one point size. 
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Reference objects 
When you create a new workspace, reference objects are automatically created as well. You can 
create new reference objects three different ways: (1) in the Model View; (2) by using the 
Reference Objects  Palette; or (3) by using the Reference Objects Toolbar. 

The table below lists the reference objects created when you create a new workspace: 

Reference Object Icon Definition 

External Data Objects 
 

 
 

You can import or create new external data 
objects and then link those objects to business 
processes and tasks. 

Business Element 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Elements are often used by business users to 
document their list of “terms and/or definitions”. 
While from a business user’s point-of-view, this 
may be no more than a list of terms, they can be 
used by a modeler to seed attributes of 
semantically-rich models. An element can be 
bound to different business attributes across 
conceptual models to enforce naming and 
definition standards. It is the The business 
element allows an organization to achieve a 
common meaning and lineage around core 
business concepts such as “customer”, “customer 
identifier”, “trade”, etc. 

Business Rule 
 

 
 

A business rule is a policy, practice, or formula 
related to the operation and enforcement of 
business practices. 

Business Unit 
 

 
 

A business unit is an organizational area within or 
external to an enterprise. 

Domains 
 

 
 
 
 

A reusable attribute template that promotes 
consistent domain definitions. You construct 
domains as you would attributes, specifying a 
name, datatype properties, null status, default 
values and validation rules. 

Stewards 
 

 
 

A steward is a person or organization responsible 
to, or associated with a model element. 

Link  
 
 

This link displays high-level views of information 
requirements. This type is used to simply relate 
objects together. 

Usage 
 

 
 
 

When you select this option you create a link that 
enables you to designate a usage type: create, 
read, update, or delete database records. The link 
you create is labeled “usage” 
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Creating a  r eference o bject in the Model v iew 

1 Right-click a reference object in the Model View tree and select New. The command that 
appears depends on the reference object clicked. For example, if you right-click on Business 
Rules, the command will be New Business Rule. 

NOTE:  If you right-click on  External Data Objects and click New, a pull-right menu opens 
listing all available data objects. 

2 The newly created reference object appears nested below the selected object in the Model 
View tree. 

NOTE:  Once you create the reference object, you can then drag that object onto the 
Diagram View. A representative icon is placed in the diagram. You can then link 
these objects to processes and tasks in the diagram. 

 
3 Right-click the newly created object to gain access to the following functions: 
 
Command Icon Description 

Rename  When you select this command or press F2, the text label for the object can 
be edited. 

Delete  
 
 

When this command is selected, the Delete Elements dialog opens asking 
you to confirm the delete action. 

Links 
 

 
 

This command opens the Create Link wizard which allows you to create links 
between elements. 

Usages 
 

 
 
 

This command opens the Create Usage wizard which allows you to create 
usage connections between elements. 

Impact Analysis 
 

 
 
 
 
 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis  Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the Impact Analysis  Report. 

Refresh  
 

Updates the currently displayed information with new data or changes. 

Properties 
 

 
 

Opens the Property View for the selected reference object. 

Creating a reference o bject using the Reference Objects p alette 

1 Expand the Reference Objects portion of the Palette and select the reference object you 
want in your diagram. 

2 Click once in the Diagram View and the object is placed in both the Model View tree and the 
diagram. 

NOTE:  The cursor is in the multi-drop mode    so you can place as many elements as 

you need. Press ESC to exit the multi-drop mode. The cursor changes from    
to .
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3 Right-click the newly created object to gain access to the following functions: 

 
Command Icon Description 

Connections  Once you have created a link, select this command to show or hide all the 
links on the diagram. 

Edit  The available commands are: cut, copy, delete, or select all. 

Links 
 

 
 

This command opens the Create Link wizard which allows you to create links 
between elements. 

Usages 
 

 
 
 

This command opens the Create Usage wizard which allows you to create 
usage connections between elements. 

Impact Analysis 
 

 
 
 
 
 
 
 
 

You have two commands available from the pull-right menu: 

You can generate an  Impact Analysis  Diagram which graphically displays all 
the associated relationships and elements. 

You can also show the Impact Analysis  Report. 

Creating as Pool  This command is available only for the business Units and Stewards reference 
objects. This command creates a pool that is semantically linked to either a 
Business Unit or Steward. 

Detaching from  
Pool 

 This command is available only for the business Units and Stewards reference 
objects. This command deletes the link between the reference object and the 
pool. 

Properties  Opens the Property View for the selected reference object. 

Creating a reference o bject using the toolbar 

1 Click the Reference Object you want to place in the Diagram View from the toolbar. 

NOTE:  If this toolbar is available, select View > Toolbars > Reference Objects from the 
main menu. 

2 Click once in the Diagram View to place the object. 

Note that the object you just placed also appears in the Model View tree under the 
appropriate Reference Object node. For example, if you placed a Business Rule object in 
the diagram, a new Business Rule node appears under the main Business Rules node. 

Using business elements 
Business Elements are often used by business users to document their list of “terms and/or 
definitions”. While from a business user’s point-of-view, this may be no more than a list of terms, 
they can be used by a modeler to seed attributes of semantically-rich models. A “business 
element” can be bound to different business attributes across conceptual models to enforce 
naming and definition standards. An organization can achieve a common meaning and lineage 
around core business concepts such as “customer”, “customer identifier”, “trade”, etc. by using 
the business element concept. 

In Conceptual Modeling, a business element can be used like a domain is used at the logical 
level. Business Elements can be “bound” to business attributes to seed a conceptual model and 
enforce standards.
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Using business rules 
A business rule is a policy, practice, or formula related to the operation and enforcement of 
business practices. You can create a new business rule in the Reference Objects node: 

 
1 Right-click on the Business Rules node in the Model View tree and select New. The 

command that appears depends on the reference object clicked. So when you right-click on 
Business Rules, the command will be New Business Rule. 

The newly created reference object appears nested below the selected object in the Model 
View tree. When you right-click the newly created object you gain access to a shortcut menu 
where you can rename or delete the Business Rule. You can also view the  Impact Analysis 
Report. You can create a link, and open the Property View for the selected business rule. 
You can also double-click an object to open the Property View. 

2 Once you create the reference object, you can then drag that object onto the Diagram View. 
A representative icon is placed in the diagram. You can then link these objects to processes 
and tasks. 

Using business units 
A business unit is an organizational area within or external to an enterprise, for example, Human 
Resources, Sales, Accounting, etc. You can create a new business unit in the Reference Objects 
node. You can create a  pool from a Business Unit or detach a pool from a Business Unit. 

Creating a new b usiness u nit 

1 Right-click on the Business Units node in the Model View tree and select New. The 
command that appears depends on the reference object clicked. So when you right-click on 
Business Units, the command will be New Business Unit. 

The newly created reference object appears nested below the selected object in the Model 
View tree. When you right-click the newly created object you gain access to a shortcut 
menu where you can rename or delete the Business Unit. You can also view the Impact 
Analysis Report. You can create a link, and open the Property View for the selected 
business unit. You can also double-click an object to open the Property View. 

2 Once you create the reference object, you can then drag that object onto the Diagram View. 
A representative icon is placed in the diagram. You can then link these objects to processes 
and tasks. 

Creating as a pool 

Conceptually a pool represents the participant in a process - the “who” of the action. Since a list 
of Business Units and Stewards is maintained in the Reference Objects, which also represent the 
“who”, you can semantically link the two objects. For example, you can keep track of the 
business units in your organization in the Reference Objects, for example Sales, Documentation, 
Engineering, etc. You then want to show the process that Documentation goes through to get 
ready for a software release. 

Rather than create a new pool called “Documentation”, it’s better to use the existing object to 
semantically link them so that we understand that it’s the same business unit we’re talking about. 
This avoids redundancy because you can define it once and use it multiple times. Because the 
two objects are “bound” if you change the name of the business unit/steward you also change 
the name of the pool. 
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Detaching from a  p ool 

Once you have created a Business Unit or Steward as a pool you can eliminate the relationship 
between the reference object and the pool. 

Right-click the reference object either in the Model View tree or in the diagram and select 
Detach from Pool. The link is deleted between the reference object and the pool. Any changes 
you make to the reference object are no longer propagated to the pool. However both the 
reference object and the pool remain on the diagram. 

Using domains 
Domains are reusable attribute templates that promote consistent domain definitions. You 
construct domains as you would attributes, specifying a name, datatype properties, null status, 
default values, and validation rules. After creating domains, you can re-use them in your data 
model by applying them to attributes and table columns. 

For more information see 

• Dragging and Dropping Domains on Business Entities 

• Importing ER/Studio Data Architect Domains as ER/Studio BA Domains 

By defining a Domain, you can then propagate changes to the underlying domain definition to 
all attributes and table columns that reference it. 

NOTE:  Domains are not visualized on diagrams so the Domain element icon is not available 
on the Reference Object’s toolbar or palette. 

One important method for enforcing business rules is to define and to apply domain restrictions. 
Domain integrity refers to the rules governing what values an attribute can take. By restricting 
and validating an attribute's values, you can implement important business rules such as ensuring 
that a checking account maintains a positive balance, or preventing the entry of invalid phone 
numbers. 

Dragging and dropping d omains on business e ntities 

Dragging/dropping of Domains to Business Entities are allowed. A Business Attribute is created 
using the domain name if an attribute with that name doesn’t already exist. If an attribute with 
that name already exists, a unique name is assigned to the attribute. 

Importing ER/Studio Data Architect domains as ER/Studio Business Architect domains 

• The ER/Studio DA domain data type will be created as the ER/Studio BA domain’s data type. 

• The ER/Studio DA width will be created as the ER/Studio BA domain’s width. 

• The ER/Studio DAscale will be created as the ER/Studio BA domain’s scale. 

• The ER/Studio DA “allow nulls” property will be created as the ER/Studio BA domain’s 
“Optionality” property. Allow nulls is equivalent to ‘optional’. 

• The enforcement options on the domains will be set from the “allow override” options of the 
ER/Studio DA domain. 

• The business attributes will be bound to the domains as per the ER/Studio DA model. 

• Since domains do not enforce description/notes from the domains, the descriptions and 
notes will be set on the business attribute, but there is no enforcement from that point on. 
Same for attribute names.
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Importing ER/Studio d omains as business e lements r eferencing domains 

• The domain’s name will be created as both the business element’s name and the ER/Studio 
BA domain’s name. The “enforce name” option will be cleared on the business element (i.e. 
not enforced). 

• The domain’s description will be created as the business element’s description. 

• The domain’s notes will be created as the business element’s notes. 

• The domain’s data type will be created as the ER/Studio BA domain’s data type. 

• The ER/Studio DA width will be created as the ER/Studio BA domain’s width. 

• The ER/Studio DA scale will be created as the ER/Studio BA domain’s scale. 

• The ER/Studio DA “allow nulls” property will be created as the ER/Studio BA domain 
“Optionality” property. 

• The enforcement options on the domains will be set from the “allow override” options of the 
ER/Studio DA domain. 

• The business element will point to the domain. 

• The business attributes will be bound to the business elements as per the ER/Studio DA 
model. 

Using stewards 
A steward is a person or organization responsible for or associated with a model element, for 
example: DBA, Auditor, Jeffrey Smith, etc. You can create a new steward in the Reference Objects 
node. You can also create a pool from a Steward. 

You can create a pool from a Steward or detach a pool from a Steward. 

Creating a new s teward 

1. Right-click on the Stewards node in the Model View tree and select New. The command 
that appears depends on the reference object clicked. So when you right-click on Steward, 
the command will be New Steward. 

The newly created reference object appears nested below the selected object in the Model 
View tree. When you right-click the newly created object you gain access to a shortcut menu 
where you can rename or delete the Steward. You can also view the  Impact Analysis Report. 
You can create a link, and open the Property View for the selected steward. You can also 
double-click an object to open the Property View. 

2. Once you create the reference object, you can then drag that object onto the Diagram View. 

A representative icon is placed in the diagram. You can then link these objects to processes 
and tasks. The example below shows a steward linked to a task via an association. 
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Creating as a pool 

Conceptually a pool represents the participant in a process - the “who” of the action. Since a list 
of Business Units and Stewards is maintained in the Reference Objects, which also represent the 
“who”, you can semantically link the two objects. For example, you can keep track of the 
business units in your organization in the Reference Objects, for example Sales, Documentation, 
Engineering, etc. You then want to show the process that Documentation goes through to get 
ready for a software release. 

Rather than create a new pool called “Documentation”, it’s better to use the existing object to 
semantically link them so that we understand that it’s the same business unit we’re talking about. 
This avoids redundancy because you can define it once and use it multiple times. Because the 
two objects are “bound” if you change the name of the business unit/steward you also change 
the name of the pool. 

Detaching from a  p ool 

Once you have created a Business Unit or Steward as a pool you can eliminate the relationship 
between the reference object and the pool. 

• Right-click the reference object either in the Model View tree or in the diagram and select 
Detach from Pool. The link is deleted between the reference object and the pool. Any 
changes you make to the reference object are no longer propagated to the pool. However 
both the reference object and the pool remain on the diagram. 

External data objects 
You can import,  export, or  create External Data Objects (EDOs). These objects can then be 
shown on a diagram. You can use an External Data Object (EDO) in a diagram for reference or 
for data flow diagramming. You can then link to EDOs with a specific business process or task. 
You can also link the  Individual Elements (attributes, columns, and data elements) contained in 
these External Data Objects. 

There are two different types of EDOs: Logical and Physical. The Logical types are entities and 
attributes. The Physical types are tables and views. 
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The table below lists the different types of EDOs. 

Type Icon Description 

Logical 

Data Source 
 

 
 

 

Data Feed 
 

 
 

 

Data Store 
 

 
 

A data store is a repository for data. 

Entity 
 

 
 

Distinguishable objects that can be represented in a database. 

Flat File 
 

 
 
 
 
 

A flat file is a file containing records, one record per line. Fields may have a 
fixed width with padding, or delimited by white space or tabs or commas (CSV) 
or other characters. There are no structural relationships. 

Report 
 

 
 

 

Physical 

Table 
 

 
 

A set of data in a database. 

View 
 

 
 

 

Individual elements 

The Individual Elements only appear on the Impact Analysis Diagrams when they are linked to a 
source object. They cannot be displayed on a Business Process or Conceptual Modeling 
diagram. Also, these Individual Elements are not available on the External Data Objects Toolbar 
or Palette. 

The table below lists the individual objects contained in External Data Objects: 

Type Icon Description 

Attribute 
 

 
 

An Attribute is a subset of an Entity 

Column 
 

 
 

An individual column of data within a Table or View. 

Data Element  
 
 

An individual piece of data in a Data Store, Data Feed, Report, or Flat File 

External data o bjects on a diagram 

Once you have imported or created External Data Objects, these objects can be visualized on a 
diagram by dragging the object from the tree to the diagram in the Diagram View, or from the 
tree to the diagram node on the tree. Representative icons are then placed in the Diagram View. 
Once on the diagram, you can open the Property View for that object. 
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Instantiating data objects for reference 

You can instantiate an External Data Object on a business process diagram. The following 
example shows that the customer data table is used and/or referenced by the Customer Pool 
through an association to a table object. 

 

Instantiating data objects for data flow diagramming 

You can use combinations of data objects and Business Processing Modeling Objects to create 
data flow diagrams. In the following example there is no limitation/validation on how objects are 
used (for example, the data object can be either a source or a target for a sequence flow). 

 

Linking b usiness p rocesses to data 

You can use the create link wizard to associate External Data Objects with other objects and then 
view it in an Impact Analysis Diagram. For example, you may want to associate data objects with 
specific business processes or tasks. 

Creating external data objects 
You can create and define generic External Data Objects to represent a high-level description of 
what data is accessed or data for which a model or database structure is not known (for example 
external data feeds from a company like JD Edwards). Once you create an external data object, 
you can create individual elements as well. 
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To create an external data object: 

1 In the Model View, right-click the External Data Objects node in the Reference Objects node 
and select New. The pull-right menu lists all the available types that can be created. 

 
2 Select the type from the list and the selected type is placed in the External Data Object 

node. The label, which you can edit, is the type name. You can then drag this object onto the 
diagram. 

 
OR 

 

Select the external data object icon from the External Data Objects Palette and click once in 
the Diagram View to place it. The object placed in the Diagram View automatically appears 
in the Model View tree. 

 
OR 

 

Select the external data object icon from the External Data Objects Toolbar and click once 
in the Diagram View to place it. The object placed in the Diagram View automatically 
appears in the Model View tree. 

You can define all elements of the newly created external data object in the Property View. 

Creating individual e lements 

1 In the Model View, right-click the External Data Object you have created. For example, you 
can right-click on an Entity EDO and create an Attribute. 

 
2 From the pull-right menu select the individual element (attributes/columns, or data) you 

want to create. 
 

NOTE:  You can also create an element from an External Data Object node by pressing insert, 
or by pressing insert on an existing individual element. 

 

 
3 The individual element appears in the Model View in an editable mode. Rename the 

element. 
 

4 Double-click on the element to open the Property View where you can set or change the 
element’s properties. 

Deleting external data objects 
You can delete external data objects either from the Model View tree or from the Diagram View. 

Deleting o bjects from the Model v iew 

1 Right-click the external data object that you want to delete in the External Data Objects 
node. 

 
2 Select Delete and the Delete Items dialog opens. 

 
3 Click Yes and the item is removed completely from the workspace.
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Deleting o bjects from the Diagram v iew 

1 Right-click the external data object that you want to delete in the Diagram View and select 
Edit > Delete. 
 
In the Delete Elements dialog you have three choices: 

 
2 Select the option you want and click OK. 

Drawing shapes 
Drawing Shapes are used to provide additional information about the Process. There are  nine  
drawing shapes, one text label, and one line. You can use these shapes to create diagram objects 
without the semantic meaning implied by the modeling notations. The drawing shapes are 
displayed in the Model View tree. You can rename these shapes in the tree. 

Characteristics: 
• The size of the shapes can be increased or decreased 

• The line and fill colors can be changed 

• The shapes can be labeled 

When you right-click the drawing shapes you gain access to a shortcut menu where you can show 
the name of the shape, or edit it. You can also view the Impact Analysis Report. You can create a 
link, and open the Property View for the selected shape. You can also double-click an object to 
open the Property View. 

Setting p references for s hapes 

You can set global preferences for the drawing shapes. The changes you make in this preferences 
dialog are then applied to all future elements you place in the Diagram View. For example, if you 
change the fill color of an octagon to red, from now on, all octagons you place in the Diagram 
View are red. 

1 To open the Preferences dialog select Windows > Preferences on the main menu. 
 

2 Expand the Formatting node and select Shapes.

Location Description 

Remove This command is available when you delete the element from the diagram only. The element 
and its associated metadata remain in the project to be used by this or other diagrams (the 
remove command affects display only). 

Delete This action permanently removes the element from the project, including the visual display on the 
diagram, the element itself, and its associated metadata. 
Note: Because this delete action may include other diagrams sharing this element, click + in the 
Delete Items dialog to list all the diagrams that are affected by this deletion. 

Cancel No action is taken and the element remains in the project and on the diagram. The Delete 
Element dialog is closed. 
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Working with ER/Studio Repository 
The Repository provides access to workspaces for one person at a time. Modelers can update or 
delete model information simultaneously by working with ER/Studio® Business Architect in the 
normal fashion and by merging their changes into a single model. 

To use Repository operations such as check in, check out, and get workspace, you must first 
specify the Repository connection details and then log in to the Repository. 

When you are finished working with the Repository, you should log out. If you close ER/Studio 
Business Architect, you are automatically logged out of the Repository. This section provides 
usage information for Repository Users: 

• Specifying Repository connection details 

• Logging in and out of the Repository 

• Establishing security for the Repository 

• Working with objects in the Repository 

NOTE:  Repository architecture, setup, maintenance, control, and query options are covered 
in the “Administrator’s Reference” of the ER/Studio Data Architect Users Guide. 

Specifying Repository connection details 
Using configurable Repository settings you can specify and modify server check out policy and 
communication settings. 

Setting Repository options 
1. Click Window > Preferences. 

2. Specify your connection details in the Repository Options and click Apply and then click 
OK to exit the editor. 

The following describe options that require additional explanation: 

o Server Machine: Specify the URL or hostname of ER/Studio Repository. 

o Server Port: Specify the port ER/Studio BA uses to communicate with the Repository 
server. The default is 54333. 

o Check out model when checking out diagram: Choose what action, if any, you want 
the system to perform with respect to the models in a diagram, when a diagram is 
checked out; always check out the models, never check out the models, or prompt 
you to decide what to do each time a diagram is checked out. 

o Check out workspace when creating/deleting models: Choose what action, if any, 
you want the system to perform with respect to the workspace, when a model is 
checked out and deleted or when diagram is checked out and a new model is added 
to it; always check out the workspace, never check out the workspace, or prompt you 
to decide what to do each time a workspace is checked out. 
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Logging in and out of the Repository 
To log in to the Repository: 

1. Click Repository > Log In. 

2. Complete the log in dialog and then click OK. 

The following describes the options that require additional explanation: 

o User Name: Enter your user name. This is case-sensitive. 

o Password: Enter your password. This is case-sensitive. You can change your 
password, click Repository > Security > Change Password. 

o Remember me: Select this option and ER/Studio BA will remember and then auto 
complete the User Name and Password for you when you choose to log in. 

Notes 

• During the Repository Installation, a default user name and password Admin is set as the 
default. The Administrator should change the Admin password after the initial log in. 

• The Admin user can’t be deleted. This prevents an accidental lockout. In the ER/Studio 
Security Center, you can set up additional users with Roles and Privileges to maintain 
Repository security. 

• If an administrator changes the repository security, users must log in again to update their 
permissions. 

To log out of the Repository: 

• To log out of the Repository, click Repository > Log Out. 

Establishing security for the Repository 
Security of the Repository contents is managed through the Repository Security Center by 
creating and then assigning users particular Roles and Privileges. 

NOTE:  To prevent an accidental lockout, the Admin user can’t be deleted. 

The Administrator can restrict user access to Repository items at the workspace level. To restrict 
access to the Repository, the administrator creates users and then assigns the users a role, which 
grants specific permissions to the user, or the administrator creates new roles to assign to users. 
Then the Administrator can grant users full access to some Repository items and restrict or deny 
access to other items. 

Before creating users and roles, the Administrator should understand the following Repository 
concepts: 

• Client Side Security Caching: To promote the concept of detached modeling collaboration 
(e.g. being logged out of ER/Studio Repository and possibly detached from the network), all 
security associated with the user by diagram is cached on the client when the user logs into 
ER/Studio Repository. 

NOTE:  When security changes are made, users must re-login to update their 
permissions.
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• Super User: Super User is a default Role created upon installation of ER/Studio Repository. 
The default 'Admin' user is assigned to the Super User role. This user can do anything to 
Repository objects, users and roles managed in the ER/Studio Repository as it is granted all 
privileges. It is not removable or editable, and is only found at the 'Repository' level of the 
Repository Security area of the Security Center. 

• No Access: No Access is a role that can be applied only at the workspace level of the 
Repository. It is a quick and global mechanism to prevent any access whatsoever to certain 
workspaces. 

Notes 

• When a user checks out a workspace from the Repository, ER/Studio BA tracks the user and 
machine combination for that particular file. In addition, to enable users to model while they 
are "offline” or unable to connect to the Repository server, when a workspace is checked 
out, ER/Studio stores information about the security rights of the user and the workspace 
with the file, which has the following effects: 

• When a user is logged into the Repository, and attempts to open a workspace that was 
retrieved from the Repository by a different user/machine combination than the currently 
logged in user, ER/Studio BA indicates that the file cannot be opened due to the conflict. 
This ensures that one user does not attempt to work on or check in changes to a workspace 
that was originally retrieved by a different user. Because the Repository keeps track of object 
check outs based on the user and machine, only the user on the machine that originally 
checked out an object can check it back in. 

• Even if a user is not logged into the Repository, Repository files that have been checked out 
can be opened and worked on in ER/Studio BA. ER/Studio BA will load the security 
permission data for the user that originally retrieved the file from the Repository, and that 
security data will govern the rest of the working session until the user either logs in to the 
Repository or closes the file. If multiple files are open while the user is NOT logged in to the 
Repository they must all have been retrieved by the same user. Of course, this also applies 
when the user IS logged in. 

• The cached security data stored with each diagram is updated whenever an open Repository 
file is saved while logged in to the Repository, but if the file is not saved before closing it, 
then any changes to the security permissions for that user and workspace will not be cached 
with the file. So, if you plan to work offline, and the security settings have changed since the 
file was last saved, then you should open each file while logged into the Repository and save 
it before taking the files to work offline. 

• If an admin makes changes to the security UI, such as changing permissions on workspaces 
to grant or revoke access, users must re-login to update their permissions. 

This section includes the following topics: 

• Creating and managing roles 

• Creating and managing users 

• Granting and prohibiting user access to Repository items 

See Also 

Working with Objects in the Repository 
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Creating and managing roles 
ER/Studio BA supports customized roles with different sets of permissions. Repository Object 
Type Permissions are pre-defined privileges to operate on Repository items. You can assign them 
to a role, which gives users assigned to that role, permission to perform certain Repository 
operations. You can use the available privileges to create specific roles to suit your environment. 

For example, you can create a role which has the Repository permissions to create, update, and 
delete workspaces. You can then assign a new user that role for the Repository and then create 
and assign another role to provide update privileges to existing workspaces the user may need to 
update. 

NOTE:  To access, create, update, and delete user and roles, a Repository administrator must 
have Access Security Info and Update Security Info privileges. 

Create, u pdate, r ename, and delete r oles 

1 Click Repository > Security > Security Center. 
 

2 Select the Manage Roles tab. 
 

3 To create a new role, click New. 

o In the Create Repository Role dialog, enter a Name and a Description for the new 
role. 

o In the Repository Object Type Permission area, select the permissions you want to 
assign to the role for the selected object type. 

o Click Apply and continue changing security settings and then when finished, click OK 
to exit the security center. 

o To apply the new role to existing users, see Assigning Users Roles for Accessing 
Repository Items. 

To update a role, select a role from the list, select or clear the checkboxes to add or remove 
permission, click OK, and then click OK again to exit the security center. 

 
To delete a role, select a role from the list and then click Delete. 

 
To rename a role, select a role from the list and then click Rename. 

o In the Rename Repository Role dialog, enter a new name, click OK, and then click OK 
again to exit the security center. 

 

4 Inform affected users that they should log out of the Repository and then log in again to 
receive the security updates. 

Notes 

• Once created, the Administrator can select the role and update, delete or rename it at any 
time. Renaming the role does not affect the privileges users have, but if you delete a role 
users who had access to Repository items through that role, will no longer have access to 
those items. 

• Users cannot modify workspaces without the necessary permissions, regardless of whether 
the user has the workspace checked out. 

• Once you delete a role from the Repository, it will no longer be in the database. 
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• The following lists the Repository Object Types, the permissions you can grant, and the 
common operations these permissions give access to: 

Repository 
Object Types 

Repository Object Type 
Permissions 

Permitted  Operations 

Repository Access Security Info Security Center: View settings 

Update Security Info Security Center: View and change settings 

Create Workspace Add Workspace 

Update Workspace Check Out Workspace, Check In Workspace 
Check Out Object(s), Check In Object(s) 
Undo Check Out Workspace, Undo Check Out Object(s) 

Delete Workspace Delete Workspace 
If you delete a workspace in Repository, the file itself remains on the 
local disk. 

Creating and managing users 
Managing users entails creating, changing, and deleting user account permissions and logins, and 
activating and deactivating their accounts. Using Roles, you can choose the permissions granted a 
user for the Repository item. 

NOTE:  To access, create, update, and delete user information, a Repository administrator 
must have Repository Object Type Permission, Access Security Info and Update 
Security Info privileges. 

Create, e dit, d elete, d eactivate, reactivate, and check in users 

1 Log in to the Repository. 
 

2 Click Repository > Security > Security Center. 
 

3 Click the Manage Users tab. 
 

4 On the Manage Users tab, you can manage users by clicking their name in the list and then 
clicking a management option and following the prompts as required. 

 
5 Continue making security changes and then click OK to exit the security center. 

 
6 To assign permissions to users, see  Assigning Users Roles for Accessing Repository Items. 

 
7 Notify users that they must log out and then log in again to receive the security updates. 

Notes 

• You cannot delete or deactivate the Admin user, but you should change the Admin password 
from the default, which is Admin. 

• The new user appears in the user list with a star indicating that this user does not yet have any 
roles assigned to it for any Repository items. 
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• Users must log out and log in again to receive any security updates. 

• The Admin does not need to know the user’s password to create a new password for the user. 

• The Admin can look to the Manage Users tab to find out which users are logged in to the 
Repository and whether or not they currently have items checked out. Knowing if users have 
items checked out is particularly useful when upgrading the Repository, because after before 
upgrading the Repository the users should check all their items in and then do a clean get 
and check out of the items when the upgrade is complete. Knowing which users are logged in 
is useful when changing security center settings because after making any setting changes, 
the Admin should request online users to log off and log in again to receive the security 
center updates. 

• The Administrator may want to deactivate a user to prevent the user from logging into the 
server while the Repository is being updated. Once deactivated the user must be reactivated 
before they can log in to the Repository. 

Granting and prohibiting user access to Repository items 
On the Repository Security tab of the Security Center, users with the appropriate privileges can 
assign other users the appropriate access privileges for different objects, granting them 
permission to perform specific operations on a Repository item and prohibiting them from 
performing other operations on the same object. 

Assigning u sers r oles for a ccessing Repository items 

1 Log in to the Repository. 
 

2 Click Repository > Security > Security Center. 
 

3 Click the Manage Roles tab; explore the available roles to determine if an existing role 
provides the access you want to grant the user. If necessary, create a new role with the 
appropriate permissions. 

 
4 To grant permission to access and update security information, or to view only workspaces, 

in the Repository Object pane, select Repository. 
 

To grant permission to update or delete an existing workspace, in the Repository Object 
pane, expand Repository  and select the name of a workspace. 

 
5 In the Available Users pane, click and drag a user name onto the name of the role you want 

to apply to the user for the Repository or for the selected workspace. 
 

6 Click Apply and then click OK to exit the Security Center. 
 

7 Notify users that the must log out and then log in again to receive the security updates. 

TIP:  To remove the role assignment of a user to a Repository item, click the Repository 
item, drag the user name from under role onto another role in the Available 
Roles area or drag the user name back to the Available Users pane. 
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Notes 

• A user can only have one role for each object. But a user can have different roles for different 
objects. 

• If a user is listed in the Available Users area, but is unselectable, the user has been 
deactivated and must be reactivated before you can modify the user. 

Prevent users from accessing specific Repository items 

The system-defined No Access role can prevent a user from accessing selected projects or 
diagrams 

 
1 Log in to the Repository. 

 
2 Click Repository > Security > Security Center. 

 
3 In the Repository Object area, navigate to and then click to select the workspace you want 

to secure from specific users. 
 

4 From the list of users in the Available Users area, click a user name or CTRL-click several 
names and then drag the users onto the No Access role in the Available Roles area. 

 
5 Repeat step 3 and step 4 as required to secure other diagrams and projects. 

 
6 Click Apply, continue changing security settings if required, and then click OK to exit the 

security center. 

Change user access to Repository items 

To change user access to Repository items, change the permissions of the role the user has for 
the Repository item or assign another role to the user for that particular Repository item. 

Working with objects in the Repository 
The Repository performs version control and allows other users to retrieve a copy of the 
workspace to view or edit on their local machines if they have permission. 

The Repository includes a robust features set for working with workspaces. Detailed procedures 
for using these features are provided in subsequent sections. 

• Adding a workspace to the Repository 

• Retrieving a Repository workspace 

• Getting the latest version of a workspace 

• Saving changed items to the Repository (Checking in) 

• Checking out Repository items 

• Discarding changes made to a checked out workspace 

• Deleting workspaces from the Repository 
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Adding a workspace to the Repository 
Using the Add Workspace operation you can add the active workspace to the Repository. 

NOTE:  You cannot add data model objects to the Repository without first adding the 
workspace containing them. 

1 Log in to the Repository. 
 

2 Click Repository > Workspace > Add Workspace. 
 

3 Enter a comment if you want to and then click OK to exit the dialog and complete the 
operation. 

When an object has been added to the Repository, the object icon changes to include a 
little database icon in the upper left-hand corner. 

Add to Repository 
 
 
 

Workspace Repository Workspace 
Checked In 

 

Retrieving a Repository workspace 
Retrieving a workspace in the Repository downloads a copy of the selected workspace from the 
Repository onto your local machine. If a local version of the workspace exists, the Get from 
Repository operation refreshes the local copy with the version from the Repository. 

NOTE:  Permissions assigned to your user account in the Repository Security Center 
determine what type of access you have to Repository objects. For more 
information, see  About  Repository Permissions. 

1 Log in to the Repository. 
 

2 Click Repository > Workspace > Get Workspace. 
 

3 In the Repository Get Workspace Selection dialog, scroll through the list of available 
workspaces, select the workspace you want, and then click OK. 

NOTE:  You can also get a workspace through the Welcome to ER/Studio Business 
Architect dialog that appears each time ER/Studio BA is started. 

Getting the latest version of a workspace 
The Get Latest Version function synchronizes the local version of the open workspace with the 
version in the Repository, copying the Repository version to local storage and overwriting the 
local copy. For example, if another user has changed the workspace since you last checked it in, 
you can get the latest version to update your local version after they submit their changes. 

• Click Repository > Workspace > Get Latest Version.
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Saving changed items to the Repository (Checking in) 
The check in process synchronizes the changes made to the local checked out item with the 
Repository version by updating the Repository version. 

The check in process lets you check in an object, such as a diagram or a model, when you are 
done working with it. 

Checking in objects 

When you check in an object, all object components are checked in as well. You can check in a 
newly created object, such as a model which you added to a checked-out workspace or you can 
check in multiple, selected objects simultaneously to the Repository. 

The procedure to check in an object into the Repository is basically the same for all object types. 

To check in a project, diagram or model 

1 Save the changes you have made to the workspace; click File > Save. 
 

2 Click the object you want to check in or CTRL-click several objects to check in more than 
one object. 

 
3 Right-click and then select Repository > Check In Object(s). 

 
4 Enter a comment in the Repository Check In Object(s) dialog and then click OK to start the 

check-in process. 

To check in a workspace 

1 Save the changes you have made to the workspace; click File > Save. 
 

2 Click Repository > Check In Workspace. 
 

3 Enter a comment in the Repository Check In Object(s) dialog and then click OK to start the 
check-in process. 

Checking out Repository items 
Checking out write enables items previously added to the Repository, such a workspace, project, 
diagram or model. The procedure to check out an item from the Repository is the same for all 
object types. 

If you have a workspace checked out, and have checked in some objects, you can check them 
back out using this procedure. 

To check out a project, diagram or model 
 

1 Open a Repository workspace; a workspace that was previously added to the Repository. 
 

2 Click the item you want to check out or CTRL-click several items to check out more than one. 
 

3 Select Repository > Workspace > Check Out Object(s). 
 

4 In the Repository Check Out Object(s) dialog, enter a comment if you want to and then 
click OK to start the check-out process. 

NOTE:  Checked out objects appear in the workspace explorer tree with a check mark in 
the top left-corner of the object icon. 
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To check out a workspace 

If the active workspace was previously added to or retrieved from the Repository, you can check 
it out. 

 
1 Open a Repository workspace. 

 
2 Select Repository > Workspace > Check Out Workspace. 

 
3 In the Repository Check Out Workspace dialog, enter a comment if you want to and then 

click OK. 

NOTE:  Checked out objects, including the workspace, appear in the workspace explorer 
tree with a check mark in the top left-corner of the object icon. 

Check Out of Repository 
 
 
 
 

Repository Workspace 
Checked In 

Repository Workspace 
Checked Out 

Discarding changes made to a checked out workspace 
If you have checked out a workspace, made changes to it, and want to undo all the changes you 
made you can undo the check out. 

 
1 Log in to the Repository and open the target workspace. 

 
2 To discard the changes, click Repository > Workspace > Undo Check Out Workspace. 

Deleting workspaces from the Repository 
The Delete Workspace operation lets you delete a workspace from the Repository. 

 
1 Log in to the Repository. 

 
2 On the Repository toolbar, click the Delete Workspace icon. 

 
3 In the Repository Delete Workspace Selection dialog, select the diagram to delete and 

then click OK. 

Notes 

• When you delete a Workspace from the Repository, the local copy of the Workspace is not 
deleted. 

• When deleting a workspace, the Repository leaves workspace data behind and marks it as 
deleted. If deleted, data is still present in the Repository but visible only when querying the 
Repository directly, not through ER/Studio BA. 
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Using business process modeling notations 
A Business Process Model is a visual representation of the flow of activities and their order of 
performance using a set of graphical elements that use shapes familiar to most modelers and 
business users. For example, activities are rectangles and decisions are diamonds. The result is 
having an easy-to-understand mechanism for creating business process models which produce 
complex business processes. 

The following example of a Business Process diagram shows the interaction between a customer 
applying for a loan and the bank/lender. 





222   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

USIN G  BUSINESS  PR OCESS  M O DELING  NOTA TIONS  >  B U SINESS  PR OCE S S  MOD E LING  ELEME N TS   

 

Business process modeling elements 
There are six different categories of Business Process Modeling Notation elements:  Events, 
Activities, Gateways, Connection Elements,  Swimlanes, and Artifacts. The following sections 
discuss all aspects of how you can use them in the application. 

ER/Studio BA offers business flow functionality when working with the elements of the diagram. 
As you place an element in the Diagram View it is validated against the BPMN specification. If a 
placement or link is invalid, based on the BPMN specification, you will get a warning dialog. 

Validating against BPMN specification 

When you  create a new model you can choose to validate the creation of certain elements and 
flows against the BPMN specifications. The validation checks compliance with the Business 
Process Modeling Notation specifications. For example, if validation is enabled and you draw a 
message flow from a start event to a task, you get a dialog stating that this is an invalid 
relationship. You can select one of three options to resolve the invalid notification: 

• Do not allow the relationship to be created. 

• Allow the relationship to be created. 

• Allow the relationship and do not validate future relationships against the BPMN 
specification. 

NOTE:  You can set a  preference to turn this feature off or on. 

Events 
An event is something that occurs during the course of a business process. These events affect 
the flow of the process and usually have either a trigger or a result, depending on the event. 
There are three types of Events based on when they affect the flow: Start, Intermediate, and End. 
The table below describes the event elements: 

Events Palette Icon Description 

Start Events 
 

 
 
 
 

Starts a process flow. In terms of a Sequence Flow, the Start Event starts the 
flow of the Process, so it won’t have an incoming Sequence Flow. A Start Event 
can have one of four Triggers that indicates how the Process starts: Message, 
Timer, Rule, and Link. 

Intermediate  
Events  

 
 

Happens during the course of a process event. The available triggers are 
Cancel, Compensation, Error, Link Message, Rule, and Timer. 

End Events 
 

 
 

Ends a process flow. The available results are: Cancel, Compensation, Error, 
Link, Message, and Terminate. 

Start events 

A Start Event indicates where a particular process starts. A trigger for a Start Event is designed to 
show the general mechanism that instantiates that particular process. Use Cases for each trigger 
type are discussed in the  Using the Start Event topic. 
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Using the Start event 

A process may begin with a start event. This start event can be normal (with no specified trigger) or 
have one of four different types of triggers. Principle characteristics of a start event are: 

• A Start Event is optional. 

• If a Process is complex and/or the starting conditions are not obvious, then it is recommended 
that a Start Event be used. 

• If there is an End Event, then there must be at least one Start Event. 

 
The table below describes the Start Event triggers that you can use to indicate what kind of start 
event is needed for the diagram: 

Element Palette Icon Description 

Start 
 

 
 

This is the normal start event without a specified trigger. 

Message  A message arrives from a participant and triggers the start of the Process. 

Timer 
 

 
 

A specific time-date or a specific cycle (e.g., every Friday at 10:00 a.m.) is set 
that triggers the start of the Process. 

Rule 
 

 
 

This type of event is triggered when the conditions for a rule become true. 

Link 
 

 
 

A mechanism for connecting the end of one Process to the start (or trigger) of 
another. 

Using the Start event message trigger 

When a message arrives from a participant it triggers the start of the process. For example a start 
event could be the receipt of a message that a repair is needed on a computer. 
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Using the Start event timer trigger 

If there is a timer trigger on a start event, the process is started whenever the timer reaches a 
specific time, date, or cycle. This timer trigger must be received or conditions must be fulfilled 
before the process can start. 

 

Using the Start event rule trigger 

A rule trigger indicates that a signal, sent from another process based on the satisfaction of a 
rule, should start the current process. This rule trigger must be received or conditions must be 
fulfilled before the process can start. 
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Using the Start e vent l ink t rigger 

A link trigger indicates that when a signal is sent from another process, the current process should 
start. This link trigger must be received or conditions must be fulfilled before the process can 
start. 

 

Intermediate events 

An Intermediate Event occurs between a Start Event and an End Event. It is an event that occurs 
after a Process has been started. It affects the flow of the process but does not directly terminate 
the process. Intermediate Events can be used to: 

• Show where messages are expected or sent within the Process, 

• Show delays that are expected within the Process, 

• Disrupt the normal flow through exception handling, or 

• Show the extra work required for compensation. 
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An example of one use of Intermediate Events is to represent exception or compensation 
handling. This is shown by placing an Intermediate Event on the boundary of a Task. The 
Intermediate Event can attach to any location of the activity boundary and the outgoing 
Sequence Flow can flow in any direction. Use Cases for each trigger type are discussed in the 
Using Intermediate Event Triggers topic. 

 

Using Intermediate event t riggers 

There are seven Intermediate Event Triggers and the table below displays the palette icon and 
description for each: 

Triggers Palette Icon Description 

Compensation 
 

 
 

Compensation is when activities are invoked that undo an undesirable outcome. 

Cancel 
 

 
 

This trigger is used within a Transaction Sub-process. This type of event must be 
attached to the boundary of a Sub- process. 

Error 
 

 
 

The trigger sets or catches errors. It sets an error if the Event is part of a Normal 
Flow. It reacts to a named error when attached to the boundary of an activity. 

Link 
 

 
 

Connects an End Event of one Process to an 
Intermediate Event in another Process. 

Message  A message arrives from a participant and triggers an Event. The Process 
then continues if it is waiting for a message, or changes the flow for 
exception handling. 

Rule 
 

 
 

This trigger is only used for exception handling. This event is triggered when 
a Rule becomes True. A Rule is an expression that evaluates some Process 
data. 

Timer 
 

 
 
 

A specific time-date or cycle is set that triggers an Event. It can act as a delay 
mechanism if used within the main flow. If used for exception handling, it 
changes the Normal Flow into an Exception Flow. 
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Using the Compensation Intermediate event 

A Compensation Association occurs outside the Normal Flow of the Process and is based upon 
an event (a Cancel Intermediate Event) that is triggered through the failure of a Transaction or a 
Compensation Event. The target of the Compensation Association must be marked as a 
Compensation Activity. 

Compensation Intermediate event u se case 

The following is a use case for how a compensation intermediate event would be implemented. 

A travel agent books a flight for a corporate client. The normal flow for the business process 
occurs as follows: 

• There is a start event (message) when a corporate client calls to book a flight. 

• The travel agent makes the necessary arrangements (a Book Flight task) and the flight is 
booked (end event). 

• However, the corporate client calls back and has to cancel. This is handled by an intermediate 
compensation event which “interrupts” the normal sequence flow to an outgoing directed 
association “flow” (compensation association). There is a rollback of travel arrangements 
(compensation activity) where the travel agent cancels the flight (a Cancel Flight task). 

NOTE:  Note that the Book Flight task cannot be compensated by a Cancel Flight task until 
the Book Flight task has been completed. The end result of this compensation is 
that the corporate client card is restored to an initial balance of $0.00, unless 
there are cancellation fees. 

 
The tasks in the above scenario could be replaced by a Book Flight sub-process (e.g., if there are 
several steps to booking a flight you may decide to create a sub-process, either embedded or 
independent) and a Cancel Flight sub-process. These would become compensated sub- 
processes if the intermediate compensation event is “invoked”. 

Placing an Intermediate Compensation e vent 

1 From the Business Process Objects Palette, click the drop-down arrow on the Intermediate 
Event node. 

 

2 Select the Compensation Intermediate Event icon ( ) and click the task that contains 
the event you want to compensate (or roll back). 

 
3 With the automatic connection feature you can then immediately draw an association link to 

the task containing the information for the roll back. A compensation marker is then 
automatically placed on the second task. 
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4 Press ESC to exit the multi-drop mode. 

NOTE:  The cursor changes from    to . 

Using the Cancel Intermediate event 

A cancel trigger can be attached to an intermediate event. The resulting event type is always 
attached to the boundary of a transaction action. It acts as a mechanism to interrupt this 
transaction action. 
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In the following example, when buying concert tickets online, if the payment succeeds the 
tickets are purchased. If the tickets are not paid, the payment action triggers a cancel action. 
This cancellation action also results in the Cancel Tickets action and the process ends. 

 

Using the Error Intermediate event 

The Process involving an error intermediate event begins with the receipt of a request for an 
online purchase. After a credit card verification, an online purchase is made. The purchase may 
take more than one attempt before it is successful. After the purchase is confirmed, a reply is sent. 
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Using the Link Intermediate event 

A link is a mechanism for connecting the end event of one process flow to the start event of 
another process flow. A link intermediate event can be used as an “Off-Page Connector” or as a 
“Go To object.” 

CAUTION:  If your off-page connectors need to be named the same, you must use the Off- 
page Connector icon instead of the Link Intermediate Event object. You cannot 
have two Link Intermediate Events with the same name on a diagram. 

Using the l ink as an off-page c onnector 

If a process model extends beyond the length of one printed page you can use a Link 
Intermediate Event to show how Sequence Flow connections extend across the page breaks. In 
the sample below, a pair of Link Intermediate Events is used; one at the end of page one and the 
second at the beginning of page two. This Event is named and has an incoming Sequence Flow 
and no outgoing Sequence Flow. The second Link Event shares the same name, and has an 
outgoing Sequence Flow and no incoming Sequence Flow. 
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Using l ink as a “Go To” object 

Link Intermediate Events can also be used is as “Go To” objects. They work the same as Off- Page 
Connectors, but can be used on the same page or across multiple pages. They reduce the length of 
Sequence Flow lines which may be hard to follow or trace. When it is used as a Go To object, the 
process continues as if the Sequence Flow had directly connected the two objects. The following 
diagram shows the “Go To” links used in place of a long Sequence Flow link from the first gateway 
to the Close Order task, thus simplifying the look of the diagram. 

 

Using the Message Intermediate event 

When placed within the diagram, a message event specifies that the process is waiting for a 
message in order to resume its activity. There are usually flow links before and/or after this event. 

 

Using the Rule Intermediate event 

The Rule Intermediate Event is triggered when the conditions for a rule become true during the 
execution of the process. This trigger can occur in the normal flow of the process or it can be 
attached to the boundary of an action or it can also be used in an event-based decision pattern. 
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The rule intermediate event is used for exception handling when a named rule becomes true. 
Because the rule intermediate event is only used for exception handling, it has to be placed on 
the edge of an activity, as it creates an exception flow. 

 

Using the Timer Intermediate event 

When placed on an activity, the timer event represents something that can occur during the 
execution of an activity. There is usually a link (flow or message) going out of the event to specify 
the action to perform if such an event occurs. 

1 Click the Timer Intermediate Event icon on the Business Process Modeling Notation 
palette. 

 
2 Click the task onto which you want to place the event. When you do this, the event then 

becomes part of the activity. 
 

The following example shows a timer event during an activity execution. 
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End events 

The End Event indicates where a process ends. You can define the consequences or results of 
reaching an End Event. The example below shows a simple online credit card application with an 
end message denoting that a message was generated at the end of a process. 

 
A use case for each End Event trigger is discussed in the Using the End Event topic. 

Using the End event 

If there is a start event, then there must be an end event. There are different results or 
consequences that happen when you reach an end result. 

The table below displays the palette icon and description for each End Event result: 

Result Palette Icon Description 

Compensation 
 

 
 

This End Event indicates that a Compensation is necessary. The 
Compensation identifier triggers an Intermediate Event when the Process 
is rolling back. 

Cancel 
 

 
 
 
 
 

The type of End Event is used within a Transaction Sub- process. It indicates 
that the Transaction should be canceled and triggers a Cancel Intermediate 
Event attached to the Sub-process boundary. It also indicates that a 
Transaction Protocol Cancel message should be sent to any Entities involved 
in the Transaction. 

Error 
 

 
 

A named Error should be generated. This Error is caught by an Intermediate 
Event within the Event Context. 

Link 
 

 
 

A Link is a mechanism for connecting the end of one process to the start of 
another. 

Message  A message is sent to a participant at the conclusion of the process. 

Terminate 
 

 
 

All activities in the Process should be ended immediately. The Process is ended 
without compensation or event handling. 

Using the Compensation End event 

This type of End Event indicates a Compensation is necessary. The Compensation identifier 
triggers an Intermediate Event when the Process is rolling back. 

At the end of a trip, a person checks out of a hotel using express checkout. Their bill has been 
delivered during the night and the person finds a charge for an extra day. Prior to departing the 
hotel the person goes to the checkout desk and asks for a refund. The clerk refunds the client’s 
credit card, rolling back the process by reimbursing the person. As express checkout was the end 
of the process (end event). A compensate end event with outgoing directed association “flow” 
(compensation association) to the original charge activity is necessary to rollback charges to the 
person’s credit card.
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Placing a Compensation End event 

Take the following steps to place a compensation end event: 

1. From the Business Process Objects Palette click the drop-down arrow on the End Event 

node . 

2. Select the Compensation End Event icon ( ) and click the task that contains the event 
you want to compensate for (or roll back). 

3. Press ESC to exit the multi-drop mode. 

NOTE:  The cursor changes from    to . 

Using the Cancel End event 

This End Event can only be used within a Transaction Sub-process and causes the cancellation 
of that Process. The process is ended with normal event handling. In the following example,  
the client did not pay for his tickets so the process was cancelled. 
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Using the Error End event 

The Error End Event indicates that a named Error should be generated. The following diagram 
shows the process for a consumer who wants to make a purchase with a credit card. If the credit 
card is invalid the process goes to an error end event. The desired behavior is a valid credit card 
which takes the flow to a task called “Charge Credit Card” and then to an end event. 

 

Using the Link End event 

There are points within a process where it is important to know whether a specific milestone has 
been met. The process model must be able to identify and react to the milestone. 

The example below shows how information can be passed from one part of a diagram to another 
part. In the diagram, paperwork must be completed in one sub-process before the paperwork in 
another sub-process can start. A Link End Event that follows the Payment Received Task is used to 
trigger a corresponding Link Start Event that precedes the first task in the second sub-process. 

 



236   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

USIN G  BUSINESS  PR OCESS  M O DELING  NOTA TIONS  >  B U SINESS  PR OCE S S  MOD E LING  ELEME N TS   

 

Using the Message End event 

A Message End Event finishes a process and sends a message to a participant. 

 

Using the Terminate End event 

The Terminate End Event indicates that all activities in the Process should be ended immediately 
even if there are tasks that have not started or are still active. This includes all instances of Multi- 
Instances. The Process is ended without compensation or event handling. The Terminate End 
Event symbol is placed where the cancellation should be signaled. 
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Activities 
An activity is work that a company performs and can be atomic or non-atomic (compound). The 
types of activities that are a part of a Process Model are: Process, Sub-process, and Task. 
Processes must be contained within a Pool. The table below displays the icon for each element 
with a description. 

Element Palette Icon Description 

Task  
 
 

This is an activity that is performed within a 
business process. 

Sub-processes 

Independent Sub- 
process  

 
 
 

An independent Sub-process element is an 
activity within a Process that calls to another 
process that exists within a business process 
definition diagram. 

Embedded Sub-process 
 

 
 
 
 
 

An Embedded (or nested) Sub-process is an 
activity that contains other activities (a 
Process). The Process within the Process is 
dependent on the parent Process for 
instigation and has visibility to the parent’s 
global data. No mapping of data is required. 

Task 

A task is an activity that is included within a Process. You use a Task when the work in the Process is 
not broken down to a finer level of Process Model detail. Generally, an end-user and/or an 
application are used to perform the Task when it is executed. The tasks can have different 
behaviors, however these behaviors are not indicated by any graphical indicators. 

To set a type for a task: 
 

1 Right-click on the tasks to open the Properties View. 
 

2 On the General tab, click the drop-down arrow in the Task type text box and select the type 
from the list. The additional properties that you can set change depending on the type 
selected. For example if you select “Service”, you can set the “In Message”, “Out Message” 
and “Implementation” properties. 

NOTE:  You can  convert a task to an Independent Sub-process or Embedded Sub-
process. 

There are seven different task types: 

Task Type Description 

Service A Service Task provides some sort of service such as a 
Web service or an automated application. 

Receive A Receive task waits for a message to arrive from an 
external participant. Once the message has been 
received, the Task is completed. A Receive Task is often 
used to start a Process. 
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Task Type Description 

Send A Send Task sends a message to an external participant. 
Once the message has been sent, the Task is completed. 

User This is a workflow task performed by a human with the 
assistance of a software application. It is scheduled 
through a task list manager of some sort. 

Script When the Task is ready to start, the engine executes a 
script written in a language that a business process 
engine can interpret. When the script is completed, the 
Task is also completed. 

Manual A Manual Task is expected to be performed without the 
aid of any business process execution engine or any 
application. 

Reference The Reference Task refers to another activity that has 
been defined with the exact same behavior. 

The table below describes the two types of markers for a Task: 

Element Icon Description 

Loop 
 

 
 
 

The attributes of Tasks and Sub-processes determine if 
they are repeated or performed once. There are two 
types of loops: Standard and Multi-Instance. The looping 
indicator is displayed at the bottom-center of the activity. 

Parallel Multiple 
Instance  

 
 

This refers to multiple instances of the activities. Activities 
that are Parallel Multi-Instance have a parallel marker 
placed in the bottom center of the activity. 

Converting a task 

When you right-click on a task you can select the Convert to command on the shortcut menu. You 
have two conversion options: Embedded Sub-process and Independent Sub-process. This 
command is useful if you want to break down a task into smaller parts or add more details/ 
subtasks. 

For example, in your design process you determined that your task will be “Load New Software 
on Computer”. You then decide you want to make the task more detailed requiring a sub- 
process where you can create tasks for each detail: (1) shop for best price on software; (2) 
purchase software; (3) verify compatibility; and (4) load software. 

When you convert a task the following characteristics apply: 

• A converted element is placed on the diagram in the same place as the task. 

• The converted task is renamed with the new element’s type default name. For example, if you 
are converting to an embedded sub-process, the converted element is named “embedded 
sub-process”. 

• When connecting objects are anchored to the task, they are not moved and after the 
conversion and retain their connection point. 

• You will get a warning dialog if the conversion breaks any validation rules. 

• Object formatting attributes are retained after the conversion. 

• Elements retain their same size after the conversion. 
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Sub-processes 

A Sub-process extends the set of common activity attributes. The two different sub-processes 
are embedded and independent. 

The Sub-process can be in a collapsed view that hides its details or it can be an expanded view 
that shows its details within the view of the Process in which it is contained. In the collapsed 
form, the Sub-process element uses a marker to distinguish it as a sub-process, rather than a 
Task. The first graphic shows a collapsed sub-process. The second graphic shows the Embedded 
Sub-process expanded. 

 

 

Embedded s ub-process 

An Embedded (or nested) Sub-process element is an activity containing other activities (a 
Process). The Process within the Process depends on the parent Process for instigation and has 
visibility to the parent’s global data. No mapping of data is required. The elements within the 
Embedded Sub-process, being dependent on their parent, do not have all the features of a full 
Business Process Diagram, such as Pools and Lanes. So an expanded view of the Embedded 
Sub-process only contains Events, Activities, connecting elements, and Artifacts. 

NOTE:  When an Embedded Subprocess is placed in the Diagram View, the label 
appears vertically centered. Once you add a child element, the label is then 
relocated to the top center of the Embedded Subprocess. 
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There are six types of standard markers for Embedded Sub-processes, including the Standard 
marker. The (Collapsed) Sub-process Marker, can be combined with four other markers: a Loop 
Marker or a Parallel Marker, a Compensation Marker, and an Ad Hoc Marker. A collapsed sub- 
process may have one to three of these other markers, in all combinations except that the Loop 
and Multiple Instance cannot be shown at the same time. 

The table below briefly describes each embedded sub-process: 

Element Palette Icon Description 

Standard 
Embedded Sub- 
process 

 
 
 
 
 
 

A Sub-process hides its flow details. The Collapsed Sub-process element uses a 
marker to distinguish it as a Sub- process, rather than a Task. The marker is a 
small square with a plus sign (+) inside. 

Ad Hoc 
Embedded Sub- 
process 

 
 

 
 
 
 
 
 
 
 
 
 

An Ad Hoc Process is a group of activities that have no pre-definable 
sequence relationships. 
Activities within the Process are disconnected from each other. During 
execution of the Process, any one or more of the activities may be active and 
they can be performed in almost any order or frequency. 

Loop 
Embedded Sub- 
process 

 
 
 
 
 
 
 

The attributes of Tasks and Sub- processes will determine if they are repeated 
or performed once. There are two types of loops: Standard and Multi- Instance. 
A small looping indicator is displayed at the bottom- center of the activity. 

Multiple 
Instance 
Embedded Sub- 
process 

 
 
 
 
 

The attributes of Tasks and Sub- processes determine if they are repeated or 
performed once. A small parallel indicator is displayed at the bottom-center 
of the activity. 

Transaction 
Embedded Sub- 
process 

 
 
 
 
 
 
 
 
 

A Sub-process, either collapsed or expanded, can be set as being a 
Transaction, which has a special behavior that is controlled through a 
transaction protocol (such as BTP or WS-Transaction). The boundary of the 
activity is double-lined to indicate that it is a Transaction. 

NOTE:  To select multiple elements in the Embedded Subprocess, hold down the ALT 
key to invoke the  marquee cursor. 

Independent s ub-process 

An Independent Sub-process element is an activity within a Process that “calls” to another 
Process that exists within a separate diagram. The Process that is called is not dependent on the 
Independent Sub-process’ parent Process for instantiation or global data. The called Process is 
instantiated when called, but it can be instantiated by other Independent Sub-process elements 
(in other diagrams) or by a message from an external source. The Independent Sub-process 
element may pass data to/from the called Processes. 

When an Independent Sub-process (ISP) is created (either in the Model View tree or dropped in 
the Diagram view), a new diagram with an associated pool and lane are created at the model 
level. The default name of the ISP will be the default name of the Independent Sub-process 
element (e.g. Independent Sub-Process). 

There are six types of standard markers for Independent Sub-processes, including the Standard 
marker. The (Collapsed) Sub-process Marker, can be combined with four other markers: a Loop 
Marker or a Parallel Marker, a Compensation Marker, and an Ad Hoc Marker. A collapsed sub- 
process may have one to three of these other markers, in all combinations except that the Loop 
and Multiple Instance cannot be shown at the same time. 
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The table below briefly describes each independent sub-process: 

Element Palette Icon Description 

Standard 
Independent 
Sub-process 

 
 
 
 
 
 

A Sub-process hides its flow details. 
The Collapsed Sub-process element 
uses a marker to distinguish it as a sub- 
process, rather than a Task. The marker 
is a small square with a plus sign (+) 
inside. 

Ad Hoc 
Independent 
Sub-process 

 
 

 
 
 
 
 
 
 
 
 
 

An Ad Hoc Process is a group of 
activities that have no pre-definable 
sequence relationships. 

 
 
Activities within the Process are 
disconnected from each other. During 
execution of the Process, any one or 
more of the activities may be active 
and they can be performed in almost 
any order or frequency. 

Loop 
Independent 
Sub-process 

 
 
 
 
 
 
 

The attributes of Tasks and Sub- 
processes will determine if they are 
repeated or performed once. There are 
two types of loops: Standard and 
Multi- Instance. A small looping 
indicator is displayed at the bottom- 
center of the activity. 

Multiple 
Instance 
Independent 
Sub-process 

 
 
 
 
 

The attributes of Tasks and Sub- 
processes determine if they are 
repeated or performed once. A small 
parallel indicator is displayed at the 
bottom-center of the activity. 

Transaction 
Independent 
Sub-process 

 
 
 
 
 
 
 
 
 

A sub-process, either collapsed or 
expanded, can be set as being a 
Transaction, which has a special 
behavior that is controlled through a 
transaction protocol (such as BTP or 
WS-Transaction). The activity has a 
double border to indicate that it is a 
Transaction. 
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Gateways 
A Gateway controls the divergence and convergence of the Sequence Flow. It determines 
branching, forking, merging, and joining of paths. Basically it is a question that is asked at a point 
in the flow. This question has a defined set of alternative answers. 

Element Palette Icon Description 

Gateway 
 

 
 
 
 
 
 

This symbol displays decisions, merges, forks, and joins in the process flow. It 
controls how Sequence Flows interact as they converge and diverge within a 
process. You can set the Gateway Control Types of a gateway and change the 
logic specified by it. 
There are two different ways to set the Gateway’s control types: from the 
palette, or on the Model View. 

Placing gateways using the palette 

1. Click Gateway in the Business Process Objects Palette to expand the node. 

2. Click the gateway with the control type you want to use from the expanded node. 

3. Click once in the Diagram View and the selected gateway is placed in the diagram. 

NOTE:  Notice that the selected gateway also appears in the Model View tree with the 
appropriate icon designating the control type. 

Placing gateways using the Model view 

1. Right-click the lane name where you want to place the gateway. 

2. Select New and then select Gateway from the list of available elements and a gateway 
node is placed in the Model View tree. 

3. Double-click the gateway node and the Gateway Properties View opens. 

4. In the Type list box select the control type you want to use from the type drop-down list 
and click OK. The gateway node icon changes to represent your control type. 

NOTE:  You can then drag the gateway node from the Model View tree on to the 
Diagram View. 
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Gateway control types 

You can set control types for gateways. A control type changes the logic and also the symbol it 
represents. The table below lists all the available control types for a gateway. 

Control Type Icon Explanation 

Data-Based 
 

 

 

These are the most common gateways used. A data token 
traverses the Process Flow arriving at the gateway. It can only 
go out on one flow. This control type is represented by either a 
diamond with an “x” in the middle or blank diamond shape. 

Event-Based 
 

 
 
 
 
 

Decision: This represents a branching point where the 
alternatives are based on an event occurring at that point. 

Merge: The exclusive merge models data-based or event- 
based merges. Only one of the many inputs is chosen as the 
output. 

Inclusive 
 

 
 
 
 
 

Decision: One or more of the outgoing Sequence Flows may 
be taken. A default flow must be specified at this point, there 
cannot be zero output flows. 

Merge: A process flow continues when it receives the first 
input signal from the input Sequence Flow. If other signals 
arrive after that, they are not used. 

Complex 
 

 

 
 
 
 

Decision: This expression determines which output flow is 
taken from multiple Sequence Flow names. 

Merge: You specify a complex flow condition referencing 
incoming Sequence Flow names or process data coming into a 
gateway. This expression determines when the task starts. 

Parallel 
 

 
 
 

Fork: All Sequence Flows out of this gateway are taken. 

Join: This gate must receive input signals from all input 
Sequence Flows. The process flow does not continue until it 
receives all signals. 

Using data-based gateways 

The Data-Based Decision is a branching point where the alternatives are based on conditional 
expressions contained within the outgoing Sequence Flow. Only one of the Alternatives is 
chosen. 
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In the following graphic, there are three alternative tasks that may be performed. The decision 
on which task is performed is based on the Boolean expression contained in the Condition 
Expression attribute of the outgoing Sequence Flow of the Gateway. The expression uses the 
values of process data to determine which path is taken. 

 

Using event-based gateways 

An Event-Based decision represents a branching point where the alternatives are based on an 
event that occurs at that point in the Process. The specific Event, such as the receipt of a 
Message or a Timer event, determines which of the paths will be taken. Only one of the 
Alternatives is chosen. The following example shows an event-based gateway using message 
events. 
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Using inclusive gateways 

Inclusive gateways provide more than one possible outcome. There is usually a corresponding 
merging inclusive gateway. The following example shows a number of chapters in a book that 
may be included in a book. 

 
Using complex gateways 

A Complex Gateway is used to handle situations that are not easily handled through the other 
types of Gateways. Complex Gateways can also be used to combine a set of linked simple 
Gateways into a single, more compact situation. Complex behavior can be defined for both the 
merging and splitting behavior. 
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Using parallel gateways 

Parallel Gateways are places in the Process where multiple parallel paths are defined. Events on 
parallel outcome paths execute simultaneously and independently of each other. You can create 
a decision point that directs the process flow down multiple flows so activities are executed in 
parallel (instead of executing in sequence). These flows can then be reunited into a single flow to 
complete the task. The process execution waits until the last task in each parallel flow has been 
completed. The following example shows two parallel gateways. The task following the second 
gateway is executed only after all the parallel paths are completed. 

 

Connection elements 
There are three ways of connecting Events and Activities to each other or to other information: 
Sequence Flow, Message Flow, and an Association. You can gain access to the Property View for 
each connection element by double-clicking the relationship element in the diagram. 

The table below describes the link types displayed on the Business Process Objects Palette: 

Connection 
elements 

Palette Icon Description 

Sequence Flow  
 
 
 
 
 

A sequence flow shows the sequence of processes in an organization. You can 
use the sequence flow lines to connect events, processes, and gateways in 
pools or lanes. The Sequence Flow has three different designations that can be 
set using the Sequence Flow Property View. 
Double-click the Sequence Flow to open the Sequence Flow Properties 
dialog. 

Message Flow 
 

 
 

Shows the model order of processes between organizations (i.e. between 
pools). 

Association  
 
 

An Association is used to associate information and artifacts with events and 
activities. 
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Sequence flow 

A Sequence Flow shows the sequence of processes in an organization or department. When 
you use pools or lanes in your diagram, you use Sequence Flow lines to connect events, 
activities, and gateways within the pools or lanes. The Sequence Flow is represented as a line 
with a filled- in arrow head. 

 
There are five different types of sequence flows and you can change a sequence flow type: 

Type Flow_Type_Examples Description 

Normal Flow  
 
 
 

This is the flow originating from a Start Event and continues 
through activities via alternative and parallel paths until ending at 
an End Event. 

Uncontrolled Flow  
 
 
 
 
 
 
 
 
 
 
 

This flow is not affected by any conditions and does not pass 
through a Gateway, for example a single Sequence Flow 
connecting two activities. An Uncontrolled Flow can also apply to 
multiple Sequence Flows converging or diverging from an activity. 
For each uncontrolled Sequence Flow, a “Token” flows from the 
source element to the target element. 

Conditional Flow 
 

 
 
 
 
 
 
 
 
 

A conditional flow is evaluated at runtime to determine whether or 
not the flow is used. If the conditional flow is outgoing from an 
activity, then the Sequence Flow has a mini-diamond at the 
beginning of the line. If the conditional flow is outgoing from a 
Gateway, then the line does not have the diamond. 

Default Flow  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For Data-Based Exclusive Decisions or Inclusive Decisions, one 
type of flow is the Default Condition flow. This flow is used only if 
all other outgoing conditional flows are not true at runtime. These 
Sequence Flows have a diagonal slash added to the beginning of 
the line. 
You would add a Default Conditional Flow marker to a Sequence 
Flow for two types of decision: Data-based Exclusive and Inclusive 
Decisions. This flow is used only if all the other outgoing 
conditional flows are not true at runtime. 

Exception Flow 

 
 
 

Exception Flows occur outside the normal flow of the Process and 
it is based upon an Intermediate Event that occurs during the 
performance of the Process. 



USING  BUSINESS  P R OCESS  MO DELING  NOTA TIONS  >  BUSINESS  PR OC ESS  MO DELING  ELE M E N TS  

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 
 

253   

 

 

Changing the type of flow marker 

1. Double-click the Sequence Flow that you want to change to a default flow marker and the 
Properties dialog opens. 

2. Click the drop-down arrow in the Condition Type box and select Default from the list. 

3. Click OK. The Properties dialog closes and the marker is added to the sequence flow. 

Message flow 

Message Flows are used to show the flow of messages between two participants that are 
prepared to send and receive them. A Message Flow can connect directly to the boundary of a 
pool or it can cross the boundary of a pool and connect to an object within that pool. Also, if 
there is an Expanded Sub-Process in one of the Pools, then the Message Flow can be connected 
to either the boundary of the Sub-Process or to objects within the Sub-Process. The following 
example shows a Message Flow across the boundary of a pool. 

 

Association 

An Association is used to associate information with events and activities. It can be used to 
associate reference objects, external data objects, shapes, and activities with textual information. 
You can also use an Association to associate Data Objects with other objects. 

There are four different Associations available: 

• Association ( ) 

• Association to Target ( ) 

• Association From Target ( ) 

• Association To/From Target ( ) 

The selection you make is reflected on the beginning and ending indicator on the Association. 
You can set global preferences for all the line display options in the Preferences. 
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The example below shows an Association connecting a Data Object with two tasks. 

 

Swimlanes 
You can group primary modeling elements by using swimlanes which consist of pools and lanes. 
A Pool represents a participant in a process. It also acts as a graphical container for partitioning 
a set of activities from other Pools, usually in the context of Business-to-Business (B2B) 
situations. 

A Lane is a subpartition within a Pool and extends the entire length of the Pool. Lanes are used 
to organize and categorize activities. 

The table below describes the types accessible from the Business Process Objects Palette: 

Swimlanes Palette 
Icon 

Description 

Pools (Horizontal)  
 
 
 
 

 
 
 
 

Horizontal Pool: This pool is drawn as a rectangular region placed 
horizontally. A lane is a subpartition within a pool and extends the entire 
length of the pool. A pool represents an organization, function, application, 
class, or an entity. 

Vertical Pool: This pool is drawn as a rectangular region placed vertically. It 
has the same characteristics as the horizontal pool. 

Lanes  
 
 
 
 
 

Lanes organize and categorize activities. When you place a process in a pool 
or lane you specify who is doing what. If you place an event in a lane you 
specify where that event occurs. When you place a gateway in a lane you 
specify where a decision is made or who makes it. 

Nested Lane  
 
 

You can insert lanes within lanes. 
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Pools 

A Pool represents a participant in a Processes. It is also called a “swimlane” and is a graphical 
container for partitioning a set of activities from other pools. The activities within separate Pools 
are considered self-contained Processes. When this is true, the Sequence Flow may not cross the 
boundary of a Pool. A Message Flow is the mechanism to show the communication between two 
participants, and is the connection used between Pools. 

 
When you create a pool in ER/Studio BA, a lane is created at the same time. If Validation is 
turned when you create the project, the lane is not labeled. 

 
A pool can be shown as a “White Box” with all the details of the activity in the pool exposed. A 
“Black Box” hides all of a pool’s activities. No Sequence Flow is associated with a black box, but 
a Message Flow can attach to its boundaries. The default display for a pool is as a white box. 

NOTE:  When all lanes are removed from a pool it becomes a black box pool. The pool 
header label remains, but the lane area is hidden. 
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Processes 

When creating a pool and lane, visible or invisible, when elements are dropped in the lane (or 
diagram), the elements appear at the same level as the lane in the Model View. 

 
However, in the Business Process Modeling Notation specification, all elements in a pool are 
owned by a process. This process is not shown by default in the Model View tree. However, it 
can be displayed by setting the Processes Preference. 

 

Lanes 

A Lane is a subpartition within a pool. Lanes organize and categorize activities. Lanes are often 
used to separate the activities associated with a specific company function or role. A Sequence 
Flow may cross the boundaries of Lanes within a Pool, but a Message Flow may not be used 
between events and activities in Lanes of the same Pool or between the lanes of the same Pool. 

When you click a lane in a pool, selection handles appear on the selected lane. 
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You have many ways to insert lanes in pools. You can also resize lanes, create nested lanes, 
reorder lanes in pools, delete lanes from pools, and remove lanes from pools. 

NOTE:  To select multiple elements in the Lane, hold down the ALT key to invoke the 
marquee cursor. 

Inserting lanes in pools 

In ER/Studio BA when you create a pool, one lane is also created in that pool. There are several 
different ways to insert additional lanes in a pool: (1) from the diagram shortcut menu; (2) from 
the palette; (3) from the Model View tree; and (4) using the insert key. You can also create nested 
lanes. 

Inserting lanes in a pool using the Diagram shortcut menu 

1. Right-click in the pool header and the shortcut menu opens. 

2. Click Insert Lane and if it is a horizontal pool, it is inserted at the bottom. If it is a vertical 
pool, it is inserted on the right. 

Inserting lanes by an existing lane using the Diagram shortcut menu 

1. Right-click in a lane and the shortcut menu opens. 

2. Click Insert Lane. If it is a horizontal pool you can choose to insert the new lane above or 
below the selected lane. If it is a vertical pool you can choose to insert the new lane to the 
left or right of the selected lane. 

Inserting lanes from the Business Process Objects palette 

1. From the Palette, click the Lane icon ( ). 

2. When you place the cursor in a pool or lane an indicator appears. This thick double-line 
indicates where the lane will be dropped (above or below selected lane). In the following 
example the new lane is inserted below the BPPool lane. 
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Inserting a lane from pool node in the Model view 

You can create a lane in a pool from the pool node in the Model View tree. 

1. Right-click the pool node in the Model View tree. 

2. Select New > Lane. If it is a horizontal pool, a lane is added to the bottom of the pool. If it 
is a vertical pool, the lane is added to the right of the pool. 

You can also create a lane from a lane node in the Model View tree. 

1. Right-click the lane node in the Model View tree and select New > Lane. 

2. Then select either Above or Below from the pull-right menu. If it is a horizontal pool, a lane 
is either added above or below the selected lane, or to the left or right of the selected 
lane. 

NOTE:  In the Model View tree hierarchy, the lanes are always placed above or below the 
selected lane based on your choice of location. 

Inserting a lane using the Insert key 

1. Select a pool or lane. 

2. Press the Insert (INS) key. 

o If pool is selected (in a diagram), and you press the Insert key, the new lane is added 
to the bottom or to the right. 

o If a lane is selected (in a diagram), and you press the Insert key, the new lane is added 
to the top (above) or to the left. 

Creating a nested lane 

You have two different ways to create a nested lane: 

• Right-click in an existing lane and select Insert Lane > Within Lane. 

• Select the Nested Lane icon ( ) from the Business Process Objects palette and click once 
in an existing lane. 

Resizing lanes 

You can resize lanes by selecting the selected lane's border on the diagram and dragging. The 
resizing function has the following characteristics/restrictions: 

• You can set a preference so the pool size will adjust when resizing lanes. 

• You can resize individual lanes. 

• When sizing the pool the minimum size limits on all of the lanes are respected (i.e. the 
minimum size of the pool is the sum of the minimum size of the child lanes.) 

• When showing/reshowing hidden lanes, the size of existing lanes within a given diagram 
does not change. Newly added lanes are the default lane size and can increase the size of 
the pool by the size of the lane, as required.
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Resizing a lane 

1. Select the lane to be resized. 

2. Place the cursor on the top or bottom (horizontal pools) or the left or right (vertical pools) 
lane selector indicators. 

NOTE:  Note that the cursor changes from the move cursor ( ) to the resize cursor  
( ) 

 
3. Drag the cursor to resize the lane or pool to the desired size. 

Reordering lanes in pools 

You can reorder the lanes in a pool either in the diagram or in the Model View tree. 

NOTE:  You can only reorder lanes within its own pool. You cannot move lanes from one 
pool to another. 

Reordering lanes in a diagram 

There are two different ways to order lanes in the diagram: (1) dragging the lane to a new 
position within the pool; or (2) using the Move Lane dialog.
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Using the drag method 

1. Click the lane or lanes you want to move. The selected lane now has selection handles. 

NOTE:  Select multiple lanes by pressing Ctrl and then clicking the lanes you want to 
move. 

2. While holding down the mouse button, drag the lane its new position. Notice that the 
order of the lanes in the Model View tree reflects the change you just made in the diagram. 

When you are reordering the lanes in a pool an indicator appears. This thick line indicates 
where the lane will be dropped (above or below selected lane). In the following example 
the new lane is placed above the lane labeled THREE. 

 

Using the Move Lane dialog 

1. In the diagram select the lane or lanes you want to reorder. 

NOTE:  Select multiple lanes by pressing Ctrl and clicking the lanes. 

2. Right-click the selected lane(s) and click Move Lane on the shortcut menu. The Move Lane 
dialog appears. 

 
3. From the list of lanes, select the lane you want to move the lane before and click OK. 
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Reordering lanes in the Model view tree 

There are two different ways to order lanes in the Model View tree: (1) dragging the lane to a 
new position within the tree; or (2) using the Move Lane dialog. 

Using the Drag method: 

1. Select the lane or lanes you want to reorder. 

NOTE:  Select multiple lanes by pressing Ctrl and then clicking the lanes you want to 
move. 

2. Drag the lane or lanes to its new position in the tree. A horizontal indicator displays where 
the moved lane will be inserted. In the example below, lane ONE is moved to just below 
lane THREE. 

 

Using the Move Lane dialog 

1. In the Model View tree select the lane or lanes you want to reorder. 

NOTE:  Select multiple lanes by pressing CTRL and clicking the lanes. 

2. Right-click the selected lane(s) and click Move Lane on the shortcut menu. The Move Lane 
dialog opens. 

 
3. From the list of lanes, select the lane you want to move the lane before and click OK.
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Deleting lanes from pools 

You can delete lanes from pools in either the Model View tree or the diagram. This command 
deletes the lane, and all elements in the lane, from the Model View tree and the diagram. The 
deleted lane and elements are eliminated from the metamodel and are not available on the 
clipboard. 

NOTE:  There must always be at least one lane in the pool. You cannot delete all of the 
lanes or the last lane in a pool. 

Deleting a lane from a pool in the Model view 

1. Right-click the lane node you want to delete in the Model View tree and select Delete. 

OR 

Select Edit > Delete from the main menu.  

OR 

Press the Delete key. The Delete Elements dialog opens. 

NOTE:  You can also delete multiple lanes. Select a lane node and while holding down 
the CTRL key, select the other lanes you want to delete. 

2. Click Yes to delete the lane from the pool. 

NOTE:  You can delete a lane or multiple lanes from the Model View tree when the 
diagram is closed. 

Deleting a lane from a pool in a diagram 

1. Select the lane you want to delete 

2. Right-click in the lane and select Edit > Delete. 

OR 

Select Edit > Delete from the main menu. OR 

Press the Delete key. 

NOTE:  You can also delete multiple lanes. Select a lane and while holding down the 
CTRL key, select the other lanes you want to delete. 

3. From the Delete Elements dialog, click Delete and the selected lane is deleted from the 
pool. 
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Removing lanes from pools 

You can remove all lanes from a pool or remove just one or more lanes. 

Removing all lanes from a pool 

You can remove (hide) lanes from a pool in the diagram including the last lane. If the last lane is 
removed, the pool is then a “Black Box” pool. 

1. Select the pool you want to remove the lanes from. 

2. Right-click in the pool and select Remove All Lanes (Black Box). 

NOTE:  When a pool becomes a black box pool, the relationships between items inside 
the pool and other entities are hidden. 

3. To show all lanes right-click in the pool and select Show All Lanes. 

NOTE:  If you have the Validation option set to On, when there is only one lane, then that 
lane shares the name of the Pool and only the Pool name is displayed. 

Removing one more lane from a pool in the diagram: 

1. Select the lane(s) you want to remove. 

2. Right-click in the lane and select Edit > Delete. 

OR 

Select Edit > Delete from the main menu.  

OR 

Press the Delete key. 

3. From the Deleting Elements dialog, click Remove and the selected lane is removed from 
the pool on the diagram. 

 
4. To show the removed lane(s) right-click the pool and select Show All Lanes.
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Artifacts 
Artifacts provide additional information about the business process. Using artifacts allows you 
to add non-standard elements to satisfy a specific need. Since you do not want to alter the 
basic look-and-feel of a diagram, you can use artifacts to link to the existing events and 
activities through Associations. Artifacts do not affect the basic Sequence Flow or Message 
Flow, nor do they affect mapping to execution languages. 

NOTE:  If you are entering text in an annotation element, the autotype text box is closed by 
pressing Enter. 

The current set of artifacts includes: data objects, groups, and annotations. The table below 
describes the artifacts available from the Business Process Objects Palette: 

Artifacts Palette 
Icon 

Description 

Data Object 
 

 
 
 
 
 
 
 
 
 

Data objects provide information about how documents, data, and other 
objects are used and updated in a Process. They represent data so are defined 
by a combination of entities or classes. 
Data Objects are Artifacts because they do not directly affect a Sequence 
or Message Flow. They provide information on what activities are required 
or what they produce. 

Group 
 

 
 
 
 
 
 

Use the Group symbol to visually organize activities. 
A Group is represented by a rounded corner rectangle drawn with a dashed 
border. The grouping can be used for documentation or analysis purposes, but 
does not affect the Sequence Flow. 

Annotation 
 

 
 
 
 
 

Textual annotation allows you to provide additional facts and details about 
an element. 
Text Annotations are used to provide additional information for the elements 
of a diagram. 

Off-Page 
Connector  

 
 
 

If a process model extends beyond the length of one printed page you can 
use an Off-Page Connector to show how Sequence Flow connections extend 
across the page breaks. 
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Using conceptual modeling notations 
Conceptual modeling is used by enterprise architects, business users, and data architects to 
model high-level business concepts and subject areas. A common usage of a Conceptual Model 
is to relate this model to a Logical Data Model. However, it could include other elements like 
data flow, process, or information assets in addition to more abstract interactions between 
business ‘things’, for example, areas of a business and their associations. 

The example below shows a basic, high-level conceptual diagram. The main subject area is “US 
Consumer Banking” and is made up of three other subject areas: “Lending”, “Online Banking”, 
and “Securities”. 

 
You can add additional information for each subject area for this high-level diagram. For 
example, you could expand the “Lending” subject area to view the Business Entities and their 
attributes. 
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Conceptual model elements 
The table below lists the objects used in creating conceptual models. 

Artifact Palette Icon Description 

Subject Area 
 

 

 
 
 
 
 
 

A Subject Area is an abstraction of a particular functional area identified in 
some manner by the business, for example a Sales Organization or Customer. 
It can also be a functional application area (CRM system, etc.). It can be 
visualized as a model object and/or used as a grouping mechanism 
containing other business entities. 

Business Entities 
 

 
 
 
 
 
 

Represents a core “object” of the business. Similar in concept to a logical entity 
in Logical Data Modeling, but at a higher level of abstraction. The audience is 
often the business user, not a technical data architect. Business Entities are 
used by data modelers and business users to get basic requirements and 
descriptions from the business. 

Business  
Attributes  

 
 

The properties of a business entity, for example, an employee identification 
number. 

Interaction  
 
 
 
 

Interactions represent an action, process, or transaction between two objects. 
For example, “Customer” ->  “Reviews Status of” -> “Orders”. They are often 
expressed as action verb phrases. 
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Artifact Palette Icon Description 

Relationship  
 
 
 
 
 
 
 
 
 
 
 
 

A relationship between two things representing a loose coupling or 
association. This is only supported between like object types, for example a 
Business Entity to a Business Entity. There are four different types of 
relationships available: Generic, Many-to-Many, Many-to-One, and One- to-
Many. 
You will get an error message if you attempt to create a relationship between a 
subject area and a business entity. 

Group 
 

 
 

Use the Group symbol to visually organize elements. 

Subject area 
Conceptual Modeling allows Business Users to create high-level designs of the core “concepts” 
and subject areas that drive the business, which can be passed onto data and process modelers 
to drive more detailed logical and physical design. A Subject Area can reference a collection of 
entities. You can embed the entities in the Subject Area, or you can have the Subject Area 
reference a diagram with multiple entities. 

• A Subject Area can be Create Mapping/Edit Mapping to other Conceptual Model diagrams. 

• The Subject Area presentation element in the Diagram View can be shown as an oval or a 
rectangle. You can set this as a global preference. You can also set the shape for each 
individual Subject Area in its Property View. Double-click on a Subject Area, select the 
Appearance tab in the Property View and then make your selection under the Shape option. 

• Subject Areas can be expanded or collapsed. You can then view or hide Business Entities or 
other Subject Areas within the parent Subject Area. Right-click in a Subject Area in the 
Diagram View and select Show as Expanded. This is a toggle command. 

• You can also elect to hide or show the expansion control in the Subject Area in the Diagram 
View. Right-click the Subject Area and select Show Expansion Control. Depending on the 
state of the element (expanded or contracted), a plus or minus symbol is placed in the 
bottom center of the Subject Area. This is a toggle command. You can also choose to show 
or hide the expansion control as a global preference. 

• When a Subject Area is placed in the Diagram View, the label appears vertically centered. 
Once you add a child element the label is then relocated to the top center of the Subject 
Area. 

• Once other Subject Areas have been placed within a Subject Area, these child items appear 

on the Impact Analysis tab under the “Heritage” ( ) heading. You can view this Impact 
Analysis Report in the Property View for the Subject Area. 

NOTE:  When a Business Entity is placed within a Subject Area, this is a mapping action and 

appears under the Mappings ( ) heading in the Impact Analysis Report.
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• The following example shows a simple, expanded Subject Area with three Business Entities. 
Business Entities contain Business Attributes which are properties of that entity. 

 
NOTE:  To select multiple elements in the Subject Area, hold down the ALT key to invoke the 

marquee cursor. 

Create mapping 

You can create mappings for Subject Areas to conceptual models, diagrams, and business 
entities. You can also map to business process model diagrams. A Subject Area can reference a 
collection of entities in a diagram, or specific individual entities. When a Conceptual model is 
exported to ER/Studio DA, the Subject Area will be an ER submodel, and all the referenced 
entities will appear under that submodel. 

 
NOTE:  All individual entities in a submodel are mapped, not just the model diagrams. 

Also, you can create an Interaction mapping to a Business Process diagram. An interaction 
represents an action, process, or transaction between two objects. Mapping an interaction to a 
Business Process diagram provides a quick and easy way to view the mapped diagram. 

Once you have created a mapping you can view,  edit, or  delete it.
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Creating s ubject a rea m appings 

To create references from a Subject Area, use the Mapping functionality. There are three ways to 
map: 

 
Right-click the Subject Area node that you want to map in either in the Model View tree or 
in the Diagram View and select Create Mapping. 

 
OR 

 

In the Subject Area Property View, select the Mappings tab and click , and the Create 
Mapping dialog opens. 

 
NOTE:  Only the first level business entity is selectable. All nested business entities (i.e., 

business entity within a business entity) are grayed out and cannot be selected. When 
you select a top level business entity all child business entities are selected as well. You 
cannot map only to a nested (or child) entity. Once you have mapped a business entity, 
you cannot delete only the nested entity. You must delete the first level business entity 
which includes the nested entity. 

 

 
OR 

 

Drag and drop Business Entities into a Subject Area. When you drag a Business Entity on a 
diagram into a Subject Area on a diagram, all contained entities are automatically mapped. 

Creating interaction mappings 

To create references from an Interaction to a Business Process diagram, use the Mapping 
functionality. There are two different ways to map. 

 
1 Right-click the Interaction node that you want to map in either in the Model View tree or in 

the Diagram View and select Create Mapping. 
 

OR 
 

In the Interaction Property View, select the Mappings tab and click , and the Create 
Mapping dialog opens. 

 
2 In this dialog, select the business process diagram from the tree and click OK. 

Viewing the mapping 

You can view the results of your mapping three ways depending on what you mapped: (1) in the 
Property View of the mapped object; (2) via the shortcut menu in the Model View tree; or (3) on 
the Impact Analysis tab in the Property View. 

 
• Open the Property View either by double-clicking the Subject Area or Interaction in the 

Diagram View or selecting Properties from the shortcut menu in the Model View tree. 
Then click the Mappings tab. 

 
NOTE:  When you double-click the mapped diagram in the Mappings tab of the Property View, 

the diagram opens in the Diagram View.



USING  C O NCEP TUAL  MODELING  NOTATI ONS  >  CONCEPTUA L  MODEL  ELEM ENTS  

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 273   

 

 

 
• For a Subject Area, if you mapped to a diagram, right-click the Subject Area node in the 

Model View tree or diagram and select Diagram Mapping. The pull-right displays all 
diagrams that are mapped. 

 

• To view an Entity’s mapping, click the Impact Analysis tab in the Entity’s Property View to 
see what Subject Areas map to it. 

Editing a mapping 

Once you have created a mapping, you can then create more mappings or delete existing 
mappings. 

 
1 Right-click the Subject Area either in the Model View tree or in a diagram, select Edit 

Mapping, and the Edit Mapping dialog opens. For a Subject Area, this dialog lists the 
workspace, model, diagram(s), and all conceptual model elements for the selected subject 
area. The elements mapped to the selected subject area are checked. 

 
NOTE:  When a business entity is grayed out, it cannot be cleared because it is graphically 

contained by the subject area on one or more diagrams. 
 

For an Interaction, right-click in the Model View tree or in a diagram and select Edit 
Mappings. The Edit Mappings dialog lists the Business Process diagrams selected. 

 
2 Deselect a checked element to delete the mapping. You can also delete a mapping using 

the Property View. 
3 Select an unchecked element and when you click OK, a mapping is created between the 

selected subject area and the checked element. 

Deleting a Mapping 

1 Open the Property View for the Subject Area or Interaction containing the created 
mappings. 

 
2 Select the Mappings tab to view the diagrams and/or entities that have been mapped. 

 

3 Select the diagram and/or entity you want to remove from the mapping and click   . 
 

• If you have nested entities, you cannot delete only the nested entity. You must delete the 
parent-level business entity which includes the nested entity. If you select the nested 
entity to delete, you will get a warning in the Property View. 

 

• If you have an entity contained in a subject area on a diagram, you cannot delete the 
mapping. You must remove the mapping by dragging the element out of the Subject 
Area. 

Business entities 
A Business Entity is a high-level “container” for businesses/organizations. They can stand alone or 
can be containers for other Business Entities or Business Attributes. 

 
• Business Entities can be expanded or collapsed. You can then view or hide other Business 

Entities and Business Attributes within the parent element. Right-click in a Business Entity in 
the Diagram View and select Show as Expanded. This is a toggle command. 
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• You can also elect to hide or show the expansion control in the Business Entity in the 

Diagram View. Right-click the Business Entity and select Show Expansion Control. 
Depending on the state of the element (expanded or contracted), a plus or minus symbol 
is placed in the bottom right-hand corner of the element. This is a toggle command. You 
can also choose to show or hide the expansion control as a global  preference. 

 
• When a Business Entity is placed in the Diagram View, the label appears vertically centered. 

Once you add a child element the label is then relocated to the top center of the Business 
Entity. 

• Once other Business Entities have been placed within a Business Entity these child 

items appear on the Impact Analysis Tab under the “Heritage” ( ) heading. You can 

view this 
Impact Analysis Report in the Property View for the Business Entity. 

 
• Business Entities contained in a Subject Area in a diagram are owned by the model, not 

the subject area. 
 

NOTE:  When a Business Entity is placed within a Subject Area, the Subject Area is 

automatically mapped to the entity and appears under the Mappings ( ) heading 
in the Impact Analysis Report. 

The following example shows two Business Entities containing their related Business Attributes 
for a shipping company. The two entities are connected with an Interaction showing a many-to- 
many relationship. 

 
NOTE:  To select multiple elements in the Business Entity, hold down the ALT key to invoke 

the marquee cursor. 
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Business attributes 
Business Attributes are the low-level details (i.e., properties), of a Business Entity. You can quickly 
add Business Attributes to a Business Entity by pressing the Insert key while the Business Entity is 
selected. A new business attribute will be added at the bottom of the list or below a selected 
Business Attribute. The following example shows the Business Entity “WEB CUSTOMER” with 
seven Business Attributes for that customer. In this example the Expansion Control is displayed in 
the lower right-hand corner of the entity. 

 
When working the Business Attributes you can: 

 
• Set Unique Identifiers, which map to Keys in the ER logical model can be set. 

 
• Set the data type for the Business Attribute in the Property View and. The Data Types 

available are high level: binary, BLOB/Image, boolean, char, CLOB/Large Text, Decimal, 
Date, Integer, Time Stamp, Varchar, and XML. 

 
• Set the Optionality for an attribute. If you select Mandatory it becomes a “required” 

property and a plus sign (+) appears to the left of the attribute. If it is optional, a minus sign 
(-) appears to the left of the attribute. You can set a export and/or print under the Display 
Options for Business Entities to always show the optionality indicator for Business Attributes. 

 
• Bind Business Attributes to Business Element or  Domains in the Reference Objects node. 

 
• Scroll through the list of attributes in a Business Entity using the up and down arrows. 

 
• Reorder the Business Attributes within a Business Entity. 

Reordering business a ttributes 

You can reorder business attributes in a Business Entity. 
 

1 Double-click the Business Entity that contains the Business Attributes you want to reorder. 
This opens the Property View. 

 
2 Click the Business Attributes tab of Business Entity property view. 

 
3 Select the attribute you want to move and click either the up arrow ( ) or the down  

 

arrow ( ) to change the order of the attributes. 
 

The change in order is reflected in both the Model View tree and in the element on the 
Diagram. 
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Setting unique identifiers 

You can set a unique identifier for a Business Attributes in the Conceptual model making the 
entity unique. When exporting to ER/Studio DA, Business Attributes designated as unique 
identifiers are created as entity attributes with the primary key set to True. 

The CASE Method (Barker) notations are used as follows: 

• Business Attributes, which are parts of the definition of a unique identifier, are shown 
preceded by hash marks (#). You can show or hide this indicator, if desired. 

• Relationships, which are part of the definition of a unique identifier, are marked by a short 
line across the relationship near the entity being identified. 

In the following example, the unique identifier of Line Item is a combination of the attribute 
"Line No." and the relationship "part of one and only one Purchase Order." Since the marked 
relationship represents the fact that each line item is partly identified by a particular purchase 
order, it implies that the Purchase Order’s unique identifier "PO Number" participates in 
identification of the Line Item as well. When implemented, a column derived from "PO Number" 
is generated in the table derived from Line Item. It serves as a foreign key to the table derived 
from Purchase Order, and is part of the primary key of the table that is derived from Line Item. 

 

Relationships 

When you set a Unique Identifier for a Business Attribute, all relationships having the Business 
Entity containing that Business Attribute as the source gets a new indicator. You can show or 
hide this indicator, if desired. 

NOTE:  If another Business Attribute is set as a Unique Identifier, additional decorators are 
not added. 

Binding business attributes to business elements 

In Conceptual Modeling, a Business Attribute can be “bound” to a Business Element to seed a 
conceptual model. You can export and/or print a binding report.There are several different ways 
of binding Business Elements to Business Attributes: 

 
• Binding via Drag and Drop 

 

• Binding from a Business Attribute 
 

• Binding from a Business Attribute 
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The binding characteristics/limitations follow: 
 

• A Business Element can be bound to a Business Attribute. 
 

• You cannot bind both a Domain and a Business Element to the same attribute. You will get a 
Bound Domain Warning dialog giving you the option to resolve the conflict. 

 
• You can bind multiple Business Attributes to a Business Element in the same Business Entity. 

 
• Once a Business Attribute is bound to a Business Element, changes to the properties (i.e., 

Name, Description, Notes, and Domain/data type) of the Business Element cascade to the 
attribute. However, you can use the  Override option if you want to change the 
enforcement of those properties. 

Binding via drag and drop 

You can drag a Business Element from the Model View tree onto a Business Entity in the 
Diagram View. 

 
1 Select the Business Element you want to bind with a Business Entity. 

 
2 Drag the Business Element from the Model View onto the Business Entity in the Diagram 

View. 
 

3 If the entity already contains a bound Business Attribute with the same name, the Duplicate 
Attribute Exists dialog opens. 

 
 

• Select the first option if you want to bind the element to a new business attribute. This 
action creates a new attribute with a unique name. For example, if your existing attribute 
was “Element”, the new attribute would be “Element1”. 

 

• The second option creates a new attribute with a new name but does not bind it to the 
Business Element. 

 

• Select the last option if you do not want to create a new attribute. This selection cancels 
your drag and drop action. 
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Binding from a business a ttribute 

To bind a Business Attribute to a Business Element: 
 

1 Double-click a Business Attribute either in the Model View tree or in the Diagram View to 
open the Property  View. 

 
2 On the General tab, in the Business Element Binding options box, click the drop-down arrow 

in the Bound Business Element list box. All available Business Elements are listed. 
 

3 Select the Business Element you want to bind the Business Attribute to. 
 

NOTE:  If a naming conflict exists, (i.e. duplicate names) the Duplicate Attribute Exists dialog 
opens allowing you to resolve the conflict. 

 

 
4 You can choose to override the properties of a bound Business Attribute (Name, 

Description, Notes, and Domain/data type) with the changes you make in the Business 
Element. For example, you can change the Data type setting of “Account” as shown in the 
following screen shot. Because the Domain/datatype enforcement option is selected in the 
Enforcement options box, that value is propagated to the bound Business Attribute. 

 

When you open the Property View for the bound Business Attribute, notice that the Data 
type setting is now the same as the “Account” Data type setting.
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5 If you change any of the properties in the bound Business Attribute a violation occurs telling 

you that one or more properties of the Business Element and the Business Attribute no 
longer match. For example if you changed the Data Type to “Decimal” in the Business 
Attribute, a violation notice appears in the Bindings hierarchy. Click Bindings and notice that 
a “Data Type Violation: Decimal” warning appears in the hierarchy. 

 

 
6 You can choose to resolve the violations by clicking . Violations do not have to be 

resolved and are left in the Bindings hierarchy as a reminder of the changes you made. 

Viewing the b inding 

There is no visual indicator on the diagram showing that a Business Element has been bound to 
the Business Attribute. However, you can view the binding either from the Business Attribute or 
from the Business Element via their Property Views: 

 
• When you double-click the bound Business Attribute, the Property View for the attribute 

opens. Click Bindings and the bindings hierarchy is shown under the Bindings heading 
( ). This hierarchy shows the Business Elements the Business Attribute is bound to. 
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• When you double-click on a Business Element, the Property View for that element opens. 
Click Bindings to view the attributes bound to an element. 

 

Binding from a business e lement 

To bind a Business Attribute from a Business Element: 
 

1 Double-click a Business Element either in the Model View tree or in the Diagram View to 
open the Property View. 

 
2 Click the Bindings tab to open the Bindings hierarchy page. 
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3 Click and the Creating Binding with Targets... dialog opens. All Business Entities and 

their associated unbound Business Attributes are listed. 
 

NOTE:  If a binding has already been created, the Add Target to Binding... dialog opens. 
 

 
4 Select the target (i.e. attribute) you want to bind with the Business Element and click OK. 

 
NOTE:  If you attempt to bind an attribute that is already bound to a Domain, you will get a 

Bound Domain Warning Dialog. 

 
 

5 In the Property View for the Business Element, click Bindings to view the Bindings 
hierarchy. 

Using the Override o ption 

When binding Business Attributes to Business Elements you can choose to enforce some or all of 
the properties of the Business Element to the Business Attribute. 

 
1 Create a Business Element and select the properties you want enforced when binding to 

Business Attributes. In the following example, when you bind a Business Attribute to 
ElementOne, the Name and Domain/data type properties will be enforced on the Business 
Attribute. The Description and Notes properties of the Business Elements will not be 
enforced.
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2 However, when you bind the Business Attribute to the Business Element, you have the 
option to override the enforced properties. In the following example notice that in the 
Business Attribute Property View, the Description and Notes options are greyed out. Also 
notice that the Name and Data type list boxes are not available. 

 
3 If you want to override any of the available properties, select that option in the Business 

Element binding options. For example, if you selected the Domain/data type option, the 
Data Type list box becomes available and you can change the setting. 
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4 Once you override a property and click on the Bindings tab, a violation notation appears in 

the hierarchy telling you that the properties of the Business Attribute and the Business 
Element no longer match and what that mismatch is. 

 

Binding business attributes to domains 

In Conceptual Modeling, a Business Attribute can be “bound” to a  Domain to seed a conceptual 
model and enforce data type standards. You can export and/or print a binding report. There are 
several different ways of binding Domains to Business Attributes: 

 
• Binding via Drag and Drop 

 

• Binding from a Business Attribute 
 

• Binding from a Domain 

The binding characteristics/limitations follow: 
 

• A Business Attribute can be bound to a Domain. 
 

• You cannot bind both a Domain and a Business Element to the same attribute. You will get a 
Bound Domain Warning dialog giving you the option to resolve the conflict. 

 
 

• You can bind multiple Business Attributes to a Domain in the same Business Entity. 
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• Once a Business Attribute is bound to a Domain, changes to the properties (i.e., data type, 

width and scale, and optionality) of the Domain cascade to the attribute. However you can 
use the Override option if you want to change the enforcement of those properties. 

Binding via drag and drop 

You can drag a Domain from the Model View tree onto a Business Entity in the Diagram View. 
 

1 Select the Domain you want to bind with a Business Entity. 
 

2 Drag the Domain from the Model View onto the Business Entity in the Diagram View. 
 

3 If the entity already contains a bound Business Attribute with the same name, a new 
attribute is created with a unique name. For example, if your existing attribute was 
“Domain”, the new attribute would be “Domain1”. 

Binding from a business a ttribute 

To bind a Business Attribute to a Domain: 
 

1 Double-click a Business Attribute either in the Model View tree or in the Diagram View to 
open the Property View. 

 
2 On the General tab, in the Domain Binding Options group box, click the drop-down arrow in 

the Bound Domain list box. All available Domains are listed. 
 

3 Select the Domain you want to bind the Business Attribute to. 
 

4 You can choose to override the properties of a bound Business Attribute (data type, width 
and scale, and optionality) with the changes you make in the Domain. For example, you can 
change the width setting of “DomainOne” as shown in the following screen shot. Because 
the Width and Scale enforcement option is selected in the Enforcement options box, that 
value is propagated to the bound Business Attribute. 

 
When you open the Property View for the bound Business Attribute, notice that the Width 
setting is now the same as the Domain One width setting. 
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5 If you change any of the properties in the bound Business Attribute a violation occurs telling 

you that one or more properties of the Domain and the Business Attribute no longer match. 
For example if you changed the Data Type to “Binary” in the Business Attribute, a violation 
notice appears in the Bindings hierarchy. Click Bindings and notice that a “Data Type 
Violation: Varchar” warning appears in the hierarchy. 

 
6 You can choose to resolve the violations by clicking . However, violations do not have to 

be resolved and are left in the Bindings hierarchy as a reminder of the changes you made. 

Viewing the b inding 

There is no visual indicator on the diagram showing that a Business Attribute has been bound to a 
Domain. However, you can view the binding either from the Business Attribute or from the 
Domain via their Property Views: 

• When you double-click the bound Business Attribute, the Property View for the attribute 
opens. Click Bindings and the bindings hierarchy is shown under the Bindings heading 
( ). This hierarchy shows the Domain(s) the Business Attribute is bound to. 
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• When you double-click on a Domain, the Property View opens. Click Bindings to view the 

attributes bound to the Domain. 

 

Binding from a domain 

To bind a Business Attribute from a Domain: 
 

1 Double-click a Domain either in the Model View tree or in the Diagram View to open the 
Property View. 

 
2 Click the Bindings tab to open the Bindings hierarchy page. 

 

3 Click  and the Creating Binding with Targets... dialog opens. All Business Entities and 
their associated Business Attributes and Domains are listed. 

 
NOTE:  If a binding has already been created, the Add Target to Binding... dialog opens. 

 
 

4 Select the target (i.e. attribute) you want to bind to the Domain and click OK. 
 

NOTE:  If you attempt to bind an attribute that is already bound to a Business Element, you will 
get a Bound Domain Warning dialog. 

 
 

5 In the Property View for the Domain, click Bindings to view the Bindings hierarchy. 
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Using the Override o ption 

When binding Business Attributes to Domains you can choose to enforce some or all of the 
properties of the Domain to the Business Attribute. 

 
1 Create a Domain and select the properties you want enforced when binding to Business 

Attributes. In the following example, when you bind a Business Attribute to DomainOne, the 
Data Type and Optionality properties will be enforced on the Business Attribute. The Width 
and Scale properties of the Domain will not be enforced. 

 
 

2 However, when you bind the Business Attribute to the Domain, you have the option to 
override the enforced properties. In the following example notice that in the Business 
Attribute Property View, the Width and Scale option is greyed out. Also notice that the Data 
type and Optionality list boxes are not available.
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3 If you want to override any of the available properties, select that option in the Domain 

binding options. For example, if you selected the Data Type option, the Data Type list box 
becomes available and you can change the setting. 

 
4 Once you override a property and click on the Bindings tab a violation notation appears in 

the hierarchy telling you that the properties of the Business Attribute and the Domain no 
longer match and what that mismatch is. 

 

Printing and exporting bindings 

You can print or export binding resolutions as a report. You could have several hundred items 
that were overridden and want to see that information in another file or printed to paper. 
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Export b indings r eport 

To export a Bindings Report: 
 

1 On the Bindings tab of a business element containing bindings or a bound business 

attribute, click . 
 

2 In the Export dialog, select the workspace where you want the report created. 
 

3 The default report name is based on the name of the business attribute. You can edit this 
name. 

 
4 In the Save as Type text box, select the format from the drop-down list. Your options are: 

html, pdf, and rtf. 
 

5 Click Save and the report is generated. 
 

6 To view this report, go to the directory where it was saved and double-click on the report 
name. 

Print b indings r eport 

To print a Bindings Report: 
 

1 In the Bindings tab of a business element containing bindings or a bound business 

attribute, click . 
 

2 In the Print dialog, select the Printer and click OK. 

Interaction 
An interaction represents an action, process, or transaction between two objects. These 
interactions are often expressed as action verb phrases. The verb and inverse verb phrases can 
be added using the Property View and then displayed in the Diagram View. You can also create a 
mapping from the Interaction to a business process diagram. 

You can set line style, line thickness, end point selection, and begin point selection for the 
Interaction in the Property View. You can also set global preferences for all the line display 
options in the Preferences. 

The following diagram shows two interactions between the Business Entities. The “Shop in 
Store” interaction displays the verb and inverse verb phrases that were added in the Property 
View for that Interaction. 
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Relationship 
Relationships can only be defined between common object types. For example two business 
entities can have a relationship, but a business entity and a subject area cannot. 

You can set Relationship properties using the Property View. These properties include the 
following: 

 
• You can add verb and inverse verb phrases which are then displayed in the Diagram View. 

 
• You can set the optionality of the relationship. 

 
• You can choose one of four different relationship types: 

 
• Generic ( ). You can customize the end points using the Line Display Options in the 

Appearance tab of the Property View. 
 

• Many-to-Many ( ) 
 

• Many-to-One ( ) 
 

• One-to-Many ( ) 
 

• The selection you make is reflected on the beginning and ending indicator on the 
relationship. 

 
• You can set line style, line width, and source/target decorator size for the Relationship in the 

Property View under the Appearance tab. 
 

• You can also set global preferences for all the line display options in the  Preferences. 

The following diagram shows a one-to-many relationship with an optionality setting of Mandatory 
to Optional between two related Business Entities. 
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Setting the optionality of a relationship 

Split-line notation appears when you set source/target optionality on a Conceptual Model 
relationship. The line display depends on the optionality selected for the relationship. The 
following options are available: 

• Optional to Mandatory 

• Mandatory to Optional 

• Optional 

• Mandatory 

To set the optionality of a relationship 
 

1 In the Diagram View, double-click the Relationship to open the Property View. 
 

OR 
 

In the Model View, double-click either the Outgoing Relationships or Incoming 
Relationships icon ( ) located in either the target or source elements to open the 
Property View. 

 
 

2 Select the Relationship Type from the drop down list and the Relationship display in the 
Diagram View changes to reflect the type chosen. 

 
3 Select the Optionality from the drop-down list and the split-line notation displayed reflect 

the optionality chosen. 
 

4 You can customize the end points using the  Line Display Options in the Appearance tab of 
the Property  View. 
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ER/Studio Business Architect tools 
ER/Studio BA Tools outlines how to use the tools and features. The table below describes the 
different sections of this chapter: 

Topic Description 

Create Diagram from  
Selected Elements 

This function gives you the ability to create diagrams from both 
Business Process and Conceptual Model elements that exist on 
the Model View tree or on a diagram. 

Find The Find functions give you the ability to find information in 
the current diagram. 

Search A Search dialog lets you search for elements, or specific text in 
descriptions and notes. You can filter the search parameters 
and view the results in the Search Results view. 

Links There are two wizards that walk you through the creation or 
editing of a link relationship between elements. 

Usages There are two wizards that walk you through the creation or 
editing of a usage relationship between elements. 

Impact Analysis Diagram This is a graphical representation of the links or usages you 
created. You can also update an existing diagram. 

Grid Editor The Grid Editor is a spreadsheet-like display format used as an 
alternative to the Tree view. This is valuable for displaying large 
numbers of objects or business-related textual objects, such as 
business rules. Grid Editors can be printed or exported as a 
report in csv, html, pdf, and rtf formats. 

Reports Note: There are two main reports in ER/Studio BA: the Impact 
Analysis Report and the Web Report. 

Views Views support editors and provides alternative presentations 
as well as ways to navigate the information in ER/Studio BA. 

Create diagram from selected elements 
You can create new diagrams from existing model objects for both Business Process and 
Conceptual diagrams. To do this, you can select model elements in the Model View tree or right- 
click on elements in an open diagram. You can then create a diagram from the selected elements. 
This command is also available on the Tools main menu. 

NOTE:  The newly-created diagram is displayed in the Model View tree with the elements 
displayed as presentation elements, which is indicated by a special marker on the 

element icons ( ). 

Specific rules apply to both the Business Process Model and Conceptual Model diagrams. The 
following rules apply in general to the creation process: 
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• Any combination of Reference Objects or External Data Objects can be selected and added 

in combination with Business Process or Conceptual Model elements, with the following 
exceptions: (1) Business Process triggers; (2) External Data Object attributes, columns, and 
data elements; and (3) Reference Object Domains. 

 
• The Create Diagram from Selected Elements command is disabled when an invalid 

combination of elements are selected. Those invalid combinations include: 
 

• Combinations of Business Process or Conceptual Model elements 
 

• Elements from more than one model (with the exception of Reference and/or External 
Data Objects). 

 

• Selections which include items which cannot be displayed on a diagram. 
 

• Elements which cannot be created on a diagram. 
 

• When creating a diagram from selected elements, relationships are discovered on the new 
diagram. However, a relationship can only be discovered when both the source and target 
nodes are selected when creating the diagram. 

Creating b usiness process m odel diagrams 
When creating a diagram from Business Process Model elements, only one diagram can exist in a 
Business Process model that shows a private (internal) process (i.e., without pool/lanes). A new 
Business Process diagram can be created using this command when the following conditions are 
met: 

• This command is only available for pools in a Business Process model and only pools in the 
same model can be selected. 

 
• This command is not available for a combination of elements in different models. 

 
• Elements of the same process are selected, where there is not already an existing diagram 

representing that abstract process. 
 

• All Reference Objects and External Data Objects can be selected and included when 
creating a diagram. 

Creating c onceptual m odel diagrams 
New diagrams can be created from existing Business Entities, Subject Areas. and Groups, 
assuming they are all in the same model. All Conceptual Model elements can be selected to 
create a new diagram, with the following clarifications: 

• This command is available for Business Entities, Subject Areas, and Group, but not for 
Business Attributes or Relationships. 

 
• If only Subject Areas, Business Entities, or Groups are selected, the relationships are 

discovered and drawn. 
 

• If Interactions and Relationships connecting elements are selected, they are also included 
on the diagram. 

 
• If a connecting element is selected without a target or source element, the source and target 

element are discovered and included on the diagram.
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Using the Create d iagram from Selected Elements command 

1 Right-click on a selected element in either the Model View or an open diagram and click 
Create Diagram from Selected Elements. 

 
NOTE:  Hold down the CTRL key to select multiple elements, for example a Subject Area and 

a Business Element. 
 

 
2 In the New Diagram dialog, enter the new diagram’s name and description. 

 
NOTE:  In the New Diagram dialog, the available model(s) depend on what model elements 

are selected. For example, if only pools are selected, the pool’s model is the only 
model available. If only reference objects are selected, all models are available. 

 

 
3 Click OK, the New Diagram dialog closes and the newly-created diagram opens in the 

Diagram View area. The diagram also appears in the Model View tree under the model node 
you specified when you created the diagram. 

Find 
The Find function has two different ways to find elements: Finding in Diagram and Finding in 
Model View. 

Finding in diagram 
This option lets you search for an object name in an active diagram. The found element is then 
highlighted in the diagram. 

 
1 On the Main menu, select Edit > Find in Diagram... or press CTRL+F and the Find dialog 

displays. 
 

2 Enter the name of the element you want to find. This searches for any element in the current 
diagram 

 
3 You can select the options to match whole words only or match case at this point. 

 
NOTE:  “Match whole word only” looks for a full match. If you want to do a partial match, you 

would keep this unchecked. Also, the “Match case’ option looks at case. 
 

 
4 Select the direction you want to search. In this case direction means up or down, searching 

an internal list that is created when the Find operation starts. 
 

NOTE:  If multiple elements are found, the Find Next command selects the next match based 
on the direction you have indicated. 

 

 
5 Click OK and the found object is centered and highlighted in the Diagram Area. 
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o If a search item is not found, a Message dialog opens telling you that there are no 
elements on the diagram that meet the search criteria. 

o If you have found all items in that diagram you will get a message that there are no 
more elements on the active diagram meeting the search criteria 

Finding in Model v iew 
This function lets you quickly locate an element on an active diagram in the Model View tree. 

• Right-click an element in the Diagram Area and click Find in Model View or click CTRL+H. 
The element is highlighted in the Model View tree. 

Search 
You can do an advanced search of the workspace using this function. Once a search is complete 
a Results View appears with all matches listed. On this view, you can find where an element 
resides in the workspace and on which diagram(s) (opened and closed) they appear. 

 
1 Select Edit > Search or press CTRL+E to open the Search dialog. 

 
2 The table below describes each field of this dialog: 

 
Field Description 

Find What Enter the name of the item you want to 
search for. A drop-down arrow gives 
you access to the last ten search 
strings. You can set a preference for 
the number of entries in this list. 

Find Click Find to start the search. This 
button is not enabled if the search 
string is blank. 

Match Case The search matches the exact case of 
the search string. 

Match whole words only The search matches a whole word, not 
partial search strings. 

Search In... You can choose what you want 
included in the search: Entire 
workspace, or specific projects, 
models, and data sources. 

Look For Select a type of items you want to 
look for: Names (of elements), 
Descriptions, or Notes. 
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Field Description 

Limit To You can choose what types of elements 
should be searched. This filter limits 
what types should be included in the 
search. You have the following options 
in this tree: 

Expand: Click  to expand all 
nodes of the tree. 

 
 
Collapse: Click  to collapse all 
nodes of the tree. 

 
 
Select All: Click  to select all 
nodes of the tree. 

 
 
Clear All: Click  to clear all 
selections made in the tree. 

Restore Defaults You can click Restore Defaults 
to reset all the values back to 
their original settings. 

 

3 Once you made all your settings in the Search dialog, click Find. A progress dialog may or 
may not be shown depending on the time it takes to do the search. 

 
4 Once the search is complete, a Search Results view opens. 

Search Results v iew 
This view opens automatically after a search is completed if it isn’t already displayed. A Search 

Result Count header displays the number of found items. The table displays five columns: 
 

Column Description 

Name Name of the element you searched for. 

Type Element type 

Description Displays the descriptive text for the 
element. 

Notes Displays the note text for the element. 

Parent The element’s owner. This is required if 
multiple elements appear with the 
same name. 

You can gain access to the commands for the View either through a shortcut menu or the toolbar. 

NOTE:  You can set preferences for the number of elements to return, as well as what 
columns you want to be displayed. 
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Using the Shortcut menu 

1 Right-click on a populated row in the Search Results view and the following commands are 
available to you: 

 
Shortcut Menu Item Description 

Name, Type, Description, Notes By default, all columns are displayed. These are 
toggle settings, so you can select or deselect which 
columns you want displayed. 

Open Search Dialog Opens the Search dialog so you can specify a new 
search or modify your existing search. 

Find In Opens a pull-right menu with the following 
commands: 

Active Diagram: This command finds and 
highlights the selected search item in the active 
diagram. This command is not available if the element 
exists only in the Model View. 

All Diagrams: This command searches for the 
selected search item on all diagrams in the model. 
The Diagram Usage dialog opens displaying all the 
diagrams where the element appears. Select the 
diagram you want to open and click OK. 

Model View: Finds the selected search item in the 
Model View tree. 

Run Previous Search The pull-right menu displays the previous searches. 
Up to ten searches are listed. You can also select the 
Clear History option. 

Filter Results Opens the Search Results Filter dialog. Use this to 
refine the search. You can select which types of 
objects you don’t want to see in the Results view. You 
can expand or collapse the tree. You can also select or 
deselect all the tree node items. 

Customize Columns Opens the Customize Columns dialog where you 
select the columns you want displayed in the Search 
Results view. 

Properties Opens the Property View for the selected search item. 

 
2 Double-click on a search results row and the associated property view is displayed. 

Using the toolbar 

The following commands are available in the Search Results view toolbar: 

Command Icon Description 

Search 
 

 
 

Opens the Search dialog so you can 
specify a new search or modify your 
existing search. 
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Command Icon Description 

Find in Model View 
 

 
 
 
 

Click this icon to find the selected 
search item in the Model View tree. 
This command is not enabled if the 
item isn’t in the Model View (for 
example it is filtered, not shown, etc.). 

Find in Active Diagram 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This command finds and highlights the 
selected search item in the active 
diagram. This icons is enabled only if 
there is a diagram open and 
something is selected in the Search 
Results view. 

 
 
If the selected search item is not found 
on the active diagram, a dialog opens 
telling you the element is not found. 
You are given the option to search for 
the element on other diagrams. If you 
click Yes, the Diagram Usage dialog 
opens. 

Find in All Diagrams 
 

 
 
 
 

This command searches for the 
selected search item on all diagram in 
the model. The Diagram Usage dialog 
opens displaying all the diagrams 
where the element appears. 

Open Property View 
 

 
 
 
 

Opens the Property View for the 
selected search item. You can also 
open the Property View by right- 
clicking on the search item and 
selecting Properties. 

Run Previous Search 
 

 
 
 
 

Click the drop-down arrow on this icon 
to display the previous searches. The 
settings are included with the search 
name so you can remember what was 
searched. Up to ten searches are listed. 

Filter Results 
 

 
 
 
 
 
 

Opens the Search Results Filter dialog. 
Use this to refine the search. You can 
select which types of objects you don’t 
want to see in the Results view. You can 
expand or collapse the tree. You can 
also select or deselect all the tree node 
items. 

Links 
With a link you create a representation of a relationship between elements. These elements can 
consist of reference objects, data objects, and elements (including lanes) within a diagram. You 
can link the Individual Elements (attributes, columns, and data elements) contained in an External 
Data Objects. 
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Once you create links you can edit the link and create an Impact Analysis Diagram displaying the 
link relationships with source and target elements. 

NOTE:  When you create a link, the wizard creates a one-to-many relationship. 

Creating a link 
1 In the Model View tree, right-click an element (i.e., project, model, pool, lane, or element) 

 

and select Links > New  . 

OR 

On the main menu select Tools > Create Link and the Create Link Wizard opens for the 
selected element in the diagram. 

OR 

Right-click an element in the diagram and select Links > New to open the Create Link 
Wizard. 

 
OR 

 

Double-click the selected element to open its Property View. Select the Links tab and then 

click  to open the Create Link wizard. 
 

NOTE:  You can also draw a link between two elements by using the Link icon ( ) on the 
Reference Objects palette. 

 

 
2 In the Create Link dialog, you can specify the details for the new link: 

 
Detail Description 

Target Elements 

Target Elements tree Lists all available target elements. Only the elements appearing in 
the Model View tree and/or diagram are available to be selected. 
Select the target element(s) you want to link with your originally 
selected source element. The tree includes the following elements: 
Business Process Modeling, Conceptual Model, External Data 
Objects, Projects/Models/Data Sources, and Reference Objects. 

Filter button Click this button to select the types you want included in the list of 
Target Elements. You can include/exclude the following types: 
Business Process Modeling, Conceptual Modeling, External Data 
Objects, Reference Objects, Shapes, and Projects/Models/Data 
Sources. 

You can click Restore Defaults)to reset all the values back to 
their original settings. 
Once you make your selection and close the Filter dialog, the label 
for the Target Elements list box now indicates the list is filtered. 

Expand All button Expands all the nodes in the Target Elements list box. 

Collapse button Collapses all the nodes in the Target Elements list box. 
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Detail Description 

Link Properties 

Name Enter the name for the link you are creating. 

Verb Phrase Type a verb phrase that describes the relationship from the 
perspective of the source. For example: EMPLOYEE "owns" 
RESUME. This label appears on the link where it connects to the 
source. 

Inverse Verb Phrase Type a verb phrase that describes the relationship from the 
perspective of the target. For example: RESUME "is owned by" 
EMPLOYEE. This label appears on the link where it connects to the 
source. 

Description You can enter a description of the link you are creating. A shortcut 
menu is available with the following commands: cut, copy, paste, 
delete and select all. The Undo command is also available. You can 
cut, copy and paste text from other applications and other dialogs 
to the Description text box. 

Notes You can enter additional information in this text field. A shortcut 
menu is available with the following commands: cut, copy, paste, 
delete and select all. The Undo command is also available. You can 
cut, copy and paste text from other applications and other dialogs 
to the Notes text box. 

 
3 Once you have specified all the details for the new link click OK. You can view this newly 

created link four different ways: 
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• Create an Impact Analysis diagram. 

• Right-click either the source or target element in the diagram and select Connections > 
Show > Links. 

 

NOTE:  If you have created links between elements that exist in two different processes (for 
example, in two different diagrams in a workspace or in two different pools), the Show 
> Links command does not display those links. 

 
 

• Click the Impact Analysis tab in the either source element, target element or link Property 
Views. 

 

• The created link appears in the Model View tree as a separate folder. In the following 
example the subject area “Lending” has an outgoing “link” relationship to the subject 
area “Securities”. 

 
 

4 You can show the link label by right-clicking on the link and selecting Show > Name. 
 

5 If you entered a Verb Phrase and/or an Inverse Verb Phrase you can also display them by 
right-clicking the link and selecting Show. 
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Connecting l inks to lanes 

You can also connect a link to a lane in a pool. 

 
1 Click Link ( ) on the Reference Objects palette. 

 
2 Click on the object you want to connect to the lane and then click in the lane. The following 

rules apply as to where you click in the lane: 
 

• Draw the link directly to the Lane Header / Name Label to connect to the lane. 
 

• In order to connect to a lane, the link must be connected closer to the center or inner 
edge of the lane. Attempting to connect to the upper (or left) portion of the lane will 
connect to the pool instead. 

 

The following example shows where you would need to click to connect to a lane. (note 
where the cursor is in the following illustration). 

 
Once you click in the lane, the link connects to the border of the selected lane. 
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Editing l inks 

You can edit links either through the Edit Links dialog or by using the Link’s property view. 
 

1 To open the Edit Links dialog, right-click the target element or source element in the model 
view tree and select Link > Edit. Select the link you want to edit from the pull-right menu 
displaying the name(s) of the links. 

 
2 To open the property view, double-click the link you just created, either in the Model View or 

in the diagram, and the Property View for that link opens. You can edit the following 
properties of the link on the General tab. 

 
3 The dialog box and the property view contain the same properties which can be edited. 

However, they are displayed in different formats. The following properties can be edited: 
 

Name Displays the names of the two linked elements. 

Verb Phrase Type a verb phrase that describes the relationship from the 
perspective of the source. For example: EMPLOYEE "owns" 
RESUME. This label appears on the link where it connects to the 
source. 

Inverse Verb Phrase Type a verb phrase that describes the relationship from the 
perspective of the target. For example: RESUME "is owned by" 
EMPLOYEE. This label appears on the link where it connects to the 
target. 

 
4 You can add a description of the link in the Description tab of the Property View and add 

additional information under the Notes tab. 
 

5 You can edit the target element by clicking  on the Source and Targets tab. The 
Property View for the selected element opens as a tabbed view. 

Drawing a link 

Instead of using the Create Link wizard, you can create a link in the Diagram View using the link 
icon ( ) in the Reference Objects palette or Reference Objects toolbar. 

 
1 Click the drop-down arrow on the Reference Objects palette and select Link, or select 

from the Reference Objects toolbar. 
 

2 Click the element that is the origination or source of the link. 
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3 Click the element that you want the first element linked to (i.e., the target) and a link is 

created. Link icons are placed on the elements at the beginning and ending of the link. 

 

Usages 
You can show the create, read, update, or delete database attributes on a connection. When this 
connection is created they are labeled with the attributes you selected at the time of creation. 
These elements can consist of reference objects, data objects, and elements within a diagram. 
Once you create these usage indicators, you can edit and export the usage. You can also create 
an Impact Analysis Diagram displaying the created usage. 

 
NOTE:  When you create a usage, the wizard creates a many-to-one relationship. 

Creating a usage 
1 In the Model View tree, right-click an element (i.e., project, model, pool, lane, or element) 

and select Usage (CRUD)> New. 

OR 

On the main menu select Tools > Create Usage and the Create Usage Wizard opens for 
the selected element. 

OR 

Right-click an element in the diagram and select Usage (CRUD) > New to open the Create 
Usage Wizard. 

 
OR 

 

Double-click the selected element to open its Property View. Select the Usage (CRUD) tab 

and then click  to open the Create Usage wizard. 

NOTE:  You can also draw a usage between two elements by using the Usage icon ( ) on the 
Reference Objects palette. 
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2 In the Create Usage dialog, you can specify the details for the new usage: 
 

Detail Description 

Target Elements 

Target Elements tree Lists all available target elements. Only the elements appearing in 
the Model View tree and/or diagram are available to be targeted. 

 
 
Select the element(s) you want to connect with your originally 
selected element. 

Filter Lists of Target Elements 
button 

Opens the Create Usage Target Element Filter. You can select the 
types you want included in the list of Target Elements. You can 
include/exclude the following types: Business Process Modeling, 
Conceptual Modeling, External Data Objects, Reference Objects, 
Shapes, and Projects/Models/Data Sources. 

 
 

You can click Restore Defaults ( ) to reset all the values back to 
their original settings. 

 
 
Once you make your selection and close the dialog, the label for the 
Target Elements list box now indicates the list is filtered. 

Expand All button Expands all the nodes in the Target Elements list box. 

Collapse button Collapses all the nodes in the Target Elements list box. 

Link Properties 

Usage Create: Attribute indicating usage adds new records or entries. 

Read: Attribute indicating usage views existing records or entries. 

Update: Attribute indicating usage edits existing records or 
entries. 

Delete: Attribute indicating usage deletes existing records or 
entries. 

Description You can enter a description of the link you are creating. 

Notes You can enter additional information in this text field. 

 
 
 

3 Once you have specified all the details for the new usage click OK. You can view this newly 
created usage five different ways: 

 
• Create an Impact Analysis Diagram. 

 

• Right-click either the source or target element and select Connections > Show > Usages. 
 

• Right-click an element in the Model View and select Usage(CRUD) > Edit or View... and 
the Property View opens. Click the Impact Analysis tab for either one of the connected 
elements. 

 

• The created usage appears in the Model View tree in either an Incoming Relationships or 
Outgoing Relationships node (depending on whether you selected the source or target 
element). In the following example the task “Task in Invisible Pool” has an outgoing 
“usage” relationship to the task “Task”. 



ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 309   

ER /S TUDI O  B U SI NE SS  A R CH IT EC T  TO O L S  >  USA G ES   

 

 
 
 
 

 
 

4 You can show the usage name by right-clicking on the link and selecting Show > Name. 
 

5 The CRUD attributes are shown by default. You can hide these attributes by right-clicking on 
the Usage and deselecting the Show > Usage command. 

Editing u sage 
You can edit the names, attributes, descriptions and notes for usages by using the Usage (CRUD) 
property view. 

 
1 Right-click the source element in the Model View tree and select Usage (CRUD) > Edit. The 

Property View for that element opens with the Usage (CRUD) tab displayed. This tab displays 
the receivers and their usage settings in the grid. 

 

2 Select a receiver from the grid and click the Edit Usage . You can edit the name and usage 
settings for the selected usage under the General tab. You can also add or edit descriptions and 
notes. 

 
NOTE:  You can also double-click the usage you just created, either in the Model View or in the 

diagram, and you are taken directly to the Property View for the usage. 
 

 
3 If you want to edit just the usage setting, select the receiver in the grid and press F2. This 

places you in an edit mode for that cell. 
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Exporting a usage 
You can export the Usage (CRUD) report from the Property View using four different formats: 
CSV, HTML, PDF, and RTF. 

 
1 From the Model View or the diagram, double-click the source element of the Usage (CRUD) 

relationship to open the Property View. For example if you created a usage from “Task A” to 
“Task B”, you would double-click on “Task A”. 

 

2 Click the Usage (CRUD) tab to open the report and click export icon ( ). 

 
3 In the Export dialog export the folder location you want to save the report in. The default 

location is the current workspace folder. 
 

4 You can use the default file name or rename it. 
 

5 Select the type of report you want to generate: CSV, HTML, PDF, or RTF and click Save. A file 
is generated and the Export dialog closes. 
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6 Open the folder where you saved the report and double-click to open it. The following 
example shows a report exported in the CSV format. 

 

Drawing a usage 
Instead of using the Create Usage wizard, you can create a usage in the Diagram View using the 
Usage ( ) icon in the Reference Objects palette or Reference Objects toolbar. 

 
1 Click the drop-down arrow on the Reference Objects palette and select  Usage, or select 

 from the Reference Objects toolbar. 
 

2 Click the element that is the origination of the usage. 
 

3 Click the element that you want the first element connected to and a usage is created. 
 

NOTE:  The usage that is placed in the diagram has an editable text field containing the usage 
settings (C, R, U, D). You can change these settings in the text field. 

 

 
4 Right-click the usage and select Show > Name. The connection is labeled with the source 

and target name (for example “Lending.Securities”. 
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5 You can set the usage type in the Property View, which can be shown as well. In the following 

example the usage indicator is “R” for read. 

 

Impact analysis diagram 
Once you have created a link or usage, you can create an Impact Analysis Diagram displaying a 
graphical representation of those links. You can update an existing Impact Analysis diagram 
rather than generating a new one for the same element. The Impact Analysis Diagram can also 
be viewed as a grid. 

If a source object has been linked to an External Data Object Attribute, Column, or Data 
Element, they also will appear on the Impact Analysis Diagram. Their names are displayed as 
ParentName.Name in the view and are not editable in the diagram. You can double-click on them 
to open the associated Property View, where you can change their properties. 

You can create an Impact Analysis Diagram several ways: 
 

Right-click an element that you have created a link or usage for in the Model View tree and 
select Impact Analysis > Generate New Diagram.... 

 
OR 

 

Right-click an element that you have created a link or usage for in the Diagram View and 
select Impact Analysis Diagram.... 

 
OR 

 

Open the Property View for an element and click  in on the Impact Analysis tab. 

OR 

Select an element in the Model View tree or Diagram View and on the main menu select 
Tools > Generate Impact Analysis Diagram.... 

 
NOTE:  You will get a warning dialog telling you that they may be a delay when generating 

large diagrams. 
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The created diagram appears as an additional tab in the Diagram View. It also appears in the 
Model View tree and is represented by the following icon:  . You can save the diagram by 

clicking . You can also print this diagram by clicking on the Standard toolbar. 

The following example shows a sample Impact Analysis Diagram. The two tasks (Company and 
Employee) are linked and have both a verb phrase and an inverse verb phrase. The data object 
(Resume) shows a usage indicator connected to the Employee task and has a usage setting of 
“C” for create. 

 

Updating an Impact Analysis d iagram 
Instead of generating a new Impact Analysis diagram each time you add links or usages, you can 
refresh or update your existing diagram to show new connections. 

 

Right-click in the background of an existing Impact Analysis Diagram in the Diagram View 
and click Update Impact Analysis. 

 
OR 

 

Right-click the Impact Analysis diagram node in the Model View and click Update Impact 
Analysis. 

OR 

Select the Impact Analysis diagram in the Model View and on the main menu, select 
Diagram > Update Impact Analysis. 

 
NOTE:  This menu option is available only if the Impact Analysis diagram is open and is 

selected on the Model View. 
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View an Impact Analysis d iagram in the Grid Editor 
1 Right-click in the background of an opened Impact Analysis Diagram. 

 
OR 

 

Right-click on the Impact Analysis Diagram in the Model View. 
 

2 Select Grid Editor.... The information now appears in a grid format with full editing 
capabilities. 

 
For more information, see Grid Editor. 

Grid Editor 
The Grid Editor displays information about diagrams, reference objects data, or selected 
elements in a diagram in a spread-sheet format. The spread-sheet format allows you to enter a 
lot of information quickly. This Grid Editor is dynamic, reflecting changes made in the Model View 
tree or the Diagram view. When you open a Grid Editor it is placed in the Diagram View as a 
tabbed view and if a diagram is already open, it appears as an additional tab. 

When you create a Grid, the Grid Editor displays all the element types in alphabetical order. The 
names of the elements are listed in alphabetical order under each element type as well. The 
following example shows some of the elements in a business process modeling diagram. 

 
The columns available depend on the node or elements selected. For example if you create a 
grid on the Steward Object node, there is a column labeled E-Mail Address. This information 
would not appear if you selected a diagram node. You can choose to hide/show columns from 
within this common subset as described in the Customizing the Grid Editor section. 
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The following table lists all the elements and the information that appears for each: 

Element Available Columns 

Business Process Modeling Elements 

Associations 

Message Flows 

Sequence Flows 

Name 

Description 

Notes 

Events Tasks 

Pools/Lanes 

Gateways 

Name 

Description 

Notes 

Data Object 

Group 

Annotation 

Off-Page Connector 

Name 

Description 

Notes 

Conceptual Modeling Elements 

Subject Area 

Business Entity 

Business Attribute 

Interaction 

Relationship 

Name 

Description 

Notes 

Reference Objects 

Business Element Name Data 

Type 

Description 

Notes 

Business Rule Name Type 

Description 

Notes 

Business Unit Name 

Description 

Notes 

Stewards Name 

Type 

E-Mail Address 

Responsibility 

Description 

Notes 

External Data Objects 
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Element Available Columns 

Data Feed 

Data Store 

Entity 

Flat File 

Report 

Table 

View 

Name 

Description 

Notes 

Drawing Shapes 

All Shapes Name 

Parent (Parent Type) 

Description 

Notes 

Opening the Grid Editor 
Right-click a node in the Model View tree and select Grid Editor. 

OR 

Select an item in the Model View tree and select Tools > Grid Editor from the main menu. 
 

NOTE:  If a filter has been set in the Model View tree node, this filter also applies to the Grid 
Editor. 

The following nodes have the Grid Editor option available: 

Node Description 

Model Displays all elements contained in the selected model. 

Diagram Displays all items contained in the diagram. 

Elements Displays information for the element and all items contained in that element. 
For example, if you right- clicked on a business entity, all the business 
attributes will be listed as well. Relationships for the selected element are 
listed also. 

Business Element/ Business 
Rule/Business Unit/Steward 
nodes 

Displays the elements, rules, units, and stewards that you have created. within 
their related folder. For example all business rules created are listed in the Grid 
Editor when you right-click on the Business Rules node. However, when you 
right-click on a created business rule within that folder, the Grid Editor is not 
available. 

External Data Objects node Displays all the external data objects you have created or added in the current 
workspace. 
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Using the Grid Editor 
It is easy to navigate in the Grid Editor. All items on this Grid Editor are editable and can be 
sorted. There is a quick and easy way to enter large amounts of reference object data in the Grid 
Editor. That data can then be imported into another grid editor. You can print or export the Grid 
Editor, and customize what columns appear. 

Navigating 

• When a cell is selected, Tab moves you forward and Shift+Tab moves you backwards 
among the populated cells in a row. If you continue to tab at the end of a row, you advance 
to the first cell in the next row. 

 
• When a cell is selected and you press Enter, you move down a row to the cell directly below 

the selected cell. For example, if you select the cell in the Name column, pressing Enter 
moves you to the Name column in the next row. You remain in edit mode until you press Esc 
or click another row. 

 
• When a row is selected and you press Enter, you move down to the next row. When there 

are no more rows, then the first row in the Grid Editor is selected. 
 

• While a row is selected, you can use the up/down arrow keys to navigate between the rows. 
Pressing F2 puts you in the edit mode for the name. 

Editing 

You can edit the text in the Grid Editor in two ways: 
 

• In-line editing: Click once to select the row and then click again to put the cell you want to 
edit in edit mode. 

 
TIP:  If a cell is in the edit mode, you cannot use the right/left arrow keys to move the cursor 

within the text field unless you press F2. 
 

 
• Property Editor: To launch the Property View for an item double-click on a row, press 

Alt+Enter, or right-click in the row and click Properties. Changes made in the Property View 
are reflected in the Grid Editor when completed. 

You can also cut, copy and paste in the Grid Editor. 
 

1 Click once to select the row and then click again to put the cell you want to edit in edit 
mode. You can also press F2. 

 
2 Right-click the selected cell and select either cut or copy. You can then paste a cut or copied 

cell into another cell or in a selected third-party applications like Microsoft® Word or 
Microsoft® Excel. 

 
3 You can also copy or cut text from a third-party applications like Microsoft Word or Microsoft 

Excel and paste it into a selected cell in the Grid Editor. 
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Sorting 

The default sorting is alphanumeric by name, within a type. When you double-click on a column 
header the sorting toggles between ascending or descending order (within the type nodes). The 
direction of the sort is indicated by a directional arrow in the column header. 

Printing 

You can print the current Grid Editor. 

1 With the Grid Editor open and active, select File > Print from the main menu, click  on 
the Standard Toolbar, or press Ctrl+P. 

 
2 In the Print dialog select the options you want and click Print. 

Using the Grid Editor for entering reference objects data 

The Grid Editor provides a fast and simple means of entering large amounts of data for Reference 
Objects. 

 

1 In the Model View tree, right-click on one of the Reference Object subnodes (for example 
Business Elements). 

 
2 Select Grid Editor and the Grid Editor opens. 

 
NOTE:  If no reference objects exist, the first row is blank. If reference objects already exist for 

the selected node, the blank row appears at the end of the existing objects. 
 

 
3 When you select the blank row, the Name text field becomes editable. Enter the element 

name and tab to the Data Type cell. 
 

4 You can select one of the data types from a drop-down list. The list of data types depends 
on the type of reference object you are creating. 

 
5 Tab to the Description cell and enter any descriptive text. You can also add addition 

information in the Notes column. 
 

6 When you tab again you are automatically taken to the next blank row where the Name cell 
is editable. 

 
NOTE:  A newly created Reference Object element now appears in the Model View tree under 

the selected subnode. 
 

 
7 You can quickly navigate through the rows. Each time you press Enter you advance down 

one row. When you reach the last row, you are returned to the first row. 
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Exporting the Grid Editor 
You can export the Grid Editor in the following formats: 

File Type Description 

csv Comma separated text file 

html Hypertext Markup Language 

pdf Adobe Acrobat 

rtf Rich Text Format 

 
1 Open a Grid Editor or select a Grid Editor that is already open in the Diagram view. 

 
Select File > Export > Grid Editor from the main menu or click  and the Export dialog 
opens. The default folder is the current workspace. 

 
2 Name the file, select the file type from the drop-down menu and click OK. The exported file 

is saved in the selected folder. 
 

NOTE:  When exporting the Grid Editor in the pdf file format, the column widths are set relative 
to their actual width in the application. 

Importing data exported from the Grid Editor 
You can import Comma Separated Value (CSV) files containing Reference Objects that you have 
exported from a Grid Editor. This function is useful when you have many Reference Objects of a 
certain type that you want to use in another workspace or make available to another user. You 
can export that information and then make it available to be imported without the burden of re- 
entering the data. 

The exported CSV files from ER/Studio BA can only contain one type of exported Reference 
Object. For example, you could export all your Business Rules contained in a workspace and your 
exported file would only contain those Business Rules. Once imported, these objects are placed 
in the appropriate folder (i.e., Business Rules) in the Model View tree. 

 
1 Open the workspace where you want to import the csv file. 

 
2 Choose File > Import > Comma Separated Values (CSV)... from the main menu 

 
OR 

 

Right-click the Reference Object node where you want to place the imported objects and 
select Import Comma Separated Values (CSV).... 

 
The CSV Import Wizard opens. 

 
3 Select the object type you want to import from the Available Object Types list. This object 

type must match the object types you exported. 
 

4 Browse to the location of the previously exported Grid Editor file and select the file you want 
to import.
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5 Click OK and then click Next. 

 
• If there are elements that exist with the same name the Possible Duplicate Elements dialog 

opens. You can choose to create a new element with a unique name or update the existing 
element. When updating existing elements the following will occur: (1) Elements in the 
project having corresponding objects in the import are updated with new information; and (2) 
Objects in the import without corresponding element in the project are added to the project 
as new element. 

 
• If there are problems with the import, a Problems in File dialog opens. A table lists any 

errors, warnings, or information, as well as the line number of the problem. 
 

• Click Launch Editor to open the application associated with the CSV extension, where 
you can view and correct any problems. 

 

• Once you have corrected the problem click Revalidate. 
 

6 If the import is successful, an Import Summary dialog opens displaying all the records that 
have been imported. 

 
7 Click Finish and a CSV Import Complete notification dialog opens telling you how many 

elements were created in ER/Studio BA. 
 

8 Once you close the notification dialog, the imported elements are placed under the 
appropriate node in the Model View tree. 

 
9 You can then drag these elements on to an existing diagram. When you double-click on an 

element, the Property View for that element opens displaying the imported data. 

Customizing the Grid Editor 
You can customize the Grid Editor to display only selected columns. 

 
1 Open a Grid Editor in the application. 

 
2 Right-click in the Grid Editor and select Customize Columns.... All columns are displayed by 

default. 
 

3 In the Customize Columns dialog, deselect the columns you want to hide in the view and 
click OK. 

 
4 The selected columns no longer appear and the tab displays the notation that you have 

customized this Grid Editor. 
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Reports 
There are two main reports in the ER/Studio BA application: The Impact Analysis Report and the 
Web Report. If your installation also encompasses ER/Studio Repository, you can view and create 
many different reports through ER/Studio Portal. For more information, see the ER/Studio Portal 
User Guide. 

Impact Analysis report 
The Impact Analysis Report exists for most elements in the Model View tree. As you make 
changes to an element this report is updated dynamically. For example, if you add a link, that link 
and its target are immediately displayed in the report. 

You can gain access to these reports by double-clicking on any element in the tree to open the 
Property View. Once the Property View for the selected element is open, click the Impact Analysis 
tab. 

You can also open the Impact Analysis Report by selecting an element in the tree and choosing 
Tools > Reports > Impact Analysis.... 

Impact Analysis Reports can be printed or exported. You can also filter the report so only 
selected elements are shown. 

This report shows the following interrelationships between elements: 

Using the Impact Analysis f ilter 

In the Impact Analysis report, click  to open the Impact Analysis Filter dialog. There are two 
tabs: Setting Relationship Types and Setting Object Types. The status of the filter (on or off) is 
displayed in the header of the Impact Analysis report. 

Setting r elationship t ypes 

You can select the types of relationships you want included in the impact analysis. You can select 
an entire level, for example, Heritage. Or you can select lower levels such as Parent, which is a 
subset of Heritage.

Main Category Definition 

Workspace Hierarchy Displays the workspace, projects, and models associated with it. 

Diagram Usage Displays all diagrams the element is in. This includes any generated Impact 
Analysis Diagrams, which include graphical representations of all links and 
usages on a diagram. 

Heritage Displays the parent and/or children of the selected element. 

Incoming and Outgoing 
Connecting Objects 

Displays all connecting objects for the selected element, including the type of 
connection, and the origination and termination of the connection. 

Links Displays all links ( ) for a selected element and the name of the element 
where the link terminates. 

 
You are also given information on whether the current element is the source or 
the target of a link. 

Usages Display all usages (     ) for a selected element and the name of the element 
where the usage terminates. 
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Setting o bject t ypes 

All object types are listed in a collapsed list under this tab. Click  to view all types associated 
with a selected heading. You can select the entire group or select individual elements within that 
group. 

Using the Text Filter o ption 

If you only want objects with a certain name or by a certain alpha character to appear in the tree: 

1 Click  to open the Impact Analysis Filter dialog. 
 

2 Select the Text Filter icon and the text box is now available. 
 

3 Enter the name you want to base the filter on. There are several different options: 
 

• If you enter an alpha character followed by an asterisk, all elements with the entered alpha 
character will appear in the tree. For example, if you entered “T*” in the text box, 
elements shown would include not only “Tasks” but “My Tasks” as well because a space is 
used in the name. 

 

• Also shown are elements that are connected to an element with the selected criteria. For 
example, if you have a gateway labeled “GateOne” connected to a sequence flow named 
“To Task One”, if you have filtered on “T*”, both the gateway and the sequence flow 
appear in the Model View tree. 

 

• Also, you can enter an alpha character followed by a question mark as a single character 
“wild card” search. For example, if you entered “T?sk” the filter would show all names 
beginning in “T” and ending with “sk” in the Model View tree. 

 

4 Once you have entered the text string you want searched on, press Enter and the Impact 
Analysis tab opens with the filtered selection. 

Exporting the Impact Analysis r eport 

You can export the report in the following formats: 

File Type Description 

csv Comma Separated Value text file 

html Hypertext Markup Language 

pdf Adobe Acrobat 

rtf Rich Text Format 

 
1 In the Property View, click  and the Export dialog opens. The default folder is the current 

workspace. 
 

2 Name the file, select the file type from the drop-down menu and click OK. The exported 
Impact Analysis Report is saved in the selected folder. 

Printing the Impact Analysis r eport 

1 In the Property View select the Impact Analysis page and click . 
 

2 In the Print dialog select the options you want and click Print. 
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Web report 
ER/Studio BA offers a Web report feature that lets you generate a series of Web pages detailing 
key information about your workspace. This read-only report contains information about both 
Conceptual Model and Business Process Diagrams. 

To create this report, you must complete the Web Report wizard. Web reports are ideal for 
adding to organizational intranets to quickly disseminate the latest information about the state of 
your projects. This section of help describes how to: 

• Create a Web report 

• Use a Web report 

Creating Web reports 

ER/Studio BA offers an extensive HTML reporting feature you can use to display and review your 
projects online. To execute this feature, you must complete the Web Report Wizard, which allows 
you to filter, set descriptions and set a location of the reports. Once executed, the wizard 
produces reports for each project and model stored in their own subfolder, which is named for 
the project/model they represent. 

Web Report w izard 

You can generate a report on all information in the opened workspace using the Web Report 
Wizard. You can generate separate web reports for individual models as well as individual 
diagrams. The reports are created in the HTML format. 

 
1 Choose Tools > Reports > Web Report from the main menu and the Web Report wizard 

opens. The first panel lists the following: 
 

• The current workspace 
 

• Reference Objects 
 

• External Data Objects 
 

• All related projects 
 

• All related models 
 

• All related diagrams 
 

All items are selected by default. 
 

NOTE:  Only reference objects in the diagrams are included in the Web Reports. Reference 
Objects that exist only on the tree are not included in the report. 

 

 
2 Deselect the items you don’t want included in your web report and click Next. 

 
NOTE:  If a diagram is selected, the model elements are filtered based on the selected 

diagram. 
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3 In the Object Type Selection list box, specify the types of objects you want to include in the 

report. The following categories are available: Business Process Modeling, Conceptual 
Modeling, External Data Objects, Reference Objects, and Shapes. All items in this list box 
are selected by default. You can expand the categories and include/exclude individual 
elements within that category. 

 
4 Click Next to the Select Report Location dialog. Select a directory where you want the 

report to be created. The default setting for the generated report is a folder named Web 
Reports under the workspace directory (...My Documents\ERStudioBusinessArchitect\Web 
Reports). The default web report name is the same as the currently opened workspace. You 
can also browse to a new directory, if you don’t want to use the default. 

 
NOTE:  If you have already created a web report for your current workspace, you will get a 

warning that a report already exists in the specified location and that files will be 
overwritten. 

 

 
5 If you selected the preference to launch the report upon completion, the “Launch report 

upon completion” option is already selected in the Web Report dialog. 
 

6 Click Next to open the Report Details dialog. The Title and Author fields can be edited. 
You can also enter a description of the report. These details are displayed on the first page 
when the report first opens. 

 
7 Click Finish and a progress information dialog opens telling you the reports are being 

generated. 
 

8 Once the report has been generated a title page opens, as well as a tree displaying the 
workspaces, projects, models, diagrams, elements, reference objects, and external data 
objects. This tree is located on the left-hand side of the window. 

 
You may get an Information Bar dialog warning you when Internet Explorer blocks a pop-up 

window. Click OK to close this dialog. Click once in the yellow bar with the warning icon (  
) and select Allow Blocked Content from the menu. Click Yes once again to close the 
Security Warning dialog. 

 
9 Expand the tree and click on any diagram node to display a graphical representation of the 

diagram. 
 

10 Click on an element and the report displays the element‘s properties. For example a 
business entity named Account in a conceptual model diagram is displayed as CMBusiness 
Entity: Customer Support. 
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Using Web reports 

When you use ER/Studio BA to create an HTML Web report, the application produces a folder for 
the workspace and all associated projects, models, diagrams, and elements. 

 

1 In the left pane, click the name of any diagram and the Web Report displays a graphic of 
that diagram in the right pane. 

 
2 Click any element in the tree and the Web Report displays, in the right pane, the element’s 

properties in a tabular format. 
 

3 Where applicable, a link is provided to a related element. For example, in the following 
graphic, the lane labeled “Underwriter” is a child of the pool “Lender”. 
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4 When you click on the hyperlink “Lender”, the web page for that element opens, displaying 

the details for that pool. 

 

Views 
Views provide alternative presentations as well as ways to navigate the information in ER/Studio 
BA. 

Views have their own menus. To open the menu for a view, click the icon at the left end of the 
view's title bar. Some views also have their own toolbars. The actions represented by buttons on 
view toolbars only affect the items within that view. 

ER/Studio BA offers six main views in the application. Each view can be opened, and moved and 
docked in a different location. And each view has a set of icons in the toolbar that makes it easy to 
manipulate the view. 

The table below lists the five views: 

Topic Description 

The Diagram View The Diagram View, located to the right of the Model View tree, is 
where you can place the graphical representations of the 
Business Process Modeling Notational and Conceptual elements 
as well as elements from the other palettes. 

The Model View The Model View tree displays the hierarchy of workspaces, 
projects, models, diagrams, and elements. It also displays the 
hierarchy of reference elements. Workspaces, projects, models, 
diagrams, and elements can be created, organized, and viewed. 
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Topic Description 

The Palette View The Palette View contains the business process elements, 
conceptual elements, reference objects, external data objects, 
and drawing shapes elements used to create business process 
modeling diagrams in the Diagram View. 

Error Logging View The Logging Views include the Error Logging view. This view 
tracks errors generated by ER/Studio BA. 

Help View The Help View displays dynamically generated help topics. 

Overview Window The Overview window is a scalable window displaying any 
diagram in its entirety. 

Search Results Shows the results of a Search of the metadata for a workspace. 

Opening a View w indow 

1 On the Window menu, select Show View. 
 

2 From the pull-right menu, select the view you want to open. 

Moving and Docking v iews 

You can change the location of a view: 
 

1 Drag the view by its title bar to the desired location. But do not release the left mouse 
button yet. 

 
As you move the view around the Workbench, the mouse pointer changes to one of the 
drop cursors. The drop cursor indicates where the view will be docked if you release the left 
mouse button. 

 
NOTE:  The drop cursor changes as you drag the view over the left, right, top, or bottom 

border of another view or editor. 
 

 
2 When the view is in the location that you want, release the left mouse button to dock the 

view. 
 

NOTE:  A group of stacked views can be dragged using the empty space to the right of the 
view tabs. 

You can also move a view by using the pop-up menu for the view. (Left-click the icon at the left 
end of the view's title bar, or right-click anywhere else in the view's title bar).
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Using d rop cursors 

The table below shows the different drop cursors and where the view will be moved to: 

Drop Cursor Where the view is moved to: 

 
 

The view is docked above the view underneath the cursor. 

 
 

The view is docked below the view underneath the cursor. 

 
 

The view is docked to the right of the view underneath the cursor. 

 
 

The view is docked to the left of the view underneath the cursor. 

 
 

The view is docked as a Tab in the same pane as the view underneath 
the cursor. 

 
 

This area is restricted and you cannot dock a view here. 

Using the Views t oolbar 

Each View window has a set of icons that allow you customize the view windows. You can use a 
drop-down menu to gain access to view tools, and you can minimize or maximize each view 
window. 

Toolbar Icon Element Description 

 
 

 

Menu Displays a drop-down menu containing all the toolbar 
icons for the selected window. 

 
 
 
 
 

Minimize This command hides the view and only the icon and tab 
representing the view are displayed in the application 
window. Click once in the tab to restore the view to its 
original size and location. 

 
 

Maximize The view is expanded to fill the entire application 
window. 

 
 
 
 

Restore Once you have maximized a view window, the Restore 
icon appears in the upper right corner of the window. 
Click this icon to restore the maximized window to its 
original size. 

Diagram view 
The Diagram View, located to the right of the Model View tree, is where you can place the 
graphical representations of the Business Process Modeling Notational elements, Conceptual 
elements, Reference Object elements, External Data Object elements, as well as elements from 
the Drawing Shapes palette. Each time you place an element in this area, it also appears in the 
Model View tree. 

Displaying the Diagram v iew 

The Diagram View is not displayed when you first open a workspace in the application. The 
diagram node appears in the Model View tree, but the actual Diagram View is closed. To display 
this area, do the following: 

 
1 In the Model View tree, right-click the diagram name node. 

 
2 Select Open and the Diagram View opens, including the Business Process or Conceptual 

Objects, Reference Objects, External Data Objects, and Drawing Shapes palettes. 
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Modifying the Diagram v iew 

You can modify, position, and size the Model View. When you right-click the Model View tab, a 
shortcut menu opens displaying the following commands: 

Command Description 

Restore Restores a maximized window to its original size within the 
application. 

Move You can move a single view or an entire tab group. When you select 
this command, the select view or tab group is outlined with a gray 
box. Move the gray box to a selected location and click once. The 
view or tab group is placed in the new location. 

Size You can the resize the top, bottom, left or right side on a view. Click 
Size and then select one of the four available sides. The selected 
side is replaced by a wide bold line. Place the cursor on this line and 
the cursor changes to resize. Hold down the mouse button and move 
the side to the desired location. 

Minimize Hides the view and only the icon and tab representing the view are 
displayed in the application window. Click once in the tab to restore 
the view to its original size and location. 

Maximize The view is expanded to fill the entire application window. 

Close Closes the selected view. You can also click  located in the tab to 
close the view. 

Close All Closes all the views. 

Close Others Closes all views except the active view. 

New Editor Opens a new editor. 

Using the Diagram v iew 

Once you have created a diagram in the Model View tree, you can design models using the 
notation elements available on the palette. 

 
1 On the palette click the element you want to place in the Diagram View. 

 
2 Click in the area to place an element. Each element placed in the Diagram View also 

appears on the Model View tree. 
 

NOTE:  The cursor is in the multi-drop mode     so you can place as many elements as you 

need. Press ESC to exit the multi-drop mode. The cursor changes from     to . 

For more information, see Using Diagram Elements. 
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Model view 
The Model View appears in the upper left portion of ER/Studio BA by default. It contains the 
Model View tree displaying the hierarchy of workspaces, projects, models, diagrams, and 
elements. It also displays the hierarchy of reference elements. Workspaces, projects, models, 
diagrams, and elements can be created, organized, and viewed. You can modify the Model View 
to fit your preferences. 

The Model View is easy to use, allowing you to create and view all aspects of the application. The 
Model View Toolbar contains tools you can use to organize and filter the tree. 

Displaying the Model v iew 

By default, the Model View is displayed when you first start the application. To display the Model 
View when hidden, do the following: 

 
1 On the Window menu, select Show View. 

 
2 Select Model from the pull-right menu. 

Modifying the Model v iew 

You can modify, position, and size the Model View. When you right-click the Model View tab, a 
shortcut menu opens displaying the following commands: 

Command Description 

Detached Click this command to detach the view from the application’s frame 
and position it anywhere within or outside the application window. 
This state of detachment is called floating. This is a toggle command 
and the Detached command is checked once it is selected. 

Restore Restores a maximized window to its original size within the 
application. 

Move You move a single view or an entire tab group. When you select this 
command, the select view or tab group is outlined with a gray box. 
Move the gray box to a selected location and click once. The view or 
tab group is placed in the new location. 

Size You can the resize the top, bottom, left or right side of a view. Click 
Size and then select one of the four available sides. The selected side 
is replaced by a wide bold line. Place the cursor on this line and the 
cursor changes to resize. Hold down the mouse button and move the 
side to the desired location. 

Minimize This command hides the view and only the icon and tab representing 
the view are displayed in the application window. Click once in the 
tab to restore the view to its original size and location. 

Maximize The view is expanded to fill the entire application window. 

Close This command closes the selected view. You can also click  
located in the tab to close the view. 
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Using the Model view 

The Model View tree displays the hierarchical representation of all elements in a model. When 
you create a new element in the Model View, it does not appear in the Diagram View. Once you 
have created it, you can then drag that element onto the Diagram View. Each element in the 
Model View tree has a representative icons. 

 
NOTE:  When you place an element in the Diagram View, a representative icon is automatically 

placed in Model View tree under the corresponding diagram node. 

Model v iew h ierarchy 

Elements appear under the model two different ways. 
 

• An element appears under the Diagram Node as a presentation element. This is indicated 
by an arrow symbol placed on the element icon ( ). Incoming and Outgoing Relationship 
nodes are also shown. 

 
NOTE:  If you have chosen to hide a connection using the Hide command from the shortcut 

menu in the Diagram, the connection node appears greyed out in the Diagram 
Node. Also, when you float your cursor over the hidden node the Tooltip displays 
the information that it is “hidden”. 

 
• The second means of display depends on whether you are creating Business Process 

Modeling diagrams or Conceptual Model diagrams. 
 

• If you are creating Business Process Modeling elements, all elements are placed either 
below the Process node, or a pool node. In the following example, the diagram contains 
a pool with an invisible boundary (named Order Picking Pool) and is indicated by the  
icon in the Model View tree. The lane, named Order Picking Lane, is “owned” by the pool. 
The event is owned by the process, but since the process is hidden, it appears under the 
pool. 
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• If you are creating Conceptual Modeling elements, all elements are placed below 
the model node. 

 
NOTE:  You can also display elements grouped by object type. 

The table below describes the different nodes in the Model View tree: 

Node Icon Description 

Workspace 
 

 
 
 
 

Top-level node containing all projects, models, diagrams, and reference 
objects. You can only have one workspace open at a time in the Model 
View. 

Project 
 

 
 

The project is associated with the workspace and is nested one 
level below the workspace. 

Conceptual Model 
 

 
 

The Conceptual Model contains diagrams and elements associated 
with the Conceptual Model type. 

Business Process 
Model 

The Business Process Model node can have two different icons depending on the 
validation setting you select. 

 
 
 

Non-Validated: If you select Off, a Non-Validated icon is displayed. 

 
 
 

Validated: When you select On, the Validated icon is displayed. 

Diagram 
 

 
 

When you expand the diagram node, presentation elements in the 
diagram are listed. 

Impact Analysis 
Diagram  

 
 

When you expand this node, all elements in the Impact Analysis 
diagram are listed. 

Pool with Invisible 
Boundary  

 
 

A pool and lane with an invisible boundary are created when first create 
a diagram. 

Elements There are two different representations of elements in the Model View tree: Regular and 
Presentation. 

When you expand an element, associated elements are then displayed, including 
incoming and outgoing relationships. 

 
 
 

Regular: If the element does not display the directional arrow, it means 
that it represents the metadata. 

 
 
 
 
 
 

Presentation: When elements are displayed under the diagram 
node, each icon includes a shortcut decorator. This indicates it is a 
presentation element only, representing an element on a diagram. 

Reference Objects 
 

 
 
 

Top-level node containing all reference elements for the current 
workspace: External Data Objects, Business Rules, Business Units, and 
Stewards. 
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Model v iew i cons 

Listed below are all the icons used in the Model View tree: 

Icon Description 

 
Workspace 

 
Project 

 
Conceptual Model 

 
Business Process Model - validation on 

 
Business Process Model - validation off 

 
 

Business Process Diagram 

 
Conceptual Model Diagram 

 
Process Node 

 
Impact Analysis Diagram 

 
 

Each modeling element is represented by an icon in the tree. 

 
 
 

If the element is a presentation element only it includes a shortcut 
decorator. 

 
 
 

When the elements are grouped by type, the element icons display a folder 
indicator. 

 
Incoming Relationships 

 
Outgoing Relationships 

 
 

Link - Represents links created using the Create Link Wizard. 

 
 

Usage - Create usages using the Create Usage Wizard. 

 
 

Reference Object - External Data Objects 

 
Reference Object - Business Element 

 
Reference Object - Business Rules 

 
Reference Object - Business Units 

 
Reference Object - Stewards 
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Model view toolbar 
You can use the icons on this toolbar to refresh, filter, and navigate through the Model View tree. 
You can also synchronize with a diagram, and group by element type. 

Toolbar 
Icon 

Element Description 

 
 

Refresh the Entire 
Model View 

Updates all the nodes in the Model View tree. 

 
 

Collapse All Collapses the tree expansion of all the resources 
in the view. 

 
 

Expand All Expands all the nodes in the tree including all 
diagrams. 

 
 
 
 
 
 
 
 
 

Sync with Diagram If this command is selected, whenever an 
element in the Model View tree is selected, that 
element is selected in the diagram. The sync 
option is on by default. 

 
 
Note: Right-click on an element in a diagram 
and select the command “Find in Model View” to 
locate an element in the Model View tree. 

 
Model View Filter Opens the Model View Filter dialog. 

 
 

Grouping by Object 
Type 

Groups items in the Model View tree by element 
type. This is a toggle switch. 

Model view filter 

You can use this filter to hide or show business process modeling elements, conceptual 
elements, reference objects, data objects, and drawing shapes in the Model View tree. When 
you click , the Model View Filter dialog opens. You can filter out elements based on a 
general type, or a specific element. A status bar located in the lower right-hand corner of the 
application displays the status of the filter (off or on). Also, if the filter is in use, it is indicated on 
the Model View tab. 

 
NOTE:  If you want to hide the Incoming Relationships grouping node, clear the checkboxes of 

all the connecting objects in the filter. 
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Using the Text f ilter o ption 

If you only want elements with a certain name or by a certain alpha character to appear in the 
tree: 

 

1 Click  to open the Model View Filter dialog. 
 

2 Select the Text Filter icon and the text box is now available. 
 

3 Enter the name you want to base the filter on. There are several different options: 
 

• If you enter an alpha character followed by an asterisk, all elements with the entered alpha 
character will appear in the tree. For example, if you entered “T*” in the text box, 
elements shown would include not only “Tasks” but “My Tasks” as well because a sCpace 
is used in the name. 

 

• Also shown are elements that are connected to an element with the selected criteria. For 
example, if you have a gateway labeled “GateOne” connected to a sequence flow named 
“To Task One”, if you have filtered on “T*”, both the gateway and the sequence flow 
appear in the Model View tree. 

 

• Also, you can enter an alpha character followed by a question mark as a single character 
“wild card” search. For example, if you entered “T?sk” the filter would show all names 
beginning in “T” and ending with “sk” in the Model View tree. 

 
NOTE:  The text filter is not case-sensitive. For example if the object name is “JOE”, both “joe” 

and JOE” would be the filter for that object. 

Grouping by object t ype 

This is a toggle command in the Model View toolbar. When this command is selected all 
diagrams and elements in the Model View tree are grouped by type. 

 
• Within each node, elements are grouped by element type (tasks, gateways, etc.). 

 
• Element Type header icons include a folder indicator ( ). 
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NOTE:  Element type groupings can also be turned off under Preferences. 

 

• Under each node or header, items are sorted alphabetically, unless there is a sequence 
associated with an element (lanes, for example). 

Palette view 
In addition to the palette that appears in the Diagram View when you open ER/Studio BA, you 
can also have the option to open the Palette View, which then replaces the Palette in the Diagram 
View. This view contains the same information, but this palette can be moved and docked 
different places inside and outside of the application. You can display the palette view if hidden, 
and modify how and where the palette is displayed. 

Displaying the Palette v iew 

To display this Palette View, do the following: 
 

Click Window > Show View > Palette on the main menu and a tabbed Palette View opens. 
Since only one palette can be visible at a time, this replaces the palette located in the 
Diagram View. 

 
NOTE:  Once you close this Palette View, the palette in the Diagram View reappears. 

Modifying the palette 

You can modify the Palette View. When you right-click the Palette tab, a shortcut menu opens 
displaying the following commands: 

Command Description 

Detached Click this command to detach the view from the application main 
frame and position it anywhere within or outside the application 
window. This state of detachment is called floating. This is a toggle 
command and the Detached command is checked once it is selected. 

Move You move a single view or an entire tab group. When you select this 
command, the select view or tab group is outlined with a gray box. 
Move the gray box to a selected location and click once. The view or 
tab group is placed in the new location. 

Size You can the resize the top, bottom, left or right side on a view. Click 
Size and then select one of the four available sides. The selected side 
is replaced by a dark blue line. Place the cursor on this line and the 
cursor changes to resize. Hold down the button and move the side to 
the desired location. 

Close This command closes the selected view. You can also click  
located in the tab to close the view. 
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Error Logging view 
All generated error messages for ER/Studio BA, appear in the log. Variousicons are used to 
identify the type of error. When using the Error Logging view, the toolbar allows you to 
manipulate the log. The following information is displayed for each error in the Error Logging 
View: 

Column Description 

Message Displays information on what caused the error to occur. 

Plug-in Displays the plug-in where the error occurred. 

Date Displays the date and time the error message was generated. 

The following message types are displayed: Fatal, Error, Warning, Information, Debug, and 
Trace. 

Displaying the Error Logging v iew 

To display the Logging view when hidden, do the following: 

1 On the Window menu, select Show View. 
 

2 Select Error Logging from the pull-right menu. 

Modifying the Error Logging v iew 

You can modify the Error Logging view. When you right-click the Error Logging tab, a shortcut 
menu opens displaying the following commands: 

Command Description 

Detached Click this command to detach the view from the application’s frame 
and position it anywhere within or outside the application window. 
This state of detachment is called floating. This is a toggle command 
and the Detached command is checked once it is selected. 

Restore Restores a maximized window to its original size within the 
application. 

Move You move a single view or an entire tab group. When you select this 
command, the select view or tab group is outlined with a gray box. 
Move the gray box to a selected location and click once. The view or 
tab group is placed in the new location. 

Size You can the resize the top, bottom, left or right side on a view. Click 
Size and then select one of the four available sides. The selected side 
is replaced by a dark blue line. Place the cursor on this line and the 
cursor changes to resize. Hold down the button and move the side to 
the desired location. 

Minimize This command hides the view and only the icon and tab representing 
the view are displayed in the application window. Click once in the 
tab to restore the view to its original size and location. 

Maximize The view is expanded to fill the entire application window. 

Close This command closes the selected view. You can also click  
located in the tab to close the view. 
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Event t ype icons 

The table below displays the icons used to specify the state of the event type. 

Toolbar Icon Element 

 
 
 

Error markers are often used to indicate the source location of syntax or 
compilation errors. 

 
 
 

Warning markers indicate the source location of, for example, compilation 
warnings. 

 
 
 

Information markers indicate the source location of information only 
tasks. 

Error Logging toolbar 

The table below details the icons and their function on the Error Logging toolbar. 

Toolbar Icon Element Description 

 
 

Copy A displayed log entry can be copied to the 
clipboard. 

 
 

Clear Log Viewer Clears all error messages from the Error Logging 
view. 

 
 
 

Delete Log Deletes all logged events from the view and the 
log file no longer exists. A message dialog opens 
asking for confirmation of the action. 

 
 

Open Log Launches a text viewer showing the contents of 
the log file. 

 
 
 

Reload Log After a log is cleared it can be restored. 

Note: If a file has been deleted, it cannot be 
restored. 

 
 
 
 

Export Log When you select this icon, a Save As dialog opens. 
The displayed Error Log file can be saved in a 
directory of your choice and is saved as a text file 
with a .log file extension. 

 
Import Log You can import an existing .log file. 

 
 

Importing an Error Log Opens a dialog listing details about the event 
messages. 

Using the Error Logging view 

You can import or export an error log, and filter an error log. If you need additional information 
on a specific error you can also open the Events Details dialog. 
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Importing an error l og 

1 Open the Error Logging view. 
 

2 Click the Import icon  on the toolbar and the Open dialog box opens. 
 

NOTE:  The default location is your current project file and the default file extension is .log. 
 

 
3 Select the log file you want to import and click OK. The imported file appears in the Error 

Logging view. 

Exporting an error l og 

1 Open the Error Logging view. 
 

2 Click the Export icon  on the toolbar and the Save As dialog opens. 
 

3 Select the folder where you want the log exported to and name the file. The default location 
is your current project file and the default file extension is .log. 

 
4 Click OK and the file is exported. 

Filtering an error l og 

You can use this command to select which event types to filter in the view display. This filter 
controls what is displayed in the error view, not the error log. 

You can specify several options in the Filter Commands dialog box. The table below describes 
these options: 

Element Explanation 

Information Select this option to display Information event types in the Error 
Logging View. 

Warning Select this option to display Warning event types in the Error Logging 
View. 

Error Select this option to display Error event types in the Error Logging View. 

Limit Visible Events Enter the number of events you want to appear in the Error Logging 
View. 

Show Events Logging During: All Sessions: Displays all events logged for all sessions. 

Most Recent Session: Displays only events logged during your most 
recent session. 

Opening the Log Filters d ialog box 

1 In the Error Logging view click in the toolbar and a shortcut menu opens. 
 

2 Select Filters and the Log Filters dialog opens. 
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3 Select the Event Types to be displayed: Information, Warning and/or Error. 
 

4 Enter the number of events to be displayed in the Limit Visible Events text box. 
 

5 Select which logging session you want displayed. 
 

6 Click OK and the changes made appear in the Error Logging view. 

Using the Event Details d ialog box 

You can view details of each error message logged in the Error Logging view. 
 

1 Right-click an error in the Error Logging view. 
 

2 Select Event Details to open the Event Details dialog. 

The following information is displayed: 
 

Event Detail Description 

Date Displays the date and time the error message was generated. 

Severity Displays the symbol and type of error. 

Message Displays information on the cause of the error generated. 

Exception Stack Trace Displays the exceptions generated. 

Session Data Displays the build identification number for Eclipse. 
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Help view 
When you open the Help View it opens as a pane located in the right-hand section of the 
application. This view dynamically displays the related topics of a selected view. You can use this 
view to search for the information you need to use the application. The Help View is divided into 
two sections: 

Section Description 

About This top portion of the view displays the name of the view 
selected. For example if Model View is selected the title would be 
About Model View. 

Dynamic Help Displays all topics related to the view selected. 

NOTE:  You can also gain access to online Help by selecting Help > Help Contents from the 
main menu. The online help opens in a separate window 

Displaying the Help view 

To display the Help view when hidden, do the following: 
 

1 On the Window menu, select Show View. 
 

2 Select Help from the pull-right menu. 

Modifying the Help v iew 

You can modify the Help view. When you right-click the Help tab, a shortcut menu opens 
displaying the following commands: 

Command Description 

Detached Click this command to detach the view from the application’s frame and 
position it anywhere within or outside the application window. This state of 
detachment is called floating. This is a toggle command and the Detached 
command is checked once it is selected. 

Restore Restores a maximized window to its original size within the 
application. 

Move You move a single view or an entire tab group. When you select this command, 
the select view or tab group is outlined with a gray box. Move the gray box to a 
selected location and click once. The view or tab group is placed in the new 
location. 

Size You can the resize the top, bottom, left or right side on a view. Click Size and 
then select one of the four available sides. The selected side is replaced by a 
dark blue line. Place the cursor on this line and the cursor changes to resize. 
Hold down the button and move the side to the desired location. 

Minimize This command hides the view and only the icon and tab representing the view 
are displayed in the application window. Click once in the tab to restore the 
view to its original size and location. 

Maximize The view is expanded to fill the entire application window. 

Close This command closes the selected view. You can also click  located 
in the tab to close the view. 
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Using the Help view 

When you click a topic in the Dynamic Help list, that topic opens in the view. The Help View 
Toolbar that appears at the top of the view helps you navigate the available information. You also 
have additional command icons that appear at the bottom of the view. 

Help v iew t oolbar 

When you open the Help View, the following commands appear in the toolbar: 

Toolbar 
Icon 

Element Description 

 
 
 
 
 
 
 
 
 
 
 
 

Show in External Window Opens the currently displayed Help topic in an 
external window. When you open this window, 
two additional icons appear in the toolbar: 

• Show in Table of Contents: Click    and 
the name of the topic displayed in the window 
is highlighted in the table of contents. 

 
 

• Print: Click  and the Print dialog opens 
allowing you to print the currently displayed 
topic. 

 
 

Show in All Topics Displays the table of contents with the current 
Help topic highlighted. 

 
 
 
 

Bookmark Document Click this icon to bookmark the current Help 
topic. The bookmarked topics are displayed 
when you click the Bookmarks icon in the  Go  
To section. 

 
 
 

Back Click this icon to return to the view that was 
displayed immediately prior to the current 
display. 

 
 
 
 

Forward This command displays the view that was 
displayed immediately after the current display. 
This command is similar to the Forward button 
in an HTML browser. 
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Help v iew Go To icons 

In addition to the Help View toolbar, additional icons are displayed at the bottom of the Help 
View. The table below displays and explains each icon. 

Toolbar 
Icon 

Element Description 

 
 
 
 

All Topics/ 
Related Topics 

This is a toggle command. When you select All Topics, a table 
of contents opens displaying all topics. The command now 
available is Related Topics. This switches the view back to the 
Dynamic Help view. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Search Opens the Search dialog where you can enter a search 
expression to search the online Help topics. When the Results 
of the search are displayed, each displays icons allowing you 

to open a link in the Help window ( ) and/or bookmark 
( ) the Result. 

 

 
Two additional icons appear in the Search dialog: 

• Show Result Categories: This is a toggle icon  that hides 
or displays the main help category headings. 

• Show Result Descriptions: This is a toggle icon  that 
hides or displays the description containing the search 
expression. 

 
 

Related Topics Displays all the topics related to the currently displayed topic 
in the Help view. 

 
 

Bookmarks Displays a list of all the Help topics that you have bookmarked. 
You can click on any listed item to display that topic. 

Overview window 
The Overview window is a scalable window displaying any diagram in its entirety. You can use 
this window to quickly and easily navigate the diagram. If the current diagram is larger than its 
Diagram View, the Overview window also displays a scalable box denoting the Diagram View’s 
field of view. By moving or changing the size of this scalable box, you can change the Diagram 
View, effectively panning through the current diagram, or zooming in and out of it. For large 
diagrams, the Overview window is a much more powerful navigation tool than using a 
combination of ER/Studio BA scroll bars and zoom features. 

Displaying the Overview view 

To display the Overview view when hidden, do the following: 
 

1 On the Window menu, select Show View. 
 

2 Select Overview from the pull-right menu. 
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Modifying the Overview view 

You can modify the Overview view. When you right-click the Overview tab, a shortcut menu 
opens displaying the following commands: 

Command Description 

Detached Click this command to detach the view from the application‘s frame 
and position it anywhere within or outside the application window. 
This state of detachment is called floating. This is a toggle command 
and the Detached command is checked once it is selected. 

Restore Restores a maximized window to its original size within the 
application. 

Move You move a single view or an entire tab group. When you select this 
command, the select view or tab group is outlined with a gray box. 
Move the gray box to a selected location and click once. The view or 
tab group is placed in the new location. 

Size You can the resize the top, bottom, left or right side on a view. Click 
Size and then select one of the four available sides. The selected 
side is replaced by a dark blue line. Place the cursor on this line and 
the cursor changes to resize. Hold down the button and move the 
side to the desired location. 

Minimize This command hides the view and only the icon and tab representing 
the view are displayed in the application window. Click once in the 
tab to restore the view to its original size and location. 

Maximize The view is expanded to fill the entire application window. 

Close This command closes the selected view. You can also click  
located in the tab to close the view. 

Search results 
1 Open this view by selecting Window > Show View > Search Results. This displays the 

name and type of elements found in a search. 
 

NOTE:  This view opens automatically after a Search, if it isn’t already open. 
 

 
2 Double-click an element in the list. If it is not on a diagram, a Message dialog opens tell you 

that the select element was not found on any diagrams. 
 

If the element you double-click is on a diagram, the Diagram Usage dialog opens showing 
the diagram(s) the element appears on. 

 
3 Select the diagram from the list and click OK to open the desired diagram. 
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ER/Studio Business Architect tools – Importing 
and exporting 
ER/Studio BA provides import and export functions that extend the usability of the application. 
The import/export functions available in ER/Studio BA are listed below: 

Function Description 

Diagrams You can export Business Process diagrams, 
Conceptual diagrams and Impact Analysis 
diagrams in three different formats: rtf, pdf, and 
jpg. 

Grid Editor You can export the Grid Editor in the four 
different formats: csv, html, pdf, and rtf. 

Workspaces Export: You can export a workspace in a 
compressed format (file extension .exz). This 
function allows you to (1) archive your workspace 
and/or (2) send to another user where it can be 
reimported. 

Workspace: This function allows you to import 
the exported compressed file from another user, 
from the archives, etc. 

CSV Files Certain data residing in Comma Separated 
Value files can be imported into ER/Studio BA. 

 
You can also export data to a CSV file using the 
Grid Editor. 

Conceptual Models You can import or update ER/Studio DA logical 
models into ER/Studio BA’s conceptual models. 

 
Note:Conceptual Models can also be exported 
to ER/Studio DA as a logical model. 

External Data Objects Export: External Data Objects can be exported 
to ER/Studio DA as a logical and physical model. 

You can Import or Update ER/Studio DA models 
into the application as external data objects. 

Visio Import You can import Visio diagrams into Business 
Process or Conceptual models. When you 
import a Visio model, you create a new model 
and associated diagrams. 
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CSV file import 
You can import large amounts of data in the Comma Separated Value file into ER/Studio BA. You 
can import the following: 

• Reference Objects 

• Business Elements 

• Business Rules 

• Business Units 

• Stewards 

• Business Entities 

• Subject Areas 

• Tasks 

By using pre-existing templates, you can input data into a comma separated value file and then 
import it into the application. A template exists for each object available in ...:\Program Files 
\IDERA\ERStudio Business Architect X.X\samples \CSV\Templates. You can open these 
templates in Microsoft Excel or any text editor to enter data. 

Importing a CSV File 

1 On the main menu, select File > Import > Comma Separated  Values (CSV)… and the 
Object Type and File Location dialog opens. 

 
2 Select the object type you want imported. Your options are Business Elements, Business 

Entities, Business Rules, Business Units, Stewards, Subject Areas, and Tasks. 
 

3 Browse to the file location where the CSV file to be imported is located and select your file. 
 

4 You can import CSV files with or without headers. If the file you are importing has headers, 
select the “First line in file is header” option. 

 
CAUTION:  If you do not select this option and your file has headers, your first row will be 

imported as data. For example if your headers were Name, Data Type, 
Description, and Notes, when the file is imported, your first row of data would 
be the Name, Data, Type, Description and Notes. This may cause errors 
because the import values will be invalid. 

 
 

5 Click Next. 
 

6 If you are importing Tasks, the Pool and Diagram Selection dialog opens. If you are 
importing Subject Areas or Entities, the Model and Diagram Selection dialog opens. This 
allows you to select a diagram on which elements appear. 

 
7 If there are elements that exist with the same name the Possible Duplicate Elements dialog 

opens. You can choose to create a new element with a unique name or update the existing 
element. When updating existing elements the following will occur: (1) Elements in the 
project having corresponding objects in the import are updated with new information; and 
(2) Objects in the import without corresponding elements in the project are added to the 
project as new elements. 
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8 If there are problems with the import, a Problems in File dialog opens. A table lists any 
errors, warnings, or information, as well as the line number of the problem. 

 
• Click Launch Editor to open the application associated with the CSV extension, where 

you can view and correct any problems. 
 

• Once you have corrected the problem click Revalidate. 
 

9 If the import is successful, an Import Summary dialog opens displaying all the records that 
have been imported. 

 
10 Click Finish and a CSV Import Complete notification dialog opens telling you how many 

elements were created in ER/Studio BA. 
 
11 Once you close the notification dialog, the imported elements are placed under the 

appropriate node in the Model View tree, and on the associated diagram. 
 

• If you are importing reference objects, once you close the notification dialog, the 
imported elements are placed under the appropriate Reference Object node in the 
Model View tree. 

 

• If you are importing Tasks, they are placed in a model and on a diagram, if you selected 
one. You will be prompted where to place them on the next page of the Import Wizard. 

 

12 You can then drag these elements on to an existing diagram. When you double-click on an 
element, the Property View for that element opens displaying the imported data. 

 
 
Importing Tasks 

When you import a task, you must place the imported tasks in either an existing pool or create a 
new one. 

 
1 After you have completed the Object Type and File Location dialog, click Next and the Pool 

and Diagram Selection dialog opens. 
 

2 If you chose to use an existing pool, click Next and the Lane and Diagram Selection dialog 
opens where you must select a lane in a model to contain the created elements. 

 
• Select a Lane from the hierarchy. 

 

• Select “Add elements to a diagram” if you want the newly imported element added to 
the diagram. 

 

• Select an existing diagram and click Next. 
 

• If elements are found with the same name, the Possible Duplicate Elements dialog opens. 
 

3 If you chose to create a new pool you must enter the name of the new pool. 
 

• Click Next and the Model and Diagram Selection dialog opens. You must select the 
model where the elements should be created. 

 

• Click Add elements to a diagram if you want the imported tasks to appear in a diagram. 
You have two options: (1) You can create a new diagram (the default name of the new 
diagram is the new pool name); or (2) You can use an existing diagram from the list box. 
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4 Click Next and the Import Summary dialog opens displaying the name and description of 
the imported elements. 

 
5 Click Finish. If you selected the option to add elements to a diagram, that diagram opens 

with the imported tasks. If you did not select this option, the imported elements are added 
to the Model View tree and a dialog opens telling you how many elements were imported. 

 
 

Importing Business Entities and Subject Areas 

Business Entities and Subject Areas are imported using a slightly different wizard. It is similar to 
importing tasks but you are not required to place the entities or subject areas in a pool. Also, the 
imported elements are automatically added to a diagram. 

 
1 On the main menu, select File > Import > Comma Separated Values (CSV)… and the CSV 

Import Wizard opens. 
 

2 Select the object type. In this case select either Subject Areas or Business Entities. 
 

3 Browse to the file location where the CSV file to be imported is located and select your file. 
 

4 You can import CSV files with or without headers. If the file you are importing has headers, 
select the “First line in file is header” option. 

 
CAUTION:  If you do not select this option and your file has headers, your first row will be 

imported as data. For example if your headers were Name, Data Type, 
Description, and Notes, when the file is imported, your first row of data would 
be the Name, Data, Type, Description and Notes. This may cause errors 
because the import values will be invalid. 

 
 

5 In the Model and Diagram Selection dialog, select the model or diagram to contain the 
imported elements. 

 
6 Click Add elements to a diagram if you want the imported element to appear in a diagram. 

You have two options: (1) You can create and name a new diagram; or (2) You can use an 
existing diagram from the list box. 

 
7 If there are elements that exist with the same name the Possible Duplicate Elements dialog 

opens. You can choose to create a new element with a unique name or update the existing 
element. When updating existing elements the following will occur: (1) Elements in the 
project having corresponding objects in the import are updated with new information; and 
(2) Objects in the import without corresponding elements in the project are added to the 
project as new elements. 

 
8 If there are problems with the import, a Problems in File dialog opens. A table lists any 

errors, warnings, or information, as well as the line number of the problem. 
 

• Click Launch Editor to open the application associated with the CSV extension, where 
you can view and correct any problems. 

 

• Once you have corrected the problem click Revalidate. 
 

9 Click Next and the Import Summary dialog opens displaying the name and description of 
the imported elements which will be created in the model. 
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10 Click Finish. If you selected the option to add elements to a diagram, that diagram opens 
with the imported tasks. If you did not select this option, the imported elements are added 
to the Model View tree and a dialog opens telling you how many elements were imported. 

Conceptual models 
Conceptual Modeling allows you to create high-level designs of core business concepts to gain 
acceptance and requirements from the business. These high-level Conceptual models can be 
forward engineered to create detailed Logical Data Models in ER/Studio DA. In addition to 
process-specific information, related business information can also be linked to data objects 
such as business rules, business elements, business units, and stewards.You can import and 
update from ER/Studio DA as well as Export to ER/Studio DA with customized mappings. 

 
 

Related Topics: 

• Conceptual Model Import from ER/Studio DA 
 

• Conceptual Model Update from ER/Studio DA 
 

• Conceptual Model Export to ER/Studio DA 

Conceptual model import from ER/Studio Data Architect 
You can import ER/Studio DA logical model elements and domains into an ER/Studio BA 
conceptual model. The import uses pre-defined  mapping. A mapping table is also included for 
Bound Business Elements. The following rules apply to the elements you are importing from ER/ 
Studio DA: 

 
• When you select a main model/submodel, all the entities inside that submodel are moved to 

the Selected Entities tree. A subject area and diagram are created for each submodel. 
 

• If you deselect the diagram that was created, the subject area and all the entity metadata 
stays in the Selected Entities tree. 

• When importing ER/Studio DA diagrams with super/subtype relationships, the supertype 

entities will not be expanded automatically. However, an expander indicator ( ) will 
appear in the parent entity indicating the presence of children. 

 
• If the Show expansion control preference is set, expanders are shown for all entities after 

an import. If the preference is not set, the expander is displayed only when there are 
children. 

 

• You do not have to import all the attributes for a given entity. You can select one or more 
attributes you want imported from the list of all attributes in an entity. 

 
• If you deselect a subject area that was created, all its nested subjects with their 

corresponding diagrams are removed from the Selected Entities tree. 
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• If you import a model having relationships with verb phrases, the verb phrases are imported 
and displayed the diagram by default 

 
• If the business name of a relationship is shown in an ER/Studio DA model, they are displayed 

on import, even if the "show name on creation" preference is not set for relationships. 
 

• There are two kinds of Entity nodes: EntityData in the Main Model, and EntityDisplay in the 
Submodel. 

 
• If you select an Entity under the Main Model (which is an EntityData) then only the entity is 

moved to the Selected Entities tree with its nested entities. No subject areas and diagram 
are created. 

 

• If you select an Entity under a Submodel (which is an EntityDisplay), a diagram and subject 
area are created in addition to the Entities. 

 

• If you select a Supertype node, both the parent and children of this supernode are selected 
as well. 

 
The following rules apply to the created Business Elements when you import domains from ER/ 
Studio DA: 

 
• ER/Studio DA domains are created as Business Elements. 

 
• The enforce name property of the created business elements is always cleared. Therefore, 

the “override name” option is never set on Business Attributes created through the import 
process. 

 
• The enforce data type, description, and notes properties are pulled from the “allow 

override” options on the ER domains themselves. Business attributes are no longer checked 
to see if they actually override the properties. 

 
• If the domains allow the properties to be overridden, the “enforce” options are cleared 

accordingly on the business element. The “override” options are never enabled on the 
business attributes, even though the properties may differ from those of the business 
element. 

 
• If the domains do not allow the properties to be overridden, the “enforce” options are set 

accordingly on the business element. The “override” options are enabled on all business 
attributes. The properties should match those of the business element because of ER/Studio 
DA behavior. 

 
 
Importing an ER/Studio DA Model to a Conceptual Model 

1 In the Model View tree right-click the project or conceptual model where you want the 
imported ER/Studio DA model to be placed. 

 
2 Select Import > From ER/Studio Data Architect  > Create New Conceptual Objects.... 

 
3 In the Source Name and Location dialog, select the ER/Studio DA diagram you want to 

import. You can browse to the location of the diagram. Under Model options, the Model 
Name is the default name of the ER/Studio DA model you are importing. 

 
4 In the tree, select where you want the model to be placed and click Next. 
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5 In the Object Selection dialog you can specify the objects you want included in the model. 
There are two tabs: Entities and Domains. Under the Entities tab, the Available Entities tree 
shows the entity hierarchy for the ER/Studio DA Logical model, including Super and Sub- 
types. 

 
NOTE:  All the physical models in the ER/Studio DA file are ignored. Also, ER/Studio DA views 

are not imported because the Conceptual model does not have a corresponding type. 
 
 

• From the list of Available Entities, select the entities you want to import and click . You 
can select multiple objects by holding down the CTRL key and clicking individual objects. 
You can also import the entire list by clicking . All the selected entities are moved to 
the Selected Object tree. 

 

• If you want to import only selected attributes within an entity, expand the entity and select 
the attributes you want to import and click . You can select multiple attributes by 
holding down the Ctrl key and clicking individual attributes. The entity and only the 
attributes you selected are moved to the Selected Object tree. 

 

• Nested Submodels are imported as nested Subject Areas. A diagram with the same name 
as the Subject Area is created and a map is created between the diagram and the Subject 
Area after the import. 

 

• The Model name that appears under Model Options on the first panel of the wizard 
appears in the Selected Entities panel. 

 

6 After you have made your selections on the Entities tab, click the Domains tab. You can 
select the type of element you want the domain imported as. Your three options are: 
Business Elements, Domains, and Business Elements Referencing Domains. 

 
NOTE:  You can set a default  preference for your import type. 

 

 
7 All domains in the ER/Studio DA model are listed. See Importing ER/Studio Data Architect  

Domains as ER/Studio BA Domains for the rules that apply when importing ER/Studio DA 
domains. 

 
NOTE:  If you only want to see bound domains, select that option “Only show domains bound 

to selected entities” located below the Available domains list box. In ER/Studio DA you 
can bind a domain to an entity attribute, so this option filters out domains that are not 
bound to entities. If no entities are selected for inclusion in the import, this option is 
not available. 

 

 
8 Click Finish and the imported model with all its associated diagrams, subject areas, and 

entities is placed in the Model View tree. 
 

CAUTION:  For diagrams, relationship bend points and connection points are not imported 
and/or updated. They will be auto-routed using the default routing algorithms). 
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Conceptual model update from ER/Studio Data Architect 
If you are working on an ER model, you can frequently update your associated EA conceptual 
model, if that ER/Studio BA model was initially created by importing the ER model. The ER 
model changes can include entity name changes, adding and removing new attributes, adding 
and removing relationships, binding and unbinding existing domains, etc. Because updates are 
based on an object’s unique identity rather than its name, you have ability to re-import just the 
changes, or the entire ER model, and the existing ER/Studio BA Conceptual Model is updated. 
All existing relationships are maintained, and renamed elements are updated properly. 

 
NOTE:  You can import several different ER models into a single Conceptual Model, and 

update this model when required. 
 

 
CAUTION:  Only the elements that were originally created by importing the ER model are 

updated. Any elements that are created in ER/Studio BA are not updated with 
information imported from the ER model. For example, you have created an 
entity named “EntityOne” in ER/Studio BA. If you import an ER model with an 
entity with the same name containing attributes and descriptions, those 
attributes and descriptions are not added to the existing ER/Studio BA entity. 

 
 

The following rules are implemented when updating a Conceptual Model from ER/Studio DA: 
 

Element Rules 

Subject Areas If you import several ER models into the same Conceptual 
Model, a unique identifier is stored with each submodel in a 
hidden attribute. 

You can rename submodels, move entities between other 
submodels, and subject area mappings are updated. 

Entities Along with existing properties, a unique identifier is stored in a 
hidden attribute on the entity which includes the ER model 
name. When an ER update occurs, each ER entity unique 
identifier is matched with ER/Studio BA’s entities to determine 
the match. This allows any property of the ER/Studio BA’s entity 
to be change (including name), without breaking the ‘link’ to the 
existing ER entity. 

Attributes As new attributes are added, removed, renamed, or reordered 
in the ER entity, the information is properly updated in the ER/ 
Studio BA model, because each attribute has a unique identifier 
stored in a hidden attribute. 

Entity Relationships Each relationship that is imported will include a unique identifier 
in a hidden attribute to identify it and match it with the 
corresponding relationship in the ER model. 

When updating elements with relationships: 
 
• You only need to pick one node connected in a relationship. 
The import discovers the other end of the relationship, and 
leaves the relationship connected. 

• If Entities with the same name already exist in the Conceptual 
Model, a new unique name is created. 
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Element Rules 

Bound Domain 
Relationships 

You have option to import domains as business elements or 
domains, or both. 

When updating entities: 

• If a bound domain is renamed, the import detects this 
situation and renames the associated business element or 
domain, depending on how the ER domains are imported. 

• If the override properties of a domain are changed, the import 
changes the same override properties in ER/Studio BA. 

• When an ER model is imported that has a domain with the 
same name as an existing business element/domain, a new 
business element/domain is created. 

• When an existing entity’s attribute is bound to a new domain, 
and you import only the entity, the new binding is detected and 
includes the new domain as well. (This assumes you have not 
excluded it during the import.) 

• If an existing entity’s attribute is disassociated with a domain 
the binding is broken in ER/Studio BA. 

 
 

Updating from ER/Studio DA 

1 Right-click a Conceptual Model in the Model View tree and select Import > From ER/ 
Studio Data Architect  > Update Existing Conceptual Objects. 

 
2 In the Update Conceptual Objects > Source Name and Location dialog select the 

location of the ER/Studio DA diagram that contains the source of the conceptual objects 
you want updated. You can browse to the location of the .dm1 file. 

 
3 In the workspace tree, select the target model you want updated. 

 
4 You can select the “Delete objects in model that aren’t contained in source file.” If you 

enable this option, any objects in the target model that no longer exists in the ER model are 
deleted. If this option is not selected, (it is not selected by default), none of the objects in 
the target model are deleted. 

 
NOTE:  This option does not work with domains. Since Business Elements/Domains are shared 

objects that can be bound to objects completely outside the scope of the update, they 
can not be deleted. 

 

 
5 Click Next and the Object Selection dialog opens. From the list of Available entities, select 

the objects you want to export and click . You can select multiple objects by holding down 

the Ctrl key and clicking individual objects. You can also import the entire list by clicking . 
All the selected entities are moved to the Selected Entities tree. 

 
6 After you have made your selections on the Entities tab, click the Domains tab and all 

domains in the ER/Studio DA model are listed. 
 

NOTE:  For updates, domains are preselected based on what bound entities are picked. 
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CAUTION:  If you do not include all the elements that are connected with relationships, the 

existing relationships will be severed because the “connected” element was 
not included in the update. 

 
 

7 Click Finish and the following happens: 
 

• The selected objects are compared with objects in the selected target model. 
 

• Existing target objects that match a corresponding source object will have all of the 
properties updated with those properties in the source objects. 

 

• If an element in an ER model is renamed, and the conceptual model is updated, the old 
entity is replaced with a new entity of the same name. 

 

• Source objects that do not match any existing target objects will be created in the target 
model/diagrams. 

 

• If a partial model is updated, any relationships that existed are lost if the other end of the 
relationship was not selected in the update wizard. 

 

• Relationships are matched by how their nodes are matched. Once a match is determined, 
all relationship properties, including its name, are updated. 

 

• If you have selected the “Delete objects in model that aren’t contained in source file” 
option on the previous page of the wizard, existing target objects will get deleted if they 
do not match any object in the ER model. 

 

CAUTION:  For diagrams, relationship bend points and connection points are not imported 
and/or updated. They will be auto-routed using the default routing algorithms. 

Conceptual model export to ER/Studio Data Architect 
You can export conceptual models to ER/Studio DA where the elements in the conceptual 
diagram map to the logical diagram in ER/Studio DA. 

 
You can choose to export all or part of the elements on a model by right-clicking on a 
Conceptual Model node ( ) in the Model View and selecting Export > Model to ER/Studio 
Data Architect.... This command is also available on the File menu. 

 

If you wan to export all or part of the elements present on a specific Conceptual Model diagram, 
right-click on the desired diagram node ( ) and select Export Diagram to ER/Studio Data 
Architect. This command is also available on the File menu. 

 
The export uses pre-defined  mapping. A mapping table is also included for Bound Business  
Elements. Click  here for instructions on using the export wizard. 

 
NOTE:  Models are exported to a format which can be opened in ER/Studio Data Architect 7.0 

and above. 
 

 
The following rules apply to the export of Subject Areas: 

 
• Subject areas are exported as sub-models 
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• All nested Subject Areas will be exported according to Subject Area containment, creating 
nested submodels. 

 
• Business Entities mapped to subject area will be exported as entities under that submodel 

 
• Business Entities contained in the subject area (on a diagram) will be exported as entities 

under that submodel 
 

• Nested Subject Areas will be exported based on mappings. 
 

• Mapped diagrams will export Business Entities in the diagram not contained in Subject 
Areas. 

 
• Mapped diagrams will not export the diagram's Subject Areas and its contents 

 
The following rules apply to the export of Entities and Attributes 

 
• Nested Business Entities will be exported as logical entities connected by a super-type/sub- 

type relationships. 
 

• Individually selected Business Entities will be exported as logical entity without exporting its 
parent subject area 

 
• If you have Business Entities with Name Collisions, (Business Entity name from one model is 

the same as the name of a Business Entity from another model) one of the Business Entities' 
names will be renamed by appending with a string like "_1". 

 
• Business Entities mapped to the Subject Area will be exported, including the nested 

Business Entities. Both the parent and child Business Entities will be selected together. 
 
 

Exporting  the Conceptual Model to ER/Studio DA 

1 In the Model View tree, right-click on either the conceptual model or diagram you want to 
export to ER/Studio DA and select Export to ER/Studio Data Architect.... 

 
2 In the Export to ER/Studio Data Architect  dialog, name your exported file in the File 

Name text box. 
 

NOTE:  The file extension of “.dm1” is automatically added. 
 

 
3 Click Browse in the Directory text box to find the directory where you want to store you 

exported file. The default directory is ...My Documents\ERStudioBusinessArchitect. 
 

4 From the list of Available elements, select the objects you want to export and click . You 
can select multiple objects by holding down the Ctrl key and clicking individual objects. You 

can also import the entire list by clicking . A Business Entity element maps as a logical 
subnode under the main model. The Subject Area element maps as a top level node in the 
Logical hierarchy 

 
5 The objects to be exported appear in the Selected Elements list box as ER/Studio DA 

objects. 
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6 Click OK and the export dialog closes. If you set the appropriate preferences, the Open 
generated model in ER/Studio Data Architect... option is selected in the dialog. The 
exported model is then opened automatically in ER/Studio DA. 

Mappings between ER/Studio Business Architect and ER/Studio Data Architect 

Exporting to ER/Studio DA is based on a pre-defined mapping to create the appropriate ER 
constructs from the Conceptual Model. The table below outlines the Entity mappings. There is 
also a section that covers the  Attribute Optionality mapping and  Attribute Datatypes mapping. 

 
 
 

ER/Studio BA Object ER/Studio DA Object 

Subject Area Submodel 

Diagram Submodel Diagram 

Subject Area Name Sub-Model Name 

Nested Subject Area Nested Sub-Model 

Business Entity Entity (Data) 

Business Entity Name Entity name and Table name 

Business Entity Description Entity Definition 

Business Attribute Attribute inside the entity 

Business Attribute Name Attribute Name and Default Column Name 

Business Elements Domain 

Binding between Business Element 
and Business Attribute 

Bounded Domain 

Relationships Relationships 

Interaction No mapped in ER/Studio DA 

Inheritance (Business Entities) Supertype/Subtype 

Inheritance (Subject Area) Nested Submodels 

 
 

Bound Business Elements 

If a Business Attribute is bound to a Business Element, the attribute is mapped to the Domain. 
The Attribute definition is mapped to that from the domain. 

 
ER/Studio BA ER/Studio DA 

Business Element Domain 

Business Element Name Domain Name, Attribute Name, 
Column Name 

Business Element Datatype Domain Datatype 

Business Element Description Domain Definition. Definition of bound 
attributes 
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Relationships 

In ER/Studio DA, relationship directions will be drawn in same direction as in ER/Studio BA. 
Relationships between business entities are exported as relationships between logical entities. 
The following are rules for each relationship type: 

 
ER/Studio BA ER/Studio DA 

Relationship Name Business Name 

Relationship Description Relationship Definition 

Verb phrase Verb Phrase (for Many to One relationships, Inverse Verb Phrase) 

Inverse verb phrase Inverse Verb Phrase (for Many to One relationships, Verb Phrase) 

Type: Generic Non-specific 

Type: Many to Many Non-specific 

Type: One to Many, Mandatory Non-identifying with the end point at the child. Existence = 
Mandatory, Cardinality = One to Zero or More 

Type: One to Many, Optional Non-identifying with the end point at the child. Existence = 
Optional, Cardinality = Zero or One to Zero or More 

Type: Many to One, Mandatory Non-identifying with the begin point at the child.(reversed parent- 
child relationship and verb, inverse verb phrases). Existence = 
Mandatory, Cardinality = One to Zero or More 

Type: Many to One, Optional Non-identifying with the begin point at the child.(reversed parent- 
child relationship and verb, inverse verb phrases). Existence = 
Optional, Cardinality = Zero or One to Zero or More 

 
NOTE:  Optional/Mandatory relationship settings are carried over to ER/Studio DA. If no 

optional/mandatory setting exists, you have the option to define what the default 
treatment is (i.e., export a non-specified optionality as either optional or mandatory). 
The default is that a non-specified relationship will be set to mandatory. 

 
 

Attribute  Optionality  and Datatypes 

The first table lists the Attribute Optionality mapping. 
 

ER/Studio BA ER/Studio DA 

Mandatory Allow Nulls = No 

Optional Allow Nulls = Yes 

Unspecified Allow Nulls = Yes 

 
 
 

This table displays the Attribute Datatypes mappings. 
 

ER/Studio BA ER/Studio DA 

Binary BINARY(10) 

Boolean BIT 

BLOB/Image IMAGE / LONG 



362   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

ER /S TU DI O BU SI NESS A R CH ITECT TO O L S - IMPOR T ING AND EXPORTING > EXTER N AL DATA OBJEC T S  

 

 
 
 

ER/Studio BA ER/Studio DA 

Char CHAR(10) 

CLOB/Large Text LONG 

Decimal DECIMAL(8, 2) 

Date DATE 

Integer INTEGER 

None CHAR(10) 

Timestamp TIMESTAMP/DATE 

Varchar TEXT 

XML XML(ER 7.1 and above) or 
VARCHAR(10) (ER 7.0) 

External data objects 
You can use an External Data Object (EDO) in a diagram for reference or for data flow  
diagramming. You can then link to External Data Objects with a specific business process or task. 
There are two different types of External Data Objects: Logical and Physical. The Logical types 
are entities and attributes. The Physical types are tables and views. 

 
 

Related Topics: 

• External Data Object Import from ER/Studio DA 
 

• External Data Object Update from ER/Studio DA Files 
 

• External Data Object Export to ER/Studio DA 

External data object import from ER/Studio Data Architect 
You can import or update External Data Objects from ER/Studio DA files using a wizard. This 
import parses the DM1 file to extract the appropriate data objects. These extracted objects are 
then loaded into the application’s storage. 

 
1 From the main menu, select File > Import > From ER/Studio Data Architect  > External 

Data Objects > Create New.... 

OR 

In the Model View, right-click the External Data Objects node and select Import > From 
ER/Studio Data Architect  > Create New External  Data Objects.... 

 
2 In the Import External  Data Objects dialog specify the source of the external data objects 

by selecting an ER/Studio DA diagram. You can find the file you want to import by clicking 
Browse. The Data Source Name that is created is based on the imported file name. 
However, you can change this name if desired. 
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3 Click Next and the Model Selection panel opens. Specify which models you want imported 
into the data source. The model selection is based on the file you selected in the previous 
panel. To narrow down your selection, you can expand the models available and select 
specific models you want to import. 

 
4 When you click Next, the Object Selection panel opens. The objects that appear are based 

on the selections you made in the previous panel. You have three tabs containing imported 
objects 

 
Tab Description 

Entities Displays a list of all available entities based on the 
selection made in the Model Selection panel. Expand the 
nodes to gain access to the individual entities. 

Tables Displays a list of all available tables based on the 
selection made in the Model Selection panel. Expand the 
nodes to gain access to the individual tables. 

Views Displays a list of all available Views based on the selection 
made in the Model Selection panel. Expand the nodes to 
gain access to the individual views. 

 
 
 

5 Select the object(s) you want to import and click . You can select multiple objects by 
holding down the Ctrl key and clicking individual objects. You can also import the entire list 
by clicking . 

 
6 Click Finish and an dialog opens telling you that the import was successful. Click Details... 

for information on what was imported. You can print or save this information. 
 

7 Click OK and the imported objects appear in the Reference Objects node under the Data 
Source name that you created in the first panel of the wizard. 

External data object update from ER/Studio Data Architect files 
You can use the Update External Data Objects option to update an existing External Data Object 
data source that you have already imported. All existing objects that match an object you have 
selected will be updated. All objects that you have selected but are not in the existing data 
source will be brought in as new. 

 
When updating existing elements the following occurs: 

 
• Elements in the data source having corresponding objects in the import are updated with 

new information. 
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• Objects in the import without corresponding elements in the data source are added to the 
data source as new elements. 

 
NOTE:  All links and diagram references to updated External Data Objects are still valid. 

 

 
1 Choose File > Import > From ER/Studio Data Architect  >External  Data Objects > 

Update Existing...  from the main menu. 
 

OR 
 

Right-click the External Data Objects node in the Model View tree and select Import > 
From ER/Studio Data Architect  > Update Existing External  Data Objects.... 

 
OR 

 

Right-click an existing data source node ( ) in the Model View tree and select Import > 
From ER/Studio Data Architect  > Update Existing External  Data Objects.... 

 
2 In the Location text box, specify the source of the external data objects. 

 
3 Select the data source containing the existing elements to be updated. 

 
4 You can select the “Delete objects in model that aren’t contained in source file.” If you 

enable this option, any objects in the target model that do not match an object that you 
select in the source model for update is deleted. If this option is not selected, (it is not 
selected by default), none of the objects in the target model are deleted. 

 
5 Click Next and select the models to be updated in the Model Selection dialog. 

 
6 Click Next and the Object Selection dialog opens. Select the entities, tables, and/or views 

from the Available Objects window, that you want included in the Selected list box. 
 

7 Click Finish and an dialog opens telling you that the import was successful. Click Details... 
for information on what was imported. You can print or save this information. 

 
8 Click OK and the updated objects appear in the External Data Objects node or the Data 

Source that you were updating. 
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External data object export to ER/Studio Data Architect 
You can export External Data Objects to ER/Studio DA where all entity elements map to a logical 
model and all table elements map to a physical model in ER/Studio DA. Only entities and tables 
are exported. The export uses pre-defined  mapping. 

 
NOTE:     Models are exported to a format which can be opened in ER/Studio DA 7.0 and above. 

 

 
1 Right-click an External Data Objects node in the Model View tree, or a datasource node. 

 
2 Select Export to ER/Studio Data Architect  and the Export to ER/Studio Data Architect 

dialog opens. 

OR 

Select the External Data Objects node and click File > Export > To ER/Studio Data 
Architect... . 

 
3 In the Export to ER/Studio Data Architect  dialog, the default name for the exported file is 

the data source name with the file extension of “.dm1”. You can change this name or leave 
the default setting. 

 
4 The default directory is ER/Studio BA’s default workspace directory: 

“...MyDocuments\ERStudioBusinessArchitect”. You can browse to a new location as 
well and make a new directory. 

 
5 From the list of Available Elements, select the elements you want to export and click . 

You can select multiple elements by holding down the Ctrl key and clicking individual items. 
You can also import the entire list by clicking . All the selected elements are moved to the 
Selected Elements tree. 

 
6 Click OK and the export dialog closes. If you set the appropriate preferences, the “Open 

generated model in ER/Studio DA...” option is selected in the dialog. The exported model 
is then opened automatically in ER/Studio DA. 

External data object to ER/Studio Data Architect mappings 

Exporting to ER/Studio DA is based on a pre-defined mapping to create the appropriate ER 
constructs from the External Data Objects. The first table below shows the Entity Attribute 
Datatype mappings. The second table shows the Table Column Datatypes. 

 
Entity Attribute Datatypes ER/Studio DA Object 

Binary (W) BINARY(W) 

Boolean BIT 

Char(W) CHAR(W) 

Date DATE 

Decimal DECIMAL(W, S) 

Float FLOAT 
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Entity Attribute Datatypes ER/Studio DA Object 

Integer INTEGER 

Long Binary IMAGE / LONG BINARY 

Money (W, S) MONEY(W, S) 

Timestamp TIMESTAMP / DATE 

Varchar (W) VARCHAR (W) 

XML XML (ER 7.1 and above) or VARCHAR (W) (ER 
7.0) 

 
 
 

Table Column Datatypes ER/Studio DA Object 

Binary(W) BIT VARYING (W) 

Boolean BIT 

Char(W) CHAR(W) 

Date DATE 

Decimal DECIMAL (W, S) 

Float FLOAT 

Integer INTEGER 

Long Binary VARCHAR (100) 

Money(W, S) DECIMAL(W, S) 

Timestamp TIMESTAMP 

Varchar (W) VARCHAR (W) 

XML VARCHAR (4000) 

Visio import 
You can import Microsoft® Visio diagrams into both the Conceptual and Business Process 
models. When you import a Visio model, the wizard walks you through the creation of a model 
and associated diagrams. Most Visio models were created using the basic drawing shapes or 
flowcharting objects. With the ER/Studio BA Visio import, you can convert these drawing shapes 
into meaningful Business Process Modeling Notations or data objects (for example a circle 
becomes a start event). 

 
When you use the import feature: 

 
• A mapping table lists the Visio objects and the corresponding ER/Studio BA objects. You 

can change these mappings. 
 

• A diagram is created for each page in the Visio model. 
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• The following font properties used in the model are imported as well: name, size, bold, italic, 
underline, strikeout and color. 

 
NOTE:  Microsoft® Office Visio® 2003 or 2007 must be installed on your computer to use this 

feature. 
 
 
Using the Import Feature 

1 From the main menu select File > Import > Microsoft Visio Model... to open the Microsoft 
Visio Import Wizard. 

OR 

In the Model View tree, right-click the workspace or a project and click Import > Microsoft 
Visio Model. 

 
2 In the Microsoft  Visio Import Wizard dialog, browse to the folder where your existing Visio 

models are stored and select the model you want to import. The two file type options are 
.vsd (drawing) and .vdx (xml drawing). 

 
3 Click Open to accept your selection and close the Browse dialog. 

 
CAUTION:  Make sure that the model you are importing is closed in Visio. 

 
 

NOTE:  When importing Visio models, the connections in Visio must show red anchors 
(indicating that it is anchored) on both the source and target elements in order for ER/ 
Studio BA to create the connection. 

 
 
 

4 Select either Business Process or Conceptual for the model type you want to import. 
 

5 Click Next to advance to the Model and Diagram Details dialog where you can specify the 
details of the model and diagrams to be created during the import process. 

 
6 In the Model Name text box, enter the model name for the imported information or leave 

default name, which is the name of the Visio model you are importing. 
 

7 You can create the model under the existing workspace, project, or model. In the hierarchy, 
click on the node where you want the model placed. 

 
NOTE:  The model that appears in the hierarchy depends on the model type you selected in 

the first panel of the wizard. 
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8 The Diagram Options section lists the Visio page name and the corresponding ER/Studio 
BA diagram name that will be created for each page of the Visio model. The page name that 
appears is based on the page name in Visio. You can change the default diagram name by 
pressing F2, which puts you in the edit mode. 

 
9 When you click Next the Mapping Visio Objects to ER/Studio BA Objects opens. The 

table lists the Visio object types, the page name where it is located, and their corresponding 
ER/Studio BA object types. 

 
10 When doing an import, you can use a previously saved custom map, use the default 

mappings, or map individual objects, including each individual element in the Visio Model. 
This is called Instance-Level Mappings. 

 
11 Once you have completed your mapping decisions, click Finish and the Importing Visio 

Objects dialog opens telling you that the import was successful. 
 

NOTE:  If any warnings were generated they are listed in the dialog. You can print and/or save 
this dialog. 

 

 
12 Click OK and all the imported diagrams open in the Diagram View area. 

 
13 In the Model View tree, the imported diagrams are listed with all associated elements listed 

as subnodes. 
 

NOTE:  When importing Visio models into ER/Studio BA, if you use default Visio shape sizes, 
the ER/Studio BA objects are created using default ER/Studio BA sizes. If an element 
is resized in Visio, you can set  preference to ensure that the resizing is carried over to 
ER/Studio BA. 

 
 

Creating Custom Mappings 

You can create and save user-defined mappings for a Visio object type in the Mapping dialog. 
 

1 Select the Visio Object Type you want to map. 
 

2 Click the corresponding ER/Studio BA Object Type and a drop-down list box opens. You can 
also press F2. This list box contains all supported Modeling elements (including embedded 
and independent sub-processes), Reference Objects, External Data Objects, Drawing 
Shapes, as well as the settings “Default” and “None”. Select the item you want to map to. 

 
3 Repeat for each object you want to map. 

 
NOTE:  If you want to restore the original mappings, click the Restore Default Objects Mapping 

icon ( ). 

 

4 To save your settings, click  to open the Save Mappings dialog. 
 

5 Enter the name you want to use for the saved mappings. It will be saved as an XML file. 
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Using Custom Mappings 

1 On the Mapping Visio Objects to ER/Studio BA Objects panel of the wizard, click the Use 
Custom Object Mappings option in the Custom Mapping Options group box. The 
Mapping File Location and Browse options are made available. 

 
2 Click Browse to go to the location where you saved your Custom Mapping files. 

 
NOTE:  You can set a  preference for your default custom mapping file location. 

 

 
3 Click Open and the Custom Mapping file is loaded and will be used when importing the 

Visio model. 
 

NOTE:  Click Reload Custom Mapping Options ( ) to restore the original state of your 
custom mappings file. This reload eliminates any mapping changes you made unless 
you saved the file. 

 
 
Instance-Level  Mappings 

You can map each individual object in the Visio model. 
 

1 Click  next to a Visio Object Type to display the individual objects. In the following 
example there are three Decisions listed under the Decision Object Type. 

 
 

 
 

2 Click the ER/Studio BA Object Type column of the specific Visio Object type you want to 
map and a drop-down list opens displaying all the available ER/Studio BA object types. 
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3 Select the object type you want to use and the selected object now appears in the column. 
This mapping is used in the import process. 

 
CAUTION:  The Instance-level mappings are not saved as part of the custom mapping file. 

You will get an “Unable to Save Instance-Level Mappings” warning dialog when 
you click Save. You have the option to “Always save current object type 
mappings without prompting”. You can also set a prompt-level preference for 
this dialog. 

Mapping Visio objects to ER/Studio Business Architect objects 
There are eight mapping tables showing all the object types that are currently imported from 
Visio to ER/Studio BA: 

 
• Basic Flowchart Shapes 

 
• Audit Diagram Shapes 

 

• EPC Diagram Shapes 
 

• Basic Shapes 
 

• Block Diagram Shapes 
 

• Cross-Functional Flowchart Shapes Horizontal 
 

• Cross-Functional Flowchart Shapes Vertical 
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Basic Flowchart  Shapes 
 

Visio Object Type ER/Studio BA Object Type 

Process Task 

Decision Gateway 

Document Data Object 

Predefined Process Task 

Manual Operation Task 

Preparation Task 

Parallel Mode Task 

Loop Limit Task with Standard Loop Type 

Terminator End Event 

On-Page Reference Off-Page Connector 

Off-Page Reference Off-Page Connector 

Auto-height box Annotation 

Dynamic Connector Sequence Flow 
Association 
Interaction (depending on type of 
source/target element and the model 
type) 

Line-curve connector Sequence Flow 
Association 
Interaction (depending on type of 
source/target element and the model 
type) 

Control Transfer Sequence Flow 
Interaction (depending on model type) 

Annotation Annotation 

Stored Data Data Store 

Paper Tape Data Feed 

Data Data Store 

Direct Data Data Store 

Manual Input Data Store 

Sequential Data Data Feed 

Display Report 

 
 

Audit Diagram Shapes 
 

Visio Object Type ER/Studio BA Object Type 

Tagged Process Task 

Decision Gateway 
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Visio Object Type ER/Studio BA Object Type 

Manual Operation Task 

Terminator End Event 

On-page Reference Off-Page Connector 

Off-Page Reference Off-Page Connector 

Divided Process Pool 

Multi Process/Doc Pool 

Lined/Shaded Process Pool 

Check 1 (audit) Gateway 

Compare 1 Gateway 

Divided Event Task 

Title Block Annotation 

Note Block Annotation 

Dynamic Connector Sequence Flow 
Association 
Interaction (depending on type of 
source/target element and the model 
type) 

Line-curve connector Sequence Flow 
Association 
Interaction (depending on type of 
source/target element and the model 
type) 

Database Data Store 

Data Transmission Data Feed 

Diskette 1 Data Feed 

Diskette 2 Data Feed 

Disk Storage Data Store 

Lined Document Flat File 

Magnetic Tape Data Feed 

Manual File Flat File 

Manual Input Flat File 

Multi-document Flat File 

Tagged Document Flat File 

Display Report 
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EPC Diagram Shapes 
 

Visio Object Type ER/Studio BA Object Type 

Event Start Event 

Function Task 

Process Path Pool 

XOR Data-Based Gateway (with Marker) 

OR Inclusive Gateway 

AND Parallel Gateway 

Dynamic Connector Sequence Flow 
Association 
Interaction (depending on type of 
source/target element and the model 
type) 

Organizational Unit Business Unit 

Enterprise Area Subject Area 

 
 

Basic Shapes 
 

Visio Object Type ER/Studio BA Object Type 

Square Task/Business Entity (depending on model type) 

Circle Start Event 

Ellipse Start Event 

Rectangle Task/Business Entity (depending on model type) 

Shadowed Box Task/Business Entity (depending on model type) 

3-D Box Task/Business Entity (depending on model type) 

Rounded Rectangle Task/Business Entity (depending on model type) 

Rounded Square Task/Business Entity (depending on model type) 

45 degree single Line/Relationship (depending on model type) 

60 degree single Line/Relationship (depending on model type) 

Fancy arrow Line/Relationship (depending on model type) 

45 degree double Line/Relationship (depending on model type) 

60 degree double Line/Relationship (depending on model type) 

45 degree tail Line/Relationship (depending on model type) 

60 degree tail Line/Relationship (depending on model type) 

Flexi-arrow 1 Line/Relationship (depending on model type) 

Flexi-arrow 2 Line/Relationship (depending on model type) 

Flexi-arrow 3 Line/Relationship (depending on model type) 

Double flexi-arrow Line/Relationship (depending on model type) 
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Visio Object Type ER/Studio BA Object Type 

Dynamic Connector Sequence Flow 
Association 
Interaction (depending on type of source/target 
element and the model type) 

Line-curve connector Sequence Flow 
Association 
Interaction (depending on type of source/target 
element and the model type) 

 
 

Block Diagram Shapes 
 

Visio Object Type ER/Studio BA Object Type 

Box Task 

Mid-Arrow Sequence Flow/Relationship (depending on model 
type) 

 
 

Cross-Functional  Flowchart  Shapes Horizontal 
 

Visio Object Type ER/Studio BA Object Type 

Functional Band Horizontal Pool 

 
 

Cross-Functional  Flowchart  Shapes Vertical 
 

Visio Object Type ER/Studio BA Object Type 

Functional Band Vertical Pool 



ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 375   

 

 

Property views 
This appendix describes the fields in the Property Views for Workspaces, Projects, Models, 
Diagrams, and Business Process Modeling Elements and Conceptual Modeling Elements. 

Workspaces 
A workspace is a unit of storage used for any collection of data modeling projects in the ER/ 
Studio BA. The application lets you only open and work with one workspace at a time, but you 
can collect any number of projects in a single workspace. You can edit the properties of a 
workspace. 

 
 

Opening the Workspace Properties 

1 Right-click the workspace node name in the Model View tree. 
 

2 Select Properties  and the Workspace Properties dialog for the selected workspace opens. 

The table below describes the Property View fields available for Workspaces: 
 

Property  View Description 

General 

Name Label that appears for a workspace both in the Model View 
tree and in the diagram. 

Location Displays the path for the workspace. 

ER/Studio BA Version Displays the version of ER/Studio BA. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Projects 
A Project is a collection of items including models, model elements, documents, business rules, 
etc. You can nest projects where a project is a parent of another project. A project does not have 
to contain a model. You can edit the properties of a project. 

 
 

Opening the Project Properties 

1 Right-click the project node name in the Model View tree. 
 

2 Select Properties and the Project Properties dialog for the selected project opens. 

The table below describes the Properties fields available for Projects: 
 

Property  View Description 

General 

Name Label that appears for a project both in the Model View tree 
and in the diagram. 

Location Displays the path and file name for the selected project. 

ER/Studio BA Version Displays the ER/Studio BA version. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit 
option becomes available. Click this to open the 
Usage edit tab where you can edit the name of the 
usage. The default name is “Usage”. You can also change the 
usage settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Models 
A model is a specific collection of elements/objects related to the Business Process Modeling 
Notation. The Model contains Business Process Diagrams which are graphical representations of 
all the elements of the process. 

 
 

Opening Model Properties 

1 Right-click the model node name in the Model View tree. 
 

2 Select Properties and the Model Properties dialog for the selected diagram opens. 

The table below describes the Properties fields available for Models: 
 

Property  View Description 

General 

Name Label that appears for a model both in the Model View tree 
and in the diagram. 

Location Displays the path and file name for the selected model. 

ER/Studio BA Version Displays the ER/Studio BA version. 
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Property  View Description 

Model Type Displays the type of model, either Business Process or 
Conceptual. 

Validate against BPMN 
Specification 

 
 
Note: This property is 
available only for Business 
Process models. 

The validation checks compliance to the Business Process 
Modeling Notation specifications. The option available 
depends on the model type. For example, if BPMN validation 
is enabled and you draw a message flow from one start event 
to another, you get a dialog stating that this is an invalid 
relationship. If validation is off, it is drawn without notification. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. This is the default display and includes the following 
main nodes: workspace hierarchy, Diagram Usage, Heritage, 
Links, Bindings, and Mappings. 

 
 
 

Click  to display the impact analysis information in a table 
format. This display includes the Impact Topic, Element Type, 
Name, Target Element Type, and Target Element Name 

 
 
Items in the tree will be exported and/or printed in the format 
you select with the exception of CSV, which cannot be 
displayed in the tree format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. This option is disabled if the 
Table format is selected. 

Collapse All Collapses all the nodes in the tree. This option is disabled if the 
Table format is selected. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Diagrams 
A Business Process Diagram (BPD) uses a flowcharting technique which is tailored for creating 
graphical models of business process operations. A Business Process Model is a network of 
graphical elements based on the Business Process Modeling Notation, which track the flow of 
activities and their order of performance. 

 
 

Opening Diagram Properties 

You have different properties available for the Business Process diagram and the Conceptual  
Model diagram. 
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• Right-click the diagram node name in the Model View tree and select Properties. 
 

NOTE:  At the time you create a diagram, a  Pool and a  Lane are automatically created. 
 

 
The table below describes the Properties fields available for Business Process Diagrams:. 

 
Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location Displays the path where the diagram file, with the file extension 
of .edsb, is stored. 

ER/Studio BA Version Displays the Version number of ER/Studio BA. 

Diagram Version Displays the Version of the diagram 

Author This text field contains the name of the author of the Diagram. 

Creation Date This displays the date on which the Diagram was created (for 
this Version). 

Last Modification Date This defines the date on which the Diagram was last modified 
(for this Version). 

Language This text field contains the name of the language in which text 
is written. The default is English. 

Expression Language A Language may be provided so that the syntax of expressions 
used in the Diagram can be understood. 

Query Language A Language may be provided so that the syntax of queries 
used in the Diagram can be understood. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Pools 

Name Displays the name of all the pools in the diagram. 

Boundary Visible Indicates whether or not the pool is visible on the diagram. 

Edit Pools 
Click  to open the Edit Pools Property View. 

 
 

Edit Pools Property View 

When you click the Edit Pool icon, an additional Property View opens. 
 

Property  View Description 

General 

Name Label that appears for a pool both in the Model View tree and 
in the diagram. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis 

Participant You must define the Participant for a Pool. The Participant can 
be either a Role or an Entity. This defines the role that a 
particular Entity or Role the Pool will play in a Diagram that 
includes collaboration. 

Process When you click an additional property view opens 

displaying the Process properties for the selected diagram. 

Boundary visible This attribute defines if the rectangular boundary for the Pool is 
visible. Only one Pool in the Diagram may have the attribute 
set to False. 

Linked steward or business 
unit 

Click the drop-down arrow to display a list of available stewards 
and business units that can be linked to a pool. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Lanes 

Name Displays the name and description of the lane(s) within the 
selected pool. You have the following functions available: 

 
 
Add: Adds another lane to the pool. If you opened the 
Property View from the Model View, the new lane appears in 
the Model View tree. If you opened the Property View from the 
presentation element, the new lane appears both in the Model 
View tree and in the Diagram View. 

 
 
Edit: Opens a Property View for the selected lane where you 
can make changes to the properties for that lane. Notice that 
the Appearance tab is not available on this page. 

 
 
Delete: Delete the selected lane from this Property View. 

Create Lane 
Click  to create a new lane. 

Edit Lane Select a lane in the list box and click Edit ( ). 

The Lane property view for the selected lane opens. 

Delete Lane Delete a selected lane by clicking  . The lane is 
immediately deleted without a w  . 
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Property  View Description 

Move Lane Up Move the selected lane up in the grid. 

Move Lane Up Move the selected lane down in the grid. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 
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Property  View Description 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
 

The table below describes the Properties fields available for Conceptual Model Diagrams:. 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location Displays the path where the diagram file, with the file extension 
of .edsb, is stored. 

ER/Studio BA Version Displays the version number of ER/Studio BA 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

You can undo any action and you can select all text by pressing 
CTRL+A. 

The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Business process modeling diagram elements 
This section describes the Property View fields for the Business Process Modeling diagram 
modeling elements. There are eight major divisions describing the modeling elements: 

 
• Events 

 

• Activities 
 

• Gateways 
 

• Connecting Objects 
 

• Swimlanes 
 

• Artifacts 
 

• Reference Objects 
 

• Drawing Shapes 
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Opening Properties  for Diagram Elements 

Right-click the diagram element node name in the Model View tree and select Properties. 

OR 

Double-click the element in the Diagram View and the Property View dialog for the selected 
element opens. 

 
NOTE:  When you open a Property View from an element in the Diagram View, an Appearance 

Tab is available. However, when you open a Property View for an element in the Model 
View tree, the Appearance tab does not appear. 

Events 
There are three event types used in the diagrams:  Start Event;  Intermediate Event; and End  
Event. 

 
 

Start Event 

The table below describes the Property View fields available for a Start Event: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Trigger Type Displays the type of trigger attached to this event: message, 
time, rule, or link. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
CTRL+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Triggers 

Type When you select a trigger icon, the type you selected appear in 
this column. 

Name This column displays the name. Each time you add a trigger, 
the name is appended by a number, for example, trigger1, 
trigger2, etc. 

Properties The type of trigger selected determines the information 
displayed in the description text box. Each trigger type is listed 
below with the information it displays: 

Link: Link identification and process reference. 

Message: Implementation type, From, and To. 

Rule: Rule Name. 

Timer: Time cycle information. 

Trigger Icons All the trigger icons are located at the bottom of the Property 
View. Only the triggers available for this element are available. 
Click the trigger icon you want to set and it appears in the grid. 

Edit Triggers Click this option ( ) to open the Trigger event Property 
View. 

Delete Trigger Deletes the trigger type from the selected event. 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 
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Property  View Description 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment 
Click  to create a new assignment for the element. 

Edit Assignment 
When you click edit , 

 
an additional tab opens where you can edit the selected 
assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 
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Property  View Description 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
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Property  View Description 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the alignment for text labels in an 
element. 

Diagram Display Option Select this option to show the element label. 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

 
 

Intermediate Event 

The table below describes the Property View fields available for an Intermediate Event: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Trigger Type Displays the type of trigger attached to this event. 

Target A Target may be included for the Intermediate Event. The 
Target must be an activity (Sub-Process or Task). This means 
that the Intermediate Event is attached to the boundary of the 
activity and is used to signify an exception or compensation for 
that activity. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Triggers 

Type When you select a trigger icon, the type you selected appear in 
this column. 

Name This column displays the name. Each time you add a trigger, 
the name is appended by a number, for example, trigger1, 
trigger2, etc. 

Properties The type of trigger selected determines the information 
displayed in the description text box. Each trigger type is listed 
below with the information it displays: 

• Cancel: No description displayed. 

• Compensation: The activity that is being compensated. 

• Error: The error code in use. 

• Link: Link identification and process reference. 

• Message: Implementation type, From and To. 

• Rule: Rule Name. 

• Timer: Time cycle information. 

Trigger Icons All the trigger icons are located at the bottom of the Property 
View. Only the triggers available for this element are available. 
Click the trigger icon you want to set and it appears in the grid. 

Edit Triggers Click this option,  to open the Trigger event Property 
View. 

Delete Trigger Deletes the trigger type from the selected event. 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 
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Property  View Description 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment 
Click   to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 
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Property  View Description 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
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Property  View Description 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to horizontally align the text for text 
labels in an element. 

Diagram Display Options Select this option to show the element label. 

Apply to Diagram Applies the formatting changes to all existing intermediate 
events on the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new intermediate event elements 
placed in the Diagram View. 

 
 

End Event 

The table below describes the Property View fields available for an End Event: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Trigger Type Displays the type of trigger attached to this event. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Results 

Type When you select a trigger icon, the type you selected appear in 
this column. 

Name This column displays the name. Each time you add a trigger, 
the name is appended by a number, for example, trigger1, 
trigger2, etc. 

Properties The type of trigger selected determines the information 
displayed in the description text box. Each trigger type is listed 
below with the information it displays: 

• Cancel: No description displayed. 

• Compensation: The activity that is being compensated. 

• Error: The error code in use. 

• Link: Link identification and process reference. 

• Message: Implementation type, From, and To. 

• Terminate: No description displayed. 

• Timer: Time cycle information. 

Trigger Icons All the trigger icons are located at the bottom of the Property 
View. Only the triggers available for this element are available. 
Click the trigger icon you want to set and it appears in the grid. 

Edit Triggers Click this option  to open the Trigger event Property 
View. 

Delete Trigger Deletes the trigger type from the selected event. 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 
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Property  View Description 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment 
Click  to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 
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Property  View Description 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
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Property  View Description 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the horizontal alignment for text 
labels in an element. 

Diagram Display Options Select this option to show the element label. 

Apply to Diagram Applies the formatting changes to all existing end events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new end event elements placed in the 
Diagram View. 

 
 

Edit Triggers 

The fields available on this tab depend on the trigger selected. 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Trigger Type Displays the type of trigger attached to this event. 

Activity This field appears only when the Compensation trigger is 
selected. 

Error Code This field appears only when the Error trigger is selected. Enter 
the Error Code for the trigger. 

Message This field appears only when the Message trigger is selected. 
Enter the Message for the trigger. 

Implementation This field appears only when Message trigger is selected. 

Link ID This field asks for the identifier for the link. This field is available 
only when the Link trigger is selected. 

Process Ref A Process must be identified. 

Rule Expression This field appears only when the Rule trigger is selected. 

Timedate This field appears only when the Timer trigger is selected. 

Time cycle This field appears only when the Timer trigger is selected. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Font and color options 

You can edit the font settings of all element labels. The following commands are available: 

Command Icon Description 

Bold 

 
Applies bold formatting to the label 
text. 

Italics 

 
Italicizes the label text. 

Underline 

 
Underlines the label text. 

Strikeout 

 
A line is drawn through the label text. 
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You can also change the font color, element outline color, and element fill color with the following 
commands: 

Command Icon Description 

Change Font 
Color  

 

Opens the Color dialog. You can select 
an existing color or create a custom 
color for the color of the label font. 

Change Line 
Color  

 

Opens the Color dialog. You can select 
an existing color or create a custom 
color for the border of the element. 

Change Fill 
Color  

 

 
 

Opens the Color dialog. You can select 
an existing color or create a custom 
color for the background of the 
element. 

Rendering 

There are two commands available that affect the appearance of elements in the Diagram View: 

 Command Description 

Shadowed When this option is selected the 
element has a slight shadowed 
background. The Shadowed 
option is the default setting. 

 

 

 

 

Gradient When this option is selected the 
element has a gradient shading. If 
it is not selected the element is a 
solid color. The Gradient option is 
the default setting. 
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Horizontal alignment 

You can justify the horizontal alignment of a text label in an element. 
 

NOTE:  These commands do not justify the text labels on elements that use text boxes outside 
the element. 

 
 

Command Icon Description 

Left Justify 
Text  

Justifies the text on the left side of the 
text box. 

Center Text 

 
Centers the text in the text box. 

Right Justify 
Text  

Justifies the text on the right side of 
the text box. 

Vertical alignment 

You can change the top to bottom alignment settings for the text label in an element. 
 

Command Icon Description 

Top 

 
Places the text in the top portion of the 
element. 

Center 

 
Centers the text within the element. 

Bottom 

 
Places the text in the bottom portion of 
the element. 

Triggers 

You can set trigger information for Start, Intermediate, and End Events by selecting the 
appropriate icon. The available triggers in the Property View depend of the element selected. 

 
Element Palette Icon Description 

Cancel 

 
 

 
 

This trigger is used within a Transaction Sub-process. This 
type of event must be attached to the boundary of a Sub- 
process. This trigger is available for intermediate and end 
events. 

Compensation 

 
 

Compensation is when activities are invoked that undo an 
undesirable outcome. This trigger is available for 
intermediate and end events. 

Error 

 
 

 
 

This trigger sets or catches errors. It sets an error if the 
Event is part of a Normal Flow. It reacts to a named error 
when attached to the boundary of an activity. This trigger 
is available for intermediate and end events. 
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Element Palette Icon Description 

Link 

 
 

A mechanism for connecting the end of one Process to 
the start (or trigger) of another. This trigger is available for 
start, intermediate, and end events. 

Message 

 
 

A message arrives from a participant and triggers the 
start of the Process. This trigger is available for start, 
intermediate, and end events. 

Rule 

 
 

This type of event is triggered when the conditions for a 
rule become true. This trigger is available for start and 
intermediate events. 

Terminate 

 
 

All activities in the Process should be ended immediately. 
The Process is ended without compensation or event 
handling. This trigger is available for and end event. 

Timer 

 
 

A specific time-date or a specific cycle (e.g., every Friday 
at 10:00 a.m.) is set that triggers the start of the Process. 
This trigger is available for start and intermediate events. 

Activities 
An Activity is work that is performed within a business process and be represented by a set of 
graphical objects usually composed of three main activities: Task, Embedded Sub-processes, 
and Independent Sub-processes. 

 
 

Task 

The table below describes the Property View fields available for a Task: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 
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Property  View Description 

Task Type Task Type may be set to the following attributes: 

Manual: A Manual Task is expected to be performed without 
the aid of any business process execution engine or any 
application. 

None: No task type designation is set. 

Receive: A simple Task that is designed to wait for a message 
to arrive from an external participant. Once the message has 
been received, the Task is completed. 

Reference: This task references another activity that has been 
defined. If the two (or more) activities share the exact same 
behavior, then by one referencing the other, the attributes that 
define the behavior are only created once and maintained in 
only one location. 

Script: A Script Task is executed by a business process engine. 
The modeler or implementer defines a script in a language that 
the engine can interpret. When the Task is ready to start, the 
engine executes the script. When the script is completed, the 
Task is also completed. 

Send: A simple Task that is designed to send a message to an 
external participant. Once the message has been sent, the Task 
is completed. 

Service: A Service Task is a Task that provides some sort of 
service, which could be a Web service or an automated 
application. This is the default setting. 

User: A typical “workflow” task where a human performer 
performs the Task with the assistance of a software application 
and is scheduled through a task list manager of some sort. 

 
 
The TaskType is impacted by the Message Flow to and/or from 
the Task, if Message Flows are used. A TaskType of Receive 
must not have an outgoing Message Flow. A TaskType of Send 
must not have an incoming Message Flow. A TaskType of 
Script, Manual, or None must not have an incoming or an 
outgoing Message Flow. The TaskType list may be extended to 
include new types. 

In Message A Message for the InMessage attribute must be entered. This 
indicates that the Message will be sent at the start of the Task, 
after the availability of any defined InputSets. A corresponding 
outgoing Message Flow MAY be shown on the diagram. 
However, the display of the Message Flow is not required. 

Out Message A Message for the OutMessage attribute MUST be entered. 
The arrival of this message marks the completion of the Task, 
which may cause the production of an OutputSet. A 
corresponding incoming Message Flow may be shown on the 
diagram. However, the display of the Message Flow is not 
required. 

Implementation This attribute specifies the technology that will be used to send 
and receive the messages. Web Service is the default 
technology. 

Instantiate This attribute is available when you select the Task Type 
“Receive”. 
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Property  View Description 

Script This field is available when you select the Task Type “Script”. 

Message This field is available when you select the Task Type “Receive” 
and “Send”. 

Task Reference When you select the Task Type of “Reference”, a Task 
Reference drop-down box opens with the available tasks listed. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Activity 

Status The Status of a Process is determined when the Process is 
being executed by a process engine. The Status of a Process 
can be used within Assignment Expressions. 

The status settings available are: None, Aborted, Aborting, 
Active, or Cancelled. 

Start Quantity The default value is 1. The value must not be less than 1. This 
attribute defines the number of Tokens that must arrive from a 
single Sequence Flow before the activity can begin. 

Loop Type LoopType is an attribute and is by default None, but may be 
set to Standard or Multi Instance. If so, the Loop marker shall 
be placed at the bottom center of the activity shape. 

A Task of type Receive that has its Instantiate attribute set to 
True must not have a Standard or MultiInstance Loop Type. 

Standard Loop Type  
Properties 

A Standard Loop activity has a boolean expression that is 
evaluated after each cycle of the loop. If the expression is still 
True, then the loop continues. 
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Property  View Description 

Multiple Instance Loop  
Type Properties 

Multi-Instance loops reflect the programming construct for 
each. The loop expression for a Multi-Instance loop is a 
numeric expression evaluated only once before the activity is 
performed. 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined. Otherwise, it is 
not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

Create Property 
Click  to create a new property for the task. 

IORules 

Expression Enter the expression that defines the relationship between one 
InputSet and one OuputSet. That is, if the activity is 
instantiated with a specified InputSet, then the output of the 
activity MUST produce the specified OutputSet. Zero or more 
IORules may be entered. 

Input Sets 

Name The InputSets attribute defines the data requirements for input 
to the activity. Zero or more InputSets MAY be defined. Each 
Input set is sufficient to allow the activity to be performed (if it 
has first been instantiated by the appropriate signal arriving 
from an incoming Sequence Flow). 

Output Sets 

Name The OutputSets attribute defines the data requirements for 
output from the activity. Zero or more OutputSets may be 
defined. At the completion of the activity, only one of the 
OutputSets may be produced--It is up to the implementation 
of the activity to determine which set will be produced. 
However, the IORules attribute may indicate a relationship 
between an OutputSet and an InputSet that started the activity. 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 
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Property  View Description 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment 
Click   to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to set the alignment (top, centered or 
bottom) of a text label within an element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing tasks on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new task elements placed in the 
Diagram View. 
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Implementation 

If you select Web Service in the Implementation field, you can set properties in an additional 
Property View. 

 
Property  View Description 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Participant The Participant attribute is mapped to the partnerLink attribute 
of the BPEL4WS activity. 

Interface The Interface attribute is mapped to the portType attribute of 
the BPEL4WS activity. 

Operation The Operation attribute is mapped to the operation attribute of 
the BPEL4WS activity. 

 
 

Standard Loop Type Properties 

If you select Standard in the Loop Type field, you can set properties in an additional Property 
View. 

 
Property  View Description 

Condition Standard Loops must have a boolean Expression to be 
evaluated, plus the timing when the expression shall be 
evaluated. 

Counter The LoopCounter attribute is used at runtime to count the 
number of loops and is automatically updated by the process 
engine. The LoopCounter attribute must be incremented at the 
start of a loop. The modeler may use the attribute in the 
LoopCondition Expression. 

Maximum The Maximum an optional attribute that provides is a simple 
way to add a cap to the number of loops. This shall be added to 
the Expression defined in the LoopCondition. 

Test time The expressions that are evaluated before the activity begins 
are equivalent to a programming while function. The expression 
that are evaluated after the activity finishes are equivalent to a 
programming until function. 

 
 

Multiple Instance Loop Type Properties 

If you select Multiple Instance in the Loop Type field, you can set properties in an additional 
Property View. 

 
Property  View Description 

Condition MultiInstance Loops must have a numeric Expression to be 
evaluated--the Expression must resolve to an integer. 
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Property  View Description 

Ordering This applies to only Multi-Instance Loops. The MI_Ordering 
attribute defines whether the loop instances will be performed 
sequentially or in parallel. Sequential MI_Ordering is a more 
traditional loop. Parallel MI_Ordering is equivalent to multi- 
instance specifications that other notations, such as UML 
Activity Diagrams use. If set to Parallel, the Parallel marker shall 
replace the Loop Marker at the bottom center of the activity 
shape. 

Counter The LoopCounter attribute is only applied for Sequential Multi- 
Instance Loops and for processes that are being executed by a 
process engine. The attribute is updated at runtime by a 
process engine to count the number of loops as they occur. The 
LoopCounter attribute must be incremented at the start of a 
loop. Unlike a Standard loop, you do not use this attribute in the 
MI_Condition Expression, but it can be used for tracking the 
status of a loop. 

Flow Condition This attribute is equivalent to using a Gateway to control the 
flow past a set of parallel paths. An MI_FlowCondition of 
“None” is the same as uncontrolled flow (no Gateway) and 
means that all activity instances shall generate a token that will 
continue when that instance is completed. An 
MI_FlowCondition of “One” is the same as an Exclusive 
Gateway and means that the Token shall continue past the 
activity after only one of the activity instances has completed. 

 
 
The activity continues its other instances, but additional Tokens 
must not be passed from the activity. An MI_FlowCondition of 
“All” is the same as a Parallel Gateway and means that the 
Token shall continue past the activity after all of the activity 
instances have completed. An MI_FlowCondition of “Complex” 
is the same as a Complex Gateway. The 
ComplexMI_FlowCondition attribute will determine the Token 
flow. 

Complex Flow Condition If the MI_FlowCondition attribute is set to “Complex,” then an 
Expression must be entered. This Expression may reference 
Process data. The expression shall determine when and how 
many Tokens will continue past the activity. 

 
 

Embedded Sub-processes 

The table below describes the Property View fields available for Sub-processes: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Sub-Process type: This maps to a BPEL4WS scope element. The scope is not an 
independent process and will share the process variables of 
the higher-level process. 
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Property  View Description 

Ad hoc Ad hoc is a boolean attribute, which has a default of False. This 
specifies whether the Embedded Sub-Process is Ad Hoc or 
not. The activities within an Ad Hoc Embedded Sub-Process 
are not controlled or sequenced in a particular order, there 
performance is determined by the performers of the activities. 

 
 
Note: You can set this attribute for multiple subprocesses. 

Transaction Properties This option determines whether or not the behavior of the Sub- 
Process will follow the behavior of a Transaction. 

 
 
Note: You can set this attribute for multiple subprocesses. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Activity 

Status The Status of a Process is determined when the Process is 
being executed by a process engine. The Status of a Process 
can be used within Assignment Expressions. 

The status settings available are: None, Aborted, Aborting, 
Active, or Cancelled. 

Start Quantity The default value is 1. The value must not be less than 1. This 
attribute defines the number of Tokens that must arrive from a 
single Sequence Flow before the activity can begin. 
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Property  View Description 

Loop Type LoopType is an attribute and is by default None, but may be 
set to Standard or MultiInstance. If so, the Loop marker shall be 
placed at the bottom center of the activity shape. 

A Task of type Receive that has its Instantiate attribute set to 
True must not have a Standard or MultiInstance Loop Type. 

Standard Loop Type  
Properties 

A Standard Loop activity has a boolean expression that is 
evaluated after each cycle of the loop. If the expression is still 
True, then the loop continues. 

Multiple Instance Loop  
Type Properties 

Multi-Instance loops reflect the programming construct for 
each. The loop expression for a Multi-Instance loop is a 
numeric expression evaluated only once before the activity is 
performed. 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined. Otherwise, it is 
not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

IORules 

Expression The IORules attribute is an expression that defines the 
relationship between one InputSet and one OuputSet. That is, 
if the activity is instantiated with a specified InputSet, then the 
output of the activity must produce the specified OutputSet. 
Zero or more IORules may be entered. 

Input Sets 

Name The InputSets attribute defines the data requirements for input 
to the activity. Zero or more InputSets MAY be defined. Each 
Input set is sufficient to allow the activity to be performed (if it 
has first been instantiated by the appropriate signal arriving 
from an incoming Sequence Flow). 

Output Sets 

Name The OutputSets attribute defines the data requirements for 
output from the activity. Zero or more OutputSets may be 
defined. At the completion of the activity, only one of the 
OutputSets may be produced--It is up to the implementation 
of the activity to determine which set will be produced. 
However, the IORules attribute may indicate a relationship 
between an OutputSet and an InputSet that started the activity. 
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Property  View Description 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment Click to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Graphical Elements 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to set the alignment (top, centered or 
bottom) of a text label within an element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing tasks on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new task elements placed in the 
Diagram View. 
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Independent Sub-processes 

The table below describes the Property View fields available for Sub-processes: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Sub-Process type: BPEL4WS does not have a sub-process element. Thus, 
Independent Sub-Processes must map to a BPEL4WS process. 
That is, the contents of the Sub-Process, whether it is 
expanded or collapsed, will be contained within a separate 
process. The DiagramRef and ProcessRef attributes will identify 
the process that will be used for the mapping to the BPEL4WS 
process. 

 
 
The attributes of the other BPEL4WS process element will be 
filled from the mapping of the referenced Process. The Sub- 
Process object itself maps to an invoke activity that “calls” the 
process. 

Diagram Ref The Business Process Diagram must be identified. 

Process Ref A Process must be identified. 

Transaction Properties Transaction determines whether or not the behavior of the 
Sub-Process will follow the behavior of a Transaction. 

Note: You can set this attribute for multiple subprocesses. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Activity 

Status The Status of a Process is determined when the Process is 
being executed by a process engine. The Status of a Process 
can be used within Assignment Expressions. 

 
 
The status settings available are: None, Aborted, Aborting, 
Active, or Cancelled. 

Start Quantity The default value is 1. The value must not be less than 1. This 
attribute defines the number of Tokens that must arrive from a 
single Sequence Flow before the activity can begin. 

Loop Type LoopType is an attribute and is by default None, but may be 
set to Standard or MultiInstance. If so, the Loop marker shall be 
placed at the bottom center of the activity shape. 

A Task of type Receive that has its Instantiate attribute set to 
True must not have a Standard or MultiInstance Loop Type. 

Standard Loop Type  
Properties 

A Standard Loop activity has a boolean expression that is 
evaluated after each cycle of the loop. If the expression is still 
True, then the loop continues. 

Multiple Instance Loop  
Type Properties 

Multi-Instance loops reflect the programming construct for 
each. The loop expression for a Multi-Instance loop is a 
numeric expression evaluated only once before the activity is 
performed. 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined. Otherwise, it is 
not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 
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Property  View Description 

IORules 

Expression The IORules attribute is an expression that defines the 
relationship between one InputSet and one OuputSet. That is, 
if the activity is instantiated with a specified InputSet, then the 
output of the activity must produce the specified OutputSet. 
Zero or more IORules may be entered. 

Input Sets 

Name The InputSets attribute defines the data requirements for input 
to the activity. Zero or more InputSets MAY be defined. Each 
Input set is sufficient to allow the activity to be performed (if it 
has first been instantiated by the appropriate signal arriving 
from an incoming Sequence Flow). 

Output Sets 

Name The OutputSets attribute defines the data requirements for 
output from the activity. Zero or more OutputSets may be 
defined. At the completion of the activity, only one of the 
OutputSets may be produced--It is up to the implementation 
of the activity to determine which set will be produced. 
However, the IORules attribute may indicate a relationship 
between an OutputSet and an InputSet that started the activity. 

Input Property  Maps 

Expression Multiple input mappings may be made between properties of 
the Independent Sub-Process and the properties of the 
Process referenced by this object. These mappings are in the 
form of an expression (although a modeling tool can present 
this to a modeler in any number of ways). 

Output Property  Maps 

Expression Multiple output mappings MAY be made between properties 
of the Independent Sub-Process and the properties of the 
Process referenced by this object. These mappings are in the 
form of an expression (although a modeling tool can present 
this to a modeler in any number of ways). 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 
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Property  View Description 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment 
Click    to create a new assignment for the element. 

Edit Assignment 
When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 
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Property  View Description 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
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Property  View Description 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to set the alignment (top, centered or 
bottom) of a text label within an element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing independent 
sub-processes on the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new independent sub-processes placed 
in the Diagram View. 

Diagram ref properties 

When you click edit  an additional tab opens where you can edit the properties for the 
selected diagram. 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location Displays the path where the diagram file, with the file extension 
of .edsb, is stored. 

Version This text field displays the Version number of ER/Studio BA. 

Diagram Version Displays the diagram version number. 

Author This text field contains the name of the author of the Diagram. 

Creation Date This displays the date on which the Diagram was created (for 
this Version). 

Last Modification Date This defines the date on which the Diagram was last modified 
(for this Version). 

Language This text field contains the name of the language in which text 
is written. The default is English. 

Expression Language A Language may be provided so that the syntax of expressions 
used in the Diagram can be understood. 

Query Language A Language may be provided so that the syntax of queries 
used in the Diagram can be understood. 



PR OPER TY  V I EWS  >  BUSI NES S  PR O C ES S  MO DELI NG  DI AGR A M  ELE M E N TS  

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 427   

 

 

 
 
 

Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Pools 

Name Displays the name of all the pools in the diagram. 

Boundary Visible Indicates whether or not the pool is visible on the diagram. 

Edit Pools 
Click  to open the Edit Pools Property View. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Process ref properties 

When you click edit  an additional tab opens where you can edit the properties for the 
selected diagram. 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories The modeler may add one or more defined Categories that 
can be used for purposes such as reporting and analysis. 

Process Type ProcessType is an attribute that provides information about 
which lower-level language the Pool will be mapped.By 
default, the ProcessType is None (or undefined). 

Status The Status of a Process is determined when the Process is 
being executed by a process engine. The Status of a Process 
can be used within Assignment Expressions. 
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Property  View Description 

Ad hoc Ad hoc is a boolean attribute, which has a default of False. This 
specifies whether the Embedded Sub-Process is Ad Hoc or 
not. The activities within an Ad Hoc Embedded Sub-Process 
are not controlled or sequenced in a particular order, there 
performance is determined by the performers of the activities. 

 
 
Note: You can set this attribute for multiple subprocesses. 

Suppress Join Failure A join condition provides status about an incoming link. A join 
failure indicates that link execution failed. At the process level, 
this attribute specifies whether a join failure is suppressed for 
the whole process. 

Enable Instance 
Compensation 

This attribute is included for mapping to BPEL4WS. It specifies 
whether or not a compensation can be performed after the 
Process has completed normally. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 
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Property  View Description 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment Click to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined. Otherwise, it is 
not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option  becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Editing the properties 

When you click edit an additional tab opens where you can edit the selected Process. 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Using the Ad hoc properties editor 

The table below describes the properties for using the Ad hoc property: 

Property  View Description 

Ad hoc 

Ad hoc Ordering If the Embedded Sub-Process is Ad Hoc (the Ad hoc attribute 
is True), then the Ad hoc Ordering attribute must be included. 
This attribute defines if the activities within the Process can be 
performed in Parallel or must be performed sequentially. The 
default setting is Parallel and the setting of Sequential is a 
restriction on the performance that may be required due to 
shared resources. 

Ad hoc Complex Condition If the Embedded Sub-Process is Ad Hoc (the Ad hoc attribute 
is True), then a Completion Condition MUST be included, 
which defines the conditions when the Process will end. The Ad 
Hoc marker SHALL be placed at the bottom center of the 
Process or the Sub-Process shape for Ad Hoc Processes. 
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Using the Transaction properties editor 

This option determines whether or not the behavior of the Sub-Process will follow the behavior of 
a Transaction. 

Property  View Description 

Transaction Select this option if you want to designate this as a transaction. 

Transaction ID If the Transaction attribute is False, then a Transaction must not 
be identified. If the Transaction attribute is True, then a 
Transaction must be identified.Note that Transactions that are 
in different Pools and are connected through Message Flow 
must have the same TransactionID. 

Transaction Protocol This identifies the Protocol (e.g., WS-Transaction or BTP) that 
will be used to control the transactional behavior of the Sub- 
Process. 

Transaction Method Transaction Method is an attribute that defines the technique 
that will be used to undo a Transaction that has been 
cancelled. The default is Compensate, but the attribute may be 
set to Store or Image. 

Gateways 
A Gateway controls the divergence and convergency of the Sequence Flow. It determines 
branching, forking, merging, and joining of paths. The table below describes the Property View 
fields available for a Gateway: 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Type The following Gateway Control Types are available: None, 
Databased, EventBased, Inclusive, and Complex. 

Incoming Condition If there are Multiple incoming Sequence Flows, you must set an 
IncomingCondition expression. This consists of an expression 
that can reference Sequence Flow names and or Process 
Properties (Data). 

Outgoing Condition If there are Multiple outgoing Sequence Flows, you must set an 
OutgoingCondition expression. This consists of an expression 
that can reference (outgoing) Sequence Flow Ids and or 
ProcessProperties (Data). 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 
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Property  View Description 

Create Assignment Click to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Gates 

Name Each Gate will map to a case of the switch. The 
cases will be listed in the switch in the same order 
as they are listed for the Gateway.You can add, edit 
these gates. 

Sequence Flow This will map to the condition for a switch case. Lists the name 
of the outgoing sequence flow. 

Default This will map to the otherwise element of the switch. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 
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Property  View Description 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
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Property  View Description 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing gateways on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new gateways placed in the Diagram 
View. 

Editing assignments 

When you click edit , an additional tab opens where you can edit the selected 
assignments. 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. 

Assign Time An Assignment may have an AssignTime setting. If the Object 
is an activity (Task, Sub-Process, or Process), then the 
Assignment must have an AssignTime. A value of Start means 
that the assignment shall occur at the start of the activity. This 
can be used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Editing gates 

When you click edit an additional tab opens where you can edit the selected gates. 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Outgoing Sequence Flow Displays the destination of the outgoing sequence flow. Click 
edit to change/view the properties for that sequence flow. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 
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Property  View Description 

Create Assignment 
Click    to create a new assignment for the element. 

Edit Assignment When you click edit  , an additional tab opens 

where you can edit t lected assignments. 

Delete Assignment Deletes the selected assignment. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Connecting objects 
There are three ways of connecting Events and Activities to each other or to other information 

Sequence Flow; Message Flow, and  Association. 
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Sequence flow 

The table below describes the Property View fields available for a Sequence Flow: 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Source Displays the source element for the sequence flow. 

Target Displays the name of the element where the sequence flow 
terminates. 

Condition Type None: The default setting 

Expression: If the ConditionType attribute is set to Expression, 
then a condition marker shall be added to the line if the 
Sequence Flow is outgoing from an activity. However, a 
condition indicator MUST NOT be added to the line if the 
Sequence Flow is outgoing from a Gateway. 

Default: The ConditionType attribute may be set to Default 
only if the Source of the Sequence Flow is an activity or an 
Exclusive Data-Based Gateway. If the ConditionType is Default, 
then the Default marker SHALL be displayed. 

Condition Expression If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined as a valid 
expression. The expression will be evaluated at runtime. If the 
result of the evaluation is True, then a Token is generated and 
will traverse the Sequence--Subject to any constraints imposed 
by a Source that is a Gateway. 

Quantity This attribute defines the number of Tokens that will be 
generated down the Sequence Flow. The default value is 1. 
The value MUST NOT be less than 1. This attribute defines the 
number of Tokens that will be generated down the Sequence 
Flow. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 
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Property  View Description 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Sequence Flow. 

Diagram Display Options Show Name: Select this option to show the element label. 

Show Connection: Select this option to display the line in the 
diagram. 
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Property  View Description 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: Select the width of the border from the drop-down 
list. You can select from 1 to 5 pixels. 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing sequence flows 
on the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new sequence flows placed in the 
Diagram View. 

Message flow 

The table below describes the Property View fields available for a Message Flow: 

 Property  View Description 

General 

Name Label that appears for an element both in the Model View tree and 
in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used for 
purposes such as reporting and analysis. 

Message Enter the text defining the message flow. Click 
 

to open an additional view where you can edit properties for the 
message. 

Source Displays the source element for the message flow. 

Target Displays the name of the element where the message flow 
terminates. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 



PR OPER TY  V I EWS  >  BUSI NES S  PR O C ES S  MO DELI NG  DI AGR A M  ELE M E N TS  

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 451   

 

 

 
 
 

Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Message Flow. 

Diagram Display Options Show Name: Select this option to show the element label. 

Show Connection: Select this option to display the line in the 
diagram. 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: Select the width of the border from the drop-down 
list. You can select from 1 to 5 pixels. 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing message flows 
on the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 
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Property  View Description 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new message flows placed in the 
Diagram View. 

 
 

Message Properties 

The table below describes the Property View fields available for a Message Properties 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

From Participant Enter the text defining the From Participant. Click to 
open 

an additional view where you can edit  properties for this entry 

To Participant Enter the text defining the To Participant. Click to open 
an 

additional view where you can edit properties for this entry. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Properties 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 
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Property  View Description 

Type Each Property has a Type (e.g., type=”String”). A Property may 
be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute MUST be defined. Otherwise, it 
is not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
 
 

From Participant Properties 

The table below describes the Property View fields available for the From Participant Properties 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Participant type Each Property has a Name (e.g., name=”Customer Name”). 



456   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

PR OPER TY  V I EWS  >  B U SINE SS  PR OCE S S  MO DELING  DIAGR A M  ELEME N TS   

 

 
 
 

Property  View Description 

Role If the ParticipantType = Role, then a Role MUST be identified. 

Entity If the ParticipantType = Entity, then an Entity must be 
identified. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
 
 

To Participant Properties 

The table below describes the Property View fields available for the From Participant Properties 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Participant type Each Property has a Name (e.g., name=”Customer Name”). 

Role If the ParticipantType = Role, then a Role MUST be identified. 

Entity If the ParticipantType = Entity, then an Entity must be 
identified. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Association 

The table below describes the Property View fields available for an Association 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Direction Direction is an attribute that defines whether or not the 
Association shows any directionality with an arrowhead. 

None: No arrow appears on the link. This is the default setting. 

To: The arrowhead is at the target object. 

From: The arrowhead is at the source artifact. 

Both: Arrows are place at both ends of the link indicating bi- 
directional flow. 

Source: Displays the source element for the Association. 

Target Displays the name of the element where the Association 
terminates. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Association. 

Diagram Display Options Show Name: Select this option to show the element label. 

Show Connection: Select this option to display the line in the 
diagram. 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: Select the width of the border from the drop-down 
list. You can select from 1 to 5 pixels. 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing associations on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 
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Property  View Description 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new associations placed in the Diagram 
View. 

Swimlanes 
You can group primary modeling elements by using swimlanes which consist of pools and lanes. 
A Pool represents a participant in a process. It also acts as a graphical container for partitioning a 
set of activities from other Pools. The three main elements are:  Pool, Lane, and Nested Lane. 

 
 

Pool 

The table below describes the Property View fields available for a Pool: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Participant You must define the Participant for a Pool. The Participant can 
be either a Role or an Entity. This defines the role that a 
particular Entity or Role the Pool will play in a Diagram that 
includes collaboration. 

Process When you click an additional property view opens 

displaying the Process properties for the selected diagram. 

Boundary visible This attribute defines if the rectangular boundary for the Pool is 
visible. Only one Pool in the Diagram may have the attribute 
set to False. 

Linked steward or business 
unit 

Click the drop-down arrow to display a list of available stewards 
and business units that can be linked to a pool. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Lanes 

Name Displays the name of the lane(s) within the selected pool. You 
have the following functions available: 

Add: Adds another lane to the pool. If you opened the 
Property View from the Model View, the new lane appears in 
the Model View tree. If you opened the Property View from the 
presentation element, the new lane appears both in the Model 
View tree and in the Diagram View. 

Edit: Opens a Property View for the selected lane where you 
can make changes to the properties for that lane. Notice that 
the Appearance tab is not available on this page. 

Delete: Delete the selected lane from this Property View. 

Create Lane Click to create a new lane. 

Edit Lane Select a lane in the list box and click Edit ( ). 

The Lane property view for the selected lane opens. 

Delete Lane Delete a selected lane by clicking  . The lane is 
immediately deleted without a w  . 

Move Lane Up Move the selected lane up in the grid. 

Move Lane Up Move the selected lane down in the grid. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show Name: Select this option to show the element label. 

Show Connection: Select this option to display the line in 
the diagram. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing pools on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new pools placed in the Diagram View. 
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Lane 

The table below describes the Property View fields available for a Lane: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Parent Pool The Parent Pool must be specified. There can be only one 
Parent. 

Parent Lane ParentLane is an optional attribute that is used if the Lane is 
nested within another Lane. Nesting can be multi-level, but 
only the immediate parent is specified. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 
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Property  View Description 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show Name: Select this option to show the element label. 

Apply to Diagram Applies the formatting changes to all existing lanes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new lanes placed in the Diagram View. 

 
 

Nested Lane 

The table below describes the Property View fields available for a Nested Lane: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 
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Property  View Description 

Parent Pool The Parent Pool must be specified. There can be only one 
Parent. 

Parent Lane ParentLane is an optional attribute that is used if the Lane is 
nested within another Lane. Nesting can be multi-level, but 
only the immediate parent is specified. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show name: Displays the label of the Association object. This 
option is selected by default. 

Apply to Diagram Applies the formatting changes to all existing nested lanes on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new nested lanes placed in the 
Diagram View. 
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Process 

 
Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Process type: This maps to a BPEL4WS scope element. The scope is not an 
independent process and will share the process variables of 
the higher-level process. 

Status  
Ad hoc Ad hoc is a boolean attribute, which has a default of False. This 

specifies whether the Embedded Sub-Process is Ad Hoc or 
not. The activities within an Ad Hoc Embedded Sub-Process 
are not controlled or sequenced in a particular order, there 
performance is determined by the performers of the activities. 

Note: You can set this attribute for multiple subprocesses. 

Suppress Join Failure A join condition provides status about an incoming link. A join 
failure indicates that link execution failed. At the process level, 
this attribute specifies whether a join failure is suppressed for 
the whole process. 

Enable Instance 
Compensation 

This attribute is included for mapping to BPEL4WS. It specifies 
whether or not a compensation can be performed after the 
Process has completed normally. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Assignments 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

To The target for the Assignment must be a Property of the 
Process or the activity itself. 

From The Expression must be made up of a combination of Values, 
Properties, and Attributes, which are separated by operators 
such as add or multiply. The expression language is defined in 
the ExpressionLanguage attribute of the Business Process 
Diagram. 

Assign Time An Assignment may have a AssignTime setting. If the Object is 
an activity (Task, Sub-Process, or Process), then the Assignment 
must have an AssignTime. A value of Start means that the 
assignment shall occur at the start of the activity. This can be 
used to assign the higher-level (global) Properties of the 
Process to the (local) Properties of the activity as an input to the 
activity. 

 
 
A value of End means that the assignment shall occur at the 
end of the activity. This can be used to assign the (local) 
Properties of the activity to the higher-level (global) Properties 
of the Process as an output to the activity. 

Create Assignment Click to create a new assignment for the element. 

Edit Assignment When you click edit , an additional tab opens 

where you can edit the selected assignments. 

Delete Assignment Deletes the selected assignment. 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 
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Property  View Description 

Type Each Property has a Type (for example, type=”String”). A 
Property may be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute must be defined. Otherwise, it is 
not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Artifacts 
Artifacts provide additional information about the business process. Using artifacts allows you to 
add non-standard elements to satisfy a specific need. Since you do not want to alter the basic 
look-and-feel of a diagram, you can use artifacts to link to the existing events and activities 
through Associations. Artifacts do not affect the basic Sequence or Message Flow, nor do they 
affect mapping to execution languages. The Artifacts include:  Data Object, Group, Annotation, 
and the Off-Page Connector. 
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Data Object 

The table below describes the Property View fields available for a Data Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

State State is an optional attribute that indicates the impact the 
Process has had on the Data Object. Multiple Data Objects 
with the same name may share the same state within one 
Process. 

Required for Start: The default value for this attribute is True. 
This means that the Input is required for the activity to start. If 
set to False, then the activity may start within the input, but 
may accept the input (more than once) after the activity has 
started. 

Produced at Completion: The default value for this attribute is 
True. This means that the Output is produced when the activity 
has been completed. If set to False, then the activity may 
produce the output (more than once) before it has completed. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Properties 

Name Modeler-defined Properties may be added to an activity. These 
Properties are “local” to the activity and are only for use within 
the processing of the activity. The fully delineated name of 
these properties is “<process name>.<activity 
name>.<property name>”. You can add, edit and delete these 
properties. 

Type Each Property has a Type (e.g., type=”String”). A Property may 
be of type Set, which allows child Properties. 

Correlation If the ConditionType attribute is set to Expression, then the 
ConditionExpression attribute MUST be defined. Otherwise, it 
is not valid. This attribute is included for mapping to BPEL4WS. 
The Property will map to a correlationSet and the child 
Properties will be properties of that correlationSet. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 
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Property  View Description 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
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Property  View Description 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show name: Displays the label of the Association object. This 
option is selected by default. 

Show state: Displays the state information you entered in the 
State text field on the General tab. 

Apply to Diagram Applies the formatting changes to all existing data objects on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new data objects placed in the Diagram 
View. 

 
 

Group 

The table below describes the Property View fields available for a Group: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 
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Property  View Description 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Group element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show name: Displays the label of the Association object. This 
option is selected by default. 
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Property  View Description 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing group objects on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new group objects placed in the 
Diagram View. 

 
 

Annotation 

The table below describes the Property View fields available for an Annotation: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Text Descriptive text for the Annotation element. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 
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Property  View Description 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Annotation element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show name: Displays the label of the Association object. 
This option is selected by default. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing annotation 
objects on the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new annotation objects placed in the 
Diagram View. 
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Off-Page Connector 

The table below describes the Property View fields available for an Off-Page Connector: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Categories You can add one or more defined Categories that can be used 
for purposes such as reporting and analysis. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element fill command is unavailable for the 
Group element. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show name: Displays the label of the Association object. This 
option is selected by default. 

Apply to Diagram Applies the formatting changes to all existing off-page 
connectors on the active diagram. 
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Property  View Description 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new off-page connectors placed in the 
Diagram View. 

Conceptual modeling diagram elements 
There are five Conceptual Data Modeling diagram elements: Subject Area, Business Entity, 
Business Attribute Interaction, and  Relationship. 

 
 

Subject Area 

The table below describes the Property View fields available for a Subject Area Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Mappings 

Create Mapping Click to open the Create Mapping dialog. 

Edit Target Click to open the Property View for the targeted 
ele 

Remove Target from 
Mapping 

The deleted target is no longer mapped. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to place the text in the top, center, or 
bottom of an element. 
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Property  View Description 

Diagram Display Options Show name: Displays the label of the Subject Area object. This 
option is selected by default. 

Show Expansion Control: You can hide or show the expander 
indicator located in the lower right-hand corner of the object. 
The expander is shown as the default setting. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Shape You can display the Subject Area object as an oval or as a 
squared-edge box. The default setting is as an oval. 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

 
 

Business Entity 

The table below describes the Property View fields available for a Business Entity: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 
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Property  View Description 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Business Attributes 

 This tab contains a table displaying all the Business Attributes, 
Domains, and/or Business Elements contained in a Business 
Entity. 

Name Displays the name of the business attribute. 

Unique Identifier Adds a “#” indicator to the Business Attribute, Domain, or 
Business Element. This designates the attribute as a unique 
attribute which is mapped to Keys in an ER logical model. 

Data Type Click in this cell and all available data types are listed. The Data 
Types available are high level: binary, BLOB/Image, boolean, 
char, CLOB/Large Text, Decimal, Date, Integer, Time Stamp, 
Varchar, and XML. 

Optionality Click in this cell and drop-down list opens with three options: 
None, Mandatory, and Other. If you select Mandatory it 
becomes a mandatory property and a plus sign (+) appears to 
the left of the attribute. Select Optional and a minus sign (-) 
appears to the left of the attribute. Select None and no 
optionality setting appears. 

Bound Business Element Click in this cell and the drop-down list displays all Business 
Elements available for binding. Note that the Business 
Attribute’s name changes to the newly selected Business 
Element. 

Bound Domain Click in this cell and the drop-down list displays all Domains 
available for binding. Note that the Business Attribute’s name 
changes to the newly selected Domain. 

Create Business Attribute Click to add a new Business Attribute to the Business 
Entity 

Edit Business Attribute Click to open the Property View for 

the select Business Attribute. 

Delete Business Attribute Delete the selected attributed. 

Move Business Attribute Up You can reorder the attributes. Use the up arrow key to move 
the selected Business Attribute up. 

Move Business Attribute 
Down 

You can reorder the attributes. Use the down arrow key to 
move the selected Business Attribute down. 
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Property  View Description 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 
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Property  View Description 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Rendering Use these commands to change the shadowing and gradient 
settings for an element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to place the text in the top, center, or 
bottom of an element. 

Diagram Display Options Show name: Displays the label of the Business Entity object. 
This option is selected by default. 

Show Expander Control: You can hide or show the expander 
indicator located in the lower right-hand corner of the object. 
The expander is shown as the default setting. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 
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Property  View Description 

Business Attribute Diagram 
Display Options 

Show Business Attributes: Displays any Business Attributes in 
the Business Entity. 

Align attributes  to top: When you place a business attribute 
in a Business Entity object, it is aligned in the top left corner of 
that object. If this option is not selected, the Business 
Attributes align in the bottom left corner of the object. 

Show Optionality:  You can choose to hide or display the 
mandatory indicators (plus or minus) for the Business Attribute. 

Show Unique Identifier:  Displays the unique identifier (#) to 
the left of the Business Attribute in a Business Entity. 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

 
 

Business Attribute 

The table below describes the Property View fields available for a Business Attribute: 
 

Property  View Description 

General 

Name Name of the Business Attribute. 

Unique Identifier Adds a “#” indicator to the business attribute. This designates 
the attribute as a unique attribute which is mapped to Keys in 
an ER logical model. This option is not selected by default. 
When this option is selected it is automatically mandatory so 
the Optionality setting is disabled. 

Data Type The data types available are: Binary, BLOB/Image, Boolean, 
Char, CLOB/Large Text, Date, Decimal, Integer, None, Time 
Stamp, Varchar, and XML. 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Optionality None: No optionality is to be set. 

Mandatory:  If you select Mandatory it becomes a mandatory 
property and a plus sign (+) appears to the left of the attribute. 

Optional: If it is optional, a minus sign (-) appears to the left of 
the attribute. 

Note: If the Unique Identifier option is selected, the 
Optionality property is automatically bet to Mandatory and is 
disabled. 
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Property  View Description 

Business Element Binding 
Options 

Bound Business Element: Select the name of the Business 
Element binding to the attribute from the drop-down list. 

Bound Business Element Domain: Click  and the Property 
View for the bound business element opens. This option is not 
available if the business attribute is not bound to a business 
element. 

Override  the following  properties  of the business element: 
Select the property(ies) you want overridden in the bound 
business element. If the attribute is bound to a business 
element, the four check boxes are enabled and are 
synchronized with the business element properties. 

Domain Binding Options Bound Domain: Select the name of the domain from the drop- 
down list displaying all domains in the Reference Objects 
project. 

Override the following  properties  of the domain: Select the 
property(ies) you want overridden in the bound business 
domain. If the attribute is bound to a domain, the four check 
boxes are enabled and are synchronized with the domain 
properties. The override options are available only if the 
corresponding enforcement property is selected on the 
domain (i.e., the property is enforced). Otherwise, if you 
change the property on the attribute, it is assumed to be 
overriding the domain property. 

CAUTION: You can bind to a Business Element or Domain, not 
to both. If you have a bound Business Element and attempt to 
also bind a domain, a Bound Domain Warning dialog opens. 
Select Yes to choose to remove the Business Element binding 
and bind the domain. If you select No the domain binding is 
not accepted and the Bound Domain selection returns to 
“None”. 

Name Name of the Business Attribute. 

Description 

Override Bound Business 
Element Description 

If the Description Override option is selected on the General 
tab, this option is selected by default. This ensures that any 
description additions or changes are always in synch with the 
bound Business Element description. 

If this option is not selected, you cannot edit the description on 
this tab. 

CAUTION: If you clear the override check box, the description 
from the Business Element is enforced on the Business 
Attribute without warning. 
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Property  View Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

Override Bound Business 
Element Notes 

If the Notes Override option is selected on the General tab, 
this option is selected by default. This ensures that any notes 
additions or changes are always in synch with the bound 
Business Element notes. 

 
 
If this option is not selected, you cannot edit the notes on this 
tab. 

 
 
CAUTION: If you clear the override check box, the notes from 
the Business Element is enforced on the Business Attribute 
without warning. 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Bindings 

Add Binding Opens the Create Binding with Targets... dialog where you can 
create bindings. 

 
 
CAUTION: You can bind to a Business Element or Domain, not 
to both. If you have a bound Business Element and attempt to 
also bind a domain, a Bound Domain Warning dialog opens. 
Select Yes to choose to remove the domain binding and bind 
the Business Element. If you select No the Business Element 
binding is not accepted and the Bound Business Element 
selection returns to “None”. 

Edit Target Opens the Property View for the selected target in the 
Bindings hierarchy. 
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Property  View Description 

Delete Binding Removes the source from the Bindings hierarchy. 

Expand All Expand the entire binding hierarchy. 

Collapse All Collapses the entire binding hierarchy. 

Refresh Binding Updates all the nodes in the Binding Report. 

Resolve Violation Resolves the conflict that occurs when a property is changed in 
a Business Attribute that doesn’t match the property in a 
bound Business Element or Domain. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options You can choose to hide or show the unique identifier (#) for the 
Business Attribute. This option is selected by default when you 
have set an attribute as a unique identifier on the General tab. 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 
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Property  View Description 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

 
 

Interaction 

The table below describes the Property View fields available for an Interaction: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Source Displays the name of the source Business Element. 

Target Displays the name of the target Business Element. 

Verb Phrase Describes the parent-to-child action. 

Inverse Verb Phrase Describes the child-to-parent action. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Mappings 

Create Mapping Click to open the Create Mapping dialog. 

Edit Target Click to open the Property View for the targeted 
ele 

Remove Target from 
Mapping 

The deleted target is no longer mapped. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 
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Property  View Description 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Diagram Display Options Name: Displays the label of the Interaction. This option is 
selected by default. 

Verb Phrase: Displays the verb phrase text you entered on the 
General tab. 

Inverse Verb Phrase: Displays the inverse verb phrase text you 
entered on the General tab. 
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Property  View Description 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: You can change the width of the interaction in the 
diagram. Select 1 through 5 pixels from the drop-down list box. 

Line Style: You can select one of five different styles from the 
drop down list. The list includes solid, dash, dot, dash-dot, and 
dash-dot-dot. 

Source Decorator: Choose between five choices for the 
beginning of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator: Choose between five choices for the 
termination of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

 
 

Relationship 

The table below describes the Property View fields available for a Relationship: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Source Displays the name of the source Business Element. 
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Property  View Description 

Target Displays the name of the target Business Element. 

Verb Phrase Describes the parent-to-child action. 

Inverse Verb Phrase Describes the child-to-parent action. 

Mandatory If you select Mandatory it becomes a mandatory property and 
a plus sign (+) appears to the left of the attribute. If it is not 
mandatory, a minus sign (-) appears to the left of the attribute. 

Relationship Type Generic, Many to Many, Many to One, One to Many 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 

Diagram Display Options Show connection: 

Show Name: Displays the label of the Interaction. This option 
is selected by default. 

Show Verb Phrase: Displays the verb phrase text you entered 
on the General tab. 

Show Inverse Verb Phrase: Displays the inverse verb phrase 
text you entered on the General tab. 

Show Unique Identifier:  Displays the identifier ( | ) on the 
relationship. 
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Property  View Description 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: You can change the width of the interaction in the 
diagram. Select 1 through 5 pixels from the drop-down list box. 

Line Style: You can select one of five different styles from the 
drop down list. The list includes solid, dash, dot, dash-dot, and 
dash-dot-dot. 

Source Decorator: Choose between five choices for the 
beginning of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator: Choose between five choices for the 
termination of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing start events on 
the active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new start event elements placed in the 
Diagram View. 

General diagram elements 
There are three general types of diagram elements available in ER/Studio BA: Reference  
Objects, External Data Objects, and Drawing Shapes. 
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Reference objects 
There are four Reference Objects:  Business Elements,  Business Rules, Business Units, Domains, 
and Stewards. Also, property views are available for the Links and Usages that you create 
between reference objects and processes and tasks. 

 
 

Business Elements 

The table below describes the Property View fields available for Business Elements: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Data Type: The data types available are: Binary, BLOB/Image, Boolean, 
Char, CLOB/Large Text, Date, Decimal, Integer, None, 
Timestamp, Varchar, and XML. The default setting is “None”. 

Enforcement options When you bind a Business Attribute to a Business Element, the 
attribute properties can be enforced (i.e., these properties 
replace the existing properties). The properties are: Name, 
Description, Notes, and Domain/Data Type. All items are 
selected by default. 

 
 
The enforced properties of Business Elements will always 
remain in synchronization with bound Business Attributes. 

 
 
CAUTION: If you change the enforcement options on an 
existing Business Element with bound Business Attributes to 
allow overrides, the “override” controls are disabled for all 
existing and new Business Attributes bound to the Business 
Element. 

 
 
Also, if you have a Business Element without enforcement 
(which is bound to attributes) and you choose to start enforcing 
the Business Element’s properties (i.e. the boxes are selected), 
a comparison is done on each of the bound Business Attributes 
to determine if the attribute’s property matches the Business 
Element’s property. 

• If the properties match, the “override” option is not selected 
on the attribute. 

• If the properties do not match, the “override” option is 
selected on the attribute. The override options are all enabled 
now that the properties are being enforced. In this manner, 
information is not lost on the Business Attribute. The 
information can be resolved at a later time from the properties 
view. 
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Property  View Description 

Description 

Override Bound Business 
Element Description 

If the Description Override option is selected on the General 
tab, this option is selected by default. This ensures that any 
description additions or changes are always in synch with the 
bound Business Element description. 

 
 
If this option is not selected, you cannot edit the description on 
this tab. 

 
 
CAUTION: If you clear the override check box, the description 
from the Business Element is enforced on the Business 
Attribute without warning. 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

Override Bound Business 
Element Notes 

If the Notes Override option is selected on the General tab, 
this option is selected by default. This ensures that any notes 
additions or changes are always in synch with the bound 
Business Element notes. 

 
 
If this option is not selected, you cannot edit the notes on this 
tab. 

 
 
CAUTION: If you clear the override check box, the notes from 
the Business Element is enforced on the Business Attribute 
without warning. 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Bindings 

Add Binding Opens the Create Binding with Targets... dialog where you can 
create bindings. 

 
 
CAUTION: You can bind to a Business Element or Domain, not 
to both. If you have a bound Business Element and attempt to 
also bind a domain, a Bound Domain Warning dialog opens. 
Select Yes to choose to remove the domain binding and bind 
the Business Element. If you select No the Business Element 
binding is not accepted and the Bound Business Element 
selection returns to “None”. 

Edit Target Opens the Property View for the selected target in the 
Bindings hierarchy. 

Delete Binding Removes the source from the Bindings hierarchy. 

Expand All Expand the entire binding hierarchy. 

Collapse All Collapses the entire binding hierarchy. 

Refresh Binding Updates all the nodes in the Binding Report. 

Resolve Violation Resolves the conflict that occurs when a property is changed in 
a Business Attribute that doesn’t match the property in a 
bound Business Element or Domain. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Business Rules 

A business rule is a policy, practice, or formula related to the operation and enforcement of 
business practices. The table below describes the Property View fields available for Business 
Rules: 

 
Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type: None: No type is required. 

Constraint: a condition that limits or controls the actions of the 
business. 

Definition: A statement that defines some aspect of the 
business. 

Derivation: A derivation is either a mathematical calculation or 
an inference. 

Fact: A fact is a set of named fields and typed values that 
encapsulates the binding information. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 
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Property  View Description 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Business Units 

A business unit is an organizational area within or external to an enterprise, for example, Human 
Resources, Sales, Accounting, etc. The table below describes the Property View fields available 
for Business Units: 

 
Property  View Description 

General 

Name: Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can 
change the Usage attributes in this column and this change is 
reflected in the diagram. For example, you can change a C 
(Create) type to a U (Update) type. 

Usage Description: Displays the information entered in 
the Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Domains 

Domains are reusable attribute templates that promote consistent domain definitions. You 
construct domains as you would attributes, specifying a name, datatype properties, null status, 
default values and validation rules. The table below describes the Property View fields available 
for Domains: 

 
Property  View Description 

General 

Name: Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Data Type: The data types available are: Binary, BLOB/Image, Boolean, 
Char, CLOB/Large Text, Date, Decimal, Integer, None, 
Timestamp, Varchar, and XML. The default setting is Varchar. 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Optionality None 

Mandatory 

Optional 

The default value is “None” 

Enforcement options When binding to Business Attributes, the attribute properties 
can be enforced (i.e., these properties replace the existing 
properties). The properties are: Data Type, Width and Scale, 
and Optionality. 

Description 

Override Bound Business 
Element Description 

If the Description Override option is selected on the General 
tab, this option is selected by default. This ensures that any 
description additions or changes are always in synch with the 
bound Business Element description. 

 
 
If this option is not selected, you cannot edit the description on 
this tab. 

 
 
CAUTION: If you clear the override check box, the description 
from the Business Element is enforced on the Business 
Attribute without warning. 
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Property  View Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

Override Bound Business 
Element Notes 

If the Notes Override option is selected on the General tab, 
this option is selected by default. This ensures that any notes 
additions or changes are always in synch with the bound 
Business Element notes. 

 
 
If this option is not selected, you cannot edit the notes on this 
tab. 

 
 
CAUTION: If you clear the override check box, the notes from 
the Business Element is enforced on the Business Attribute 
without warning. 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Bindings 

Add Binding Opens the Create Binding with Targets... dialog where you can 
create bindings. 

 
 
CAUTION: You can bind to a Business Element or Domain, not 
to both. If you have a bound Business Element and attempt to 
also bind a domain, a Bound Domain Warning dialog opens. 
Select Yes to choose to remove the domain binding and bind 
the Business Element. If you select No the Business Element 
binding is not accepted and the Bound Business Element 
selection returns to “None”. 

Edit Target Opens the Property View for the selected target in the 
Bindings hierarchy. 
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Property  View Description 

Delete Binding Removes the source from the Bindings hierarchy. 

Expand All Expand the entire binding hierarchy. 

Collapse All Collapses the entire binding hierarchy. 

Refresh Binding Updates all the nodes in the Binding Report. 

Resolve Violation Resolves the conflict that occurs when a property is changed in 
a Business Attribute that doesn’t match the property in a 
bound Business Element or Domain. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 
 
 
Stewards 

A steward is a person or organization responsible or associated with a model element, for 
example “DBA, Auditor, Jeffrey Smith, etc.” The table below describes the Property View fields 
available.: 

 
Property  View Description 

General 

Name: Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type: Does the steward represent an Individual or an organization? 

E-mail Address: If applicable, enter the e-mail address for the steward. 

Responsibility: If applicable, enter the responsibilities of the steward. 
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Property  View Description 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Links 

The table below describes the Property View fields available for the link: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Verb phrase Type a verb phrase that describes the relationship from the 
perspective of the target. For example: EMPLOYEE "owns" 
RESUME. This label appears on the link where it connects to 
the linked element. 

Inverse verb phrase Type a verb phrase that describes the relationship from the 
perspective of the element to be linked to. For example: 
RESUME "is owned by" EMPLOYEE. This label appears on the 
link where it connects to the originating element. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Source and Receivers 

Source 
Click  to display the properties for the Link source. 

Targets A grid shows the Name and Element Type for the targets. 

You can add a link ( ), 

edit the properties of a link ( ), 
or delete a link ( ). 



PR OPERTY  V I EW S  >  GENERAL  DIA G RAM  ELEM ENTS  

ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 527   

 

 

 
 
 

Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Diagram Display Options Show Connection: Selection this option to display the link in 
the diagram. 

Show Name: Select this option to display the label that 
appears for an element in the diagram. 

Show Inverse Verb Phrase: Displays the inverse verb phrase 
that describes the relationship from the perspective of the 
element to be linked to. 

Show Verb Phrase: Displays the verb phrase that describes 
the relationship from the perspective of the target. 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: Select the width of the border from the drop-down 
list. You can select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 



528   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

PR OPER TY  V I EWS  >  GE NER A L  DIAGRAM  E L EMENTS   

 

 
 
 

Property  View Description 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 

 
 

Usages 

The table below describes the Property View fields available for the Usage link: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Usage Create: Add new records or entries. Read: 

View existing records or entries. Update: 

Edit existing records or entries. Delete: 

Eliminate existing records or entries. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Show Connection: Select this option to display the Usage 
element. 

Show Name: Select this option to display the label that 
appears for an element in the diagram. 

Show Usage: Select this option to display the usage setting for 
the Usage. 
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Property  View Description 

Line Display Options Layout: You can select one of three layout styles: curved, 
elbowed, or straight. The default is curved. 

Line Width: You can change the width of the interaction in the 
diagram. Select 1 through 5 pixels from the drop-down list box. 

Line Style: You can select one of five different styles from the 
drop down list. The list includes solid, dash, dot, dash-dot, and 
dash-dot-dot. 

Source Decorator: Choose between five choices for the 
beginning of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Source Decorator Size: Set the size of the decorator (arrow) at 
the origination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Target Decorator: Choose between five choices for the 
termination of the Interaction link. Your choices are: 

• none 

• arrow 

• diamond 

• many to many 

• triangle 

Target Decorator  Size: Set the size of the decorator (arrow) at 
the termination point of the sequence flow. Your choices are: 
extra small (XS), small (S), medium (M), large (L), and extra large 
(XL). 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 

External data objects 
There are eight different external data objects:  Data Feed Object,  Data Store Object,  Entity  
Object, Flat File Object,  Report Object, Table Object and  View Object. There are also 
associated Individual Elements: Attribute, Column, and Data Element. 
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The table below describes the Property View fields available for an External Business Objects 
project: 

 
Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location Displays the path and file name for the selected reference 
object. 

Version Displays the version of ER/Studio BA. 

Model Type Displays whether it is a Conceptual or Business Process model. 

Model Type  
Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

 
 

Data Feed Object 

The table below describes the Property View fields available for the Data Feed Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 



532   ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 

PR OPER TY  V I EWS  >  GE NER A L  DIAGRAM  E L EMENTS   

 

 
 
 

Property  View Description 

Location: Displays the path and file name for the selected reference 
object. 

Type Type of data being transferred. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Data Elements 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Pint Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Data Store Object 

The table below describes the Property View fields available for the Data Store Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location: Displays the path and file name for the selected reference 
object. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Data Elements 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 
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Property  View Description 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Entity Object 

The table below describes the Property View fields available for the Entity Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Attributes 

Name Default name is Attribute. 

Data Type Displays the data type for the Entity. Click in the cell and a 
drop-down list opens displaying all data type: Binary, Boolean, 
Char, Date, Decimal, Float, Integer, Long Binary, Money, 
Timestamp, Varchar, or XML 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Nulls Allowed Select Yes or No from the drop-down list to indicate whether 
nulls are allowed in the row. 

Primary Key Select Yes or No from the drop-down list to indicate whether 
the attribute is a primary key. 
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Property  View Description 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 
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Property  View Description 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Flat File Object 

The table below describes the Property View fields available for this Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location: Displays the path and file name for the selected reference 
object. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Data Elements 

Name Name of data element contained in the flat file. Default name 
is Data Element. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 
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Property  View Description 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Report Object 

The table below describes the Property View fields available for the Report Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Location: Displays the path and file name for the selected reference 
object. 

Type Select a type of report from a drop-down list: Business 
Intelligence (BI) Report, Microsoft Word Document, or 
Microsoft Excel Spreadsheet. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Data Elements 

Name Name of data element contained in the flat file. Default name 
is Data Element. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 
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Property  View Description 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 

 
 

Table Object 

The table below describes the Property View fields available for the Table Object: 
 

Property View  Description 
 

General 
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Property  View Description 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Columns 

Name Default name is Column. 

Data Type Displays the data type for the Table. Click in the cell and a 
drop-down list opens displaying all data types: Binary, Boolean, 
Char, Date, Decimal, Float, Integer, Long Binary, Money, 
Timestamp, Varchar, or XML 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Nulls Allowed Select Yes or No from the drop-down list to indicate whether 
nulls are allowed in the row. 

Primary Key Select Yes or No from the drop-down list to indicate whether 
the attribute is a primary key. 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 
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Property  View Description 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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View Object 

The table below describes the Property View fields available for the View Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Columns 

Name Default name is Column. 

Data Type Displays the data type for the Table. Click in the cell and a 
drop-down list opens displaying all data types: Binary, Boolean, 
Char, Date, Decimal, Float, Integer, Long Binary, Money, 
Timestamp, Varchar, or XML 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Nulls Allowed Select Yes or No from the drop-down list to indicate whether 
nulls are allowed in the row. 

Primary Key Select Yes or No from the drop-down list to indicate whether 
the attribute is a primary key. 
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Property  View Description 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 
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Property  View Description 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Attribute 

The table below describes the Property View fields available for the Data Feed Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Data Type Click in this cell and all available data types are listed. The Data 
Types available are high level: binary, BLOB/Image, boolean, 
char, CLOB/Large Text, Decimal, Date, Integer, Time Stamp, 
Varchar, and XML. 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Allow Nulls Specifies whether or no nulls are possible. 

Primary Key Select Yes or No from the drop-down list to indicate whether 
the attribute is a primary key. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 
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Property  View Description 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Pint Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 

 
 

Column 

The table below describes the Property View fields available for the Data Feed Object: 
 

Property View  Description 
 

General 
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Property  View Description 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Data Type Click in this cell and all available data types are listed. The Data 
Types available are high level: binary, BLOB/Image, boolean, 
char, CLOB/Large Text, Decimal, Date, Integer, Time Stamp, 
Varchar, and XML. 

Width The length of the attribute/domain datatype. 

Scale Indicates the number of digits after a decimal (for those data 
types that imply a decimal. 

Allow Nulls Specifies whether or no nulls are possible. 

Primary Key Select Yes or No from the drop-down list to indicate whether 
the attribute is a primary key. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 
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Property  View Description 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Pint Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Data Element 

The table below describes the Property View fields available for the Data Feed Object: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Pint Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to display the object’s name. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Drawing shapes 
Drawing Shapes are used to provide additional information about the Process. There are nine 
different shapes: Box, Rounded Box, Circle, Triangle, Diamond, Pentagon, Hexagon, Octagon, 
Cylinder, and Text Label. The properties are the same for all the shapes with the exception of the 
Text Label, Line, and Annotation. 

The table below describes the Property View fields available for all the drawing shapes: 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type: Displays the type of shape, i.e., Octagon. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 
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Property  View Description 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete option     
() becomes available. This action removes the selected 
receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Rendering There are two commands available: 
 
 
Shadowed: Turn the “3-D” shadowing on or off for the drawing 
shape. 

 
 
Transparent: Turn the “fill” off so drawing shape is transparent. 
Only the border is displayed. 

Note: You can set Rendering default preferences. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to set the alignment (top, centered or 
bottom) of a text label within an element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Line Width: Select the width of the border from the drop-down 
list. You can select from 1 to 5 pixels. 

 
 
Line Style: Select the line style from a drop-down list. 
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Property  View Description 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 

 
 

Text Label 

The table below describes the Property View fields available for the Text Label: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Text Contains the text for the label. 

Type: Displays the type of shape, for example, text label. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 
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Property  View Description 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 

Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Vertical Alignment Use these commands to set the alignment (top, centered or 
bottom) of a text label within an element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing text labels on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new text labels placed in the Diagram 
View. 
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Line 

The table below describes the Property View fields available for the Line drawing shapes: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type: Displays the type of shape, i.e., Octagon. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Diagram Display Options Select this option to show the element label and any 
connections. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

You can also set the line style, source decorator, and target 
decorator. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Annotation 

The table below describes the Property View fields available for the Annotation drawing shapes: 
 

Property  View Description 

General 

Name Label that appears for an element both in the Model View tree 
and in the diagram. You can edit this label. 

Type: Displays the type of shape, i.e., Octagon. 

Description 

 A text box where you can enter information describing or 
defining the project. Right-click text to open a shortcut menu. 
You can cut, copy, paste, and delete selected text within the 
Description text box. You can paste plain text from external 
applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color. 

Notes 

 A text box where you can annotate the element with additional 
information. Right-click text to open a shortcut menu. You can 
cut, copy, paste, and delete selected text within the Notes text 
box. You can paste plain text from external applications. 

 
 
You can undo any action and you can select all text by pressing 
Ctrl+A. 

 
 
The following formatting options are available for the text: 
Bold, Italics, Underscore, and Strikethrough. You can also 
change the font color as well as the background color 

Links 

Add Link Opens the  Create Link wizard. This wizard allows you to create 
conceptual or usage links between elements. 

Edit Link Opens the property view for the selected link. 

Delete Link Deletes the selected link (either the link or the link target). 

Show Selected Links on 
Active Diagram 

Once you have created a link in the Diagram View, click this 
icon to display the links for the selected object in the diagram. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Links Updates all the nodes in the Link Report. 
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Property  View Description 

Usage (CRUD) 

Usage The header displays the name of the linked element and the 
status of the filter (on or off). 

Receivers: Displays a list of the elements with usages 
(receivers). You can select multiple receivers in this list and 
delete all the receivers that are selected. 

Usage: Displays the usage setting (C, R, U, D). You can change 
the Usage attributes in this column and this change is reflected 
in the diagram. For example, you can change a C (Create) type 
to a U (Update) type. 

Usage Description: Displays the information entered in the 
Description text field for the target object of the usage. For 
example, if a usage was drawn between a task and a Data Store 
object, the description of the Data Store object is displayed. 

If there are no links or all the links have been filtered out, you 
are given the information that “No usages have been defined 
for this element” in the Receivers column. 

Add Usage Opens the Create Usage wizard where you can create a new 
usage. 

Edit Usage When you select a Receiver in the table, the edit option 
becomes available. Click this to open the Usage edit 
tab where you can edit the name of the usage. The 
default name is “Usage”. You can also change the usage 
settings (Create, Read, Update, and Delete). 

Delete When you select a Receiver in the table, the delete 
option becomes available. This action removes the 
selected receiver from the usage. 

Show Selected Usages When you select a Receiver in the table, the Show Selected 
Usages option ( ) becomes available. Click this icon to 
display the usage for the selected receiver in the diagram, 
including the usage settings. 

Filter Receiver Types Opens the Usage Report Filter dialog where you can select the 
types of objects you want included in the Usage Report. 

Export Usage Report You can export the Usage (CRUD) reports in the following 
formats: CSV, HTML, PDF, and RTF 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Refresh Usage Updates all the nodes in the Usage Report. 
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Property  View Description 

Impact Analysis 

Filter Designation Indicates whether a Filter has been set for the Impact Analysis 
Report. 

Two icons are displayed to the left of the Filter Designation 
indicator: 

 

Click    to display the impact analysis information in a tree 
format. 

 

Click  to display the impact analysis information in a table 
format. 

Create Impact Analysis  
Diagram 

Once you create a link you can create a diagram that is a 
graphical representation of that link. 

Filter Opens the Impact Analysis Filter dialog 

Export You can export and save the Impact Analysis report in the 
following file formats: CSV, HTML, PDF, and RTF. 

Print Opens the Print dialog where you can select a printer, set 
preferences, select a page range and number of copies and 
then print. 

Expand All Expands all the nodes in the tree. 

Collapse All Collapses all the nodes in the tree. 

Refresh Updates all the nodes in the Impact Analysis Report. 

Appearance 

Font and Color Options Use these commands to change fonts and element colors. 
Note that the element line and fill command is unavailable for 
the Business Rule element. 

Horizontal Alignment Use these commands to set the justification for text labels in an 
element. 

Diagram Display Options Select this option to show the element label. 

Line Display Options Select the width of the border from the drop-down list. You can 
select from 1 to 5 pixels. 

Apply to Diagram Applies the formatting changes to all existing shapes on the 
active diagram. 

Restore Defaults Restores the default settings for all changes made in the 
Appearance tab. 

Set as Default All formatting changes made in the Appearance tab become 
the default settings for new shapes placed in the Diagram 
View. 
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Glossary 
Annotation:  An Annotation is a piece of information attached to a certain region of a text 
document. Annotations are attached to documents via their annotation model and may be 
displayed in text editors and views. 

API:  Abbreviation of application program interface, a set of routines, protocols, and tools for 
building software applications. A good API makes it easier to develop a program by providing 
all the building blocks. A programmer puts the blocks together. 

Most operating environments, such as MS-Windows, provide an API so that programmers can 
write applications consistent with the operating environment. Although APIs are designed for 
programmers, they are ultimately good for users because they guarantee that all programs 
using a common API will have similar interfaces. This makes it easier for users to learn new 
programs. 

Assign Time:  An Assignment may have an AssignTime setting. If the Object is an activity (Task, 
Sub-Process, or Process), then the Assignment must have an AssignTime. A value of Start means 
that the assignment shall occur at the start of the activity. This can be used to assign the higher- 
level (global) Properties of the Process to the (local) Properties of the activity as an input to the 
activity. A value of End means that the assignment shall occur at the end of the activity. This can 
be used to assign the (local) Properties of the activity to the higher-level (global) Properties of 
the Process as an output to the activity. 

Association - Conceptual Modeling:  An Association shows the relationship between two 
things representing a loose coupling. 

Association - Business Process Modeling:  An Association is used to associate information and 
artifacts with events and activities. 

Black Box Pool:  A Black Box Pool hides all activity detailed within the Pool. 

Business Attribute: Used in Conceptual Modeling. This is a property of a business entity. An 
example would be “Customer Name”. 

Business Entity:  Used in Conceptual Modeling. A “thing” of the business/organization 
containing other business entities or elements. An example of an entity would be “Customer”. 

Business Process Diagram (BPD):  A Business Process Diagram (BPD) uses a flowcharting 
technique which is tailored for creating graphical models of business process operations. A 
Business Process Model is a network of graphical elements, which track the flow of activities and 
their order of performance. 

Business Process Management System (BPMS):  Refers to activities performed by businesses 
to optimize and adapt their processes. 

Business Process Modeling Language (BPML):  The Business Process Modeling Language 
(BPML) is a meta-language for the modeling of business processes, just as XML is a meta- 
language for the modeling of business data. BPML provides an abstracted execution model for 
collaborative and transactional business processes based on the concept of a transactional 
finite-state machine. 

Business Process Modeling Notation (BPMN):  A Business Process Diagram is made up of a 
set of graphical elements. These elements enable the development of simple diagrams.
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Business Process Query Language (BPQL):  The Business Process Query Language (BPQL) is a 
management interface to a business process management infrastructure that includes a process 
execution facility (Process Server) and a process deployment facility (Process Repository). 

The BPQL interface to a Process Server enables business analysts to query the state and control 
the execution of process instances managed by the Process Server. This interface is based on 
the Simple Object Access Protocol (SOAP). 

Business Rules System:  An automated system where the “rules” are separated and shared 
across data stores, user interfaces and applications. A rule is a formal expression of knowledge 
or preference which steers behavior in a desired direction. 

Business Unit:  Part of an organization treated for any purpose as a separate entity within the 
parent organization. Examples include a department or distribution center. 

Compensation:  Compensation is when activities are invoked that undo an undesirable 
outcome. 

Complex Decision:  This expression determines which output flow is taken from multiple 
Sequence Flow names. 

Complex Merge:  You specify a complex flow condition referencing incoming Sequence Flow 
names or process data coming into a gateway. This expression determines when the task starts. 

Conceptual Modeling:  High level models used to explain entities related to the business / 
organization. This modeling maps to the higher level Subject Area model and to the lower level 
Logical Data model. 

Data-based XOR decision:  A data-based XOR decision is the most common XOR gateway 
used. A data token traverses the Process Flow and arrives at the XOR gateway. The path it 
chooses is based on condition expressions for each gate. It is restricted to only one flow. 

Data Objects:  Data objects provide information about how documents, data, and other 
objects are used and updated in a Process. They represent data so are defined by a 
combination of entities or classes. 

Design:  The part of software development process whose primary purpose is to decide how 
the system will be implemented. During design, strategic and tactical decisions are made to 
meet the required functional and quality requirements of a system. 

Design Area:  The area in the Diagram window where you create your designs. 

Diagram:  A graphical presentation of a collection of model elements often rendered as 
connected graph of arcs and vertices. UML supports the following diagrams: class diagram, 
object diagram, use case diagram, sequence diagram, collaboration diagram, state diagram, 
activity diagram, component diagram, and deployment diagram. 

End Event:  Ends a process flow. Additional result types are available on the palette, from the 
shortcut menu, and in the property view. 

End Kill Event:  The process has encountered a fatal error and all activities in the process 
should be immediately ended. The process is ended without compensation or event handling. 

Enumeration:  A list of named values used as the range of a particular attribute type. For 
example, RGBColor = {red, green, blue}. Boolean is a predefined enumeration with values from 
the set {false, true}.



ER/STUDIO® BUSINESS ARCHITECT USER GUIDE 577   

GLOSSARY >  

 

 

Event:  Happens during the course of a process flow. 

Exception:  Error messages generated. 

Execution:  The running of a dynamic model. 

Exclusive Merge (XOR):  The most common gateways used. A data token traverses the Process 
Flow arriving at the gateway. It can only go out on one flow. This control type is represented by 
either a blank diamond shape or a diamond with an “x” in the middle. 

Expression:  Enter the expression that defines the relationship between one InputSet and one 
OutputSet. That is, if the activity is instantiated with a specified InputSet, then the output of the 
activity MUST produce the specified OutputSet. Zero or more IORules may be entered. 

Final Node:  Final node that stops all flows in an activity. An activity may have more than one 
final node. 

Flow Final:  Final node that terminates a flow. A flow final destroys all tokens that arrive at it. 

Gateways:  The gateway symbol models decisions, merges, forks and joins in the process flow. 
A gateway is a question that is asked at a point in the process flow with alternative answers. 

Generated Name:  The generated name is a code-friendly name that you may not want to see 
in the Model View tree or the diagram. For example, you may want to display a multibyte name 
(name), and have a code friendly single byte generated name. Or you may want a user-friendly 
name (e.g My First Task), but a generated name like “MY_FIRST_TASK”. You can edit this name. 

Grid Editor:  This is a table-like editor which is an alternative to the Model View. Content in the 
Grid Editor can be printed or exported as a report. 

IDEF:  Integrated Computer-aided Manufacturing (ICAM) Definition. 16 different IDEF methods. 
Key methods are listed below. The three core models are: IDEF0, IDEF1X, and IDEF3. 

• IDEF0 -Business Process Diagram (Integration Definition Language 0) (functional modeling) 

• IDEF1X - Data Modeling 

• IDEF2 - Simulation 

• IDEF3 - Workflow or Process Diagramming 

• IDEF4 - Object oriented Design  

• IDEF8 - User-interface Design  

• IDEF12 - Organization Modeling 

Impact Analysis Diagram:  Opens a new diagram which graphically displays all links associated 
with the object. Links connect to objects that can’t be visualized on a diagram are not included. 

Impact Analysis Report:  Opens the Impact Analysis tab in the property view, which shows the 
interrelationships between elements in the Model View tree. 

Inclusive OR Decision:  One or more of the outgoing Sequence Flows may be taken. A default 
flow must be specified at this point, there cannot be zero output flows. 

Inclusive OR Merge:  A process flow continues when it receives the first input signal from the 
input Sequence Flows. If other signals arrive after that, they are not used. 

Inheritance:  Used in Conceptual modeling. It is the relationship between two things where one 
is created from the other.
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Interaction:  Used in Conceptual modeling. It is a relationship between two things representing 
an action, process, or transaction. 

Intermediate Event:  Happens during the course of a process event. Additional trigger types 
are available on the palette, from the shortcut menu, and in the property view. 

Iterative:  In the context of the software development lifecycle, a process that involves 
managing a stream of executable releases. 

Lane:  A lane is a container or package. They are children of pools. Lanes can represent different 
parts of an organization. 

Local History:  Local history of a file is maintained when you create or modify a file. Each time 
you edit and save a file, a copy of it is saved. This allows you to compare your current file state 
to a previous state, or replace the file with a previous state. Each state in the local history is 
identified by the date and time the file was saved. 

Location:  The placement of a component on a node. 

Loop Type:  LoopType is an attribute and is by default None, but may be set to Standard or 
Multi Instance. If so, the Loop marker shall be placed at the bottom center of the activity shape. 

Message Flow:  Helps you order the processes between organizations or departments (i.e., 
between pools). 

Message Numbers:  Message numbers illustrate the ordering of messages on Sequence and 
Collaboration diagrams. 

Metaclass:  A class whose instances are classes. Metaclasses are typically used to construct 
metamodels. 

Meta-metamodel: A model that defines the language for expressing a metamodel. The 
relationship between a meta-metamodel and a metamodel is analogous to the relationship 
between a metamodel and model. 

Metamodel:  A model that defines the language for expressing a model. 

Metaobject:  A generic term for all metaentites in a metamodeling language. For example, 
metatypes, metaclasses, metaattributes, and metaassociations. 

Model:  A Model is a specific collection of diagrams and elements related to the Business 
Process Modeling Notation. For example, a banking industry BPMN model would contain those 
elements associated with the banking business process. The Model contains Business Process 
Diagrams which are graphical representations of all the elements of the process. 

Model Business Events:  In business process modeling, events are modeled that happen in the 
business and how they affect process flows. An event can kick off a process flow, it can happen 
during a process flow, 0or it can end a process flow. 

Model Elaboration:  The process of generating a repository type from a published model. 
Includes the generation of interfaces and implementations which allows repositories to be 
instantiated and populated based on, and in compliance with, the model elaborated. 

Model Element:  An element that is an abstraction drawn from the system being modeled. 

Model Library:  A stereotyped package that contains model elements that are intended to be 
reused by other packages. A model library differs from a profile in that a model library does not 
extend the metamodel using stereotypes and tagged definitions. A model library is analogous 
to a class library in some programming languages.
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Multi-Drop State:  This is the default setting in ER/Studio BA that allows you to drop multiple 
elements in the diagram design area. 

Name:  A string used to identify a model element. 

Namespace:  A part of the model in which the names may be defined and use. Within a 
namespace, each name has a unique meaning. 

Nature:  Project natures allow a plug-in to tag a project as a specific kind of project. For 
example, the Java development tools (JDT) use a "Java nature" to add Java-specific behavior 
to projects. Project natures are defined by plug-ins, and are typically added or removed per-
project when the user performs some action defined by the plug-in. 

Object:  An entity with a well-defined boundary and identity that encapsulates state and 
behavior. State is represented by attributes and relationships, behavior is represented by 
operations, methods, and state machines. An object is an instance of a class. 

Object Constraint Language:  A formal language used to express side effect-free constraints. 

Objects and Instances:  Object is an abstraction representing some component of a system, 
and can be used to represent the components of any system. When the actual component 
occurs, it is an instance of that object. Often, the object is said to have been instantiated, or 
created in a system. In software systems, objects represent run-time instances of some type of 
processing, and the values used to accomplish this processing. In this documentation, object is 
used in the broadest sense -- it is not restricted to objects as defined in object-oriented design 
theory. 

Palette:  Palettes contain icons representing all the symbols you need for a particular 
methodology model, such as the Class Diagram notation. When laying out your design, you use 
these symbols to represent different symbols and their relationships with each other. Every time 
you open a new diagram, the palette with the diagram's associated symbols appears in the left 
side of the Diagram window. 

Parallel Forking (AND):  All sequence flows out of this gateway are taken. 

Parallel Joining (AND):  This gate must receive input signals from all input Sequence Flows. 
The process flow does not continue until it receives all signals. 

Parameter:  The specification of a variable that can be changed, passed, or returned. A 
parameter may include a name, type, and direction. Parameters are used for operations, 
messages, and events. 

Parameterized Element:  The descriptor for a class with one or more unbound parameters. 

Parent:  In a generalization relationship, the generalization of another element, the child. 

Participant:  You must define the Participant for a Pool. The Participant can be either a Role or 
an Entity. This defines the role that a particular Entity or Role the Pool will play in a Diagram that 
includes collaboration. 

Participate:  The connection of a model element to a relationship or to a relationship. For 
example, a class participates in an association, an actor participates in an use case. 

Partition: 1. Activity graphs: A portion of an activity graphs that organizes the responsibilities for 
actions. 2. Architecture: A set of related classifiers or packages at the same level of abstraction 
or across layers in a layered architecture. A partition represents a vertical slice through an 
architecture, whereas a layer represents a horizontal slice.
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Path Variable:  Path variables specify locations on the file system. The location of linked 
resources may be specified relative to these path variables. They allow you to avoid references 
to a fixed location on your file system. By using a path variable, you can share projects 
containing linked resources with team members without requiring the exact same directory 
structure as on your file system. 

Pinning:  One element can be selected and pinned, allowing you to select other elements will 
still being able to document the pinned element. 

Pools:  Pools denote who is performing a process. A pool can be partitioned into lanes. A pool 
represents an organization and a lane is a department within that organization, functions, 
application or systems. 

Presentation Element:  Elements displayed in the Model View tree are represented by an icon 
only with no associated meta-data. If an element is a presentation element, it is indicated by a 
small white box with a directional arrow attached to the element. 

Process:  A Process is a collection of flow objects that reside in a pool connected by flows that 
is executed in a sequence (usually depicted on a diagram). In ER/Studio BA, all processes are 
contained by a pool. A pool contains only one process, but you can have multiple pools in a 
diagram which can then collaborate via message links. 

In the Business Process Modeling Notation Specification, all Business Process Diagrams must 
contain at least one pool. In ER/Studio BA, when you create a new diagram, a pool and lane with 
an invisible boundary are created as well. In ER/Studio BA, when you place an object in the 
diagram, that object is placed in the lane. 

Project:  A project is used to create a collection of user-created data models or subprojects. 
Data sources and reference objects also exist as their own projects within the workspace. A 
Project is a collection of items including models, model elements, documents, business rules, 
etc. For example, a “Human Resources” project might contain a business process model 
describing the main functions of the Human Resources department, and a data model describing 
the data structures used by these processes, and business rules describing prescribed behavior 
of the organization. You can also create nested projects where a project is a parent of another 
project. 

Qualif ier:  An association attribute whose values partition the set of objects related to an 
object across an association. 

RCP:  Rich Client Platform. A platform for building client applications with rich functionality. 

RDBMS:  Short for relational database management system and pronounced as separate letters, 
a type of database management system (DBMS) that stores data in the form of related tables. 
Relational databases are powerful because they require few assumptions about how data is 
related or how it will be extracted from the database. As a result, the same database can be 
viewed in many different ways. 

An important feature of relational systems is that a single database can be spread across several 
tables. This differs from flat-file databases, in which each database is self-contained in a single 
table. 

Almost all full-scale database systems are RDBMS's. Small database systems, however, use other 
designs that provide less flexibility in posing queries. 

Receive Task:  A simple Task that is designed to wait for a message to arrive from an external 
participant. Once the message has been received, the Task is completed.
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Run Time: The period of time during which a computer program executes. 

Scenario:  A specific sequence of actions that illustrates behaviors. A scenario may be used to 
illustrate an interaction or the execution of a use case instance. 

Script Task:  A Script Task is executed by a business process engine. The modeler or 
implementer defines a script in a language that the engine can interpret. When the Task is ready 
to start, the engine executes the script. When the script is completed, the Task is also 
completed. 

Semantic Symbols:  When designing interaction diagrams before creating the class diagrams if 
a symbol with no class assigned is assigned to a class that does not exist, ER/Studio BA asks if 
you want it to create a corresponding class. If you instruct ER/Studio BA to create the class, ER/ 
Studio BA creates a semantic (non-displayed) class and places it in the ER/Studio BA System 
Tree as well as the Navigator window. ER/Studio BA populates the class with defined attributes 
and operations corresponding to the incoming messages and creates all of the internal linkage 
necessary to support subsequent consistency and diagram synchronization. You can drag these 
classes (including their associated attributes and operations) onto any class diagram. 

Semantic Variation Point:  A point of variation in the semantics of a metamodel. It provides an 
intentional degree of freedom for the interpretation of the metamodel semantics. 

Send Message:  The passing of a stimulus from a sender instance to a receiver instance. 

Send Task:  A simple Task that is designed to send a message to an external participant. Once 
the message has been sent, the Task is completed. 

Sequence Flow:  This is used to show the sequence of processes in an organization or 
department. If you have pools or lanes in your diagram, you can use Sequence Flow lines to 
connect events, processes and gateways placed within the pools or lanes. 

Service Task:  A Service Task is a Task that provides some sort of service, which could be a Web 
service or an automated application. This is the default setting. 

Start Message:  A start message comes from a participant and triggers the start of the process. 
Or it can continue the process in the case of an intermediate event. 

Start Event:  Starts a process flow 

Start Timer:  A specific time-date or a specific cycle (e.g., every Friday at 10:00 a.m.) is set that 
triggers the start of the Process. 

Start Link:  A mechanism for connecting the end of one Process to the start (or trigger) of 
another. 

Start Message:  A message arrives from a participant and triggers the start of the Process. 

Start Rule:  This type of event is triggered when the conditions for a rule become true. 

SWT:  Standard Widget Toolkit (SWT) is a widget toolkit for Java designed to provide efficient, 
portable access to the user-interface facilities of the operating systems on which it is 
implemented. 

Subject Area Modeling:  Extremely high-level model of “things” related in the 
business/organization. This modeling maps to the lower-level Conceptual Model. 

Subject Area:  Used in Conceptual modeling. Element is a container for other subject areas or 
business entities.
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Sub-process:  A process drawn on a ‘child’ diagram is called a sub-process. 

Swim Lanes:  You can group primary modeling elements by using swimlanes which consist of 
pools and lanes. A Pool represents a participant in a process. It also acts as a graphical 
container for partitioning a set of activities from other Pools, usually in the context of Business-
to-Business (B2B) situations.  A Lane is a subpartition within a Pool and extends the entire 
length of the Pool. Lanes are used to organize and categorize activities. 

Symbol:  In this documentation, symbol refers to a model element. 

Systems:  A system is a set or arrangement of things that form a whole. A system also 
embodies a set of rules and guidelines that specify a given plan or method of doing 
something. In accordance with this definition, a software system is comprised of a collection of 
software programs that accomplish a computer-based task. Some examples of these software 
systems are an Automated Teller System, an Inventory System, and a Flight Reservation 
System. 

System: A top-level subsystem in a model. 

Task:  This is an activity that is performed within a business process. 

Time:  A value representing an absolute or relative moment. 

Time Event:  An event that denotes the time elapsed since the current state was entered. 

Time Expression:  An expression that resolves to an absolute or relative value of time. 

Timing Constraint:  A semantic statement about the relative or absolute value of time or 
duration. 

Timing Mark:  A denotation for the time at which an event occurs. 

Trigger:  Events (Start, Intermediate and End) can have triggers that indicate the purpose of 
the event. Triggers include: Cancel, Compensate, Error, Message, Timer, Rule, Link, Multiple, 
or Terminate. 

Type Expression:  An expression that evaluates to a reference to one or more types. 

UML:  Unified Modeling Language, a language for visualizing, specifying, constructing, and 
documenting the artifacts of a software-intensive system. 

Usage (CRUD) Reports:  Usage (CRUD) Reports are designed to show how a process affects 
given data objects, specifically whether objects are Created, Read, Updated, or Deleted. 

User Task:  A typical “workflow” task where a human performer performs the Task with the 
assistance of a software application and is scheduled through a task list manager of some sort. 

Value:  An element of a type domain. 

View:  A projection of a model, which is seen from a given perspective or vantage point and 
omits entities that are not relevant to this perspective. 

View Element:  A view element is a textual and/or graphical projection of a collection of 
model elements. 

View Projection:  A projection of model elements onto view elements. A view projection 
provides a location and a style for each view element. 

Visibility: An enumeration whose value (public, protected, or private) denotes how the model 
element to which it refers may be seen outside its enclosing namespace.
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Visitor Behavioral Pattern: Represent an operation to be performed on the elements of an 
object structure. Visitor lets you define a new operation without changing the classes of the 
elements on which it operates. 

Workspace:  A workspace is a unit of storage used for any collection of data modeling 
projects, reference objects, and data source projects. In ER/Studio BA you can only open and 
work with one workspace at a time, but you can collect any number of projects in a single 
workspace. 

XOR Gateway:  XOR gates can model either data-based or event-based decisions. 

XSLT:  Short for Extensible Style Language Transformation, the language used in XSL style 
sheets to transform XML documents into other XML documents. 

An XSL processor reads the XML document and follows the instructions in the XSL style sheet, 
then it outputs a new XML document or XML-document fragment. 

This is extremely useful in e-commerce, where the same data need to be converted into 
different representations of XML. Not all companies use the exact same programs, 
applications and computer systems. 

XSLT Recommendation was written and developed by the XSL Working Group and became 
ratified by the W3C on November 16, 1999. 
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